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Chapitre 1 : Démarrage 
 
Système Hardware 
 
         Configuration Recommandée                         Configuration Minimum 
• Microsoft® Windows® 98, 2000 ou NT 4.0                      Microsoft® Windows® 95 ou NT 4.0    

(ou supérieur)                                                                      (ou supérieur) 
• Microprocesseur Intel® Pentium® ou compatible de        Microprocesseur Intel® Pentium® ou compatible 

300MHz ou plus                                                                 de 166MHz ou plus 
• RAM 64-128Mb                                                                 RAM 32-64Mb 
• Ecran couleur Super VGA 1024x768x32k                         Ecran couleur Super VGA 800x600x256 
• Hardware Son compatible Windows avec entrée(s)           Hardware Son compatible Windows avec entrée(s) 

stéréo à niveau ligne, résolution 16-24 bit, fréquence        stéréo à niveau ligne, résolution 16 bit, fréquence 
d’échantillonnage entre 5512 et 48k, avec capacité           d’échantillonnage 44.1k                                       
d’opération double. 

 
 
         Une fois installés, le programme et les fichiers nécessitent environ 18Mb d’espace de disque dur mais   
         souvenez-vous que les données audio peuvent prendre énormément d’espace lorsqu’ils sont enregistrés sur  
         le disque. Les fichiers audio numériques (.wav), également appelés fichiers wave, peuvent être très gros et  
         en raison de la nature des données, ne se compressent pas très bien (si vous utilisez des logiciels de  
         compression du disque). La chose est vraie pour les fichiers d’origine de Smaart.                                                
 
 
A Propos du Hardware Son de l’Ordinateur  
 
         SIA SmaartLive n’utilise pas directement le hardware son de l’ordinateur. Toutes les données audio sont  
         obtenues via les API audio bas niveau de Windows et ce programme fonctionnera donc avec la plupart des  
         cartes son compatible Windows. Seule la partie A/N et N/A du hardware son de l’ordinateur est utilisée,  
         ainsi SmaartLive fonctionnera avec une large gamme d’appareils d’entrée audio dont les cartes son  
         basiques.  
 
         Deux canaux d’entrée externe à niveau ligne indépendants (en général sous la forme d’un seul connecteur  
         stéréo) sont indispensables pour la fonction de transfert et les mesures de la réponse d’impulsion. nous  
         vous déconseillons d’utiliser les entrées microphones  
 
                  Sur la plupart des cartes son pour tous types de mesures. Pour le microphone de mesure, une console  
         externe ou un préamplificateur micro doivent être utilisés avec les entrées niveau ligne de l’ordinateur. de  
         plus, le hardware doit être capable de réaliser deux opérations simultanément si vous avez l’intention  
         d’utiliser le générateur de signal interne de SmaartLive comme source de signal pour vos mesures. 
         SIA SmaartLive n’utilise pas les capacités de synthèse du hardware son. En ce qui nous concerne le facteur 
         de différenciation entre les hardware son est la fréquence d’échantillonnage maximum, la résolution de  



         l’échantillonnage (bits par échantillon) et le rapport signal/bruit (S/B). Si votre ordinateur ne dispose pas de  
         hardware son, d’entrée à niveau ligne, ou que vous pensez que le hardware dont vous disposez peut se   
         révéler problématique pour quelque raison, il existe de nombreux appareils d’extension son sur le marché  
         que vous pouvez utiliser pour l’entrée et la sortie audio. 
         Lors de la sélection d’un hardware son pour l’utilisation avec SIA-Smaart, nous vous recommandons de  
         vérifier les fonctions et les caractéristiques audio suivantes : 
 

• Capacité de double opération (lecture et enregistrement simultané) 
• 2 canaux d’entrée externe à niveau ligne indépendants 
• Résolution d’échantillonnage 16 à 24 bit 
• Entrées numériques pour l’utilisation avec des convertisseurs A/N externes (optionnel mais vivement 

conseillé) 
• Fréquences d’échantillonnage réglables : SmaartLive supporte de nombreuses fréquences 

d’échantillonnage de 5512 à 48kHz. Un appareil d’entrée audio utiliser avec SmaartPro doit supporter 
des fréquences d’échantillonnage de 44.1kHz et/ou 48kHz et idéalement doit pouvoir supporter au 
moins une fréquence d’échantillonnage inférieure, quelque part entre 4kHz et 12kHz.  

 
 
Hardware Externe 
 
         En plus de votre ordinateur et de SIA SmaartLive, d’autres appareils externes peuvent être nécessaires afin  
         de réaliser les mesures sur le terrain. La liste suivante comprend les équipements dont vous pourrez avoir  
         besoin pour compléter votre kit de mesure: 
 

• Microphone de Mesure :Nous vous recommandons le meilleur microphone omnidirectionnel avec 
la réponse en fréquence la plus linéaire que vous puissiez raisonnablement vous offrir. Un 
préamplificateur microphone de grande qualité et une alimentation fantôme externe sont également des 
pièces très pratique au sein de votre kit de mesure.  

 
• Console ou autre appareil de réglage de niveau : Bien que vous puissiez régler les niveaux 

relatifs du signal sur l’ordinateur dans la plupart des cas, il est très pratique de pouvoir ajuster les 
niveaux de signal de l’extérieur. De plus, pouvoir changer rapidement les signaux qui alimentent les 
entrées de la carte son peut grandement accélérer le processus de mesure dans de nombreux cas. Une 
console compacte avec des entrées microphones silencieuses et une alimentation fantôme interne est 
idéale, puisque cela place plusieurs parties du « puzzle » dans une seule boite.  

• Câbles et adaptateurs : Les câbles Y sont pratiques pour liés le système de mesure au système de 
sonorisation. De plus, puisque la plupart des cartes son utilisent des entrées asymétriques (2 
conducteurs), plusieurs adaptateurs qui permettent la connexion symétrique/asymétrique peuvent être 
nécessaires. 

• Calibreur de Microphone et/ou Vu-mêtre SPL : Pour faire des mesures de Sound Pressure Level 
(SPL) avec SmaartLive, le programme doit être calibré en utilisant des références externes. La 
méthode la plus précise pour calibrer en SPL nécessite l’utilisation d’un calibreur de microphone à 
piston. Vous pouvez également calibrer efficacement SmaartLive en SPL en utilisant un vu-mêtre SPL 
comme référence si un calibreur de microphone n’est pas disponible. Notez qu’un vu-mêtre de niveau 
de pression sonore de haute qualité avec une sortie audio peut également être très efficace comme 
microphone de mesure. 

 
 
 
 
 
 
 
 
 
 
 
 
 



 
Installer SIA SmaartLive 
          
Installer SIA SmaartLive pour la Première Fois 
 
         La première installation de SmaartLive sur un ordinateur se déroule en deux étapes. L'installation initiale   
         installera une copie temporaire, d'une limite de 21 jours, de SmaartLive vous permettant ainsi d'utiliser le   
         programme immédiatement. L'installation permanante de SmaartLive nécessite la création d'un Code  
         d'Installation Permanente par SIA. Lors de l'installation initiale, l'installateur SmartLive générera un fichier  
         texte contenant les informations nécessaires à l'enregistrement de votre installation. Vous pouvez  
         simplement envoyer ce fichier à SIA ou (en dehors des USA) à votre distributeur SmaartLive, via fax ou  
         e-mail, pour obtenir le Code d'Installation Permanente.  
 
         Un Mot à Propos de la Législation  
 
         Notez que lors de l'installation de SIA SmaartLive, l'installation nécessite que vous accéptiez les termes de  
         la End User License Agreement. Par ceci, vous acceptez d'être légalement lié par les tremes de cet  
         agréemment.  
 
         Nous vous encourageons grandement à lire les termes de la license utilisateur avant d'accepter mais si  
         vous ne lisez pas la license, veuillez lire ceci: 
 
         SIA SmaartLive a une license à un utilisateur ou, dans le cas de license pour site à plusieurs stations,  
         une base à une seule station. Cela signifie que chaque copie utilisateur ou chaque station peut-être  
         utilisée légalement par une personne sur une machine à un moment donné.  
  
         Les méchanismes de protyection de l'installation et de la copie sont conçus pour faire respecter cette  
         restriction. Ils ne sont pas conçus pour compliquer l'utilisation légitime du logiciel. Si vous voulez installer  
         votre copie de SmaartLive sur une seconde machine, par exemple, sur la machine de votre bureau et sur le  
         portable que vous utilisez sur le terrain, cela est tout à fait possible. Réalisez tout simplement l'installation  
         initiale sur votre deuxième machine et envoyez le fichier texte d'enregistrement généré par l'installateur  
         pour obtenir un Code d'Installation Permanente pour la seconde machine. Si vous avez besoin d'autres  
         installations pour des utilisateurs supplémentaires, toute copie de SmaartLive 5 peut être convertie en  
         license multi utilisateurs vous permettant d'ajouter des stations de travail à la license à un prix réduit dès  
         que vous en avez besoin.  
 
         Réinstaller SmaartLive sur le Même Ordinateur  
 
         Une fois que vous avez obtenu un Code d'Installation Permanente pour un ordinateur spécifique, ce même  
         code pourra être utilisé si vous avez besoin de réinstaller le logiciel sur le même ordinateur. Lors de la  
         réinstallation, l'installateur vous demandera si vous avez déjà un Code d'Installation Permanente pour cette  
         machine et si tel est le cas, vous pouvez simplement réentrer ce code afin de court circuiter l'installation  
         temporaire et la procédure d'enregistrement. Si pour une raison quelconque l'installateur n'accepte plus le  
         Code d'Installation Permanente d'origine donné pour une machine spécifique, procédez comme pour une  
         nouvelle machine et envoyez les informations d'enregistrement générées par l'installateur pour recevoir un  
         nouveau Code d'Installation Permanente de SIA.  
 
Instructions d'Installation  
     
         La procédure d'installation de SmaartLive est très simple. Tout ce que vous  
         avez à faire est lancer le programme d’installation automatique et suivre les instructions à l’écran. 
         Avec Microsoft Windows en marche, placez le CD d’installation SmaartLive/Smaart Acoustic Tools dans  
         votre lecteur de CD-ROM. Le menu du programme devrait s’ouvrir automatiquement. Si le menu ne se  
         lance pas automatiquement (ou que vous l’ayez quitter pour éteindre votre anti-virus, double cliquez sur  
         l’icône Poste de Travail sur votre bureau puis faites un clique droit sur l’icône du CD et sélectionnez  
         AutoPlay dans le menu déroulant. Lorsque le programme s’ouvre, sélectionnez Install Smaart dans le menu  
         supérieure puis cliquez sur SmaartLive dans le sous-menu d’installation. 
 
          



         Nous vous recommandons vivement de fermer tous les autres programmes Windows,    
         particulièrement les anti-virus  automatiques et/ou les logiciels de surveillance du système, avant  
         d’installer ce logiciel. Pratiquement tous les problèmes d'installation de SmaartLive connus sont liés  
         à des conflits entre le programme d'installation et un anti-virus ou un utilitaire de contrôle du  
         système.  
  
         Si vous installez SmaartLive sur cette machine pour la première fois, vous serez inviter à entrer le code de  
         la license de la carte comprise dans le pack ainsi que votre nom, le nom de votre compagnie et d'autres  
         informations afin de vous contacter. Si vous réinstallez sur une machine pour laquelle vous avez déjà  
         obtenu un Code d'Installation Permanente, sélectionnez l'option réinstaller et entrez votre code pour  
         accéder directement à la procédure d'installation permanente.       
         Si vous avez été invité à redémarrer votre ordinateur à la fin de l’installation, faites le avant    
         d’utiliser SmaartLive. Dans le cas contraire vous pouvez utiliser le logiciel immédiatement. Double cliquez  
         sur l’icône SmaartLive du bureau ou cliquez sur le bouton Démarrer de la Barre des Tâches, puis  
         sélectionnez Programmes > SIA-SmaartLive > SIA-SmaartLive. Si vous rencontrez des problèmes durant  
         ou après l’installation, reportez-vous au chapitre 6 de ce manuel, commençant en page 184, pour les  
         problèmes de fonctionnement et les informations concernant le support technique. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
          
 
 
 
 
 
 
 
 
 
 
 
 
 



Naviguer dans SmaartLive 
 

 
          
         L’interface de SmaartLive est conçue pour mettre à votre disposition les fonctions nécessaires à la plupart  
         des applications de mesure, d’optimisation et de contrôle des systèmes de sonorisation. Les commandes à  
         l’écran vous donnent accès d’un simple clique aux fonctions les plus communément utilisées. L’utilisation  
         intensive des fenêtres de dialogue et des menus déroulants variables selon le contexte signifie que vous  
         n’aurez peut-être jamais besoin d’ouvrir un menu pour accéder aux fonctions. 
  
         Dans la plupart des cas, cliquer simplement sur le nom ou sur l’affichage d’une commande à l’écran vous 
         permettra d’accéder à la majorité des paramètres et des options dont vous aurez besoin. Les utilisateurs  
         expérimentés retrouveront le contrôle et la polyvalence que l’on peut attendre d’une plate forme de mesure  
         et de contrôle professionnelle, tout ceci avec un accès facile depuis les menu de commandes, les touches de  
         raccourcis et la fenêtre de dialogue Options. 
 
         Voici une brève description des éléments basiques qui constituent la fenêtre du programme SmaartLive.  
         Des informations détaillées sur les affichages et les fonctions de SmaartLive sont présentes dans le  
         Chapitre 2 de ce manuel. Le Chapitre 4  comprend une liste complète de tous les menus de commandes et  
         de toutes les options. 
 
 
 
 
 
 
 
 
 
 
 
 



La Barre de Menu 
 
          
 
         Les commandes et les fonctions les plus utilisées de SmaartLive sont disponibles depuis des commandes à  
         l’écran, des menus déroulants et des fenêtres de dialogue et/ou des raccourcis clavier. Les menus  
         déroulants, accessibles depuis la Barre de Menu fournissent une méthode alternative pour sélectionner  
         toutes ces commandes ainsi qu’un accès à d’autres fonctions moins fréquemment utilisées. 
 
         Pour activer un menu déroulant depuis la Barre de Menu, cliquez sur son nom en utilisant la souris ou   
         appuyez sur la touche [Alt] et sur la touche correspondant à la lettre soulignée dans le nom du menu.  
         Lorsqu’un menu est actif, les commandes peuvent être sélectionnées en cliquant sur leur nom avec la souris  
         ou tapant la lettre soulignée. 
 
         Les menus de commandes suivis par trois points ouvrent des fenêtres de dialogue. Une flèche pointée vers  
         la droite à côté d’un objet d’un menu indique que cette commande active un sous-menu. Notez que les  
         menus dans SmaartLive indiquent également le raccourci clavier pour chacune des commandes (si  
         disponible). Une liste complète de tous les menus de commandes et de toutes les options se trouvent page  
         90. 
 
Titre du tracé et Horloge 
 

          
 
         Le titre du tracé est défini depuis Graph dans la fenêtre de dialogue Options (vois page 113 pour les   
         détails). Cliquer sur le champ du titre du tracé avec la souris ouvre les options Graph dans n’importe quel  
         mode d’affichage sauf en mode Impulse. A gauche du champ du titre du tracé se trouve un affichage  
         d’horloge. L’affichage d’horloge dispose de plusieurs options auxquelles vous pouvez accéder en cliquant  
         n’importe où dans l’affichage de l’horloge (voir Clock page 157). 
 
Affichage du Curseur 
 

          
 
         L’affichage du curseur au dessus de la zone du tracé de Smaart Pro vous donne les valeurs des coordonnées  
         numériques de la position du curseur en amplitude/magnitude et fréquence ou temps, en fonction du type  
         d’affichage. Lorsque le Locked Cursor (voir page 67) est présent, vous verrez trois ensembles de valeurs du  
         curseurs au-dessus du tracé. De gauche à droite, ce sont la position du locked cursor, la position du curseur  
         de la souris et la différence entre les positions des deux curseurs. 
 
La Zone du Tracé  
 
         La Zone du Tracé est utilisée pour les données du tracé dans tous les modes d’affichage de smaartLive.  
         Plus d’information sur les affichages des données de Smaartlive peut être trouvé dans le Chapitre 2 de ce  
         manuel page 14. 
 
Commandes du Tracé de Référence 
 
         

 
 
         Les commandes du tracé de référence sont utilisées pour capturer, enregistrer, et afficher des « snapshots »  
         des tracés en modes RTA et Fonction de Transfert. Pour plus d’information sur la fonction de tracé de  
         référence de SmaartLive, reportez-vous à Travailler avec des Données de Mesures Enregistrées page 48.      



 
La Barre d’Appareil 
 

          
 
         La Barre d’Appareil de SmaartLive vous donne accès grâce à un simple clique aux appareils externes   
         assignées aux boutons de cette barre. La barre d’appareil est visible au-dessus du titre de la zone de tracé  
         lorsque vous sélectionnez Device Bar dans le menu view ou que vous cliquez sur le bouton Bar au dessus  
         du champ selected device à droite du tracé (voir page suivante). Le nombre de boutons de la barre  
         d’appareil disponibles peut varier en fonction de la résolution de votre écran et de la taille de la fenêtre du  
         programme SmaartLive. 
  
         Les appareils configurés peuvent être assignés aux boutons via la fenêtre de dialogue External Device   
         Information ou en cliquant simplement sur un bouton non utilisé lorsque la barre est visible. Vous pouvez  
         modifier l’appareil assigné à un bouton ou enlever l’assignation d’un bouton en cliquant dessus avec le  
         bouton droit de la souris puis en sélectionnant Edit Button ou Remove Device From button dans le menu  
         déroulant. 
 
         Pour plus d’information sur la configuration et le contrôle des appareils externes dans SmaartLive,   
         reportez-vous à l’Interface de Contrôle d’Appareil Externe page 53 et à la description de la fenêtre de  
         dialogue External Device Information page 56. 
 
 
Boutons On et Pause 
 

          
 
         Dans tous les modes opérationnels en temps réel (RTA, Fonction de transfert, ou Spectrographe), cliquer  
         sur le bouton On lance l’analyseur de SmaartLive et commence à afficher les données à partir des entrées  
         de votre carte son en temps réel. Le bouton Pause à gauche du bouton On stoppe l’affichage des données en  
         laissant les données déjà affichées dans la zone du tracé. On et Pause sont des interrupteurs, cliquer sur l’un  
         de ces boutons (ou appuyer sur les touches [O] ou [P] de votre clavier) arrêtera l’analyseur lorsqu’il est en  
         marche et le mettra en marche s’il est arrêté.     
 
Boutons de Mode d’Affichage 
 

          
 
         Les boutons de Mode d’Affichage mettent l’analyseur de SmaartLive dans quatre modes d’affichage  
         (modes opérationnels). Pour plus d’information sur les modes d’affichage de SmaartLive, reportez-vous  
         aux sujets suivants dans le Chapitre 2 de ce manuel : 
 
         Vue d'Ensemble du Mode Spectre (page 14) 
 
         Vue d'Ensemble de la Fonction de Transfert (page26) 
 
         Mesures de la réponse d’Impulsionet du Délai (page38) 
 
Commandes Spécifiques aux Modes 
 
         Les commandes sous les boutons de sélection des modes d’affichage (voir ci-dessus) et à droite du tracé  
         changeront en fonction du mode d’affichage actuellement sélectionné. Par exemple, en mode Fonction de  
         transfert, cette zone comprendra les boutons pour l’affichage de phase et la fonction de cohérence,  
         l’échange et la Note ID ainsi que des potentiomètres pour sélectionner les paramètres de la moyenne, de  



         l’adoucissement, du décalage vertical et en option du seuil de cohérence. En mode spectrographe, cette  
         zone est vide. Pour plus d’information sur les modes d’affichage de SmaartLive, reportez-vous au sujet  
         indiqués ci-dessus dans le Chapitre 2. 
 
Paramètres FFT 
 

          
 
         La commande Paramètres FFT, ici à gauche, fournit des informations à propos des paramètres actuels des  
         entrées de l'analyseur et vous permet de faire des modifications. Cliquer sur cette commande avec la souris  
         ouvrira une fenêtre de dialogue vous permettant de sélectionner les valeurs des paramètres FFT affichés ici.  
         Voir Paramètres des Mesures du Mode Spectre page 20 et Paramètres des Mesures du Mode Impulsion  
         page 39 pour plus de détails. 
 
Commandes de l'Echelle du Spectrographe et de la Fenêtre Temporelle 
 

          
 
         En mode RTA, l'Echelle du Spectrogrpahe apparaît immédiatement sous l'affichage des Paramètres FFT.  
         Cette commande fournit une légende pour la gamme de couleur représentant les valeurs de magnitude de  
         l'affichage du Spectrographe (voir page 153). Cliquer sur l'une de ces commandes avec la souris ouvre  
         l'onglet Spectrograph de la fenêtre de dialogue options à partir duquel vous pouvez modifier les propriétés  
         du Spectrographe. 
 

          
 
         En mode Fonction de Transfert, la commande de l'Echelle du Spectrographe est remplacée par un ensemble  
         de commandes pour le tracé de la Fonction de Transfert dans une Fenêtre temporelle (voir page 30).  
  
Commandes d’Appareil Externe 
 

          
 
         Les commandes d’appareil externe sont utilisées pour accéder à l’interface de contrôle d’appareil externe  
         de SmaartLive. Lorsqu’un ou plusieurs appareils sont configurés dans SmaartLive, cliquer sur le champ  
         Ext. Device ouvre un menu déroulant qui vous permet de sélectionner n’importe quel appareil/canal  
         configuré. Sélectionner Configure dans ce menu ouvrira une fenêtre de dialogue External Device  
         Information. Si aucun appareil n’est configuré, cliquer sur ce champ ouvrira immédiatement la fenêtre de  
         dialogue External Device Information afin de vous permettre de configurer un nouvel appareil. Cliquer sur  
         le bouton Bar à droite du champ Ext. Device active et désactive la Barre d’Appareil.        
       
         Pour plus d’information sur le contrôle des appareils externes dans SmaartLive, reportez-vous à la section  
         Interface de Contrôle d’Appareil Externe du Chapitre 2 page 53. 
 



 
 
 
Commandes de Preset Système  
 

          
 
         Les commandes de preset système vous donne un accès à l’écran aux Presets du Système de SmaartLive.  
         Les boutons Store et Load peuvent être utilisés pour sauvegarder les paramètres actuels en tant que preset  
         ou pour rappeler un preset existant. Cliquer sur Presets (au dessus des boutons Load et Store) ouvrira la  
         fenêtre de dialogue System Presets vous permettant de créer, de rechercher, d’éditer et de rappeler les  
         paramètres du programme sauvegardés comme presets. Pour plus d’information sur cette fonction, voir  
         Presets du Système page 58. 
 
Commandes du Générateur de Signal 
 

          
 
         Les commandes du générateur de signal vous donne accès grâce à un simple clique au générateur de signal  
         interne de SmaartLive. Le bouton nommé Gen active et désactive le générateur de signal. Le réglage à  
         droite du bouton Gen définit le niveau de sortie en décibels. Cliquer n’importe où dans l’affichage du  
         niveau de sortie du champ Generator ouvre une fenêtre de dialogue avec des commandes supplémentaires  
         pour le générateur de signal. Pour plus d’information, reportez-vous à Générateur de Signal Interne page  
         65 et à Signal Generator page 159. 
 
Affichage du Niveau du Signal/SPL 
 

          
 
         L’affichage du Niveau du Signal/SPL vous donne une indication numérique sur le niveau global du signal  
         pour une des deux entrées et peut être calibré pour fournir une indication en Sound Pressure Level (SPL).  
         Pour les détails sur cette fonction, reportez-vous à L’Affichage du Niveau du Signal/SPL page 47, à  
         Calibrer en SPL page 44, et à SPL page 165. 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
Vu-Mêtres du Niveau d’Entrée 
 
         Les vu-mêtres du niveau d’entrée de SmaartLive vous indique les niveaux des deux entrées relativement à  
         la tension d’entrée maximum (soit 0dB) pour les convertisseurs A/N de l’appareil d’entrée sélectionné.  
         Chaque vu-mêtre comprend un indicateur de clip qui s’allume si le niveau du signal d’entrée excède la  
         tension d’entrée maximum du convertisseur A/N. 
 

          
 
         Cliquer sur l’un des vu-mêtres en mode RTA activera le tracé correspondant et le placera au premier plan  
         de l’affichage RTA. Notez que l’Affichage du Niveau du Signal/SPL (voir ci-dessus) contrôle également  
         l’entrée active. Le champ nommé Active en-dessous des deux vu-mêtres indiquent l’entrée active. Cliquer  
         n’importe où sur l’un des deux vu-mêtres en mode de Fonction de Transfert fait apparaître le tracé de la  
         fonction de transfert au premier plan de la zone de tracé et assigne l’entrée correspondante à l’Affichage du  
         Niveau de Signal/SPL. Voir Active Input page 97 pour plus d’information. 
 
Boutons Afficher/Cacher le Tracé 
 

          
 
         Les deux boutons immédiatement en-dessous des vu-mêtres de niveau d’entrée peuvent être utilisés pour  
         afficher/cacher l’un des deux tracés du mode RTA. Voir Show Inputs page 109 pour plus d’information.  
 



 
 
 
 
Commande du Délai Interne  
 

          
 
         La commande de délai à l’écran fournit un accès au délai interne de SmaartLive. Le délai interne pour  
         fournir un délai maximum de 750 millisecondes (en pas de 1/100 millisecondes) pour l’une des deux  
         entrées, et est généralement utilisé pour fournir un alignement du signal pour les mesures de fonction de  
         transfert. Pour plus d’information, voir Le délai Interne page 63. 
 
Boutons Auto Delay Locator 
 

          
 
         Les boutons Auto Sm et Auto Lg active le Point de Localisation du Délai Automatique de smaartLive en  
         utilisant le petit ou le grand preset de temps (respectivement). Pour plus de détails, voir Automatic Delay  
         Locator page 43 du Chapitre 2. 
 

          
 
         Notez qu’en mode Impulse, cette fonction n’est pas nécessaire et que les boutons Auto Sm et Auto Lg sont  
         remplacés par un bouton Set Delay To Peak utilisé pour appeler la commande Find Peak (voir Le Curseur  
         Locked page 67 pour plus d’information). 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Chapitre 2 : Fonctions de SmaartLive 
 
Mesures de Spectre et SPL 
 
Vue d'Ensemble du Mode Spectre 
 

          
 
         Les modes d'analyse et d'affichage principaux de SIA SmaartLive sont divisés en trois catégories: Spectre,  
         Fonction de Transfert et Réponse d'Impulsion. Des trois, les nouveaux utilisateurs seront le plus à l'aise  
         avec le mode Spectre car il inclut une implémentation logiciel de l'un des outils d'analyse audio le plus  
         utilisé, l'analyseur de spectre audio en temps réel (Affichage RTA). L'affichage RTA, vous permet de  
         visualiser la quantité d'énergie présente dans différentes gammes de fréquence, en général des fractions  
         d'octave, le long du spectre audible.  
         L'analyse du spectre en temps réel est un excellent outil pour de nombreuses applications dont la lutte  
         contre le larsen, l'entrainement auditif et le contrôle du contenu fréquentiel d'un programme. Dans le passé,  
         les RTA étaient également fréquemment utilisés pour l'égalisation des systèmes de sonorisation mais leur  
         efficacité dans cet exercice s'est révélée limitée. C'est pour cela que les analyseurs FFT à deux ports  
         comme SmaartLive, ainsi que les systèmes plus anciens basés sur la Spéctrométrie à Temps de Délai  
         (TDS) et les Séquences à Durée Maximum (MLS) ont peu à peu remplacés les RTA comme outils de  
         référence pour l'égalisation et l'optimisation des systèmes de sonorisation professionnels.  
         Les analyseurs à double FFT, MLS et TDS utilisent tous une approche très différente pour la mesure de la  
         réponse d'un système. Des trois, l'analyse FFT offre la plus grande polyvalence et facilité d'utilisation  
         toutefois elle nécessite beaucoup plus de puissance de traitement informatique que le MLS ou le TDS et  
         devint réellement une option pratique sur les analyseur PC au milieu des années 90. Une chose que les trois  
         techniques ont en commun, est qu'elles vous permettent de visualiser les trois dimensions du son  
         (fréquence, énergie et temps) alors qu'un simple RTA n'est pas réceptif au temps.  
         En dehors du réglage d'un système, un bon RTA est toujours un outil très pratique pour d'autres  
         applications et SmaartLive vous fournit un ensemble d'outils très puissant et polyvalent pour l'analyse du  
         spectre en temps réel. En plus de l'affichage RTA standard, un deuxième type d'affichage en mode Spectre  
         appelée le Spectrographe, donne la possibilité de visualiser les modifications des données sur une certaine  
         période. Le Spectrographe affiche le temps (en images FFT) sur l'axe x et la fréquence sur l'axe y avec  
         l'amplitude représentée par une couleur.  
         Le troisième type d'affichage du mode Spectre est l'Historique SPL qui vous permet de visualiser les  
         modifications du niveau du signal ou du Niveau de Pression Sonore (SPL) sur une certaine période. Le SPL  
         est une mesure pleine bande compilant toutes les fréquences audibles bien qu'il soit mesuré en général avec  
         une courbe de pondération dépendante de la fréquence  (en général pondération ANSI/IEC "A" ou "C").  
         Notez que pour les mesures SPL, SmaartLive doit être calibré en SPL. Pour plus d'informations sur les  
         capacités de mesure du niveau sonore de SmaartLive, voir Affichage du Niveau du Signal/SPL page 47 et  
         Mesures du Spectre dans le Temps/LEQ page 23.  
     
         Sélectionner les Types d'Affichage en Mode Spectre 
 

          
 
         Chacun des trois types de graphique du mode Spectre, RTA, Spectrographe ou Historique SPL peut être  
         affiché seul ou sur un écran divisé avec l'un des deux autres. L'affichage du mode Spectre par défaut, c'est à  
         dire celui qui apparaît lorsque vous ouvrez SmaartLive est le graphique RTA. Pour afficher un deuxième  
         type de graphique avec l'affichage RTA cliquez sur les boutons Spectro (Spectrographe) ou SPL  
         (Historique). Cela réduira l'affichage RTA dans la moitié inférieure de l'écran et insérera le deuxième  
         graphique dans l'espace au-dessus de celui-ci. Lorsque deux graphiques sont affichés ensemble dans  
         SmaartLive celui du bas est considéré comme le graphique principal et celui du haut comme le secondaire.  
         L'idée de graphiques principals et secondaires est importante pour deux raisons: 
 



• Il y a des ensembles de menus et de raccourcis claviers séparés pour régler les gammes de 
fréquence et de magnitude du graphique principal et secondaire (voir Frequency range et 
Amplitude Range pages 126 et 130 pour plus de détails).  

• Lorsque deux graphiques sont affichés ensemble, cliquer sur le bouton du troisième type de 
graphique enlève le graphique secondaire. Par exemple, si les graphiques RTA et Historique SPL 
sont affichés avec le graphique RTA en bas, cliquer sur le bouton Spectro remplacera la graphique 
Historique SPL par le Spectrographe. Cliquer sur le bouton RTA étendrait alors le Spectrographe 
sur la totalité de la zone du tracé et il deviendrait le graphique principal ainsi si vous cliquiez sur 
les boutons RTA ou SPL, le type de graphique correspondant apparaitrait au-dessus du 
Spectrographe dans la position secondaire.  

    
L'Affichage RTA 
 

          
 
         En mode RTA, SmaartLive fonctionne comme un analyseur de spectre FFT en temps réel à deux canaux.  
         Le tracé RTA indique le spectre (valeurs de magnitude par fréquence) pour une ou les deux entrées de la  
         carte son. Les couleurs des barres ou des tracés correspondent aux couleurs utilisées sur les vu-mêtres du  
         niveau d’entrée droite et gauche qui se trouvent à droite de la zone du tracé. L’opération en temps réel de  
         l’analyseur de SmaartLive commence lorsque vous appuyez sur le bouton Smaart On. 
    
         Le tracé du mode RTA place la magnitude sur l’axe y (vertical) et la fréquence sur l’axe x (horizontal). Les  
         données audio du domaine temporel reçues depuis les entrées sont transformées dans le domaine  
         fréquentiel en utilisant les calculs FFT et reproduites en temps réel. Les magnitudes pour chaque bande de  
         fréquence (ou point de données ) sur chacune des deux entrées sont mises à jour plusieurs fois par seconde  

– le nombre de fois par seconde dépend de principalement de la vitesse de l’ordinateur. La gamme de 
magnitude (axe y) du tracé RTA peut être modifié en utilisant les commandes Amplitude Range Zoom 
et Move du clavier ou du menu.  

 
         L’axe y du tracé en mode RTA est gradué en décibels. En utilisant le calibrage par défaut, la valeur  
         maximum de 0dB est égale à la magnitude FFT d’un signal sinus 16 bit full-scale (+/-32,767) d’1kHz. Cela  
         signifie qu’un signal en entrée avec une amplitude exactement identique à la tension maximum d’entrée du  
         convertisseur A/N devrait atteindre 0dB sur le tracé du mode RTA. SmaartLive comprend également une  
         fonction de calibrage vous permettant de déplacer la gamme de décibel des données entrantes pour les faire    
         correspondre au SPL ou à une autre référence externe.  
 

          
 
         L’échelle de fréquence (axe x) du tracé du mode RTA peut être graduée en octave, en 1/3, en 1/6, en 1/12  
         ou en 1/24 d’octave. Vous pouvez également afficher les données RTA en bande plus étroite avec une  
         échelle logarithmique si l’option « Allow Narrowband RTA » est sélectionnée via Graph dans la fenêtre de  
         dialogue Options. Notez que les bandes d’octave et de 1/3 octave ne sont pas affichées aux fréquences  
         (basses) pour lesquelles la résolution en fréquence est insuffisante pur obtenir au moins deux points de  
         données RTA par bande. En résolution 1/6, 1/12 et 1/24 d’octave toute bande contenant au moins 1 point  
         de données RTA sera affichée. 
 
         La résolution en fréquence de l’affichage RTA est déterminée par la fréquence d’échantillonnage et la taille  
         FFT sélectionnées via Inputs dans la fenêtre de dialogue Options. Pour augmenter la résolution en  
         fréquence (une plus grande résolution résout le problème des basses fréquences), vous pouvez baisser la  
         fréquence d’échantillonnage et/ou augmenter la taille FFT.  
 
 
 
 
 
 
 
 



 
 
         La gamme de fréquence du tracé du mode RTA peut être modifié en rappelant l’un de nos quatre prestes  
         utilisateurs de Zoom de fréquence. Vous pouvez également modifier la gamme de fréquence du tracé en  
         utilisant les commandes du Zoom (de fréquence) et Move du clavier/menu.  
 
Le Spectrographe 
 

          
 
         L’affichage du Spectrographe de SmaartLive permet d’analyser le spectre d’un signal sur une certaine  
         période. Au lieu de vous monter une seule image FFT, le spectrographe peut vous montrer les 100  
         dernières images ou plus. On peut voir le Spectrographe comme un analyseur de spectre en temps réel  
         standard (RTA). 
 
         Sur un affichage RTA, les valeurs de magnitude pour les différentes fréquences sont typiquement indiquées  
         par des barres verticales de taille variable. Si au lieu d’avoir une taille différente, chaque fréquence a une  
         couleur différente pour indiquer une magnitude plus haute ou plus basse, vous obtiendriez une ligne  
         horizontale constituée de différents segments de couleurs qui indiqueraient le spectre d’un signal à u  
         moment donné. Si vous faites ensuite une rotation de 90° de cette ligne vous obtiendriez une tranche  
         verticale de cet affichage Spectrographe. Empilez plusieurs de ces tranches côte à côte et vous aurez un  
         tracé qui vous indiquera la variation du spectre du signal sur une certaine période. C’est la spectrographe de  
         SmaartLive. 
 
         Le Spectrograpghe indique trois données dimensionnelles (le temps, la fréquence et l'énergie) sur un tracé  
         en deux dimensions avec le temps sur l'axe x, la fréquence sur l'axe y et la magnitude représentée par une  
         couleur.  En mode spectrographe, une légende sous le tracé vous indique la magnitude associée à chaque    
         couleur du spectre. Ceci est déterminé par l’échelle de dynamique, le nombre de couleurs utilisées et le  
         point du zéro dB. Toutes ces options ainsi que la gamme de fréquence et les options de couleurs sont  
         définies via Spectrograph dans la fenêtre de dialogue Options. Les valeurs supérieures à la gamme de  
         magnitude spécifiée pour le Spectrographe sont indiquées sur le tracé en blanc. Les valeures inférieures  
         sont indiquées en noir.  
 

          
 
         La gamme d'amplitude du tracé du Spectrographe est affichée sur la commande Spectro Range qui apparaît  
         à droite de la zone du tracé en mode Spectrographe. Cliquer sur ce contrôle ouvrira automatiquement la  
         fenêtre de dialogue des options du Spectrographe vous permettant d'effectuer des modifications. La gamme  
         d'amplitude du Spectrographe peut également être modifiée en utilisant les commandes X Range (Primaire  
         et Secondaire) dans le menu View et les commandes du clavier correspondantes.    
 

          
 
         La gamme de fréquence du Spectrographe peut être réglée grâce à la commande Scale qui apparaît à droite  
         du tracé en mode Spectrographe ou en utilisant les commandes Y Range (Primaire et Secondaire) du menu  
         View. La gamme de fréquence (axe y) du spectrographe peut être réglée en utilisant l'un des quatre Presets  
         Frequency Range (Zooms) assignés aux touches numériques 1-4 sur votre clavier. Lorsque le  
         Spectrographe est est affiché avec l'affichage RTA standard en mode Spectre, leurs gammes de fréquence  
         sont normalement liées afin que toute modification affecte également l'autre de la même manière. Les  
         gammes de fréquence des deux tracés peuvent être indépendants en désactivant la case "Spectrograph  
         Frequency follows RTA Frequency" dans l'onglet Zooms de la fenêtre de dialogue Options.               
          
 
 
 
 



Historique SPL 
 

     
 
    L'Historique SPL de SmaartLive fournit une façon pratique pour visualiser les modifications du niveau global  
    du signal (pleine bande) ou du niveau de la Pression Sonore (lorsqu'il est calibré en SPL) de l'entrée Active sur  
    une certaine période. L'Historique SPL peut être affiché seul ou sur un écran divisé avec l'affichage RTA ou le  
    Spectrographe (voir Vue d'Ensemble du mode Spectre page 14 pour plus d'informations).  
  
    La fonction Historique SPL agit avec l'Affichage du Niveau du Signal/SPL et trace simplement les valeurs de  
    décibels calculées pour l'affichage numérique avec chacune des mises à jour de l'affichage principal. Une  
    différence majeure lors de l'utilisation du calibrage Full Scale (interne) par défaut est que l'Affichage du  
    Niveau du Signal/SPL et l'Historique SPL utilisent les données du domaine temporelle, telles qu'elles sont  
    mesurées par les Vu-Mêtres du Niveau d'Entrée. Lorsqu'il est calibré en SPL (ou toute autre référence externe)  
    le vu-mêtre SPL et l'Historique SPL sont basées sur les données FFT du domaine fréquenciel.  
     
    L'Historique SPL peut être tracé comme un histogramme solide ou comme une courbe linéaire. Comme le  
    Spectrographe, l'Historique SPL ne s'occupe que d'une des deux entrées analogiques à la fois. La couleur  
    normale du tracé de cet affichage correspond à la couleur du vu-mêtre de l'Entrée Active actuelle mais  
    changera de couleur lorsque l'amplitude du signal d'entrée excèdera les niveaux d'alarme spécifiés pour le vu- 
    mêtre SPL. Le type du tracé ainsi que les gammes d'amplitude et de temps du tracé Historique SPL sont réglés  
    depuis l'onglet SPL History de la fenêtre de dialogue Options. La gamme de magnitude de cet affichage peut  
    également être réglée en utilisant les commandes du menu ou du clavier Amplitude Range Zoom et Move. Les  
    paramètres de l'Affichage du Niveau du Signal/SPL, qui affectent également l'affichage Historique SPL, sont  
    réglés depuis la fenêtre de dialogue SPL Options.  
    
    Notez que lorsque le curseur de la souris est placé sur SPL History, l'affichage du curseur indique les valeurs  
    SPL Minimum et Maximum ainsi que la valeur SPL actuellement affichée aux coordonnées de la souris. Les  
    valeurs SPL Minimum/Maximum sont conservées pour toute la durée de votre session SmaartLive ou jusqu'à  
    ce qu'elles soient effacées et remises à zéro en utilisant la commande Restart SPL History ([Ctrl]+[R]). 
     
    Notez également qu'en plus de l'affichage (graphique) Historique SPL, SmaartLive peut échantillonner la  
    sortie du vu-mêtre SPL à des intervals spécifiés par l'utilisateur et en registré les données sur un fichier texte  
    ASCII pour une analyse ultérieure sur d'autres programmes. Pour plus d'informations sur les capacités de  
    SmaartLive, veuillez vous reporter à SPL (options) page 162 et Mesures Temporelles du Spectre/LEQ page  
    23.  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
Paramètres de Mesure du Mode Spectre 
 
Moyenne  
 

     
 
    La moyenne est utilisée pour les mesures RTA, Spectrographe et Fonction de Transfert afin d'améliorer le  
    rapport signal/bruit (S/B) de la mesure et de réduire l'influence des transitoires, stabilisant ainsi l'affichage et  
    rendant les tendances globales plus faciles à lire. Toutes les moyennes en Mode Spectre sont RMS toutefois il  
    y a trois schémas d'intégration disponibles: linéaire "premier, dernier" (FIFO), exponentiel (Rapide, Lent et  
    variable) et Infini. La moyenne FIFO est une moyenne arithmétique simple d'un certain nombre (2, 4, 8, 16…)  
    des plus récentes images FFT avec un coefficient égal pour chacune d'elles. Notez que lorsque le nombre de  
    points de moyenne est réglé sur 1 aucune moyenne n'est faite et chacune mise à jour de l'affichage ne  
    comprend que la donnée d'amplitude de l'image FFT la plus récente.  
 
    La moyenne Infinie (Inf.) est similaire à la moyenne FIFO puisque toutes les mesures FFT ont le même  
    coefficient mais plutôt que d'analyser un nombre fixe d'images FFT les plus récentes, cette option fait une  
    moyenne de toutes les FFT enregistrées depuis la dernière remise à zéro du buffer. Les buffers de moyenne  
    sont remis à zéro à chaque fois que vous modifiez les paramètres de moyenne, la taille FFT ou la fréquence  
    d'échantillonnage, que vous arrêtez l'analyseur ou que modifier le mode d'affichage principal. Vous pouvez  
    également remettre les buffers à zéro à tout moment en appuyant sur la touche [V] sur votre clavier.  
 
    La moyenne exponentielle donne un coefficient plus important aux données les plus récentes alors que  
    l'influence des données plus anciennes décroit exponentiellement. Les options appelées Fast et Slow sont des  
    méthodes de moyennes exponentielles qui reproduisent les caractéristiques temporelles des circuits  
    d'intégration temporel Rapide et Lent d'un vu-mêtre de niveau sonore ANSI/IEC standard aussi fidèlement que  
    possible. L'option Exp est identique aux options Fast et Slow toutefois sa "demi-vie" est réglable par  
    l'utilisateur depuis l'onglet Inputs de la fenêtre de dialogue Options.  
     
Courbes de Pondération 
 

     
 
    La commande Weight vous permet d'appliquer une courbe de pondération dépendante de la fréquence aux  
    affichages RTA, Spectrographe et Fonction de Transfert. Les courbes de pondération définies par l'utilisateur  
    sont supportées ainsi que les options A (ANSI/IEC) et C ou None (pas de pondération). Pour plus  
    d'information, voir Courbes de pondération page 20.  
  
Paramètres FFT et Résolution en Fréquence  
 
    Pour les mesures en temps réel de réponse en fréquence et de spectre (Fonction de Transfert), l'un des  
    paramètres FFt les plus importants est la résolution en fréquence du FFT. La résolution en fréquence de la  
    donnée FFT est une fonction de la taille FFT et la fréquence d'échantillonnage. Les points de donnée FFT sont  
    équidistants avec un point tous les Q Hertz, de 0 hertz jusqu'à la moitié de la fréquence d'échantillonnage (la  
    fréquence de Nyquist), avec Q la fréquence d'échantillonnage (en samples par secondes) divisée par la taille  
    FFT (en samples). 
 
    Le problème est que nous autre humain entendons de façon logarithmique, et qu'il est donc en général plus  
    pratique pour nous de visualiser des données audio sur une échelle logarithmique. SmaartLive utilise de  
    nombreuses techniques pour transposer les données FFT linéaires sur un afichage logarithmique plus  
    significatif mais il est important d'être conscient qu'en ce faisant, les octaves les plus basses auront toujours  
    une résolution en fréqueznce plus basse que les octaves plus hautes car les données FFT de base sont toujours  
    linéaires. 
 
    Ceci implique donc que la précision dans les basses fréquences nécessitent une résolution en fréquence FFT  



    accrue soit en augmentant la taille FFT ou en diminuant la fréquence d'échantillonnage. Notez que chacune de  
    ces actions augmentera la constante temporelle FFT – la quantité de temps nécessaire pour collecter tous les  
    échantillons pour une taille FFT donnée à une fréquence d'échantillonnage donnée.  
  
    La résolution temporelle diminue lorsque la résolution en fréquence augmente car chaque FFT représente  
    alors une période plus longue et que les FFT plus longs prennent plus de temps à traiter. Ainsi, les  
    modifications rapides dans les données du signal d'entrée pauvent être cachées lorsque la constante temporelle  
    FFT augmente. SmaartLive évite le problème d'une certaine façn en utilisant des données du domaine  
    temporelle qui se chevauchent pour les FFT toutefois votre ordinateur aura toujours besoin de plus temps pour  
    traiter chaque mise à jour de l'affichage lorsque la taille FFT est augmentée.  
     
    En règle général pour les mesures en temps réel, lorsque vous analysez la totalité du spectre audio, une taille  
    FFT de 8k à des fréquences d'échantillonnage de 44.1 ou 48k fournit un niveau raisonnable de détail pour les  
    basses fréquences et une bonne réponse RTA sur la plupart des ordinateurs. Vous devrez augmenter la taille  
    FFT et/ou diminuer la fréquence d'échantillonnage pour obtenir plus de détails aux très basses fréquences.  
    Lorsque vous êtes plus concerné par les transitoires et/ou les hautes fréquences, utilisez des fréquences  
    d'échantillonnage plus grande et des tailles FFT plus petites afin d'obtenir des mises à jour de l'affichage plus  
    rapides et une résolution temporelle plus détaillée.  
   
Paramètres FFT 
 

     
 
    En Modes Spectre et Fonction de Transfert, il y a une commande pour tous les paramètres FFT d'Entrée.  
    Cliquez n'importe où sur cette commande ouvrira la fenêtre de dialogue FFT Parameters illustrées ci-dessous.  
    En mode Impulse, les paramètres sont un peu différents et il y a des commandes séparées pour chauqe  
    paramètre (voir ci-dessous). 
    
    La fenêtre de dialogue des Paramètres FFT des modes Spectre/Fonction de Transfert est composée des  
    éléments suivants: 
 

     
 
    Sélecteur Sample Rate – Chaque fois que vous démarrez SmaartLive ou que vous modifiez la sélection de  
    l'appareil Wave-In, la programme vérifie la hardaware son de votre ordinateur afin de déterminer les  
    fréquences d'échantillonnage supportées par l'appareil d'entrée sélectioné et place les fréquences  
    d'échantillonnages supportées dans le menu du sélecteur Sample Rate.  
  
    Sélecteur FFT Size – Le menu déroulant du sélecteur FFT Size vous permet de sélectionner une taille  
    d'image FFT de 128 à 32k échantillons en mode Fonction de Transfert, RTA et Spectrographe ou de 128 à  
    512k en mode Impulse. 
 
    Time Constant – La constante temporelle ou "fenêtre temporelle" d'une FFT est une fonction de la taille FFT  
    et de la fréquence d'échantillonnage. SmaartLive calcule automatiquement lma constante temporelle en  



    fonction de la taille FFT et de la fréquence d'échantillonnage actuellement sélectionnées et l'affiche dans le  
    champ Time Constant. Cliquer sur la flèche avec votre souris affichera une liste des constantes temporelles  
    pour chaque taille FFT en fonction de la fréquence d'échantillonnage actuelle. Sélectionner une constante  
    temporelle directement depuis cette liste modifiera automatiquement la taille FFT dans le champ FFT.  
   
    Frequency Resolution – La résolution en fréquence d'une FFT est également une fonction de la taille FFT et  
    de la fréquence d'échantillonnage. SmaartLive calcule automatiquement la résolution en fréquence en fonction  
    de la taille FFt et de la fréquence d'échantillonnage actuellement sélectionnée et l'affiche dans le champ FR.  
    Cliquer sur la flèche affcihera une liste des résolutions en fréquence pour chaque taille FFT disponible, en  
    fonction de la fréquence d'échantillonnage actuelle. Sélectionner une résolution en fréquence depuis cette liste  
    modifiera automatiquement la taille FFT dans le champ FFT.  
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Mesures Temporelles du Spectre/LEQ 
 
    Il y a de nombreuses applications qui nécessitent l'étude de données spectrales et SPL sur une certaine période.  
    Deux des mesures typiques sont le Niveau Sonore Equivalent (LEQ) et Bruit Centile (ex: L10, L50, L80, …),  
    utilisés pour définir le bruit ambiant, et les moyennes spectrales temporelles toujours fréquemment utilisées  
    comme base pour les systèmes de sonorisation des cinémas. SmaartLive offre une grande polyvalence au  
    niveau de ses capacités de traitement et de moyenne qui vous permettent d'étudier et de traiter les SPL, LEQ et  
    Bruit Centile, ou des données spectrales avec des périodes de moyenne allant de une seconde à 24 heures et  
    des durées de mesures totales allant jusqu'à une semaine.  
 
Traitement SPL 
 
    Une fonction simple de traitement SPL qui échantillonne les valeurs SPL à des intervals spécifiés et inscrit ces  
    données sur un fichier texte ASCII accessible via la fenêtre de dialogue SPL Options. Cette fonction n'offre  
    pas de capacité de moyenne/intégration ou de post-traitement mais n'est pas limité (sauf par la quantité  
    d'espace disponible sur le disque dur) en durée et intérfère le moins possible avec les autres opérations de  
    l'analyseur. 
 
Moyenne et Traitement Temporelle 
 
    Des capacités de mesures temporelles plus avancées, basées sur la moyenne des magnitudes sur une période  
    d'échantillonnage donnée, sont disponibles via la fonction Timed Average/LEQ. Ces fonctions sont  
    configurées et activées depuis la fenêtre de dialogue Timed Average/LEQ Setup, accessible depuis le menu  
    Spectrum.  
  
    SmaartLive offre trois types de mesures temporelles différentes: Timed Average, LEQ log et Spectrum Log.  
 

• Time Average est une moyenne spectrale temporelle sur une certaine période qui affiche ses résultats 
sur une résolution à bande étroite sous forme de Tracé de Référence smaartLive. Les périodes 
d'échantillonnage pour cette mesure peuvent aller de 1 seconde à 24 heures.  

• LEQ Log calcule Leq, L10, L50 et L90 ainsi que LMIN et LMAX (les valeurs SPL la plus haute et la 
plus basse sur une période d'échantillonnage) à la volée pour pour chacune des Périodes 



d'echantillonnage spécifiées, ainsi que les valeurs cumulées pour toute la durée de la mesure. Les 
résultats de cette mesure sont affichés sur un fichier texte ASCII standard importable dans un 
processeur de document texte. Les Périodes d'Echantillonnage peuvent aller de 1 minute à 24 heures 
sur une durée de mesure totale maximum de 1 semaine (168 heures).  

• Spectrum Log enregistre les moyennes par octave ou les mesures spectrales par fraction d'octave pour 
chacune des Périodes d'Echantillonnage spécifiées et affiche ses résultats sur un fichier texte ASCII. 
Au contraire des fonctions Timed Average et LEQ Log, le traitement Spectrum n'enregistre que les 
données spectrales brutes. Les Périodes d'Echantillonnage peuvent aller de 1 seconde à 24 heures 
avec une durée de mesure totale maximum de 1 semaine (168 heures). La fonction create LEQ report 
from Log File peut être utilisé pour traiter les fichiers Spectrum Log afin de calculer les valeurs 
pondérées A/C et non pondérées LEQ, LMIN, LMAX et Bruit Centile à partir du fichier de données 
spectrales.  

 
Notes: 
 
1. Pour obtenir des mesures de niveau sonores correctes, dont SPL, LEQ et Bruit Centile, 

SmaartLive doit être calibré en SPL avant de réaliser la mesure.  
2. Spectrum Log offre une grande polyvaloence au niveau de l'utilisation des données mais nécessite 

une grande quantité d'espace du disque dur – jusqu'à 8Mb par heure – pour ses fichiers de résultats.  
3. Lors de la capture de données spectrales pour un traitement ultérieur pour le LEQ ou le Bruit Centile 

la Période d'Echantillonnage spécifiée doit être plus petite, dans un rapport de 10/100, que la plus 
petite période d'intégration. Par exemple, si vous avez besoin de calculer le LEQ et le Bruit Centile 
sur des intervals de 1 minute en utilisant les données spectrales, la période d'Echantillonnage ne doit 
pas dépasser 6 secondes lors de l'acquisition des données et 1 seconde (le minimum permis) serait 
préférable, si vous avez assez d'espace sur le disque. Si vous n'utilisez que des intervals de 1 heure, 
une période d'échantillonnage de 30 secondes à 1 minute devrait fournir une résolution temporelle 
suffisante. 

4. Lors du traitement Spectrale et de la Moyenne Temporelle, SmaartLive est en mode Spectrum et ne 
permettra pas certaines modifications d'Affichage ou de paramètres lors de la mesure.  

5. LEQ et SPL Logging ne réduisent pas l'utilisation des autres fonctions de SmaartLive mais soyez 
conscient que passer en mode Impulse ou réaliser des mesures de délai automatique alors que le 
traitement est activé interrompra l'acquisition des données SPL et pourra donner des trous dans le 
fichier des résultats. Les options de sauvegarde de certains ordinateurs peuvent également interférées 
avec l'acquisition des données, particulièrement lors d'untraitement sur de longues périodes.    

           
 
     
     
  
  
  
     
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Mesures Fonction de Transfert   
 
Vue d’Ensemble 
 

          
 
         La capacité de mesure de fonction de transfert en temps réel de SmaartLive est un outil très pratique pour  
         régler des égaliseurs et des filtres de systèmes de sonorisation comme décrit dans le Chapitre 3 de ce  
         manuel. Une fonction de transfert est une comparaison mathématique complexe de deux signaux – en  
         général l’entrée et la sortie d’un appareil ou d’un système à tester. SmaartLive utilise ce calcul pour trouver  
         les différences entre les deux signaux. 
 
         En comparant ce qui entre dans un système et ce qui en ressort, SmaartLive peut calculer sa réponse en  
         fréquence très précisément (magnitude et phase). Un avantage majeur de cette approche à deux canaux est  
         sa compatibilité avec de nombreux signaux de test, dont la musique ou d’autres programmes  
         reconnaissables. 
      
         Pour faire une mesure de fonction de transfert, un signal de test est divisé à la source et envoyé au système  
         à tester et à l’entrée droite de la carte son (canal 1) sur votre ordinateur. Ce sera le signal de référence. La  
         sortie du système est renvoyée vers l’entrée gauche de la carte son (canal 0). C’est le signal de mesure.                      
        

                             

Input 1

Input 0

Device or
System

Under Test
Computer

Signal
Source

 
  
         L’opération en temps réel de l’analyseur de SmaartLive commence lorsque vous appuyez sur le  
         bouton On à gauche de la zone du tracé. En mode Fonction de Transfert, SmaartLive réalise les calculs  
         en utilisant les données audio des deux entrées puis compare les deux ensembles de données FFT et affiche  
         le résultat sur un seul tracé. Une magnitude de 0dB sur un point de fréquence donné sur le tracé du mode de  
         fonction de transfert représente une quantité d’énergie égale sur les deux signaux pour cette fréquence. Des  
         valeurs positives ou négatives pour une fréquence donnée indique une quantité d’énergie supérieure ou  
         inférieure dans le signal de mesure (sortie du système ) par rapport au signal de référence (entrée du  
         système) pour cette fréquence. 
 
         Notez que le point fixe par octave (FPPO) par défaut du tracé du mode de fonction de transfert possède 24  
         points de données pour chaque octave (sauf pour les deux octaves les plus basses qui ont respectivement 8  
         et 16 points de données). Cette résolution équivalente par octave est obtenue en combinant les résultats de  
         plusieurs calculs FFT. L’affichage du FFPO de la fonction de transfert tend à être plus stable et plus facile  
         à lire, particulièrement aux hautes fréquences, qu’un tracé d’une Fonction de Transfert à u seul FFT.              
         

          
 
         Appuyer sur le bouton Swap dans le mode de Fonction de Transfert inverse les entrées pour le calcul de la  
         fonction de transfert afin que SmaartLive divise le signal de référence sur l’entrée Droite (canal 1) par le  
         signal de mesure sur l’entrée Gauche (canal 0). Cette fonction est principalement utilisée lorsque vous  
         voulez afficher la courbe de réponse en magnitude inverse d’un EQ ou d’un processeur afin de faciliter   
         l’utilisation d’une mesure de système/pièce enregistrée comme guide pour le réglage de filtres. La fonction  
         swap peut également être utilisée si vous avez fait une erreur dans la connexion des signaux de référence et  
         de mesure mais il est préférable de modifier physiquement la connectique afin d’éviter toute confusion.     
 
         Notes Importantes : 
 

• La Fonction de transfert fonctionnant en comparant les deux signaux en entrée, tout délai entre les 
deux signaux doit être détecté et compensé afin d’obtenir une mesure valide (une comparaison 
« pomme-pomme »). Cela peut être accompli en utilisant le point de localisation du délai et le délai 
interne de SmaartLive.  



• Des appareils de traitement du signal non linéaire tels que des limiteurs ou des compresseurs ne 
doivent pas être utilisés lors des opérations de mesures de réponse d’impulsion et de Fonction de 
transfert –voir la Fonction de Cohérence page 20).  

 
L’Affichage de Phase 
 

          
 
         Activer l’affichage de Phase en mode de Fonction de Transfert divise la zone de tracé et fait apparaître un  
         autre tracé (au dessus du tracé de réponse fréquence/magnitude) qui indique le décalage de phase, ou la  
         différence temporelle entre le signal de mesure et le signal de référence fréquence par fréquence. Le  
         décalage de phase relatif pour chaque point de donnée sur l’affichage de phase est exprimé en degrés.     
 
         Sur l’affichage du tracé de Phase par défaut, toutes les valeurs de phase sont tracées sur une échelle de 360°  
         de +180° à –180° avec 0° au centre. Cette échelle de 360° représente un cycle complet à n’importe quelle  
         fréquence donnée. Une valeur de phase de 0° (pas de décalage de phase) pour un point de données de  
         fréquences donné signifie que la mesure et la référence arrive exactement au même point du cycle pour  
         cette fréquence. Les fréquences pour lesquelles le signal de mesure arrive plutôt dans le cycle par rapport  
         au signal de référence indiqueront un décalage de phase négatif. Aux fréquences où le signal de mesure  
         arrive après dans le cycle vous verrez un décalage de phase positif. 
 
         Vous pouvez déplacer la ligne 0° sur l’affichage de phase vers le haut et vers le bas sur le tracé par pas de  
         45° en appuyant sur la touche [Alt] et sur les touches [Page Up] et [page Down] de votre clavier. [Alt] +  
         [End] met l’échelle de phase sur 0°-360°. Appuyer sur [alt] + [Home] remet l’échelle de phase par défaut  
         de +180° à –180°. 
 
Affichage de Phase à Plat 
 
         Etant donné que les hautes fréquences ont un cycle plus rapide que les basses fréquences (ce qui en fait des  
         hautes fréquences), il est commun de voir une relation de phase entre deux signaux diverger de plusieurs  
         cycles lorsqu’on augmente en fréquence. Sur l’affichage de phase standard, les décalages de phase  
         supérieurs ou inférieurs à +/- un demi cycle sont « wrapped » around so a positive phase shift of 1.25  
         cycles (+450°) that would « wrapped around » and plotted at as +90°. Cela donne l’apparence « zig-zag »  
         familière d’un tracé de phase standard. 
 
         Si vous voulez obtenir une image de la tendance globale du tracé de phase sur une large gamme de  
         fréquence vous pouvez appuyer sur la touche [U] pour « révéler » l’affichage de phase. Sur l’affichage de  
         phase « révélé », le même décalage de phase de +450° mentionné ci-dessus serait tracé à +450° et un  
         décalage de phase de 360° qui apparaîtrait à 0° sur un affichage « caché » serait tracé à 360°. Notez  
         toutefois que ce type d’affichage de phase n’est en aucun cas approprié pour toutes les applications et peut  
         en fait être trompeur dans certains cas. Notez également que les valeurs de phase provenant du calcul de la  
         fonction de transfert sont toujours dans la gamme +180° -180°. L’affiche de phase « révélé » extrapole ces  
         valeurs en dehors de cette gamme et cela fonctionne mieux dans certains cas que dans d’autres. 
 
 
 
Déduction à partir de Groupe de Délai Minimum 
 
    La fonction Show as Group Delay, accessible depuis Phase Display Properties dans le menu Transfer 
Function, fonctionne en extrapolant les relation entre les points voisins des données de phase. Au cours de ce 
calcul, SmaartLive compare chaque point de l'affichage de phase à son voisin et calcule une valeur en 
millisecondes pour chaque point en fonction de la fréquence et de la pente des angles entre les points voisins. Le 
tracé du groupe de délai est similaire à l'affichage de magnitude et à l'affichage de phase à plat puisqu'il affiche 
les valeurs de délai comme des nombres positifs et négatifs en fonction d'un point zéro pour lequel une valeur de 
zéro millisecondes pour un point donné représente la parité entre les signaux de référence et de mesure pour cette 
fréquence.  
 
Veuillez noter que les options Unwrapped et Show Phase as Group Delay peuvent être considérées comme des 
fonctions en cours de dévellopement. Toutefois elles peuvent être pratiques dans leur forme actuelle et méritent 



donc d'être incluses dans cette version de SmaartLive. Si vous décidez d'utiliser ces options, n'oubliez pas 
qu'elles nécessitent l'utilisation de données d'entrée stables afin de fonctionner au mieux et qu'elles reposent sur 
des hypothèses qui peuvent s'avérer fausses, particulièrement lorsque les données d'entrée ne sont pas très 
stables.  
 
 
Fenêtre Temporelle 
 

     
 
    La Fenêtre Temporelle est une autre méthode permettant de supprimer des données douteuses ou non désirées  
    des mesures de fonction de transfert et d'adoucir et de stabiliser les tracés des données de fonction de transfert.  
    L'utilisation typique de cette fonction inclus l'isolation de la réponse des composants haute fréquence et  
    l'élimination des réflexions qui peuvent engendrer un filtrage en peigne au niveau de votre micriophone de  
    mesure.  
 
    La fenêtre temporelle utilise une combinaison des techniques de mesure du domaine temporel et fréquentiel  
    pour accomplir sa mission. Le processus se déroule ainsi: 
 

• Les données du domaine fréquentiel de la fonction de transfert sont transformées dans leur 
représentation du domaine temporel en utilisant une transformation de Fourrier inversée (IFT). Le 
résultat est une réponse d'impulsion dans le domaine temporel – c'est le même processus que celui 
utilisé par SmaartLive pour obtenir une réponse d'impulsion en mode Impulse et des mesures Auto-
Delay Locator mais dans ce cas, tout est réalisé en temps réel. 

• Une fenêtre de données spéciale avec une constante temporelle double par rapport à la taille de la 
fenêtre temporelle spécifiée (pour des raisons mathématiques) est appliquée à la réponse 
d'impulsion, sur la première crête – en fait au début de l'enregistrement de la réponse d'impulsion 
mais cela correspondra en général à la première crête, en supposant que le temps de délai est réglé 
correctement en mode fonction de transfert. La fenêtre de données met les échantillons non désirés 
"en dehors" de la fenêtre à zéro.  

• Les données de réponse d'impulsion éditées sont ensuite retransformées dans le domaine fréquentiel 
par un FFT et les données de magnitude en fréquence et de phase obtenues sont tracées sur la 
Fonction de Transfert en temps réel.  

 
    La fonction de transfert modifiée par la fenêtre temporelle apparaît comme un second tracé dans une couleur  
    différente (un bleu-vert clair par défaut) sur les affichages d'Amplitude et de Phase du mode Fonction de  
    Transfert. Ce tracé peut être placé au premier plan sur l'axe z et sauvegardé comme tracé de référence.  
     
    Notez qu'étant donné que la dimension temporelle de la fenêtre de données utilisée est deux fois celle de la  
    fenêtre temporelle spécifiée, la fenêtre maximum autorisée est égale à la moitié de la constante temporelle  
    taille FFT/fréquence d'échantillonnage sélectionnée en mode Fonction de Transfert. Notez également que la  
    fonction de transfert FPPO, qui utilise plusieurs tailles FFT avec plusieurs constantes temporelles, est  
    incompatible avec cette fonction et que la commande Time Window est désactivée lorsque l'option FPPO est  
    sélectionnée.  
 
    La taille de la fenêtre temporelle est spécifiée en millisecondes. Cette valeur peut être réglée en utilisant les  
    boutons haut/bas qui apparaissent sur la commande Time Window à droite de la zone de tracé en mode  
    Fonction de Transfert et impulmse, ou en tapant un numéro dans la fenêtre de dialogue qui apparaît lorsque  
    vous cliquez sur le champ d'affichage de la commande. 
    En mode Impulse, activer la Fenêtre Temporelle affiche un curseur vous indiquant la frontière finale de la  
    fenêtre temporelle actuellement spécifiée, en fonction de la position du Locked Curseur. Vous pouvez régler la  
    taille de la fenêtre temporelle en déplaçant le curseur sur le tracé avec la souris. C'est particulièrement pratique  
    lorsque vous utilisez la fenête temporelle pour réduire ou éliminer les effets des réflexions sur des données de  
    fonction de transfert puisque les réflexions sont en général faciles à visualiser sur le tracé de la réponse * 
    d'impulsion.  
  
     
 



     
  
    L'inconvénient principal lié à l'utilisation de la fenêtre temporelle est que la constante temporelle de la    
    fonction de transfert est réduite (par rapport à la version d'origine) et avec elle, la résolution basse fréquence  
    de la fenêtre de données. SmaartLive calcule automatiquement la résolution en fréquence (EFR) du tracé de la  
    fonction de transfert traitée et affiche cette valeur dans la fenêtre de dialogue FFT Parameters lorsque la  
    fenêtre temporelle est activée.  
 
    
Moyenne et Adoucissement 
 
         Moyenne  
 
         SmaartLive offre trois différentes options de moyenne dans le mode de transfert de fonction afin de rendre  
         l’affichage plus stable et plus facile à lire et à interpréter : moyenne Root Mean Square (RMS), moyenne  
         Vectorielle et « Adoucissement ». La moyenne RMS est également utilisée en mode RTA et en mode  
         Impulse pour améliorer le rapport signal sur bruit des mesures et pour stabiliser l’affichage RTA. La  
         moyenne Vectorielle et l’Adoucissement sont disponibles uniquement en mode de Fonction de Transfert.  
         Le type de Moyenne (Vectorielle ou RMS) que SmaartLive utilise pour les mesures de fonction de transfert  
        est modifiable depuis le menu Control ou en cliquant sur les commandes de moyennes (Avg) à droite du   
         tracé. L’indication « (V) » ou « (R) » apparaît sur les commandes de moyenne en mode de Fonction de  
         Transfert pour indiquer le type de moyenne actuellement utilisée. L’adoucissement est une fonction séparée  
         avec sa propre commande (voir ci-dessous). 
 
         Pour les utilisateurs expérimentés de Smaart, RMS sera l’option de moyenne la plus familière puisque cette  
         méthode était présente sur toutes les versions précédentes. Des deux, RMS est la plus adaptée aux  
         conditions extérieures (vent) pouvant modifier la position relative d’un microphone de mesure avec un  
         système de haut parleur à tester. Etant donné que la moyenne RMS permet la mesure d’une quantité plus  
         importante d’énergie réverbérante, elle tend à restituer plus efficacement la perception humaine d’un  
         système en ce qui concerne la tonalité et la « musicalité ». La moyenne vectorielle est plus efficace que le  
         RMS en ce qui concerne le rejet du bruit externe et de l’énergie réverbérante et restitue bien la perception  
         humaines des facteurs d’intelligibilité et de « précision » de la reproduction du signal. Elle est, par contre,  
         beaucoup plus sensible au mouvement du haut-parleur/source, elle est donc plus appropriée au mesure en  
         espace clos ou en conditions calmes. 
 

          
 
         Chacune des deux méthodes de moyenne fonctionnent en calculant une moyenne de chacun des point de  
         données des fréquences sur un certains nombres d’images FFT (comme définit par la commande Avg à  
         droite du tracé). Cela augmente le temps de contrôle des données entrantes. Si la commande Avg est réglée  
         sur 1, seules les données de l’image FFT sont tracées. Si la commande est réglée sur 2, la moyenne se fera  
         à partir du point de donnée de l’image actuelle et du même point sur l’image précédente. Si la commande  
         est réglée sur 4, chaque point de donnée (ou barre de données en mode RTA) représentera la moyenne des  
         4 dernières images FFT et ainsi de suite. 
 
         A chaque fois que l’on doublera le nombre de points de moyenne, le rapport signal sur bruit de la mesure  
         augmentera de 3dB (jusqu’à ce que le plafond du système à tester ou du système de mesure, en fonction  
         duquel est le plus élevé, soit atteint). Notez toutefois que l’augmentation du nombre de moyennes entraîne  
         également une réponse plus lente de l’affichage en temps réel, ce qui peut être désagréable dans certaines  
         applications. 
 
         En règle générale, plus les conditions de mesure sont mauvaises, plus la moyenne et l’adoucissement sont  
         nécessaires. Les mesures « électriques », telle que la comparaison de l’entrée et de la sortie d’un EQ ou  
         d’un processeur, nécessitent en général très peu de points de moyenne et le fait de garder le nombre de  



         points de moyenne à un niveau faible permet à l’affichage de répondre rapidement aux modifications des  
         filtres. Les mesures acoustiques (ex : mesures faites en utilisant un microphone) nécessitent en général au  
         moins 16-32 points de moyenne. Lorsque vous faites des mesures acoustiques dans des espaces très  
         bruyants et/ou réverbérants ou à l’extérieur dans le vent, il peut être nécessaire d’augmenter le nombre de  
         points de moyenne jusqu’à 64, 128 ou même 256. 
 
 Adoucissement 
 

          
 
         L’adoucissement est un autre type de moyenne uniquement disponible en mode de fonction de transfert.  
         Cette fonction permet de réduire les fluctuations du tracé de la fonction de transfert et de rendre les  
         tendances du système ou de l’appareil plus facile à lire. Sur un tracé de fonction de transfert, la moyenne de  
         chacun des points de données est faite avec un certains nombres de points adjacents à celui-ci (déterminé  
         par la commande Smooth à droite du tracé). Par exemple, si la commande Smooth est réglée sur 3, chacun  
         des points de données représentera la valeur de la moyenne de ce point est du point supérieur et inférieur  
         du tracé. Lorsque cette commande est réglée sur 5, la moyenne est faite avec le point est les deux points  
         supérieurs et inférieurs et ainsi de suite. En d’autres mots, vous faites une moyenne sur les fréquences, en  
         augmentant la largeur de bande de chacun des points de données plus que sur le temps comme dans les  
         moyennes RMS ou Vectorielle. 
 
 
La Fonction de Cohérence  
 
         Vue d’Ensemble 
 
         Loa cohérence est une mesure de linéarité entre les deux signaux dans une mesure de fonction de transfert.  
         La fonction de cohérence de SmaartLive pose cette question « Quelles sont les chances pour que le signal  
         qui entre dans le système devienne le signal qui en sorte en résultant d’un processus linéaire ? » La  
         cohérence est exprimée par une valeur comprise entre 0 et 1 pour chaque point de donnée avec 1 la  
         cohérence parfaite et 0 aucune cohérence. Toutes les valeurs de cohérence de SmaartLive sont données en  
         tant que pourcentage où 100%=1 (cohérence parfaite). 
 
         Les valeurs proches de 1 signifient une meilleure linéarité et donc de meilleures données. Il est toutefois  
         important de noter, qu’une cohérence faible ne signifie pas nécessairement que vos données ne sont pas  
         fiables. C’est particulièrement vrai lors d’une mesure dans un environnement bruyant où beaucoup de  
         points de moyenne sont nécessaires. La cohérence diminue naturellement lorsque le nombre de points de  
         moyenne augmente et beaucoup des facteurs qui auraient tendance à vous donner envie d’utiliser plus de  
         points de moyenne, tel que le bruit ambiant, affectent également la cohérence. 
 
        Dans la réalité, une bonne cohérence est un terme relatif et il est souvent plus utile de regarder les tendances  
         globales de la cohérence dans une mesure plutôt que les valeurs de cohérence spécifiques. Lorsque des  
         fréquences spécifiques ont des valeurs de cohérence beaucoup plus faible que la majorité des autres  
         fréquences, ce sont typiquement les fréquences pour lesquelles vous devez le moins vous fiez aux mesures.            
 
         Des exemples de facteurs autres que le nombre de points de moyenne qui peuvent affecter la cohérence des  
         données de la fonction de transfert comprennent le délai entre les deux signaux, l’énergie insuffisante pour  
         faire une mesure au niveau du signal de référence à une certaine fréquence, des influences acoustiques  
         telles que les réflexions, la modulation et la réverbération, le bruit ambiant ou électrique. Les processeurs  
         non linéaires tels que les compresseurs et les limiteurs dans le cheminement du signal peuvent également  
         avoir une influence négative sur la cohérence et doivent être désactivés si possible pour les mesures de  
         fonction de transfert et de réponse d’impulsion. 
 
         Le Tracé de Cohérence  
 

          
 
         SmaartLive offre deux affichages différents des mesures de cohérence de la Fonction de Transfert, un  



         Tracé de Cohérence et un Seuil de Cohérence (voir ci-dessous). Le Tracé de Cohérence est activé par le  
         bouton Coh à droite de la zone de  tracé en mode Fonction de Transfert. Lorsqu’il est activé, un deuxième  
         tracé qui représente les valeurs de cohérence pour chaque point de donnée apparaîtra (par défaut en rouge)  
         dans la partie supérieure du tracé de réponse fréquence/magnitude du mode Fonction de Transfert. 
 
         Le tracé de Cohérence considère la ligne zéro du tracé comme la cohérence 0 et la magnitude maximum  
         comme 100% (cohérence parfaite). Lorsque vous déplacez la souris sur la zone du tracé, vous pouvez lire  
         la valeur de cohérence pour les points de donnée dans l’affichage du curseur au-dessus du tracé. La valeur  
         de cohérence est ajoutée aux valeurs de fréquence, magnitude et de phase (si possible) normalement  
         affichées ici avec la couleur du texte correspondant à la couleur du tracé de cohérence. 
 
         Le Seuil de Cohérence 
 

          
 
         La deuxième option d’affichage liée à la cohérence dans SmaartLive permet de ne pas voir les données  
         dont la cohérence est trop faible. Pour activer la fonction de seuil de Cohérence, réglez simplement la  
         commande de seuil de cohérence qui apparaît à droite du tracé en mode fonction de transfert sur autre  
         chose que zéro. Lorsqu’elle est activée, SmaartLive enlèvera tous les points de donnée des tracés de  
         magnitude et de phase de la Fonction de Transfert dont la valeur de cohérence est inférieur au seuil  
         spécifié. Le tracé de cohérence, s’il est présent, n’est pas affecté. Le seuil de Cohérence est similaire dans  
         le concept au seuil de Magnitude (voir ci-dessous) mais fonctionne sur la valeur de cohérence plutôt que  
         sur la force du signal. 
 
 
Seuil de Magnitude  
 

          
 
         Une autre façon d’écarter les mauvaises données des mesures de fonction de transfert de SmaartLive est  
         d’utiliser le Seuil de Magnitude. Cette fonction vous permet de définir un seuil pour le niveau du signal de  
         référence, en dessous duquel SmaartLive rejettera les données entrantes du signal de mesure fréquence par  
         fréquence. Lorsque le Seuil de Magnitude est activé SmaartLive contrôle tous les points de donnée du  
         signal de référence et si ils sont inférieurs au seuil, le point correspondant sur le tracé de la fonction de  
         transfert ne sera pas pris en compte lorsque l’affichage de la fonction de transfert est mis à jour.                   
 
         Il y a deux vrais avantages à cette fonction, particulièrement lorsque vous utilisez SmaartLive pendant un  
         spectacle ou dans un environnement bruyant. L’une est d’éviter d’afficher à l’écran des données qui n’ont  
         pas comme origine le système mesuré (l’hypothèse étant que si vous n’avez rien fait entrer dans le système  
         à une certaine fréquence, vous ne devriez rien avoir en sortie à cette fréquence). L’autre étant que les  
         derniers points de donnée valide restant à l’écran jusqu’à ce qu’ils soient remplacés par de nouvelles  
         données valides, cette fonction protège le tracé de la fonction de transfert lors des fins de chanson ou  
         lorsque le signal de stimulus s’arrête. Cela signifie également que cela peut prendre un certain temps avant  
         que le tracé de la fonction de transfert se « construise » lorsque vous commencez à mesurer. Si le tracé  
         n’apparaît as après quelques secondes, vous devrez peut être baisser le niveau du seuil. 
 
         Le seuil de Magnitude est uniquement disponible en mode de Fonction de Transfert toutefois la commande  
         de seuil est également accessible en mode Spectre car dans la plupart des cas, il est plus facile d’identifier  
         le point où le signal croise le bruit sur l’affichage RTA. Le seuil est défini comme un pourcentage du  
         niveau maximum et une ligne horizontale apparaîtra sur le tracé RTA pour indiquer le niveau actuel du  
         seuil lorsqu’il est activé. 
 
Mesures de la Réponse d’Impulsion 
 

          
 
         En mode Impulse, SmaartLive mesure et affiche la réponse d’impulsion du système à tester. Le résultat de  
         la mesure de la réponse d’impulsion peut être enregistré en tant que fichier wave standard dans Windows  



         pour une analyse avec Smaart Acoustic Tools mais dans SmaartLive, la réponse d’impulsion est  
         principalement utilisée pour déterminer le décalage temporel (délai) entre deux signaux d’entrée. Le tracé  
         du mode Impulse est différent du tracé du mode d’analyse (RTA et Fonction de Transfert) puisqu’il affiche  
         l’énergie et le temps (plutôt que l’énergie et la fréquence). 
 
Fonctionnement de l’Enregistreur de la Réponse d’Impulsion 
 
         Comme l’affichage de la Fonction de transfert en temps réel, les calculs de la réponse d’impulsion de  
         SmaartLive supposent que les deux entrées de la carte son reçoivent le même signal, transmis via deux  
         cheminements différents (vois diagramme ci-dessous). Les données audio sont enregistrées depuis les  
         entrées puis transformées dans le domaine fréquentiel et traitées en utilisant une fonction de transfert. Le  
         résultat est ensuite transformé dans le domaine temporel par un FFT Inversé (IFFT). A l’exception de  
         l’enregistrement, il s’agit d’une opération « off-line » (pas en temps réel). 
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         Cette technique de mesure nécessite une Constante Temporelle FFT, ou une « fenêtre temporelle » pour la  
         comparer au temps de « decay » du système à tester. La Constante temporelle FFT est la taille du FFT  
         divisée par la fréquence d’échantillonnage. Par exemple, une fréquence d’échantillonnage de 44.1k avec  
         une taille FFT de 32768, donne une Constante Temporelle FFT de 743 millisecondes (0.743 secondes).  
         Cela fournira une fenêtre temporelle suffisante pour la plupart des pièces petites ou moyennes. Les espaces  
         plus larges ou très réverbérants avec des temps de « decay » plus long nécessite une fenêtre temporelle plus  
         longue. 
 
         Vous pouvez augmenter la taille de la Constante Temporelle FFT en augmentant la taille du FFT et/ou en 
         diminuant la fréquence d’échantillonnage mais garder à l’esprit que la dernière possibilité limite également  
         le contenu des fréquences de la réponse d’impulsion enregistrée (cela peut être utile dans certains cas).  
         SmaartLive fournit deux presets de fenêtre temporelle réglables par l’utilisateur (petit et grand) qui sont  
         utilisés par la fonction de point de localisation du délai automatique et par le mode Impulse. Les paramètres  
         des deux presets sont définis via Locator dans la fenêtre de dialogue Options. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
         Vous passez de la petite (Sm) à la grande (Lg) fenêtre temporelle en mode Impulse en utilisant la  
         commande à droite du tracé. 
 
         Note : Les appareils de traitement du signal non linéaires ne doivent pas être utilisés lors des mesures de  
         réponse d’impulsion et de Fonction de Transfert. 
 
Paramètres des Mesures du Mode Impulse 
 
         Les paramètres d'entrée des mesures du mode Impulse sont légèrement différents de ceux présents en mode  
         Spectre et Fonction de Transfert. En règle général, on utilise plus les paramètres FFT pour les mesures de  
         réponse d'impulsion que pour les mesures en temps réel, donc en mode impulse, il y a des commandes  
         séparées pour chaque paramètre plutôt qu'une commande pour tous. Les trois premiers ^paramètres du  
         mode impulse, Fréquence d'Ecghantillonnage (SR), Taille FFT et Constante Temporelle (TC) sont  
         identiques aux options des modes de mesure en temps réel. La seule différence vient des tailles FFT  
         supplémentaires (jusqu'à 512k) avec des constantes temporelles plus longues disponibles en mode Impulse.  
 

          
 
         Notez que la Résolution en Fréquence FFT (FR) n'est pas affichée en mode Impulse étant donné que la  
         réponse d'impulsion est un affichage du domaine temporel. Il y a, toutefois, le paramètre supplémentaire du  
         pourcentage de Overlap et en mode Impulse, la moyenne est considérée comme un paramètre d'entrée,  
         plutôt que comme un paramètre d'affichage.  
        

          
  
          Averages – Ce champ règle le nombre d'imùages FFT que l'enregistreur d'impulsion doit enregistrer.  
         Lorsqu'une valeur supérieure à 1 est spécifiée, l'enregistreur d'impulsion collecte et traite le nombre  
         d'images spécifié puis fait la moyenne de toutes les images pour donner le résultat final de la mesure. La  
         raison principale de ce procédé est la réjection du bruit – chaque que l'on double le nombre de points de  
         moyenne le rapport signal sur bruit de la mesure augmente de 3dB (jusqu'au bruit minimal du système à  
         tester ou du système de mesure). 
 

          
 
         Overlap – Régler cette valeur sur un nombre supérieur à zéro active la fonction de chevauchement de  
         l'enregistreur d'impulsion de SmaartLive, au lieu de l'utilisation classique de données du domaine  
         temporelle contigüe pour calculer plusieurs FFT. C'est particulièrement pratique pour des mesures où vous  
         avez besoin d'utiliser une grande taille FFT et/ou un grand nombre de points de moyenne car cela peut  
         énormément réduire le nombre d'échantillons nécessaires et donc le temps nécessaire pour collecter les  
         données. 
 
 
Utilisation de l’Enregistreur d’Impulsion 
 

          
 
         Pour entrer en mode Impulse, appuyer sur le bouton Impulse ou sur la touche [I] du clavier. L’enregistreur  
         d’Impulsion démarrera automatiquement et commencera à enregistrer les données audio depuis les entrées  
         de la carte son. L’enregistreur d’impulsion collecte le nombre d’échantillons nécessaire – la taille FFT  
         multipliée par le nombre d’images spécifié via Options>Locator>Averages. 
 
         Si le nombre de points de moyenne spécifié est supérieur à un, toutes les images sont enregistrées puis la  
         moyenne est faite à partir de celles-ci. Les calculs de la fonction de transfert et de l’IFFT sont ensuite  



         réalisés et un tracé de réponse d’impulsion dans le domaine temporel est affiché dans la zone de tracé.  
         L’axe temporel (horizontal) du tracé de la réponse d’impulsion sera égal à la Constante Temporelle FFT.  
         Cliquer sur le tracé avec le bouton gauche fera un zoom sur l’échelle temporelle (axe x), vous permettant  
         de visualiser les détails. Cliquer en dehors du tracé avec le bouton gauche fera revenir le niveau de zoom de  
         l'échelle temporelle (axe x) dans son état par défaut. 
 

          
 
         Le premier « pic » ou la première crête du tracé de réponse d’impulsion sera en général placé à la position  
         temporelle de la première entrée. Le Locked Cursor de SmaartLive sera automatiquement placé sur la crête  
         et sa position sera indiquée dans l’affichage du curseur bloqué au-dessus du tracé. Lorsque le Locked  
         Cursor est actif, appuyer sur [Ctrl]+[Barre d’Espace] ou appuyer sur la touche [Shift] et cliquer sur le tracé  
         avec le bouton gauche de la souris ouvrira l’onglet Delay de la fenêtre de dialogu Options avec la position  
         du Locked Cursor entré comme Temps de Délai pour la fonction de délai interne. Si le Locked Cursor n’est  
         pas actif, [Shift]+ cliquer sur le tracé ouvrira l’onglet Delay avec la position du curseur entrée comme  
         Temps de Délai. 
 
         

 
 
         La réponse d’Impulsion générée par la fonction du point de localisation du délai est enregistrée dans un  
         fichier de forme d’onde Windows standard (.wav). L’enregistreur d’impulsion utilise toujours le même  
         nom de fichier pour son fichier de sortie et remplace ce fichier à chaque fois que vous faites une nouvelle  
         mesure. Si vous voulez sauvegardez la mesure de réponse d’impulsion pour l’analyse dans SIA-Smaart  
         Acoustic Tools (ou pour une autre raison), cliquez sur la bouton Save As à droite du tracé pour écrire les  
         données sur un nouveau fichier wave. 
 

          
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
Automatic Delay Locator 
 
         Le Delay Locator de SmaartLive trouve le décalage temporel (délai) entre les deux signaux d’entrée en  
         mesurant la réponse d’impulsion de l’appareil ou du système à tester. Cette mesure peut être réalisée de  
         façon interactive en mode impulse ou automatiquement dans tout autre mode d’affichage (RTA, Fonction   
         de Transfert, ou Spectrographe). La configuration physique de la mesure pour les mesures de délai à celle  
         de la mesure de la Fonction de Transfert, nécessitant un signal de référence (source) et un signal de  
         référence (retour). 
 

          
 
         Le localisateur de délai automatique est activé en cliquant sur les boutons Auto Sm (Quick Auto Delay  
         Smaal) ou Auto Lg (Quick Auto Delay Large) sous l’affichage du délai dans la partie inférieure droite de la  
         fenêtre SmaartLive. Les options petit et grand se réfèrent à la fenêtre temporelle utilisée dans la méthode de  
         mesure. Il existe deux options car la technique de mesure de réponse d’impulsion à deux FFT qu’utilise  
         SmaartLive pour trouver les temps de délai est très sensible au temps de « decay » du système mesuré. Il  
         est essentiel que la fenêtre temporelle utilisée lors de la mesure soit grande par rapport au temps de decay  
         de la pièce/système à tester. 
 
         Les paramètres par défaut des options de localisation automatique petit et grand ont des fenêtres  
         temporelles de 300 millisecondes et 3 secondes respectivement. La petite fenêtre par défaut est appropriée  
        à la mesure de délais à travers des appareils électroniques ou des mesures acoustiques (microphone) dans  
         des pièces petites ou moyennes. La grande fenêtre par défaut doit être suffisante pour des mesures  
         acoustiques dans des pièces moyennes et grandes mais pourra devoir être augmenter pour des mesures dans  
         des espaces très grands et/ou très réverbérants. La taille des deux presets de fenêtre temporelle est  
         déterminée par la fréquence d’échantillonnage et par la taille FFT sélectionnées via Locator dans la fenêtre  
         de dialogue Options. 
 
         Le localisateur de délai automatique est principalement présent afin de détecter et de compenser le  
         décalage entre les signaux de référence et de mesure lors des mesures de Fonction de Transfert (bien qu’il  
         puisse certainement être utilisé pour d’autres raisons). Une fois les étapes Auto Sm et Auto Lg terminées,  
         une fenêtre de dialogue vous permettant de définir le délai interne du canal de référence en fonction du  
         temps de délai trouvé s’ouvrira. Cette fenêtre de dialogue vous indique également la polarité absolue de la  
         réponse d’impulsion. La polarité de la réponse d’impulsion peut être utile pour déterminer la polarité d’un  
         seul haut parleur mais peut être trompeuse lors de la mesure d’une enceinte à plusieurs haut parleurs.                                        
          
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Mesures SPL 
 
Calibrer en SPL 
 
         Il est important de se rappeler que SIA SmaartLive fonctionne uniquement dans le domaine numérique.  
         Etant donné que SmaartLive utilise le matériel audio standard de Windows pour accéder aux données du  
         hardware son de l’ordinateur, il ne voit que la sortie numérique du convertisseur A/N. SmaartLive ne  
         connaît pas la gamme de tension de l’entrée du convertisseur A/N ou tous les autres détails à propos de la  
         structure du gain du cheminement du signal en entrée avant ce point.   
 
         Par défaut, SmaartLive est calibré pour définir 0dB comme la plus haute magnitude pour un signal sinus à  
         1000Hz. En d’autres mots, si on prend un signal sinus à 1kHz avec une amplitude exactement égale à la  
         tension d’entrée maximum du convertisseur A/N de votre hardware son, le tracé RTA de SmaartLive  
         (analyseur de spectre conventionnel) devrait afficher une crête de 0dB à 1kHz.   
 
         Notez que lors de l’utilisation du calibrage par défaut, l’affichage du niveau du signal au-dessus des  
         vu-mêtres d’entrée indique toujours une valeur négative et l’indication FS (pour full scale) apparaît dans le  
         champ à droite. Lorsque SmaartLive est calibré en SPL, cette indication devient « SPL », d’autres  
         indications supplémentaires apparaissent sur une deuxième ligne juste en dessous et les niveaux en décibels  
         seront positifs. 
 
         Pour obtenir des indications précises de Sound Pressure Level (SPL) dans SmaartLive, l’affichage RTA  
         doit être recalibré sur une référence externe. Gardez également à l’esprit que l’affichage du niveau du  
         signal suit l’entrée active (voir Active Input page 84 pour plus d’informations) et doit éviter mesurer une  
         entrée transportant un signal provenant d’un microphone pour une mesure SPL.   
 
Méthode de Calibrage SPL Conseillée 
 
         La méthode la plus précise pour calibrer SmaartLive en SPL nécessite l’utilisation d’un calibreur de  
         microphone acoustique. Le calibreur doit être fixé à la capsule de votre microphone de mesure. Si vous ne  
         pouvez pas trouver un calibreur conçu spécifiquement pour votre microphone, consultez le fabricant. Vous  
         devriez pouvoir vous procurer un adaptateur qui vous permettra de fixer le microphone au calibreur.  
 
         L’analyseur de SmaartLive doit fonctionner en mode RTA pour réaliser une procédure de recalibrage. Pour  
         obtenir les résultats les plus précis utilisez un affichage de fréquence 1/24 d’octave ou Narrowband pour  
         isoler précisément la fréquence du calibreur.  
         Mettez le gain du préamplificateur de votre microphone et de l’entrée de votre carte son sur un niveau utile  
         puis fixez le calibreur à votre microphone et activez le calibreur. Lorsque vous voyez la crête du tracé RTA  
         se stabilisée sur la fréquence du calibreur double cliquez sur le tracé ou cliquez sur l’affichage du niveau du  
         signal puis cliquez sur le bouton Calibrate to SPL dans la fenêtre de dialogue Signal Level/SPL Readout  
         Options. 
     
         SmaartLive trouvera automatiquement la magnitude du plus haut point du tracé RTA et une fenêtre de  
         dialogue s’ouvrira pour indiquer la valeur actuelle de la magnitude de la crête de fréquence. Le champ Set  
         this value de la fenêtre de dialogue Amplitude Calibration sera mise en surbrillance et vous n’aurez plus  
         qu’à entrer la valeur en décibels correctes pour la sortie du calibreur (consultez la documentation pour  
         votre calibreur) et cliquez sur le bouton OK. Lorsque la fenêtre de dialogue se refermera le tracé se  
         remettra à jour lui-même en fonction de la valeur en décibels spécifiée. C’est tout. Vous devriez maintenant  
         pouvoir obtenir une indication SPL très précise en utilisant SmaartLive.           
 
         Notez que si vous voulez modifier le gain du préamplificateur du microphone ou de la console ou la  
         tension du convertisseur A/N, vous devrez recommencer la procédure pour recalibrer. Et notez que  
         SmaartLive utilisant un schéma de calibrage « engineering units » pour le calibrage SPL, cette même  
         procédure peut être utilisée pour calibrer le programme sur pratiquement tout signal dont l’amplitude est  
         connue. 
 
Calibrage SPL « Rapide » 
 
         Si vous ne possédez pas de calibreur de microphone mais que vous avez un vu-mêtre SPL, vous pouvez  



         calibrer SmaartLive afin de fournir des indications SPL assez fidèle pour être utilisable en utilisant le  
         vu-mêtre SPL comme référence. La procédure pour le calibrage SPL rapide à l’air un peu compliquée à  
         première vue mais en fait elle est très simple et ne prend qu’une minute à réaliser.    
 

1. Avec SmaartLive en mode RTA, enlevez tous les tracés de référence de l’affichage et éteignez 
l’analyseur. La zone de tracé doit être complètement vide.  

2. Double cliquez au centre de la zone de tracé et lorsque la fenêtre de dialogue Amplitude calibration 
apparaît, sélectionnez Set this value to et tapez un nombre positif de décibels. 50 est un bon numéro. 
Cliquez sur le bouton OK pour fermer la fenêtre de dialogue.  

3. Cliquez sur l’Affichage du Niveau du Signal/SPL de SmaartLive et réglez les options de pondération et 
vitesse SPL afin de les faire correspondre au vu-mêtre SPL. Si votre vu-mêtre SPL peut afficher  

                 une indication SPL Plate (non pondérée), c’est probablement le meilleur choix. Sinon réglez     
                 SmaartLive et le vu-mêtre afin qu’ils affichent une courbe Lente, pondérée A ou C.    

4. Placez votre microphone de mesure et votre vu-mêtre SPL très proche l’un de l’autre à la même 
distance du haut parleur puis envoyez un signal, de préférence du bruit rose, à travers le haut parleur.  

5. Notez les indications SPL de SmaartLive et du vu-mêtre SPL.  
6. Faites une soustraction ente les deux valeurs pour déterminer la différence.  
7. Eteignez l’analyseur de SmaartLive et double cliquez sur l’affichage. Si l’indication du vu-mêtre SPL 

était supérieure à celle de SmaartLive dans l’étape 5, ajoutez la différence trouvée dans l’étape 6 au 
nombre dans le champ Current Value de la fenêtre de dialogue Amplitude Calibration et tapez le 
résultat dans le champ Set this value. Si la valeur du vu-mêtre SPL était inférieure, soustrayez la 
différence à la valeur actuelle et entrez le résultat dans le champ Set this value. Cliquez sur le bouton 
OK pour fermer la fenêtre de dialogue.  

8. Lancez le RTA de SmaartLive et comparez à nouveau les indications du vu-mêtre et de SmaartLive. 
Elles devraient être très proches. Si smaartLive est décalé de plus de deux dB par rapport au vu-mêtre, 
recommencez les étapes 6 et 7 jusqu’à ce que vous soyez satisfait du résultat.  

 
L’Affichage Niveau du Signal/SPL 
 

          
 
         L’affichage en décibels (dB) qui apparaît dans le coin supérieur droit de la fenêtre SmaartLive au-dessus  
         des vu-mêtres de niveau d’entrée affiche une valeur numérique d’amplitude pour l’une des deux entrées en  
         temps réel. Cet affichage est pratique pour contrôler le niveau global des signaux d’entrée et lorsque  
         SmaartLive est bien calibré, il peut être utilisé pour contrôler le Sound Pressure Level (SPL). Veuillez  
         noter que les mesures SPL ne sont valides que si SmaartLive est calibré en SPL. De plus, étant donné  
         que cet affichage ne contrôle qu’une seule entrée simultanément, elle doit être assignée à une entrée  
         transportant un signal provenant d’un microphone lors d’une mesure SPL.  
 
          
 
         L’affichage du niveau du signal suit le canal d’entrée actif. Notez que vous pouvez activer l’une des deux  
         entrées en cliquant simplement sur son vu-mêtre dans n’importe quel mode d’affichage. L’entrée  
         actuellement active est indiquée par une case Active juste sous son vu-mêtre. La couleur du texte de  
         l’affichage du niveau du signal correspond à la couleur du vu-mêtre du niveau d’entrée du canal mesuré.  
         Lorsque SmaartLive est calibré en SPL, l’affichage peut afficher une valeur SPL pondérée A, C ou plate  
         (non pondérée) basée sur l’image FFT actuelle (uniquement) ou sur une moyenne des données d’un certain  
         nombre des plus récentes images. 
 
         Les indications dans le champ juste à droite de l’affichage du niveau du signal concernent les paramètres  
         actuels. Lorsque SmaartLive utilise son calibrage full scale par défaut, la ligne supérieure du champ affiche  
         l’indication « FS » et la deuxième ligne est vide. Si SmaartLive est calibré en SPL (ou une référence  
         externe) cette indication sera remplacé par SPL et deux indications supplémentaires apparaîtront sur la igne  
         inférieure. Une lettre à gauche de la deuxième ligne indique si la courbe de pondération utilisée est la A, la  
         B, ou la F (pour plat). A droite de la section de pondération, l’indication « sl » indique que l’option SPL  
         Slow (moyenne de données) est sélectionnée. Cette indication sera remplacée par « fa » lorsque l’option  



         Fast (pas de moyenne ) est sélectionnée. 
 
         Cliquer n’importe où à l’intérieur de ca champ avec la souris ouvrira une fenêtre de dialogue vous  
         permettant de définir les propriétés de l’affichage du niveau du signal et/ou de recalibrer SmaartLive. Les  
         propriétés de l’affichage SPL peuvent également être définies depuis l’onglet Inputs de la fenêtre de  
      dialogue Options. 

 
Travailler avec des Mesures Enregistrées 
 
Sauvegarder et Comparer les Tracés  
 
         En modes RTA et Fonction de Transfert, il est possible de capturer, d’enregistrer et d’afficher les  
         « snapshots » ou les copies statiques du tracé actif. Nous appelons ces tracés capturés des tracés de  
         référence. Les tracés de référence sont enregistrés sur Reference dans SmaartLive, et peuvent également  
         être sauvegardés sur des fichiers dans le disque dur. Lorsque vous capturez un tracé en mode RTA, le tracé  
         du spectre de l’entrée active est celui qui est capturé (voir Active Input page 84 pour plus d’information).  
         En mode de Fonction de Transfert, il n’y a qu’un seul tracé (représentant la différence entre les deux  
         signaux) donc cela ne pose pas de problème.  
 
         SmaartLive a deux ensembles de 20 References (un total de 40) – un ensemble sert aux tracés de référence  
         capturés en mode RTA et l’autre pour les tracés en mode Fonction de Transfert. Etant donné que les tracés  
         de référence capturés en mode RTA ne peuvent pas être affichés en mode Fonction de Transfert et vice  
         versa, un seul groupe de contrôle est utilisé pour contrôler les deux ensembles. Les References sont  
         disposées dans cinq banques de quatre, nommées A, B, C, D et E.           
          
Capturer un Tracé de Référence  
 

          
 
         Une Reference par banque est toujours sélectionnée. Vous pouvez capturer (échantillon) un tracé dans le  
         registre sélectionné dans n’importe quelle banque en appuyant sur la touche [Ctrl] et en appuyant sur la  
         lettre (A, B, C, D, ou E) de la banque sur laquelle vous voulez le capturer. La face de chaque bouton de  
         banque fournit une légende pour la couleur du tracé de référence affiché.      
 
         Appuyer sur la touche [Shift] et sur la lettre sélectionne le registre suivant sur la banque correspondante et  
         [Shift] + [Ctrl] + ([A], [B], [C], [D], ou [E]) sélectionne et capture sur le registre suivant de la banque, avec  
         une navigation de gauche à droite. Vous pouvez également capturer dans un registre en cliquant son bouton  
         pour l’activer puis en cliquant sur le bouton de capture (Capt) ou en appuyant sur la [Barre d’Espace].    
          
         Un nouveau tracé de référence est affiché immédiatement après la capture. Il deviendra également  
         automatiquement le tracé supérieur (sur l’axe z du tracé) et son registre deviendra le registre de référence  
         actif s’il ne l’était pas déjà. Le tracé au premier plan est le tracé concerné par l’opération Track Nearest  
         Data Point et de toutes les opérations de Locked Cursor. Notez également que la couleur de la valeur de la  
         commande dB à droite de la zone du tracé change afin de correspondre à la couleur du tracé supérieur. Les  
         boutons de la commande (haut/bas) à droite de la commande du champ de texte vous permettent d’ajuster  
         la position verticale du tracé supérieur. 
 
         En mode RTA, vous pouvez revenir à la visualisation des tracés en cliquant sur l’un des vu-mêtres d’entrée  
         ou en utilisant la commande Active Trace dans le menu Control. En mode Fonction de Transfert, cliquer  
         sur l’un des vu-mêtres d’entrée fera revenir la visualisation du tracé de fonction de transfert. Pour visualiser  
         un tracé de référence enregistré, cliquez simplement sur le bouton du registre. Cela fonctionne même si le  
         bouton de registre est déjà enfoncé et activera le registre sélectionné comme registre de référence actif.                        
          
         Le numéro du registre (ex : A1) du registre de référence actif est indiqué dans le petit champ à gauche du  
         champ de commentaire sur la référence sous le tracé. Vous pouvez ajouter un texte de commentaire à un  
         tracé enregistré dans le registre actif en cliquant sur le champ de commentaire et en tapant votre  
         commentaire dans la fenêtre de dialogue qui s’ouvrira. Le champ d’entrée du texte de cette fenêtre de  
         dialogue enregistre également les commentaires de référence précédemment utilisés dans une liste  



         déroulante. Si vous voulez utiliser un commentaire de la liste pour le tracé de référence actuel,  
         sélectionnez-le simplement dans la liste. 
 
         Notez que le registre de référence actif est la cible de la commande Capture et donc cliquer sur le bouton  
         Capture ou appuyer sur la [Barre d’Espace] remplacera les données présentes dans le registre sans aucun  
         avertissement. Par défaut, l’écrasement d’un registre effacera également le commentaire lié au tracé  
         précédent. Si vous décochez la case nommée « Clear Ref Comment After Capture » via l’onglet Graph de  
         la fenêtre de dialogue Options, la fenêtre de dialogue Reference Trace Comment apparaîtra à chaque fois  
         que vous capturerez un tracé et si le contenu précédent du registre sélectionné possédait un commentaire,  
         ce commentaire sera conservé (à moins que vous ne tapiez un nouveau commentaire ou que vous n’effaciez  
         le commentaire existant). 
 

          
 
         A gauche du egistre actif et du champ de commentaire se trouvent quatre boutons nommés Capt (capture),  
         Del (delete), Hide et Info. Le bouton Capt capture un nouveau tracé de référence dans le registre de  
         référence actif comme décrit ci-dessus. Cliquer sur le bouton Del ou appuyer sur [Ctrl] + [Delete] sur le  
         clavier efface le contenu du registre actif. Le bouton Hide enlève temporairement tous les tracés de  
         référence de l’écran. Les sélections du registre de référence ne sont pas affectées. Cliquer à nouveau sur le  
         bouton Hide fait réapparaître tous les tracés de référence qui étaient affichés. Le bouton Info appelle la  
         fenêtre de dialogue Reference Trace Information vous permettant de sauvegarder et de charger des fichiers  
         de référence (.ref) et des fichiers de groupe de référence (.rgp).          
   
Afficher des Tracés de Référence  
 
         Les boutons A, B, C, D et E sont utilisés pour activer les tracés de référence enregistrés dans le registre  
         sélectionné et dans les banques correspondantes. Un tracé de référence de chacune des cinq banques peut  
         être affiché simultanément en plus du tracé actuel. 
 
Faire une Moyenne des Tracés de Référence 
 
         Les Registres de Référence de la banque E peuvent être utilisés comme 4 registres normaux, en capturant  
         directement des tracés depuis le tracé actuel, ou comme des registres de « moyenne ». Lorsque le bouton  
         « avg » à côté de la banque E est enfoncé, capturer sur un registre E ne reproduit pas le racé actuel. En fait,  
         tous les tracés de référence affichés des banques A, B, C et D sont pris en compte et la moyenne en  
         résultant est enregistrée et affichée comme un seul tracé. 
 
Sauvegarder et Charger les Fichiers de Référence 
 
         Pour sauvegarder un Tracé de Référence actif sur un fichier (.ref) sur le disque dur, appuyez sur [Ctrl] + [S]  
         ou sélectionnez Save Active Reference Trace dans le menu Control>Reference. Vous pouvez également  
         sauvegarder des tracés de référence enregistrés sur des fichiers et rappeler des données de tracé enregistrées  
         dans des fichiers de référence en utilisant la fenêtre de dialogue Reference Trace Information. Cette fenêtre  
         de dialogue est accessible en cliquant le bouton Info sous le tracé ou en sélectionnant Show Reference  
         Information depuis le menu Control>Reference. La fenêtre de dialogue Reference Trace Information  
         possèdent six onglets ; un onglet General et un onglet pour chacune des banques de registre de référence  
         (A, B, C, D, et E). 
 
         L’Onglet General     
 
         Sur l’onglet General de la fenêtre Reference trace Information vous pouvez éditer les commentaires et  
         ajuster la position verticale de chacun des Tracés de référence enregistrés. Les boutons Load All et Save All  
         de l’onglet General vous permettent de sauvegarder et charger le contenu des 40 (RTA et Fonction de  
         Tarnsfert) Registres de Référence comme un simple fichier de groupe de référence (.rgp), en une seule  
         opération. 
 

          
 



         La commande Save All enregistre le contenu actuel de tous les Registres de Référence sur un seul fichier de  
         Groupe de Référence (.rgp). Cliquer sur le bouton Save All ouvre une fenêtre de dialogue Save As vous  
         permettant de spécifier un nom de fichier et d’entrer un commentaire pour le fichier groupe si vous le  
         désirez. Le commentaire sera visible (dans la fenêtre de dialogue Open) durant les opérations Load All.       
 

          
 
         Load All ouvre une fenêtre de dialogue Open vous permettant de sélectionner un fichier de Groupe de  
         Référence précédemment sauvegardé à charger. 
 
         Note importante : L’opération Load All replace le contenu des 40 Registres de Référence donc tous les  
         tracés de références existants non sauvegardés seront perdus. SmaartLive vous demandera confirmation  
         avant le chargement afin d’éviter tout écrasement de données accidentel.   
          
         Les Onglets A, B, C, D et E 
 
         Les onglets individuels des banques de registre vous permettent de visualiser les paramètres de tous les  
         tracés sauvegardés, de sauvegarder des fichiers de tracé de référence sur le disque dur et de rappeler des  
         fichiers de référence (.ref) précédemment sauvegardés. 
 

          
 
         Pour sauvegarder de façon permanente un fichier de Tracé de Référence (.ref) sur le disque, sélectionnez  
         l’onglet de la banque de registre appropriée, sélectionnez le registre contenant le tracé que vous désirez  
         sauvegarder en cliquant sur l’un des quatre boutons de registre, puis appuyez sur le bouton Save. Une  
         fenêtre de dialogue Save apparaîtra avec le nom du registre (ex : a1.ref) suggéré comme nom pour le  
         nouveau fichier. N’importe quel nom de fichier peut être utilisé à condition qu’il se termine par l’extension  
         « .ref » (le programme ajoutera lui-même l’extension si vous ne le faites pas).      
 

          
 
         Pour rappeler un fichier de Référence (.ref) précédemment sauvegardé sur un registre de référence,  
         sélectionnez l’onglet de la banque de référence appropriée dans la fenêtre de dialogue Reference Trace  
         Information, puis cliquez sur le bouton du registre que vous désirez utiliser et cliquez sur le bouton Load.  
         Cela ouvre une fenêtre de dialogue Open. 
 
         En utilisant les commandes de la fenêtre de dialogue Open, naviguer jusqu’au dossier contenant le fichier  
         que vous désirez charger puis cliquez sur le nom du fichier de référence (.ref) pour le sélectionner. Notez  
         que la fenêtre de dialogue standard de Windows a été modifié pour vous indiquer le Commentaire, la  
         Fréquence d’Echantillonnage, la taille FFT et le numéro de version du fichier sélectionné.   
       
         Lorsque vous avez fait votre sélection, cliquez sur le bouton Open pour charger le fichier. Cela vous  
         ramène à la fenêtre de dialogue Reference Trace Information. Vous pouvez répétez la même procédure  
         pour charger des Fichiers de Référence supplémentaires ou cliquez sur le bouton OK pour fermer la fenêtre  
         de dialogue. Pour afficher le tracé chargé, cliquez sur son bouton de registre de référence dans la zone de  
         référence en-dessous du tracé. 
 
         Note : Gardez toujours à l’esprit qu’il existe deux ensembles de registres de référence pour les tracés de  
         référence RTA et de Fonction de Transfert et toutes les commandes du registre de référence s’appliquent  
         uniquement aux registres de référence du mode opérationnel actuel. Cela signifie que SmaartLive ne peut  
         charger que des fichiers contenant des tracés RTA en mode RTA ou des fichiers contenant des tracés de  
         Fonction de Transfert en mode Fonction de Transfert. 
 
Contrôle d’Appareil Externe  
 
         L’interface de contrôle d’Appareils Externes de SmaartLive permet un contrôle direct des égaliseurs (EQ),  
         processeurs et autres appareils contrôlables par télécommande. En utilisant, cette fonction, il est possible  
         d’ajuster les filtres des EQ et les autres paramètres depuis SmaartLive tout en affichant la réponse en  



         fréquence de l’unité en temps réel sur le(s) tracé(s) de la Fonction de Transfert. 
 
         Certains appareils externes peuvent être contrôlés en utilisant le port série ou parfois le port parallèle de  
         l’ordinateur, d’autres nécessiteront une communication MIDI. Pour communiquer avec une télécommande  
         via MIDI, votre ordinateur doit posséder une interface I/O MIDI compatible Windows – en général un  
         adaptateur joystick/MIDI ou une extension MIDI I/O qui se connecte à un port série ou parallèle.       
          
         Le support logiciel des différents appareils est ajouté à SmaartLive via les fichiers « plug-in » donc la liste  
         des appareils supportés est sujette à modification. Notez que Smaart Pro peut ne pas supporter toutes les  
         fonctions disponibles pour un appareil donné et que le nombre et le type des fonctions supportées peut  
         varier d’un appareil à l’autre. 
 

          
 
         Appuyer sur [X] sur votre clavier ou sélectionner External Device Mode depuis le menu External Device  
         ouvrira un panneau de contrôle pour l’appareil externe actuellement sélectionné. Si aucun appareil n’est  
         configuré internement, SmaartLive vous demandera si vous voulez ajouter une nouvelle définition  
         d’appareil. 
 
         Lorsque plusieurs appareils sont configurés dans SmaartLive, vous pouvez sélectionner l’appareil que vous  
         voulez contrôler depuis le menu External Devices ou le menu déroulant qui apparaît lorsque faites un  
         clique droit. Cliquer sur le nom Ext. Device au-dessus du champ d’appareil avec le bouton gauche ouvrira  
         un menu de commandes d’appareil. Vous pouvez également assigner les appareils à une barre de boutons  
         qui apparaît au-dessus du tracé lorsque vous cliquez sur le bouton Bar à côté du nom Ext. Device.                 
       
         Le panneau de contrôle de l’appareil externe vous permet de régler les filtres, d’enregistrer et de rappeler  
         des programmes et de contrôler le gain de sortie et d’autres paramètres de la télécommande. Les contrôles  
         spécifiques disponibles varieront en fonction du modèle et du type d’appareil sélectionné.  
  
   Lorsque vous activez le contrôle d’appareil externe en mode de Fonction de Transfert un ensemble de  
         marqueurs apparaîtra sur le tracé indiquant les positions des fréquences et des augmentation/diminution de  
         tous les filtres des EQ sur le canal/appareil sélectionné. Les filtres passe haut et passe bas sont représentés  
         par des marqueurs triangulaires. Tous les autres types de filtre sont indiqués par des carrés. 
 
         Les paramètres des filtres de la télécommande ^peuvent être ajustés en cliquant et tirant ces marqueurs sur  
         le tracé avec la souris. Lorsque vous sélectionnez un marqueur de filtre en cliquant dessus, les paramètres  
         du filtre sont affichés dans la partie supérieure du panneau de contrôle de l’appareil externe. L’information  
         indiquée varie en fonction du type de filtre sélectionné. Par exemple, la fréquence centrale et la largeur de  
         bande des filtres individuels d’un EQ graphique sont fixes mais sont réglables sur un paramétrique.       
 
         Vous pouvez passer d’un marqueur de filtres à l’autre en utilisant la touche [Tab] ([Shift] + [Tab] inverse la  
         direction de la navigation). Lorsqu’un filtre est sélectionné, sa fréquence centrale (Hz), sa Largeur de  
         Bande (Oct), et sa valeur d’augmentation/diminution (dB) sont indiquées dans les trois champs supérieures  
         du panneau de contrôle de l’appareil externe. 
 
         Les filtres à 0dB d’augmentation/diminution sont considérés inutilisés. Notez que sur certains appareils  
         numériques, les filtres inutilisés sont considérés non assignés et linéariser un filtre peut entraîner la  
         disparition complète de son marqueur. Un raccourci pour régler les filtres est d’appuyer sur la touche shift  
         en cliquant sur un point du tracé. Cette action sélectionnera automatiquement le filtre inutilisé le plus  
         proche et le placera sur le point où vous avez cliqué ou assignera un nouveau filtre sur le point où vous  
         avez cliqué, en fonction de l’appareil. 
 
         Pour ajuster la valeur d’augmentation/diminution et la fréquence centrale (seulement sur les paramétriques)  
         du filtre sélectionné, utilisez les touches de flèches du clavier ou tirez le marqueur d’un point du tracé à un  
         autre avec la souris. Sur un EQ paramétrique, vous pouvez également ajuster la largeur de bande du filtre  
         en appuyant sur la touche [Shift] et sur la touche de la flèche droite ou gauche.            
 
         Les paramètres du filtre peuvent également être réglés en utilisant les boutons à droite des champs  
         d’édition des paramètres sur le panneau de contrôle. Certains champs de paramètre peuvent être édités  



         directement, c’est à dire que vous n’avez qu’à cliquer dans le champ pour entrer les valeurs directement  
         depuis le clavier. Notez que la plupart des appareils contrôlables par télécommande règlent les paramètres  
         des filtres suivant des pas donnés, SmaartLive devra donc ajuster les valeurs que vous entrez sur les valeurs  
         disponibles les plus proches. 
 
         Note : Plus d’information sur de nombreux appareils externes supportés par SmaartLive est disponible sur  
         le site web de SIA (www.siasoft.com). 
 
Configuration des Appareils Externes 
 
         La commande External Devices du menu Options ouvre la fenêtre de dialogue External Device  
         Information. Cette fenêtre de dialogue vous permet d’ajouter, de configurer et d’éditer les « définitions  
         d’appareil » pour les égaliseurs, les processeurs et les autres appareils contrôlables par télécommande  
         supportés. 
 

          
 
         Avant de pouvoir contrôler un appareil externe supporté depuis SmaartLive, vous devez configurer une  
         définition d’appareil pour cet appareil. Les définitions d’appareil sont créées et gérées via la fenêtre de  
        dialogue External Device Information. Pour accéder à cette fenêtre de dialogue, sélectionnez Devices >  
         Configure dans le menu External Devices ou dans le menu déroulant du clique droit ou cliquez sur le nom  
         (Ext. Device) au-dessus du champ de l’appareil sélectionné (voir ci-dessus) et sélectionnez Configure dans  
         le menu déroulant. 
 
         Pour ajouter une nouvelle définition d’appareil, cliquez sur le bouton Add dans la fenêtre de dialogue  
         External Device Information. Vous serez invité à sélectionner le type d’appareil que vous voulez ajouter  
         depuis la liste actuelle des appareils supportés (basée sur les fichiers « plug-in » présents dans le dossier  
         Devices de votre dossier SmaartLive). Après avoir sélectionner le type d’appareil, une fenêtre de dialogue  
         de configuration d’appareil apparaîtra. Ici vous pouvez entrer le nom de l’appareil (ou accepter le nom par  
         défaut) et sélectionner le port E/S (COM ou LPT) ou le numéro du canal MIDI que vous utiliserez pour  
         communiquer avec cet appareil et la ID de l’appareil (s’il y en a une).          
 
         

 
 
         Les appareils multi-canaux présenteront des options supplémentaires. Lors de la configuration d’un  
         appareil multi-canaux, un premier nom d’appareil est assigné à l’appareil physique actuel et apparaît à  
         gauche de la fenêtre de dialohue External Device Information. Vous pouvez également assigner des noms  
         individuellement aux canaux et/ou aux modes opérationnels de l’appareil et sélectionner les noms qui  
         apparaîtront dans les listes d’Appareils disponibles des menus déroulants, la section Devices du menu  
         External Devices et la fenêtre de dialogue System Presets. 
 
         Une fois que l’appareil est configuré, le nom de l’appareil (ou le nom principal pour les appareils  
         multi-canaux) apparaîtra à gauche dans la fenêtre de dialogue External Device Information avec le type  



         d’appareil et l’assignation du port E/S (Configuration). Un marqueur vert apparaît à gauche de l’appareil  
         actuellement contrôlé. Lorsque vous sélectionnez le nom d’un appareil physique dans la liste à gauche, une  
         liste de tous les noms d’appareils associés à celui-ci et de tous les numéros de presets Système l’utilisant  
         apparaîtra à droite. 
 
         Vous pouvez assigner un appareil mono ou toute entrée ou sortie d’un appareil multi-canal à un bouton sur  
         la Barre d’Appareil en sélectionnant l’appareil dans la liste et en cliquant sur le bouton Assign to Device  
         Bar. La Barre d’Appareil apparaît au-dessus du tracé lorsque vous cliquez sur le bouton Bar au-dessus du  
         champ de l’appareil sélectionné à droite du tracé ou que vous sélectionnez Device Bar dans le menu View.      

 
Configurer SmaartLive 
  
Configurer l’Ecran  
 
         Appuyer sur [Alt] + [G] sur le clavier, sélectionner Graph dans le menu Options ou cliquer dans le champ  
         du titre au-dessus du tracé ouvrira l’onglet Graph de la fenêtre de dialogue Options. Ici vous pouvez  
         spécifier les options d’affichage et les paramètres de démarrage pour le tracé y compris le titre, l’échelle de  
         l’axe y (magnitude) pour le tracé RTA et Fonction de Transfert (en fonction du mode dans lequel vous  
         êtes), et les pas pour les commandes Zoom, Move et Y +/-.            

 
SmaartLive vous permet également de régler les couleurs de pratiquement tous les éléments de l’écran et 
même d’utiliser vos propres fichiers bitmap comme fond. Les options de couleur et de fond sont chargées 
en tant qu’ensembles appelés Colour Schemes. Plusieurs ensembles de couleurs prêt à l’utilisation (dont 
deux avec des fonds métalliques) sont inclus avec le programme et vous pouvez facilement définir le votre. 
Les commandes des ensembles de couleurs sont accessibles via l’onglet Colors de la fenêtre de dialogue 
Options. 
 
Sélectionner la commande Quick Zoom dans le menu View ou appuyer sur [Ctrl] + [Q] maximise la zone 
d’affichage des données en enlevant tous les contrôles (sauf les commandes des registres de référence) de 
l’affichage. Cette fonction est très pratique lors de l’utilisation de SmaartLive avec un petit écran et/ou 
lorsque les paramètres sont réglés et que vous désirez une zone de tracé plus large.  

 
Sauvegarder et Charger les Configurations du Programme 
 
         La configuration de SmaartLive, y compris l’état de tous les paramètres réglables par l’utilisateur, est  
         enregistrée dans le registre du programme dans la base de données du registre de Windows. Les paramètres  
         de la configuration actuelle sont sauvegardés lorsque vous quittez le programme normalement et peuvent  
         être sauvegardés à tout moment durant la session en sélectionnant Configuration > Save depuis le menu  
         File. 
 
         La commande Configuration > Save As du menu File vous permet d’enregistrer plusieurs configurations  
         pour différentes applications ou différents utilisateurs. La commande Configuration > Load charge une  
         configuration précédemment sauvegardée.      

 
La commande Configuration > Export extrait une copie de toutes les informations de configuration de 
SmaartLive depuis le registre de Windows vers un fichier ( ;reg) sur le disque. C’est pratique pour copier 
vos préférences sur une autre machine ou pour conserver une copie.  
 
La commande Configuration > Import charge le contenu d’un fichier .reg sur la base de données du 
registre de Windows, remplaçant complètement les paramètres précédents.  
 

Charger la Configuration par Défaut 
 
         Les options d’affichage et d’échelle de Smaartlive sont extrêmement flexibles et peuvent parfois être   
         confuses, surtout au premier abord. La plupart de ces options sont enregistrés dans la Configuration  
         actuelle qui est mise à jour à chaque fois que vous quittez le programme.      

 



Lorsque vous démarrez SmaartLive, il examine la dernière Configuration utilisée et charge les paramètres. 
A chaque fois que vous voulez revenir aux paramètres par défaut du programme, sélectionnez Set All 
Values To Default dans la section Configuration du menu File. Cela remet tous les paramètres par défaut 
sauf les sélections de Couleurs et d’Appareils.  

 
Presets du Système 
 

          
 
         Mesurer et optimiser un système de sonorisation implique l’utilisation de nombreux points de mesures. Les  
         Presets du Système sont conçus pour vous aider à automatiser ce processus en vous permettant de changer  
        rapidement de nombreux paramètres du système pour différents types de mesures. Par exemple, vous  
         pouvez définir des Prestes Système séparés pour différentes positions de microphone, un pour chaque EQ  
         et chaque processeur du système, etc., et passez de l’un à l’autre en une seule opération.         

 
SmaartLive peut enregistrer jusqu’à 100 Presets Système dans chaque configuration. Chaque Preset 
Système enregistre de nombreux paramètres dont la Fréquence d’Echantillonnage, la taille FFT, le Temps 
de Délai, les Moyennes, le mode opérationnel et la sélection des appareils externes, et en option, un 
changement de programme MIDI à envoyer lorsque le Preset est appelé. Les Prestes Système peuvent 

         être enregistrés et rappelés en utilisant les boutons Store et Load à droite de la zone du tracé ou avec les   
         commandes du menu ou du clavier. Vous pouvez également rappelé les Presets Systèmes à distance en  
         envoyant un changement de programme MIDI correspondant à un numéro de preset à l’ordinateur sur  
         lequel tourne SmaartLive via MIDI (voir Devices page 112 pour plus d’information).    

 
Cliquer sur le bouton Store (Preset Système) ouvre un menu vous permettant d’enregistrer directement sur 
n’importe lequel des neuf premiers registres de preset. Vous pouvez également enregistrer les paramètres 
actuels sur les presets 1-9 en appuyant sur [Ctrl] + [shift] + ([1] – [9]) sur le clavier. Appuyer sur [Ctrl] + 
[Shift] + [0] ou sélectionner « any » depuis le menu déroulant du bouton Store ouvrira une fenêtre de 
dialogue vous permettant de nommer et d’enregistrer sur n’importe quel emplacement de Preset Système 
(1-100). 
 
De même, appuyer  sur [Ctrl] + ([1] – [9]) ou cliquer sur le bouton Load (Preset Système) et sélectionner 
Preset (1-9) depuis le menu déroulant rappellera immédiatement les paramètres enregistrés dans les presets 
1-9. Appuyer sur [Ctrl] + [0] ou sélectionner « any » depuis le menu déroulant du bouton Load ouvrira une 
fenêtre de dialogue vous permettant de rappeler n’importe quel Preset Système (1-100) par le nom ou le 
numéro. 
 
Vous pouvez accéder aux paramètres pour tous les presets enregistrés via la fenêtre de dialogue System 
Presets. Cette fenêtre de dialogue vous permet de changer le nom des presets et d’éditer les paramètres 
enregistrés. Pour accéder à la fenêtre de dialogue Presets Options, cliquez sur Presets au-dessus des 
boutons Load et Store à droite du tracé, sélectionnez Presets depuis le menu Options ou appuyez sur [Alt] 
+ [P] sur le clavier.  
 

         Lorsque vous commencez une session SmaartLive, aucun Preset Système n’est sélectionné. Lorsque vous  
         chargez un preset enregistré vous verrez son nom dans  la ligne de titre au-dessus du tracé. Après avoir  
        chargé le preset, changer l’un des paramètres qui a été chargé avec le preset – ex : changer le nombre de  
         points de moyenne en utilisant le sélecteur Avg à droite du tracé – entraîne l’apparition d’un astérisque à  
         côté du nom du preset sur la ligne de titre. L’astérisque signifie que les paramètres actuels ne correspondent  
         plus aux paramètres enregistrés sur le preset. La mise à jour (écrasement) du preset avec les paramètres  
         actuels fera disparaître l’astérisque. 
 
Configurer les Autres Options et Propriétés 
 
         La commande All du menu Options ouvre la fenêtre de dialogue Options avec le dernier onglet utilisé au  
         premier plan (tous les onglets peuvent être sélectionnés à chaque fois que la fenêtre de dialogue Options est  
         ouverte). Cette fenêtre de dialogue vous donne accès à la plupart des options et des propriétés réglables par  
         l’utilisateur de SmaartLive.     



 
La fenêtre de dialogue options est organisée en 9 pages séparées pour les différents types de paramètres. 
Nous appelons ces pages des onglets car chacune d’elle à un onglet d’index qui est toujours visible dans la 
partie supérieure de la fenêtre de dialogue. Sélectionner une des commandes du menu Options ouvrira (sauf 
pour les commandes All, External Devices, System Presets et Volume Control) la fenêtre de dialogue 
options avec la page sélectionnée au premier plan. Pour ouvrir une autre page lorsque la fenêtre de dialogue 
est ouverte, cliquez simplement sur son onglet.  
 

Liaisons vers d’Autres Programmes  
 

          
 
         SmaartLive peut être configuré pour démarrer et passer automatiquement ses fichiers de données Wave  
         (.wav) et ASCII (.txt) à d’autres programmes en utilisant sa fonction de saut. La fonction de saut est activée  
         en cliquant sur le logo SmaartLive dans le coin supérieur droit de la fenêtre SmaartLive puis en  
         sélectionnant une option configurée précédemment dans le menu déroulant. Les options de ce menu sont  
         déterminées par un fichier texte enregistré dans un sous dossier Système du dossier principal de  
         SmaartLive.     

 
Pour activer la fonction de saut, vous devez créer un fichier texte nommé rtjumps.txt dans le dossier system 
de smaartLive et créer une ou plusieurs sections de saut dans le fichier pour définir les sauts. 
L’emplacement par défaut du dossier est c:\Program Files\SIA SmaartLive\System. 
 

         Le fichier rtjumps.txt peut être créé et édité en utilisant un éditeur de texte ASCII tel que Windows   
         Notepad. SmaartLive lit rtjumps.txt lors du démarrage donc vos sauts devraient être disponibles la  
         prochaine fois que vous lancerez le programme après avoir créé ou édité un fichier. L’exemple suivant  
         d’une définition de saut rtjumps.txt ajouterait l’entrée « Excel » au menu de saut et lorsqu’il est  
         sélectionné, ouvrira Microsoft® Excel et chargera le dernier fichier texte ASCII sauvegardé par  
         SmaartLive : 

 
[Excel] 
PATH=c:\program files\office\excel\excel.exe 
ARGS= 
EXIT=N 
SMAART=N 
WAVE=N 
TEXT=Y 
 
Chaque section doit commencer par un nom de section dans des crochets qui fournit également un nom 
pour l’entrée dans le menu déroulant de SmaartLive. La ligne PATH doit fournir l’adresse complète et le 
nom du fichier cible. La ligne ARGS peut être utilisée pour passer des commandes supplémentaires à 
l’application cible si nécessaire.  
 
Les lignes restantes sont des questions à réponse affirmative ou négative qui doivent comporter un « Y » ou 
un « N » après le signe = comme suit : 
 
• Si EXIT=Y, SmaartLive s’éteindra après avoir lancé le programme cible.  
• La ligne SMAART sert à l’utilisation avec Smart Acoustic Tools 4.0 ou plus et doit être réglée sur 

« N » pour les autres applications.  
• Si WAVE=Y, SmaartLive passera le dernier fichier wave de réponse d’impulsion enregistré en mode 

Impulse à l’application cible. Cette ligne doit être réglée sur « N » si la ligne TEXT est réglée sur 
« Y ».  

• Si TEXT=Y, SmaartLive passera le dernier fichier text sauvegardé en utilisant la fonction ASCII Save 
de SmaartLive au programme cible. Cette ligne doit être réglée sur « N » si WAVE=Y.  

 
Mesure 
 
         La configuration de la mesure de fonction de transfert de SmaartLive peut être très simple ou très complexe  
         mais le principe de base est toujours le même ; comparer le signal entrant dans un appareil ou un système  



         au signal en sortant. Et étant donné que les mesures de réponse d’impulsion de SmaartLive sont également  
         basées sur la technique de la fonction de transfert, la configuration utilisée pour mesurer une réponse en  
         fréquence peut être utilisée pour mesurer un temps de délai.   

 
Le schéma ci-dessus illustre le cheminement du signal basique d’une mesure de fonction de transfert. 
Notez que le signal ne doit pas être généré depuis l’ordinateur. Une source de signal externe tel un lecteur 
de CD, un générateur de bruit peuvent être utilisés. SmaartLive reçoit deux signaux : 
• Un signal de référence, également utilisé pour stimuler le système à tester, sur l’entrée droite (canal 1) 
• Un signal de mesure, la sortie du système à tester, sur l’entrée gauche (canal 0) 

 
Mesure de Fonction de Transfert Typique  
 
         L’exemple de la page suivante illustre une configuration possible d’un système de mesure pour mesurer et  
         optimiser un système de sonorisation simple. La configuration pour un système plus complexe pourrait  
         également inclure des points de mesure à la sortie de chaque filtre/processeur, microphones  
         supplémentaires, etc.    

 
Cette configuration divise le signal de référence à l’intérieur de la console de mesure. Le signal de 
référence est envoyé à l’ordinateur depuis l’une des sorties principales de la console de mesure et vers le 
système de sonorisation sur un bus auxiliaire. Cela permet le contrôle des niveaux des signaux de référence 
et de mesure directement depuis la console de mesure.  
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         Une autre approche serait de faire revenir la sortie de la console de mixage du système de sonorisation sur  
         la console du système de mesure comme signal de référence. Cela vous permettrait également d’utiliser le  
         mix de la console comme signal de référence pour réaliser des mesures pendant un spectacle.  

 
Note : Il est souvent possible d’utiliser les entrées inutilisées et les bus auxiliaires de la console principale 
comme entrée du système de mesure – éliminant ainsi le besoin d’une console de mesure séparée.  

 
Le Délai Interne 
 

          
 
         SmaartLive peut fournir un délai interne maximum de 750 millisecondes (par pas de 1/100 milliseconde)  
         pour l’une des deux entrées. Cette fonction est principalement utilisée pour aligner les signaux de référence  
         et de mesure lors des mesures de fonction de transfert. Les propriétés du délai sont réglées depuis Delay  
         dans la fenêtre de dialogue Options, elles sont accessibles depuis le menu Options ou en cliquant sur le  
         nom au-dessus de l’affichage du Délai dans le coin inférieur droit de la fenêtre SmaartLive. L’assignation  
         du délai interne au canal d’entrée est réalisé par SmaartLive et peut uniquement être modifié depuis Delay  



         dans la fenêtre de dialogue Options. 
 
         Les boutons à droite de l’affichage du Délai ou les touches [F3] et [F4] du clavier peuvent être utilisées  
         pour augmenter ou diminuer le Temps de délai actuel par pas de 0.01 milliseconde. Vous pouvez  
         également modifier le temps du délai en entrant une valeur dans le champ Delay Time via Delay dans la  
         fenêtre de dialogue Options. La touche [F5] remet le Temps du Délai interne sur 0ms. 
 

          
 
         Le délai interne de SmaartLive est conçu pour fonctionner facilement avec l’Auto Delay Locator et le  
         mode Impulse. A chaque fois que vous utilisez l’Auto Delay Locator, vous avez l’option d’assigner le  
         temps de délai trouver au délai interne. En mode Impulse, cliquer sur le bouton Set Delay To Peak sous  
         l’affichage Delay, appuyer sur [Ctrl] + [Barre d’Espace] ou appuyer sur la touche [Shift] et cliquer sur le  
         tracé avec le bouton gauche de la souris fait apparître l’onglet Delay de la fenêtre de dialogue Options avec  
         la position du Locked Cursor entrée comme valeur actuelle de Temps du Délai. Si le Locked Cursor n’est  
         pas actif, [shift] + cliquer sur le tracé de la réponse d’impulsion ouvre les Options de délai avec la position  
         du curseur de la souris entrée comme Temps de délai pour le délai interne. 
 
         SmaartLive possède cinq presets de délai réglables par l’utilisateur que vous pouvez utiliser pour  
         enregistrer et rappeler des temps de délai pour le délai interne. Les presets de délai sont accessibles depuis  
         l’onglet Delay de la fenêtre de dialogue Options. Chaque preset de délai est également assigné à une touche  
         de fonction ([F6]-[F10]) sur votre clavier. Pour rappeler un temps de délai enregistré sur un de ces presets  
         de délai comme délai actuel en modes RTA, Fonction de Transfert ou Spectrographe appuyez simplement  
         sur la touche de fonction associée. Les presets de délai ne doivent pas être confondus avec les Presets  
         Système qui peuvent enregistrés de nombreux paramètres du programme (dont un temps de délai).                                           
  

          
 
         En mode Impulse, les presets de délai ont une fonction différente. Remarquez que les boutons pour les  
         presets de délai apparaissent sous le racé lorsque vous passez en mode impulse. Cliquez sur les boutons  
         [F6]-[F10] ou appuyer sur les touches de Fonction correspondantes sur votre clavier en mode Impulse  
         tracera une ligne verticale sur le tracé de la réponse d’impulsion pour indiquer la position temporelle de la  
         valeur de délai enregistrée associée. Cette fonction est principalement prévue pour aligner des haut- 
         parleurs. Cliquer sur le champ de l’affichage sous le bouton d’un des presets de délai ouvrira un menu  
         déroulant qui vous permet d’assigner le Locked Cursor actuel à ce preset (et d’afficher son marqueur sur le  
      tracé) ou fait apparaître les Options du Délai. 
 
         Lorsqu'un ou plusieurs boutons de Preset de délai sont activés en mode Impulse, cliquer sur le bouton  
         Compare à droite des boutons de preset ouvre une fenêtre de dialogue qui compare les temps de chacun des   
         presets et du Curseur Bloqué et calcule les différences relatives. Cette fonction est principalement conçue  
         pour l'alignement des haut-parleurs des enceintes. Toute entrée de la liste (en général celle avec le temps de  
         délai absolu le plus long) peut être sélectionnée comme "Temps 0". Tous les temps de délai relatifs sont  
         ensuite recalculés en fonction de ce point de référence.  
     
Générateur de Signal Interne  
 

          
 
         Si votre hardware son est capable de réaliser deux opérations simultanément (lecture et enregistrement)  
         vous pouvez utiliser le générateur de signal de SmaartLive pour générer un stimulus lors des mesures de  
         signaux. Le générateur de signal interne peut créer plusieurs types de signaux de stimulus internes  
         ou faire une boucle infinie d’un fichier spécifié par l’utilisateur. Cliquer n’importe où à l’intérieur de la  
         zone du Générateur de SmaartLive ouvrira une fenêtre de dialogue vous permettant d’ajuster les propriétés  
         du générateur de signal. 
          



         Les options pour les signaux internes comprennent: 
        

• Bruit rose, énergie égale par octave 
• Onde sinus avec fréquence et amplitude variable 
• Double onde sinus avec fréquence et amplitude indépendante variable 
• "Sync Pink" – bruit synchronisé avec spectre rose 
• "Sync Red" – bruit synchronisé avec spectre "rouge" 
• "Pink sweep" – sinus logarithmique synchronisé avec spectre rose 
• "Red Sweep" – sinus logarithmique synchronisé avec spectre "rouge" 
 

         Un fichier wave stéréo peut être utilisé avec l’option de bouclage d’un fichier pour générer un signal stéréo  
         de test, dans tous les autres cas le générateur de signal enverra le même signal aux sorties gauche et droite.  
         Toutefois, il est préférable de n’utiliser qu’un seul canal et diviser physiquement le signal en dehors de  
         l’ordinateur pour obtenir les signaux de référence et de mesure nécessaire aux mesures de Fonction de  
         Transfert. La raison principale est qu’il existe typiquement un petit décalage de temps entre les sorties  
         Gauche et Droite qui pourrait causer des problèmes dans les mesures de phase et de délai. De plus, si vous  
         divisiez le signal à l’intérieur de l’ordinateur, vous ne seriez jamais totalement sûr que le signal de  
         référence soit identique au signal envoyé à l’appareil ou au système à tester.           
            
Stimulus Synchronisés 
 
         Les options de stimulus synchronisés du générateur de signal de SmaartLive construisent des séuences  
         répétitives de bruit ou de signaux sinus logarithmique qui ont exactement la même durée, en échantillons,  
         que la taille FFT actuellement utilisée. Ces types de stimulus sont conçus principalement pour l'utilisation  
         lors des mesures de Fonction de Transfert et de Réponse d'Impulsion mais sont également disponibles en  
         mode Spectre. L'utilisation de stimulus suynchronisés vous permet de réaliser des mesures de réponse  
         d'impulsion/fréquence FFT avec des caractéristiques de réjection du bruit similaires aux techniques de  
         mesures MLS et TDS – sans avoir recours aux fenêtres de données et/ou aux larges quantités de moyenne  
         associées à l'utilisation de signaux de stimulus aléatoires dans les mesures FFT.  
         Il existe des types de stimulus synchronisés basiques (pseudo aléatoire ou logarithmique) et deux options  
         de pondérations spéciales pour chacune, rose ou rouge. L'option de pondération spectrale "rose" délivre un  
         signal avec une énzergie égale pour chaque octave – déclinant de 3 dB par octave par rapport à un spectre  
         "blanc". Un signal avec une pondération spectrale rose semblera avoir un spectre plat lorsqu'on le  
         visualisera sur un affichage RTA à fraction d'octave. La pondération spectrale "rouge" est identique à la  
         rose mais a une pente de déclinaison qui s'accroit avec la fréquence, épargnant ainsi vos oreilles lors  
         d'écoute prolongée tout en fournissant assez d'énergie haute  fréquence pour les mesures de fonction de  
         transfert et de réponse d'impulsion.  
  
Stimulus Utilisateur 
 
         L'option Bouclage de fichier du générateur de signal de SmaartLive vous permet de boucler en continue  
         pratiquement tout signal audio, enregistré dans un fichier wave, pour l'utiliser comme stimulus de mesure.  
 
         Lorsque vous utilisez vos propres fichiers wave pour créer des signaux test, la fréquence d’échantillonnage  
         et la résolution (bits par échantillon) du fichier wave doit correspondre aux paramètres audio actuellement  
         sélectionnés dans SmaartLive (via Inputs et Devices dans la fenêtre de dialogue Options).    
          
         Le bouclage de fichier est fait en RAM pour éviter les trous au début et à la fin du fichier. Vous pouvez,  
         toutefois, toujours entendre un « pop » au début de chaque boucle si le premier et le dernier échantillon du  
         fichier ne sont pas très proche en amplitude. Et puisque le fichier entier se trouve dans la mémoire du  
         buffer, il est conseillé d’utiliser des fichiers de petite taille avec cette fonction.                 
 
 
Le Curseur Locked 
 
         La fonction Locked Cursor de SmaartLive crée un marqueur fixe à un point sélectionné sur le tracé, vous  
         permettant de trouver la différence entre ce point et tout autre point avec un haut degré de précision.  
         Lorsque le Locked Cursor est actif, vous verrez trois ensembles de valeurs de curseur au-dessus du tracé. A  
         gauche se trouve la position du curseur bloqué, au centre la position du curseur de la souris et à droite la  



         différence entre la position des deux curseurs. 
 
         En modes RTA et de Fonction de Transfert, le Curseur Bloqué peut être configuré pour indiquer les  
         fréquences harmoniques et sous harmoniques pour une fréquence (fondamentale) sélectionnée. En mode        
         impulse, le curseur bloqué est automatiquement placé sur le point le plus haut du tracé après chaque mesure   
         pour indiquer le délai de propagation.  
 
         Vous pouvez créer un Curseur Bloqué sur la position du curseur de la souris sur tous les affichages de  
         SmaartLive sauf sur le Spectrographe en appuyant sur la touche [Ctrl] et en cliquant sur le tracé avec le  
         bouton gauche de la souris. Cela place un curseur bloqué sur le point de donnée le plus proche sur le tracé  
         supérieur, ou si aucun tracé n’est affiché, sur la position du curseur de la souris. Vous pouvez également  
         créer automatiquement un Curseur Bloqué sur le point le plus haut ou le plus bas du tracé supérieur en  
         utilisant les commandes Find peak et Find Low (voir Commandes du Locked Cursor page 86). Pour  
         annuler le curseur bloqué, appuyez sur la touche [Ctrl] et cliquez sur le bord de la zone du tracé ou appuyez  
         sur [Ctrl] + [X] sur le clavier. 
 
 
Courbes de Pondération 
 

          
 
         La plupart des applications de mesure audio professionnelles et de configuration de système nécessitent  
         l'utilisation de courbes de pondération dépendantes de la fréquence. Des exemples courants comprennent  
         les courbes de pondération ANSI/IEC "A" et "C" utilisées dans les mesures de niveau sonore et les courbes  
         de réponse du système de différents types utilisées pour des applications allant de la sonorisation  
         cinématographique aux systèmes de réduction du bruit.  
 
         SmaartLive a un support interne pour les courbes de ^pondération standards "A" et "C" dans son Affichage  
         de Niveau du Signal/SPL (et par extension, le graphique Historique SPL) et son affichage RTA et fournit  
         également un outil permettant d'ajouter des courbes de pondération définies par l'utilisateur qui peuvent  
         être utilisées en mode Spectre et Fonction de Transfert. Les courbes de pondération dépendantes de la  
         fréquence sont, dans la plupart des cas, très similaires aux courbes de Fonction de Transfert puisqu'elles  
         définissent les différences relatives au niveau de la fréquence (ex, +/- x dB, fréquence par fréquence) donc  
         SmaartLive vous permet d'utiliser des Tracés de référence FPPO 1/24 d'octave comme courbes de  
         pondération. 
        
         Cela signifie que tout ce qui peut être mesuré en utilisant l'analyseur de Fonction de Transfert en temps réel  
         de SmaartLive peut être utilisé comme courbe de pondération. Tout ce que vous avez à faire c'est le  
         capturer comme tracé de référence FPPO, sauvegarder le tracé comme Fichier de référence, et placer le  
         fichier dans le dossier Weighting dans le dossier Files de SIA SmaartLive 5. SmaartLive vérifie ce dossier  
         au démarrage donc la prochaine fois que vous lancerez le programme, votre nouvelle courbe devrait  
         apparaître dans la liste des courbes de pondération disponibles. Assurez-vous d'ajouter un commentaire (1- 
         5 caractères) au tracé avant de le sauvegarder puisque celui-ci deviendra le nom de la courbe dans la liste  
         des courbes disponibles.  
  
         Un outil d'édition des courbes est également fournit, il est accessible depuis la fenêtre de dialogue  
         Reference Trace Information pour l'utilisation avec cette fonction. Cet outil peut-être utilisé pour retoucher  
         des courbes mesurées afin de les utiliser comme courbes de pondération ou pour créer une courbe de  
         pondération idéale à partir d'un tracé plat sur n'importe quelle résolution de fraction d'octave jusqu'à 1/24  
         d'octave.  
  
Faire une Capture d’Ecran 
 
         Microsoft Windows possède une fonction interne qui vous permet de capturer la fenêtre active sous un  
         fichier bitmap. Bien que ce ne soit pas une fonction de SmaartLive en tant que telle, les écrans fournissent  
         une façon simple d’inclure les affichages de données de SmaartLive comme illustrations dans vos rapports  
         ou dans d’autres documents. 
 



         Pour faire une capture d’écran, cliquez sur la fenêtre que vous voulez capturer pour vous assurez que c’est  
         bien la fenêtre active et appuyez sur [Alt] + [Impr écran] (aussi appelée F3 sur certains claviers). Cela  
         copie une image de la fenêtre active sur le clipboard de Windows. L’image du clipboard peut coller  
 
 
         directement sur un processeur word et sur des applications de mise en page, d’autres peuvent nécessités  
         une première sauvegarde de l’image sous un fichier bitmap puis l’importation du fichier dans le document.      
          
         Pour sauvegarder l’image capturée comme un fichier bitmap en utilisant le programme Paint inclus avec  
         Windows, ouvrez le programme en cliquant sur le bouton Démarrer de la Barre de Tâche de Windows et  
         sélectionner Programmes > Accessoires > Paint. Dans le programme Paint sélectionnez Coller dans le  
         menu Edit ou appuyez sur [Ctrl] + [V] pour importer l’image depuis le clipboard. Si vous voyez un  
         message disant que l’image est trop grande et vous demandant si vous voulez élargir le bitmap, cliquez sur  
         Oui. Puis, alors que l’image est encore sélectionnée, ouvrez le menu Edition et sélectionnez Copier Vers.  
         Dans la fenêtre de dialogue Copier Vers naviguer pour trouver le dossier vers lequel vous voulez copier le  
         fichier, tapez un nom de fichier et cliquez sur le bouton Enregistrer. 
 
         Note : Tous les logiciels SIA-Smaart vous laissent configurer vos propres Couleurs pour les tracés. Cette  
         fonction peut être très utile lors d’un travail avec des captures d’écran. Par exemple, vous pouvez définir un  
         ensemble de Couleur avec un fond blanc et des tracés noirs afin d’optimiser l’impression en noir et blanc  
         d’une image capturée. Les couleurs sont accessibles depuis l’onglet Colors de la fenêtre de dialogue  
         Options. Vous voudrez peut être également utilisée la commande Quick Zoom du menu View pour enlever  
         les zones de contrôle de la fenêtre et maximiser la zone du tracé avant la capture.       
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Chapitre 3 : Applications de SmaartLive 
 
         Dans le Chapitre 2 nous avons principalement abordé ce que SmaartLive pouvait faire. La prochaine  
         question, bien sur, est qu’est-ce que vous pouvez faire avec lui ? Ce chapitre est conçu pour vous aider à  
         utiliser SmaartLive afin de réaliser des mesures de systèmes et de composants audio.   
 
         A partir e la prochaine page, vous trouverez une série d’exemple d’applications qui illustre la mise en place  
         de tests utilisant votre ordinateur et SmaartLive. Les exemples sont organisés dans un ordre de complexité  
         croissant. Les derniers exemples étant basés sur les informations présentées dans les premiers, nous vous  
         recommandons donc de lire, au moins, les premiers exemples avant de réaliser les exercices plus  
         complexes.  
          
         La deuxième partie de ce chapitre, intitulée Une approche Structurée de la Mesure et de l’Optimisation  
         d’un système de Sonorisation (commençant page 59), décrit un processus d’évaluation et d’optimisation  
         des performances d’un système de sonorisation en utilisant SmaartLive. Le but sera d’améliorer l’équilibre  
         spectral et la stabilité des systèmes de sonorisation. SmaartLive est également un outil très d’alignement du  
         système très efficace mais ce sujet ne peut pas être abordé ici. L’alignement du système est traité en détails  
         dans les classes d’entraînement de la Smaart School.  
         
         Avant de passer aux exemples d’applications, assurez-vous que le hardware son de votre ordinateur est  
         installé et fonctionne. Reportez-vous au Chapitre 6 de ce manuel et à la documentation de votre ordinateur  
         et de votre carte son en cas de problèmes. Tous les exemples suivants supposent que votre ordinateur  
         dispose de deux canaux d’entrée audio indépendants. Si votre carte n’a qu’une seule entrée mono à niveau  
         ligne (ou aucune entrée à niveau ligne) vous pourrez utiliser SmaartLive comme analyseur de spectre à un  
         canal mais les fonctions Transfer Function et Delay Locator seront désactivées.  
 
         Note Pratique : Pour obtenir les meilleurs performances de SmaartLive, les niveaux d’entrée doivent être  
         assez fort pour fournir un bon rapport signal sur bruit mais ne doivent pas faire saturer les entrées. Nous  
         vous recommandons de garder les niveaux d’entrée à environ –12dB sur les vu-mêtres d’entrée de  
         SmaartLive.  
    
       
 
              SIA Software Company, Inc. n’est pas responsable de l’endommagement de votre équipement  
              résultant d’une utilisation incorrecte de ce produit. Assurez-vous d’avoir compris et respecté  
              les niveaux d’entrée et de sortie, les impédances et les conventions de câblage appropriés pour  
              tous les composants du système avant d’essayer les mesures décrites dans ce chapitre.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Exemple d’Application 1 
 
SmaartLive en tant qu’Analyseur de Spectre en Temps Réel (RTA) 
 
         La première fonction de SmaartLive est celle d’un analyseur de spectre audio en temps réel à deux canaux  
         (RTA). L’affichage RTA est très utile pour identifier le contenu fréquentiel des signaux audio. Le mode  
         opérationnel par défaut RTA affiche un ensemble de barres de données indiquant la fréquence/magnitude  
         par octave ou fractions d’octave pour chacun des deux canaux d'entrée de la carte son. 
    
         Pour utiliser SmaartLive comme analyseur de spectre, connectez une source de signal audio à niveau ligne  
         sur l’entrée audio à niveau ligne de l’ordinateur. Par exemple, le Schéma #1 illsutre une sortie d’un lecteur  
         de CD connectée à l’entrée Droite de la carte son (canal 0) et un microphone et un préamplificateur  
         connectés à l’entrée Gauche (canal 1).  
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         Lancez SmaartLive en cliquant sur le bouton Démarrez de la Barre de Tâche de Windows et sélectionnez  
         Programmes > SmaartLive > SmaartLive. Cliquez sur le bouton Smaart On à droite du titre du tracé dans la  
         fenêtre SmaartLive pour commencer le traitement et le traçage des données provenant des entrées de la  
         carte son. Avec tous les appareils d’entrée désactivés vous verrez probablement un signal à un niveau très  
         faible représentant le bruit interne du hardware son de l’ordinateur.  
    
         Avec le microphone interne de l’ordinateur ou le signal provenant d’un microphone externe sélectionné  
         comme source d’entrée (voir Configurer les Commandes Entrée/Sortie Audio dans le Chapitre 6 pour plus  
         d’informations), notez comment l’affichage RTA répond à tous les bruits dans la portée du microphone.  
         Siffler un air donne un signal facile à identifier qui devrait donner une barre notable à la fréquence à  
         laquelle vous avez sifflé.  
  
         Le mode RTA peut être très utile pour identifier les fréquences résonnantes dans un système de  
         sonorisation et il y a un nombre infini d’autres applications possibles. Une application RTA très fréquente  
         que nous ne vous recommandons pas est de mesurer la réponse en fréquence d’un système. La fonction  
         Transfer Function de SmaartLive est un outil bien plus adapté à cette tâche. 
   
 
 
 
 
 
 
 
 
 
 
 



Exemple d’Application 2 
 
Mesurer un Egaliseur Analogique 
 
         Dans cet exemple, nous utilisons la Fonction de Transfert de SmaartLive pour mesurer la réponse en  
         fréquence d’un égaliseur. En plus de votre ordinateur et de SmaartLive, les composants suivants sont  
         nécessaires pour faire cette mesure : 
   

1. Une source de signal externe, telle qu’un lecteur de CD ou un générateur de bruit.  
2. Un égaliseur analogique (si un EQ analogique n’est pas disponible, les EQ d’une tranche de console 

analogique ou d’un autre appareil analogique qui peut affecter le contenu fréquentiel d’un signal sans 
ajouter de délai peuvent être utilisés) 

3. Des câbles et des adaptateurs pour réaliser les connections nécessaires, dont un câble Y.  
 
Connectez tous les composants comme indiqué sur le Schéma #2 ci-dessous.  

 
Configuration de la Mesure 
 
         Divisez l’un des canaux de votre lecteur de CD (droite ou gauche) en utilisant un câble Y. L’un des côtés  
         du câble Y doit être connecté pour alimenter l’entrée de l’égaliseur. La sortie de l’égaliseur est connectée à  
         l’entrée gauche de la carte son de l’ordinateur (canal 0), comme indiqué sur le Schéma #2. Ce canal sera  
         considéré comme le canal de mesure ou de test. L’autre côté du câble Y est connecté à l’entrée Droite de  
         l’ordinateur (canal 1). Celui-ci est le signal de référence car il fournit une visualisation du signal d’origine.  
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Procédure de Mesure 
 
         Lancez SmaartLive et lisez un CD avec du bruit rose ou de la musique (ou allumez votre générateur de  
         bruit). Cliquez sur le bouton Smaart On pour démarrer l’Analyseur en Temps Réel. A ce moment vous  
         devriez voir deux ensembles de barres de données de fréquence correspondant aux deux entrées de la carte  
         son. Ajustez les contrôles de niveau disponibles sur l’EQ et le lecteur de CD 
 
         Afin que les deux signaux est à peu près le même niveau en amplitude. Consultez les Vu-mêtres de Niveau  
         d’Entrée de SmaartLive pour vous assurez que les niveaux d’entrée ne saturent pas les entrées de la carte  
         son.  
 
         Note Pratique : Vous aurez peut être plus de faciliter à régler les niveaux des deux signaux en mode RTA  
         si vous utilisez l’affichage RTA narrowband plutôt que l’affichage de barre par défaut. Pour activer  
         l’affichage RTA narrowband, sélectionnez Graph dans le menu Options, cochez la case nommée Allow  
         Narrowband RTA sur l’onglet Graph de la fenêtre de dialogue Options, puis fermez la fenêtre de dialogue  
         et sélectionnez « nb » sur la commande Scale à droite du tracé.  
  
         Lorsque les niveaux des deux signaux sont identiques, cliquez sur le bouton Transfer. L’affichage de  
         SmaartLive deviendra un seul tracé indiquant la différence entre les deux signaux, c.a.d. la magnitude de la  
         réponse en fréquence de l’égaliseur en temps réel.  
  
         Par défaut, les calculs de la fonction de transfert divisent le signal de l’entrée Gauche (canal 0) par le signal  
         de l’entrée Droite (canal 1). Si vous modifiez le réglage de l’égaliseur pour ajouter une atténuation et que le  
         tracé de la fonction de transfert indique un gain (une montée sur le tracé) au niveau de la fréquence du  
         filtre, les entrées sont interverties. Vous pouvez corriger ceci de deux façons : 
 



1. Intervertissez les câbles pour modifier les canaux d’entrée au niveau de la carte son, ou 
2. Cliquez sur le bouton nommé Swap qui apparaît à droite du tracé en mode Fonction de Transfert.  
 
Puisque toutes les connections de cette configuration sont électriques, la réponse en fréquence de 
l’égaliseur devrait être facile à visualiser sur l’affichage de la Fonction de Transfert. Si tous les filtres de 
l’égaliseur sont désactivés (ou réglés sur zéro) le tracé de la Fonction de Transfert sera une ligne plate à 
0dB. Si la ligne est plate mais est décalée du zéro, il y a deux corrections possibles :  
 
• Revenez en mode RTA (cliquez sur le bouton RTA à droite du tracé) et réajustez le niveau de chaque 

entrée afin que les tracés semblent avoir la même amplitude, ou  
• Utilisez la commande dB+/- (à droite du tracé) pour déplacer le tracé de la fonction de transfert vers le 

haut ou le bas sur l’affichage afin que la ligne soit à 0dB.  
 
Vous pouvez faire l’expérience avec différents paramètres d’EQ, de fréquences d’échantillonnage, de 
tailles FFT et de types de musique ou d’autres signaux de test. Notez que la mesure diverge, c.a.d, devient 
très instable, si vous éteignez la source de signal (le lecteur de CD ou le générateur de signal) et/ou aux 
fréquences où le signal source n’a pas d’énergie. Cela est dû au fait que SmaartLive mesure toujours le 
bruit interne de la carte son de l’ordinateur et/ou des composants externes.  

 
Note : Dans l’exemple deux, il n’était pas nécessaire de compenser le délai. Le délai à travers la plupart des 
égaliseurs analogiques sera insignifiant comparé à la longueur des FFT utilisées dans les calculs de la 
fonction de transfert. Lors de la mesure de haut-parleurs (en utilisant un microphone) ou d’appareils 
numériques, le Delay Locator et le délai interne de SmaartLive doivent être utilisés pour aligner les deux 
signaux (dans le temps) avant de réaliser la mesure de fonction de transfert (voir Exemple d’Application 3).  

 
Exemple d’Application 3 
 
Mesurer un Haut-Parleur 
 
         Dans cet exemple, nous utilisons la Fonction de Transfert et le Localisateur de Délai de SmaartLive pour  
         réaliser deux mesures de la réponse en fréquence d’un haut-parleur, nous introduisons la fonction de Tracé  
         de Référence.  
         
         Ces mesures nécessitent les composants suivants : 
 

1. Une source de bruit externe, telle qu’un lecteur de CD ou un générateur de bruit 
2. Un amplificateur et un haut-parleur 
3. Un microphone de mesure avec une réponse en fréquence très plate (et un 

préamplificateur/alimentation fantôme si nécessaire) 
4. Des câbles et des adaptateurs pour faire les connections nécessaires, dont un câble Y 
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Connectez tous les composants comme indiqué sur le Schéma #3 ci-dessous. 



Configuration de la Mesure  
 
         Comme indiqué sur le Schéma #3, l’un des canaux de sortie du lecteur de CD (ou d’une autre source de  
         bruit) est divisé afin que l’une des branches du câble Y alimente l’entrée Droite de la carte son (canal 1).  
         L’autre branche alimente un amplificateur et un haut-parleur. La sortie du microphone (ou du  
         préamplificateur microphone) est connectée à l’entrée Gauche de la carte son (canal 0). Cette configuration  
         crée deux cheminements de signaux. Le chemin de signal partant du lecteur de CD et connecté directement  
         à l’ordinateur est appelé signal de référence. Le signal revenant du microphone est appelé signal de mesure.  
 
Mesure Une 
 
         Pour la première mesure, placez le microphone très près du haut-parleur – à moins de 30 cm. Ouvrez  
         SmaartLive et lisez un disque compact avec un bruit rose ou de la musique (ou allumez votre générateur de  
         bruit). 
 
         Cliquez sur le bouton Smaart On ou appuyez sur la touche [o] de votre clavier pour lancer l’analyseur de  
         SmaartLive en mode RTA. Ajustez les niveaux de sortie de la source de signal, de l’amplificateur et du  
         préamplificateur microphone pour obtenir des niveaux d’amplitude à peu près identique pour les deux  
         tracés sur l’affichage de SmaartLive. Il est important d’harmoniser les niveaux des deux tracés aussi bien  
         que possible. Assurez-vous que les niveaux des signaux ne saturent pas les entrées de la carte son – si vous  
         utilisez un bruit rose ou de la musique comme signal de test ne dépassez pas –12dB sur les vu-mêtres (à  
         cause du haut facteur de crête du signal).  
    
         Après avoir harmonisé les niveaux d’entrée, cliquez sur le bouton Tranfser pour mettre l’analyseur en  
         mode Fonction de Transfert. La réponse en fréquence du haut-parleur s’affichera en temps réel sur un tracé  
         Fréquence/magnitude.  
 
         Notez que nous n’avons pas compenser le délai de propagation entre le haut-parleur et le  
         microphone. Le microphone doit être très proche du haut-parleur pour obtenir une mesure précise ! 
 
Sauvegarder un Tracé de Référence 
 

          
 
         Les Registres de Référence de SmaartLive sont utilisés pour capturer et enregistrer des « snapshots » des  
         tracés. Les Registres de Référence sont représentés par cinq groupes de boutons, nommés A, B, C, D et E,  
         et placés sous la zone du tracé. 
 
         Cliquez sur le bouton du registre A1 (le premier bouton de registre du groupe a). Cela active le registre  
         même si le bouton était déjà enfoncé.  
  
         Cliquez sur le bouton Capt (capture) sous la zone du tracé pour échantillonner et afficher le tracé actuel.  
         Cliquez sur le bouton A pour enlever le tracé capturé de l’affichage. Le tracé de données échantillonné,  
         appelé Tracé de référence restera enregistré sur le registre jusqu’à ce que vous l’effaciez ou que vous  
         capturiez un autre tracé sur le même registre. 
  
         Pour sauvegarder de façon permanente un tracé de référence sur un fichier du disque, appelé un Fichier de  
         Référence, cliquez sur le bouton Info à droite du bouton de capture. Cela ouvre la fenêtre de dialogue  
         Reference Trace Information. Cette fenêtre de dialogue possède six pages. Cliquez sur l’onglet A dans la  
         partie supérieure de la fenêtre de dialogue pour afficher cette page au premier plan.  
   
         Sélectionnez le registre contenant le Tracé de Référence que vous venez de capturer ( en cliquant sur le  
         premier des quatre boutons de registre à gauche) et cliquez sur le bouton Save. Cela ouvre une fenêtre de  
         dialogue Enregistrer vous permettant de sélectionner un nom de fichier finissant par l’extension .ref. Les  
         Fichiers de Référence peuvent être rappelés et affichés comme tracés en sélectionnant un registre dans la  
         même fenêtre de dialogue et en appuyant sur le bouton Load. Vous pouvez également sauvegardé et  
         charger le contenu des 40 registres de référence comme fichiers de groupe de référence (.rgp) en utilisant  
         les boutons Save All et Load All sur l’onglet General de cette fenêtre de dialogue. Après avoir sauvegardé  
         le tracé de référence sur un fichier, cliquez sur le bouton OK pour quitter la fenêtre de dialogue Reference  
         Trace Information. 



   
         Notez que lorsque vous capturez un tracé de référence, le tracé enregistré est affiché initialement au  
         premier plan. La couleur du texte du champ de la commande dB+/- à droite du tracé correspond à la  
         couleur du tracé de référence et lorsque le suivi du curseur est activé, le curseur suit le tracé enregistré au  
         lieu du tracé actuel. Vous pouvez revenir à l’affichage du tracé de la fonction de transfert en cliquant sur le  
         vu-mêtre du niveau d’entrée. Maintenant cliquez sur le bouton A en-dessous du tracé pour enlever le tracé  
         enregistré de l’affichage pendant que vous faites la mesure suivante.      
 
Mesure Deux  
 
         Déplacez le microphone et placez-le à au moins deux mètres du haut-parleur. Notez que le tracé de la  
         fonction de transfert commence à diverger (devenant très instable) lorsque la distance entre le microphone  
         et le haut-parleur augmente. Cela résulte de l’augmentation du temps de délai entre les deux signaux  
         d’entrée. Les mesures de fonction de transfert nécessitent que les deux signaux d’entrée soient  
         précisément alignés (dans le temps).  
  
         L’alignement du signal pour la mesure de fonction de transfert est réalisé en appliquant un délai au signal  
         de référence – le signal provenant directement de la source de signal et connecté à l’entrée Droite. Vous  
         devrez réaliser les deux étapes suivantes : 
   

• Trouver le temps de délai nécessaire pour aligner le signal de référence avec le signal de mesure 
(microphone), en utilisant le Delay locator de SmaartLive. 

• Régler le délai interne sur le canal de l’entrée de référence en fonction de celui-ci.  
 
Cliquez sur le bouton Auto Sm sous les vu-mêtres de niveau d’entrée pour lancer le localisateur de délai 
automatique de SmaartLive en utilisant l’option de fenêtre temporelle Small. Une fois que cette opération 
est terminée, Cliquez sur le bouton Insert Delay dans la fenêtre de dialogue Delay found pour régler le délai 
interne de SmaartLive sur le temps de délai trouvé. La fenêtre de dialogue se ferme alors automatiquement 
et le temps de délai spécifié devrait apparaître dans l’affichage du délai sous les vu-mêtres d’entrée.  
 
Si le temps de délai trouvé semble beaucoup trop long, il y a des chances pour que les entrées de la carte 
son soient interverties. Pour corriger ceci, modifiez les connections des entrées de l’ordinateur puis cliquez 
sur le bouton Auto Sm pour recommencer l’opération.  
 
Pour assigner le Temps de Délai actuel à l’un des cinq presets de délai réglables par l’utilisateur, cliquez 
sur Delay au-dessus de l’affichage du délai puis cliquez sur l’un des cinq boutons nommés ([F6]-[F10]) sur 
l’onglet Delay de la fenêtre de dialogue Options. Vous serez ensuite en mesure de rappeler ce temps de 
délai en appuyant sur la touche de fonction correspondante sur votre clavier. Après avoir enregistré le 
temps de délai, cliquez sur le bouton OK pour fermer la fenêtre de dialogue Options.  
 
Avec l’Analyseur de SmaartLive en mode Fonction de Transfert, réglez le nombre de points de moyenne 
sur 16 ou plus en utilisant la commande Avg à droite du tracé pour vous aider à stabiliser le tracé de la 
fonction de transfert. Une fois que les buffers de moyenne se remplissent, le tracé devrait se stabiliser et la 
magnitude de la réponse en fréquence devrait correspondre avec ce que vous avez entendu. 
 
Maintenant cliquez sur le bouton A de la zone de référence de registre sous le tracé pour afficher le tracé de 
référence que vous avez enregistré plus tôt et comparez le tracé enregistré avec le nouveau tracé. Vous 
verrez sans doute une différence entre les deux tracés résultante de l’interaction du haut-parleur avec son 
environnement (la pièce) dans la seconde mesure. La fonction de Tracé de référence de SmaartLive est très 
pratique pour comparer différentes positions de microphone.         
 
 
 
 
 
 
 
 
 
 



Exemple d’Application 4 
 
Mesurer un Haut-Parleur et Définir un Egaliseur 
 
         Dans cet exemple, nous avons combiné les techniques utilisées dans les deux exemples précédants. Nous  
         utiliserons la Fonction de Transfert pour mesurer la réponse en fréquence du haut-parleur puis nous  
         réglerons l’égaliseur pour optimiser les performances du haut-parleur. Cette procédure nécessite les  
         composants suivants : 
  

1. Une source de signal externe, telle qu’un lecteur de CD ou un générateur de bruit rose 
2. Un amplificateur et un haut-parleur 
3. Un microphone de mesure (et un préamplificateur microphone si nécessaire) 
4. Un égaliseur paramétrique (conseillé) ou graphique (numérique ou analogique) 
5. Des câbles et des adaptateurs pour réaliser les connections nécessaires, dont un câble Y 
6. Une console stéréo (optionnelle mais vivement conseillée) 
 
Connectez les composants comme indiqué sur le Schéma #4 ci-dessous. 
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C’est à peu près la même configuration que dans l’Exemple d’Application 3 avec une console et un EQ en 
plus. La console vous permet de passer rapidement de la mesure du haut-parleur à la mesure de l’égaliseur. 
La tranche de la console utilisée pour le signal de référence (A) doit être « panée » complètement à droite. 
Les canaux des deux points des signaux de mesure (B et C) doivent être « panés » complètement à gauche.   
 
Suivez la même procédure que dans l’Exemple d’Application 3 pour mesurer la réponse en fréquence du 
haut-parleur et enregistrez le temps de délai et les résultats des mesure.  
 
Vous devrez réaliser les étapes suivantes :  
 
• Réglez les commandes de la console afin que les signaux des entrées A et C du Schéma #4 soient 

envoyés sur les canaux d’entrée 1 et 0 (Droite et Gauche) de la carte son. Assurez-vous qu’aucun 
signal provenant de la sortie de l’égaliseur (entrée B de la console sur le Schéma #4) ne soit envoyé sur 
les entrées de la carte son de l’ordinateur. Seuls les signaux des entrées A et C doivent atteindre 
l’ordinateur.  

• Utilisez le localisateur de délai automatique pour déterminer le temps de délai entre le haut-parleur et 
le microphone puis réglez le délai interne pour aligner les deux signaux d’entrée.  

• Enregistrez la valeur du temps de délai mesuré sur l’un des presets de délai ([F6]-[F10]) pour un rappel 
facile.  

• Faites une mesure de fonction de transfert de la réponse en fréquence du haut-parleur.  
• Assurez-vous que les niveaux d’entrée et que le paramètre dB+/- sont tels que le tracé de la réponse en 

fréquence de la Fonction de transfert soit positionné près du point 0dB sur l’échelle verticale du tracé 
(amplitude).  



• Capturez le tracé de référence depuis le Tracé de la Fonction de transfert actuel.  
 
Maintenant, changez les paramètres de la console afin que les entrées de l’ordinateur soient la sortie du 
lecteur de CD ou u générateur de bruit (entrée A de la console) et la sortie de l’égaliseur (entrée B de la 
console). Assurez-vous qu’aucun signal provenant du microphone n’atteint les entrées audio de 
l’ordinateur. 
 
Note Importante :  Le Delay Locator de SmaartLive nécessite une Constante temporelle FFT (fenêtre 
temporelle ) relativement large par rapport au temps de decay de l’appareil ou du système en test. Pour un 
appareil électronique ou une pièce petite ou moyenne, une fenêtre temporelle de 0.3 à 1.0 seconde sera en 
général suffisante. Une pièce plus grande nécessitera une fenêtre plus grande.    

 
Si vous utilisez un EQ analogique appuyer sur la touche [F5] de votre clavier pour remettre le délai interne 
sur 0.0ms. Etant donné qu’un égaliser analogique n’induit aucun délai (latence) significatif et que les deux 
entrées sont électriques, il ne devrait pas y avoir de délai significatif sur les signaux. Si vous utilisez un EQ 
numérique (et/ou une console numérique) utilisez le localisateur de délai automatique pour trouver et 
compenser le délai induit par les appareils.  
 
Cliquez sur le bouton Swap pour régler le calcul de la fonction de transfert afin qu’il affiche la courbe de 
réponse inverse de l’EQ par dessus le tracé de référence de la réponse du haut-parleur précédemment 
mesurée. Cela facilitera l’utilisation d’une réponse de haut-parleur/pièce enregistrée comme gabarit pour 
une courbe d’EQ.  
 
Sur le tracé inversé de la réponse de l’EQ, une atténuation sera affichée par une bosse plutôt qu’un trou. En 
faisant correspondre les fluctuations du tracé de réponse de l’EQ avec celles du tracé de réponse du 
système enregistré, vous pourrez facilement trouver et atténuer les fréquences résonnantes afin de linéariser 
la réponse du haut-parleur/pièce. En pratique, il peut être préférable de faire ceci par étapes, en faisant des 
mesures supplémentaires de la réponse du haut-parleur/pièce pour visualiser vos progrès.  
 
Note Pratique : Les augmentations sont à utiliser avec minutie lors de l’égalisation de la réponse en 
fréquence d’un système de sonorisation. Une utilisation excessive des augmentations peut introduire un 
décalage de phase et une distorsion et peut avoir une influence déstabilisante sur le système. 
Alternativement, pensez à modifier les paramètres de l’amplificateur et/ou des filtres, si possible, pour 
remonter les trous puis utilisez l’atténuation pour linéariser la réponse globale du système. De plus, nous 
vous recommandons vivement d’utiliser des égaliseurs paramétriques pour ce type d’application, afin 
d’avoir accès au paramètre de largeur de bande pour chaque filtre. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Une Approche Structurée de la Mesure et de l’Optimisation d’un Système 
de Sonorisation 
   
         Avant de faire les mesures d’un système de sonorisation, il est essentiel de vous demander, « Qu’est-ce que  
         j’essaye de mesurer et pourquoi ? » La performance d’un système de sonorisation est déterminée de  
         nombreuses façons, qualitatives et quantitatives. Voici une liste des questions les plus importantes lors de  
         l’évaluation de la performance d’un système. 
  

• Réponse en Fréquence : Est-ce que le système a la capacité de délivrer le son sur la gamme de 
fréquence désirée, avec les variations attendues ? 

• Puissance Supportée : Est-ce que le système peut supporter la puissance désirée sans problèmes ou 
distorsion ?  

• Couverture : Est-ce que le système fournit une couverture suffisante pour les zones nécessaires à 
toutes les fréquences ? 

• Qualité Subjective : C’est toujours le critère le plus important. Est-ce que le système satisfait les 
attentes de qualité sonore du public/patron/artistes/opérateurs ? 

• Stabilité : Est-ce que le système larsen lorsque les microphones sont ouverts et que le gain est réglé sur 
un niveau utile ?  

• Bruit : Est-ce que le système est bruyant ? Est-ce que des bruits non désirés (buzz, ect.) sont présents 
dans le système ?  

• Configuration : Comprenez-vous la configuration du système ? Certains systèmes de sonorisation ont 
des groupes d’enceintes alimentés par une seule source. D’autres sont divisés en plusieurs sections, 
chacune contrôlée par différents circuits de commande (tels que des égaliseurs, des délais, des filtres 
etc.) 

• Est-ce que tous les composants du système fonctionnent ? 
 
Aucun hardware ou software ne peut répondre précisément tout seul à toutes ces questions. Régler un 
système de sonorisation nécessite une compréhension du matériel, une oreille affûtée, des mesures précises 
et une approche disciplinée et systématique.  
 
Nous doutons que deux techniciens réglant un système de sonorisation approchent le problème de la même 
façon. De plus, le procédé diffère, en fonction de la complexité du système et de sa nature (installation 
existante, système de tournée, ou nouveau système installé).  

 
Il y a, toutefois, plusieurs étapes que nous pensons indispensables à une mesure et une optimisation d’un 
système de sonorisation réussie. L’ordre dans lequel elles seront suivies peut différer en fonction des 
préférences de l’opérateur et de la tâche à accomplir. La procédure décrite ici est basée sur notre propre 
expérience et suppose que le système est déjà installé.  

 
Etape 1 : Ecoute d’Evaluation 
 
         Avant de commencer à mesurer un système de sonorisation, nous vous recommandons vivement de  
         l’écouter ! Vous devriez essayer de répondre qualitativement à toutes les questions de la page 59. Vous  
         devrez pour ce faire vous déplacez et écoutez chaque section et sous section du système. Explorez les  
         bordures de la couverture pour voir où les différents éléments couvrent ou non. Il peut également être utile  
         de désactiver certaines parties du système afin de faire une évaluation plus détaillée des sous systèmes et  
         des composants. 
 
Note Pratique : A moins que vous n’ayez conçu le système, prenez du temps pour essayer et comprendre ce que 
le concepteur du système avait à l’esprit et comment les différents éléments sont liés aux autres.  
 
Etape 2 : Identifier les Problèmes Potentiels  
 
         En vous référant à la liste des questions de la page 59, est-ce qu’un problème particulier à besoin d’être  
         résolu ? Par exemple, un bruit néfaste, tel qu’un buzz associé à une boucle de masse et à une alimentation  
         « sale », peut dégrader la performance du système et doit être traité avant que les tests de SmaartLive  
         commence. Les connexions doivent être sûres. Une structure du gain générant un sifflement sur le système  
         doit être corrigée. 
 



Note Pratique : Le système doit opérer correctement avant de faire des mesures. Les systèmes qui semblent 
changer de gain ou qui induisent des bruits aléatoires ne sont pas de bons candidats pour une optimisation. 
Prenez le temps nécessaire pour arranger ces problèmes.    
 
Etape 3 : Sélectionner les Points de Mesure et les Positions 
 
         C’est l’un des points les plus importants du processus. Vous devez sélectionner des points de mesure qui  
         vous indiqueront ce que vous avez besoin de voir. Il y a deux types de points de mesure, électrique et  
         acoustique. 
 
         Les points de mesure électrique sont utilisés pour mesurer l’entrée et/ou la sortie d’un seul appareil ou  
         d’une seule série d’appareils. Si vous voulez mesurer un appareil, ou le résultat d’une série d’appareil,  
         faites les connexions au niveau de l’entrée du premier appareil de la chaîne et de la sortie du dernier.  
   
         Les mesures acoustiques sont faites avec un microphone. Lorsque vous faites une mesure de fonction de  
         transfert avec un microphone, un signal de référence est également nécessaire. La connexion du signal de  
         référence doit se trouver au niveau de l’entrée de l’amplificateur du système d’enceintes, du processeur si  
         c’est un système traité, ou de l’égaliseur du système.  
 
Note Pratique : Les réflexions des surfaces larges (et parfois pas si larges) génèrent un filtrage en peigne dans le 
signal de mesure. Le résultat est un ensemble de trous dans la réponse en fréquence qui sont espacés de façon 
égale en fréquence. Ils sont faciles à voir sur les tracés de Fonction de Transfert et RTA puisqu’ils apparaîtront 
comme des creux à intervalle équivalent.  
 
         La sélection et la position du microphone sont très importantes. Le microphone doit être connu. Pour la  
         plupart des applications, nous vous recommandons le microphone à condensateur omnidirectionnel de la  
         plus haute qualité et avec la réponse en fréquence la plus plate que vous pourrez acquérir.  
    
         Lorsque vous sélectionnez la positon du microphone, posez-vous deux questions : « Est-ce un endroit utile  
         pour faire une mesure ? » et « Est-ce que d’autres choses, que le microphone captera depuis cet endroit,  
         pourront affecter la mesure ? » Les réflexions sur les côtés et à l’arrière d’un microphone de mesure  
         peuvent sérieusement réduire la précision d’une mesure. Pensez « miroir », et regardez autour de vous à la  
         recherche de surfaces qui pourraient vous surprendre tels que des murs et des sols durs. Placer un  
         microphone trop près d’une surface réfléchissante (ou trop loin) engendrera des réflexions courtes qui  
         induiront un filtrage en peigne.  
 
         Note : Si vous ne pouvez pas éviter un rebond sur le sol, essayez de placer le microphone sur le sol. Cela  
         réduira le temps de la réflexion et le filtrage en peigne sera au-dessus de la fréquence audible.  
   
Etape 4 : Comparer les Positions 
 
         Lors de la réalisation de mesures acoustiques pour un système, il est important de faire plusieurs mesures  
         depuis différentes positions pour s’assurer que vous n’êtes pas tromper par un facteur externe au niveau de  
         la mesure à un endroit donné tel qu’une réflexion). Déplacez le microphone et regardez ce qui se passe au  
         niveau de la réponse en fréquence mesurée pour chaque positions différentes.  
    
 
Etape 5 : Définir des Egaliseurs et des Délais 
 
         Le réglage des égaliseurs et des délais peut prendre beaucoup de temps. Il y a en général deux étapes  
         distinctes dans ce processus ; un réglage approximatif et une finition. Dans la première étape, de gros  
         ajustements sont faits au niveau des EQ et des délais pour régler grossièrement un système. Parfois,  
         l’importance de ces ajustements peut surprendre, mais si cela sonne bien, vous êtes probablement dans le  
         vrai. 
 
         L’étape suivante commence lorsque le système devient presque bon. A ce moment, des modifications de  
         quelques dB peuvent faire la différence entre un bon système et un superbe système. Apprenez à  
         reconnaître cette nuance. 
 
         Après avoir modifier plusieurs paramètres d’égalisation, il est important d’écouter si la direction dans  



         laquelle vous allez fait progresser le système. L’aspect de l’analyseur ne reflète pas toujours la vérité.  
         Souvenez-vous, vous travaillez avec vos oreilles, pas avec vos instruments de mesure.    
  
         Notes Importantes : 
 

• Faites toujours les ajustements sur le délai avant de régler précisément les paramètres d’égalisation. La 
combinaison d’un petit délai et de modifications d’égalisation peut complètement changer le caractère 
du délai.  

• Régler les délais et les égaliseurs peut aider certains systèmes de sonorisation mal conçus à sonner 
mieux. Toutefois, il est très rare de pouvoir modifier une mauvaise couverture des haut-parleurs avec 
ces appareils. 

 
Etape 6 : Ecoute Critique 
 
         Voilà l’essentiel, donc enlevez votre casquette de mathématicien et ouvrez vos oreilles. Mettez un CD (ou  
         un programme de source) et explorez le système. Ecoutez dans toute la pièce. Essayez le à bas niveau.  
         Essayez-le à haut niveau. Coupez la source et écoutez le silence. Assurez-vous que le bruit de fond est  
         assez bas pour ne pas affecter la gamme de dynamique du système.  
    
         Utilisez un matériel qui vous est familier. N’ayez pas peur d’écouter des chose qui peuvent ne pas être      
         appréciées des autres. Pour évaluer un système, le meilleur choix peut être quelque chose que vous avez  
         entendu si souvent que vous ne l’aimez plus. Vous ne pourrez utiliser un programme comme base pour  
         évaluer rapidement et précisément un système que lorsque vous serez très familier avec celui-ci. 
     
 
Etape 7 : Test de Stabilité 
 
         Il est très important d’explorer la stabilité d’un système utilisant un ou plusieurs microphones avant de  
         l’utiliser. Dans le cas contraire, quelqu’un pourrait se trouver dans la position très inconfortable d’essayer  
         de trouver et d’égaliser des fréquences de larsen pendant un spectacle ou un autre événement.  
 
         Les systèmes de sonorisation instables sont des systèmes qui ont un gain global, cheminement acoustique  
         compris, supérieur à un – en d’autres mots un larsen – à une ou plusieurs fréquences.  
 
         Il s’en suit qu’un système stable est un système qui a une marge confortable de gain avant le larsen (GBF)  
         à son niveau opérationnel standard tout en délivrant une intelligibilité et des caractéristiques de réponse en  
         fréquence nécessaires à sa tâche.      
 
Note Importante : Le larsen peut endommager les composants audio. Prenez des précautions lorsque vous testez 
la stabilité du système. Le larsen est particulièrement dangereux lorsqu’il monte très rapidement et qu’il sature 
le système. Il peut s’avérer prudent d’utiliser un limiteur ou un compresseur pendant les tests de stabilité pour 
protéger les composants du système. Souvenez-vous toutefois que les appareils non linéaires tels que les 
limiteurs ne doivent pas être utilisés lors des mesures de fonction de transfert. 
 
         Causes Typiques de l’Instabilité 
   
         L’instabilité, ou le larsen, est souvent le résultat d’une interaction entre la réponse hors axe d’un système  
         d’enceintes et la réponse hors axe des microphones. Les plus gros problèmes apparaissent lorsque les crêtes  
         étroites des réponses hors axe du haut-parleur et du microphone coïncident. Ces types d’interactions  
         peuvent poser de gros problèmes, puisqu’elles ne sont pas aussi faciles à contrôler que les réponses dans  
         l’axe.  
 
         D’autres causes possibles à ces problèmes de stabilité incluent les caractéristiques acoustiques de la pièce  
         et le matériel de traitement du signal – en particulier les unités de réverbération utilisés dans les systèmes  
         pour des applications musicales.  
  
         Détecter l’Instabilité 
 
         La façon la plus simple pour mettre en avant un problème de stabilité sur un système de sonorisation est de  
         monter le gain, doucement et avec précautions, jusqu’à ce que le système larsen. Ce n’est pas une  



         approche très élégante, mais cela fonctionne presque toujours. S’il n’y a pas de larsen avant que le gain soit  
         augmenté bien au-dessus du niveau opérationnel prévu et que le système ne comporte aucun scintillement à  
         des niveaux normaux, il est stable. Sinon, vous devrez trouver un moyen pour améliorer sa stabilité. En  
         fonction de la situation, la meilleure solution peut être électronique, mécanique, acoustique, éducative ou  
         une combinaison des quatre.  
      
         Quelques Approches pour Stabiliser un Système de Sonorisation 
 
         Stabiliser un système instable, ou donner plus de marge (GBF) implique tout d’abord de réduire le gain du  
         système aux fréquences problématiques. En fonction de la nature du problème, la solution la plus évidente              
         est l’égalisation. Bien que l’égalisation ne soit pas une solution miracle pouvant remplacer un système bien  
         conçu, c’est l’un des outils les plus puissants que vous pouvez utiliser pour stabiliser un système de   
         sonorisation existant.  
 
         SmaartLive peut vous aider à identifier les fréquences problématiques et à appliquer une égalisation avec  
         une grande précision. Mais avant de tourner les potentiomètres, considérez que l’égalisation affecte la  
         réponse en fréquence globale de votre système. Il y a d’autres stratégies qui peuvent être aussi efficaces –  
         ou plus efficaces  -- et qui peuvent vous donner plus de liberté pour optimiser le système de sonorisation.  
    
         Solutions Mécaniques et Acoustiques  
 
         La position des microphones par rapport aux haut-parleurs peut dramatiquement affecter la fréquence de  
         larsen (ou les fréquences). Réduire le gain à une fréquence problématique peut parfois être aussi simple que  
         d’utiliser un autre microphone, ou en réorienter un déjà utilisé (une stratégie qui fonctionne mieux avec des  
         microphones stationnaires). Déplacer ou réorienter les haut-parleurs peut également être une solution.  
  
         Les problèmes de stabilité apparaissent souvent lorsque les haut-parleurs sont placés trop près (ou derrière)  
         les microphones. Dans ce cas, il peut être possible d’ajouter un matériau absorbant ou un déflecteur qui  
         réduit le champ de l’enceinte au niveau du microphone ou simplement de réduire les niveaux opérationnels  
         des haut-parleurs en question. Ce genre de solutions sont bien sur plus attirantes lorsqu’elles peuvent être  
         appliquées sans abandonner les buts du système de sonorisation.  
 
Note Pratique : Les microphones en mouvement sont des cibles mouvantes. Lorsque les orateurs ou les artistes 
se déplacent avec les microphones, les fréquences de larsen peuvent changer. Essayez toujours de réaliser les 
tests de stabilité en fonction de l’utilisation du système de sonorisation.  
  
         Solutions Educatives  
 
         Un système d’ordinaire stable peut perdre sa stabilité lorsque plusieurs microphones sont ouverts  
         simultanément. Dans ce cas, la meilleure solution peut être d’entraîner l’opérateur à ouvrir les microphones  
         uniquement lorsqu’ils sont utilisés.     
 
         Eduquer les utilisateurs du système en ce qui concerne l’utilisation des microphones peut également être  
         bénéfique. Beaucoup de gens ont tendance à tenir le microphone ou à se tenir trop près lorsqu’ils  
         parlent. 
 
         Ces deux actions peuvent créer des problèmes. Tenir un microphone cardioïde peut augmenter son gain  
         physique à certaines fréquences lorsque la main de l’utilisateur ferme les ports arrières du microphone,  
         rendant un système stable soudainement instable. De plus, lorsque les gens se tienne trop près du  
         microphone, ils peuvent réfléchir dans le microphone de l’énergie à des fréquences problématiques,  
         entraînant alors un larsen.  
   
         Solutions Electroniques  
 
         Certaines unités de réverbération électroniques peuvent déstabilisées un système. Si cela semble être le cas,  
         essayer d’autres paramètres et/ou de réduire le niveau global de la réverbération électronique. Gardez à  
         l’esprit que les générateurs de réverbération font ce qu’ils font en récupérant une partie de la sortie du  
         système via des délais jusqu’à l’entrée.  
   
         Avec un système assez simple, les changements de polarité ou de phase peuvent également résoudre  



         immédiatement le problème. Lorsque la polarité est inversée, au lieu d’un retour positif (que nous n’aimons  
         pas) nous devrions obtenir un retour négatif (qui peut être bénéfique). Toutefois, sur de gros systèmes  
         complexes avec plusieurs réseaux de retour très long, les modifications de phase ou de polarité tenderont  
         plutôt à décaler la fréquence du larsen, sans améliorer la stabilité.  
       
         Sans doute la solution la plus fréquente au larsen est l’utilisation de l’égalisation pour éliminer les crêtes  
         gênantes. Par crêtes, nous voulons dire les endroits dans le spectre où le gain est beaucoup plus important  
         qu’ailleurs. La procédure nécessite de mettre précautionneusement le système en larsen, d’identifier les  
         fréquences problématiques et de régler les filtres pour réduire le gain à ces fréquences. Nous vous  
         recommandons vivement l’utilisation d’EQ paramétriques pour ce type d’application.     
    
         Régler des égaliseurs est une tâche pour laquelle SmaartLive excelle. Pour commencer la procédure, vous  
         devez faire entrer un signal dans les entrées de la carte son de l’ordinateur. Vous pouvez utiliser un  
         microphone ou simplement connecter un point du cheminement du signal du système de sonorisation.  
         Connecter de chaque côté de l’égaliseur, comme indiqué sur le schéma #5 fonctionne très bien et vous  
         permet également de mesurer l’EQ sans avoir à modifier les signaux d’entrée de l’ordinateur. 
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Input 1
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         Lorsque vous avez réaliser les connections, démarrez SmaartLive en mode RTA, définissez un nombre de  
         points de moyenne bas et excitez le système de sonorisation à un niveau bas avec du bruit rose. Maintenant  
         montez doucement et avec précautions le gain d’un microphone ouvert jusqu’à ce que vous voyiez les  
         crêtes augmentées sur l’affichage RTA. A ce moment, le système commencera en général a sonné  
         « trouble » puisque le bruit rose essaiera d’exciter le larsen à plusieurs fréquences en même temps.  
   
         Cliquez sur le bouton correspondant à l’un des Registres de Référence de SmaartLive pour l’activer puis  
         AVEC PRECAUTIONS et très doucement, augmentez le gain du canal d’entrée du microphone jusqu’à ce  
         que le système soit en larsen. Regardez le tracé RTA sur l’écran de l’ordinateur et vous devriez voir un  
         grand pic indiquant la fréquence de larsen. Appuyer sur la [Barre d’Espace] pour enregistrer une copie du  
         tracé dans le Registre de Référence sélectionné. Après avoir enregistré le Tracé de Référence, réduisez le  
         gain du système de sonorisation à un niveau confortable (où il n’y a pas de larsen), mais ne le baissez pas  
         complètement. Placez le curseur de la souris sur la crête du larsen sur le tracé de SmaartLive et notez la  
         fréquence dans l’affichage au-dessus du tracé.  
    
         La prochaine étape est de passer en mode Fonction de Transfert pour mesurer la réponse de l’égaliseur. Le  
         but est de régler une atténuation centrée sur la fréquence du larsen pour réduire les résonances causes du  
         larsen. Pour rendre la forme du filtre facile à visualiser, réglez une largeur de bande étroite avec une  
         atténuation de 6 à 10dB. 
   
         Ajustez la fréquence centrale du filtre afin qu’elle corresponde exactement à la fréquence du larsen notée  
         précédemment. Lorsque vous avez réglé la fréquence centrale, élargissez la largeur de bande à environ un  
         tiers d’octave, et réduisez l’atténuation sur environ –3dB. Utiliser des filtres larges et légers permet de  
         contrôler les distorsions de phase et laisse une marge au cas où la fréquence de larsen glisserait. Lorsque  
         vous réglez un filtre avec une largeur de bande très étroite, la fréquence du larsen peut s’en échapper si les  
         conditions changent.  
 
         Pour déterminer l’efficacité d’un filtre, cliquez sur le bouton RTA ou appuyez sur [R] sur votre clavier  
         pour revenir au mode RTA de SmaartLive. Remontez le gain du système avec le même microphone ouvert  
         jusqu’à ce qu’il y ait à nouveau un larsen. Regardez la fréquence du larsen. Si c’est la même ou presque,  
         atténuez encore un peu plus le filtre que vous venez de régler. Si le larsen a lieu à une autre fréquence,  



         réglez un autre filtre pour celle-ci. Comme vous pouvez le voir, la procédure est simple et beaucoup plus  
         simple qu’à l’oreille. Et identifier chaque fréquence problématique précisément facilitera le réglage des  
         filtres. 
 
         Peut-on Trop Egaliser ?  
 
         Lorsque vous égalisez un système pour augmenter la stabilité, souvenez-vous que vous réduisez le gain –  
         même si vous le réduisez uniquement à des fréquences spécifiques. Dans de nombreux cas, les fréquences  
         en question ont trop de gain de toute façon donc vous pouvez réellement améliorer la réponse en fréquence  
         du système tout en augmentant la stabilité. Il existe, toutefois, réellement une chose telle que trop  
         d’égalisation.        
    
         En règle générale, l’égalisation a tendance à être plus efficace pour améliorer la stabilité d’un système  
         lorsque les fréquences de larsen sont très proches les unes des autres. Lorsqu’il y a de nombreuses  
         fréquences de larsen réparties sur une gamme de fréquence très large, il peut être nécessaire d’explorer  
         d’autres solutions. Lorsque vous appliquez de nombreuses atténuations sur des fréquences très largement  
         espacées, vous ne faites que réduire le gain global du système sans améliorer réellement la stabilité ou la  
         GBF. Dans des cas extrêmes, il peut être nécessaire de modifier la conception du système afin de corriger  
         l’instabilité. 
 
Etape 8 : Nouvelle Ecoute Critique 
 
         Une fois que le système est stabilisé aux niveaux opérationnels, si la balance spectrale et temporelle vous  
         convient et que vous (et tous ceux qui sont concernés) êtes satisfait de ces performances, c’est fini. Vous  
         aurez certainement à répétez certaines des Etapes 2 à 7 pour obtenir la meilleure performance possible.  
         Optimiser un système de sonorisation est en général en processus graduel (qui prend souvent plus de temps  
         qu’on le penserait ou qu’on le voudrait). Nous éspèrons que SmaartLive facilitera ce processus.  
    
 
 
 
 
   
 
  
   
 
        
     

 
 
         

          
 
 
 
 
 
 
 
 
  
 
 
      

 
   
 
 



Chapitre 4 :Commandes de SmaartLive 
 
Commandes du Menu File 
 
Configuration  
 
Load 
 
         Menu File > Configuration > Load 
 
         La commande Load ouvre la fenêtre de dialogue Load Configuration, vous permettant de charger une  
         configuration de programme précédemment sauvegardée. Dans cette fenêtre de dialogue, sélectionnez le  
         nom de la Configuration que vous désirez charger et cliquez sur le bouton OK. La configuration que vous  
         avez sélectionné devient active et son nom est affiché dans la barre de titre de SmaartLive. 
 

Save 
 
         Menu File > Configuration > Save  
 
         La commande Save remplace les paramètres de la configuration actuellement enregistrée par les paramètres  
         actuellement en utilisation. SmaartLive sauvegarde également les paramètres actuels sur le configuration          
         active à chaque fois que vous quittez le programme normalement. 
 

Save As 
 
         Menu File > Configuration > Save As 
 
         La commande Save As ouvre la fenêtre de dialogue Save Configuration As, vous permettant de créer une  
         nouvelle configuration pour SmaartLive. Dans cette fenêtre de dialogue, vous n’aurez qu’à entrer un nom  
         pour la nouvelle configuration puis à cliquer sur OK. La nouvelle configuration que vous avez créé devient  
         active et son nom est affiché sur la barre de titre de SmaartLive. 
  
         Note : Vous devez régler tous les paramètres que vous voulez enregistrer tel que les options d’entrée, les  
         échelles de zoom, etc avant de sélectionner la commande Save As. 
 

Delete 
 
         Menu File > Configuration > Delete  
 
         La commande Delete ouvre la fenêtre de dialogue Delete Configuration, vous permettant d’effacer une  
         configuration précédemment sauvegardée. Dans la fenêtre de dialogue, sélectionnez le nom de la  
         configuration que vous vouloez effacer puis cliquez sur le bouton Delete. Lorsque vous avez fini, cliquez  
         sur le bouton Close pour fermer la fenêtre de dialogue.  
   
 
 
 
 
 
 
 
 
 
 
 
 



 
 

Export 
 
         Menu File > Configuration > Export  
 
         La commande Configuration > Export du menu File est utilisée pour extraire une copie du registre de  
         SmaartLive, depuis la bas de données du registre de Windows vers un fichier (.reg) sur le disque dur.  
         Sélectionner Export ouvre une fenêtre de dialogue Ouvrir standard vous demandant d’entrer un nom de  
         fichier et un dossier de destination pour le nouveau fichier. Le fichier .reg que vous créez inclura une copie  
         de tous les paramètres de Configuration enregistrés. Cette fonction est pratique pour les copies ou pour  
         transférer les préférences vers un nouvel ordinateur.  
  

Import  
 
         Menu File > Configuration > Import 
 
         La commande Configuration > Import du menu File ouvre une fenêtre de dialogue Ouvrir standard, vous  
         permettant d’importer un fichier de registre (.reg) pour SmaartLive précédemment sauvegardé vers la base  
         de données du registre de Windows. Importer un fichier de registre remplace le registre complet de  
         SmaartLive, y compris les paramètres de configuration enregistrés.  
 

Set All Values to Default 
 
         Menu File > Configuration > Set All Values to Default  
 
         La commande Set All Values to Dafault remet pratiquement tous les paramètres de la configuration actuelle  
         de SmaartLive sur leur valeur par défaut. Les seuls exceptions sont la sélection Color Schemes et la  
         sélection Wave In/Wave Out et MIDI In/MIDI Out qui ne sont pas affectées et doivent être réglées  
         individuellement depuis les onglets Colors et Devices de la fenêtre de dialogue Options.  
 
Open Impulse 
 
         Menu File > Open Impulse 
 
         Open Impulse est disponible en mode Impulse et vous permet d'ouvrir une mesure de réponse d'impulsion  
         précédemment enregistrée qui a été sauvegardée sur un fichier wave (.wav) standard. SmaartLive peut  
         aussi ouvrir des fichiers wave provenant d'autres sources s'ils ont été enregistrés à une fréquence  
         d'échantillonnage supportée par par le programme et que la durée du fichier se conforme à une taille FFT  
         supportée, ce qui signifie que la durée totale du fichier doit être une puissance de 2 échantillons comprise  
         entre 128 et 512k (ex: 128, 256, 512, 1k…). Tout fichier wave de réponse d'impulsion écrit par SmaartLive  
         se conformera automatiquement à ces caractéristiques et les fichiers provenant d'autres sources peuvent  
         facilement être édités afin d'obtenir une durée compatible en utilisant SIA Smaart Acoustic Tools ou la  
         plupart des éditeurs de fichier wave.  
    
         Notez que les fichiers chargés depuis le disque dur en mode impulse sont traités de la même façon qu'un  
         tracé de réponse d'impulsion enregistré par SmaartLive. L'affichage du mode Impulse est automatiquement  
         remis à jour lorsque vous modifiez la fréquences d'échantillonnage ou la taille FFT, vous enregistrez une  
         nouvelle réponse d'impulsion, ou que vous sortez du mode Impulse, vous n'avez donc pas à vous soucier de  
         fermer le fichier. 
  
Save Impulse 
 
         Menu File > Save Impulse   
 

          
 



         Les mesures de réponse d'impulsion enregistrés dans SmaartLive sont sauvegardés temporairement dans un  
         fichier wave (.wav) Windows standard. L'enregistreur d'impulsion utilise toujours le même nom de fichier  
         pour son fichier de sortie et remplace ce fichier à chaque fois que vous faîtes une nouvelle mesure. Si vous  
         voulez conserver les résultats d'une mesure de réponse d'impulsion pour en faire l'analyse avec SIA Smaart  
         Acoustic Tools (ou pour une autre raison), cliquez sur le bouton Save As qui apparaît à droite de la zone du  
         tracé en mode Impulse ou sélectionnez Save Impulse depuis le menu File. Cela ouvrira une denêtre de  
         dialogue standard Enregistrer Sous vous permettant d'écrire les données sur un nouveau fichier wave qui ne  
         sera pas remplacé par la prochaine mesure.  
  
ASCII Save 
 
         Menu File > ASCII Save 
 
         La commande ASCII Save arrête temporairement l’analyseur s’il est en marche et affiche une fenêtre de  
         dialogue spéciale Enregistrer Sous. Depuis la fenêtre de dialogue, vous pouvez sélectionner n’importe  
         quelle combinaison de tracés affichés pour une conversion en texte ASCII. Vous pouvez également entrer  
         un commentaire pour le fichier avant de sauvegarder.  
  
         Cette commande fonctionne uniquement en mode RTA et Fonction de Transfert. Si vous avez besoin de  
         convertir une réponse d’impulsion en ASCII, utilisez le module SIA-Smaart Analysis (inclus dans SIA- 
         Smaart Acoustic Tools) ou tout autre utilitaire de conversion WAV/ASCII.  
 
         Les fichiers provenant de la fonction ASCII Save de SmaartLive sont arrangés dans un format qui diffère en  
         fonction du mode opérationnel et de l’affichage sélectionnés au moment de la sauvegarde du fichier.  
 

• Les fichiers ASCII en mode RTA sont arrangés en un seul tableau. La colonne de gauche comprend les 
fréquences de chacun des points de donnée FFT, l’octave ou la fraction de bande (en fonction de 
l’affichage sélectionné au moment de la création du fichier). A droite de cette colonne se trouve une 
colonne pour chaque tracé sélectionné avec les magnitudes pour chaque fréquence.  

• Les fichiers ASCII de la Fonction de Transfert ont des tableaux séparés pour chaque tracé. Chaque 
tableau est constitué de trois colonnes ; pour la fréquence, la magnitude et la phase. Les tableaux sont 
placés les uns sur les autres dans le fichier texte ASCII.  

 
Print  
 
         Menu File > Print  
 
         Commande du clavier = [Ctrl] + [P] 
 
         La commande Print ouvre d’abord la fenêtre de dialogue Custom Print Information vous permettant de  
         donner un titre et de régler d’autres options avant l’impression. La fenêtre de dialogue Custom Print  
         Information peut être utilisée pour régler les mêmes options d’impression que l’onglet Printing de la  
         fenêtre de dialogue Options. Après avoir définit le titre et les options de page, cliquez sur le bouton OK.  
         Une fenêtre de dialogue Imprimer standard s’ouvrira vous permettant de sélectionner une imprimante et de  
         régler les options de votre imprimante avant de commencer l’impression.  
     
         Note : Si vous décochez la case « Show custom print dialog before print and print preview » de l’onglet  
         Printing de la fenêtre de dialogue Options ou la case nommée « show this dialog before print and print  
         preview » dans le fenêtre de dialogue Custom Print Information, la commande Print ignorera la fenêtre de  
         dialogue Custom Print Information et vous accéderez directement à la fenêtre de dialogue Imprimer. 
 
Print Preview 
 
         File Menu > Print Preview 
 
         La commande Print Preview ouvre d’abord la fenêtre de dialogue Custom Print Information vous  
         permettant de nommer et de régler les options de l’impression. La fenêtre de dialogue Custom Print  
         Information peut être utilisée pour régler les mêmes options d’impression que l’onglet Printing de la  
         fenêtre de dialogue Options. Lorsque vous cliquez sur le bouton OK dans la fenêtre de dialogue Custom  
         Print Information, SmaartLive passe au mode Aperçu avant Impression.  



    
         En mode Print Preview, vous verrez un aperçu de ce que vous obtiendrez après l’impression. La zone où le  
         tracé apparaîtra est indiquée par un rectangle vide. Vous pouvez utiliser le bouton Print pour commencer  
         l’impression sur l’imprimante actuellement sélectionnée et quitter immédiatement le mode Print Preview  
         ou sélectionnez Close pour revenir dans SmaartLive sans imprimer le document.  
  
         Note : Si vous décochez la case « Show custom print dialog before print and print preview » de l’onglet  
         Printing de la fenêtre de dialogue Options ou la case nommée « show this dialog before print and print  
         preview » dans le fenêtre de dialogue Custom Print Information, la commande Print Preview ignorera la  
         fenêtre de dialogue Custom Print Information et vous accéderez directement au mode Print Preview. 
 
Print Setup 
 
         Menu File > Print Setup 
 
         La commande Print Setup ouvre une fenêtre de dialogue Mise en Page standard vous permettant de  
         sélectionner une imprimante et de régler la taille de la page, l’orientation et la source du papier. En fonction  
         du type d’imprimante sélectionné, i peut y avoir des options supplémentaires auxquelles vous pourrez  
         accéder en cliquant sur le bouton Propriétés de la fenêtre Mise en Page.  
   
 
Commandes du Menu Control 
 
Smaart On 
 
         Menu Control > Smaart On  
 

          
 
         Commande du clavier = [O] 
 
         En mode RTA, Fonction de Transfert ou Spectrographe, cette commande lance l’analyseur de SmaartLive  
         et commence le tracé des données à partir des entrées de votre carte son en temps réel. La commande  
         Smaart On est un interrupteur. Cliquez à nouveau ce bouton, appuyez sur [O] ou sélectionnez à nouveau la  
         commande du menu pour arrêter l’analyseur.  
  
Pause 
 
         Menu Control > Pause  
 

          
 
         Commande du Clavier = [P] 
 
         La commande met l’analyseur en pause lorsqu’il est en marche. Tous les tracés restent visibles dans la zone  
         de tracé. Les tracés sont figés sur l’écran. Lorsque la pause est sélectionnée, la lumière indicatrice au- 
         dessus des boutons ON (Smaart On ) et Pause devient jaune pour indiquer que l ‘analyseur est en pause. La  
         commande Pause est un interrupteur. Pour relancer le processus d’acquisition des données en temps réel,  
         cliquez sur le bouton Pause, appuyer sur [P] ou sélectionnez la commande dans le menu control.  
 
Instantaneous 
 
         Menu Control > Instantaneous  
 
         En mode Fonction de Transfert et Spectre vous pouvez utiliser la moyenne pour stabiliser les tracés. La  
         moyenne rend les tendances des tracés plus facile à lire mais ralentit la réponse de l’affichage et peut  



         masquer les transitoires. En mode RTA la commande Instantaneous vous permet de passer du tracé normal  
         à la moyenne instantanément sans modifier quoi que ce soit. 
 
Generate Signal  
 
         Menu Control > Generate Signal  
 

          
 
         Commande du Clavier = [G] 
 
         La commande Generate Signal active le générateur de signal interne de SmaartLive et commence l’envoie  
         du signal vers l’appareil de sortie sélectionné au niveau spécifié par la commande du Générateur (voir  
         ci-dessus). Notez que des options supplémentaires pour le générateur de signal sont disponibles depuis la  
         fenêtre de dialogue qui apparaît lorsque vous cliquez sur Generator au-dessus du champ du niveau de      
         sortie.  
    
         La commande Generate Signal est un interrupteur. Répétez cette commande ou cliquez à nouveau sur le  
         bouton pour désactiver le générateur de signal.  
 
Reseed Averages 
 
         Menu Control > Reseed Averages  
 
         Commande du Clavier = [V] 
 
         Reseed Averages efface le contenu des buffers de moyenne (utilisés pour améliorer la stabilité des tracés).  
         Cela force SmaartLive à « alimenter » les buffers de moyenne avec des données fraiches. Le tracé aura  
         besoin d’un court instant pour se stabiliser pendant que les buffers se remplissent.  
      
         Note : Modifier le nombre de points de moyenne ou passer du mode RTA au mode Fonction de Transfert  
         remplace également le contenu des buffers de moyenne. 
 
MIDI Program Change 
 
         Menu Control > MIDI Program Change  
 
         Commande du Clavier = [Ctrl] + [M] 
 
         Cette commande ouvre une fenêtre de dialogue MIDI Program Change, vous permettant d’envoyer un  
         changement de programme (par un numéro de programme) à un appareil contrôlé par MIDI sur un canal  
         MIDI spécifié.  
 
Active Input  
 
         Menu Control > Active Input  
 
         Gauche (0) – Commande du Clavier = [Shift] + [0] 
         Droit (1) – Commande du Clavier = [Shift] + [1] 
 
         Bien que SmaartLive analyse les données des entrées audio gauche et droite simultanément, il y a plusieurs  
         fonctions du programme qui ne fonctionne que sur une des deux entrées à un moment donné. Lorsque  
         l’analyseur de SmaartLive est en mode RTA, par exemple, le tracé du spectre de l’entrée active est celui  
         qui est échantillonné lorsque vous faites une capture du Tracé de Référence. L’Affichage du Niveau du  
         Signal/SPL au-dessus des vu-mêtres suit l’entrée active dans tous les modes. En mode Spectrographe,  
         SmaartLive ne peut afficher qu’un seul spectre simultanément, le concept de l’entrée active s’applique  
         donc également ici. 



 
 
                   
 
         Les commandes Active Input du menu Control peuvent être utilisées pour sélectionner si l’entrée Gauche  
         (canal 0) ou l’entrée Droite (canal 1) est active. L’entrée active peut également être sélectionnée en  
         cliquant sur le vu-mêtre d’entrée du canal que vous voulez activer. L’entrée actuellement active est  
         indiquée par un point (.) dans la section Active Input du menu Control et par l’indication Active sous les  
         vu-mêtres de niveau d’entrée. 
 
         Lorsque plusieurs tracés sont affichés, sélectionner l’entrée active place le tracé correspondant au premier  
         plan que l’entrée ait été précédemment active ou non. Cela fonctionne également pour le mode Fonction de  
         Transfert où cliquer sur l’un des vu-mêtres place le tracé de fonction de transfert au premier plan (en plus  
         de sélectionner l’entrée active). 
 
         Le tracé au premier plan sur l’axe z est la cible de toutes les opérations Locked Cursor et de l’opération  
         Track Nearest Data Point. Le tracé supérieur est également la cible de la commande dB+/- à droite de la  
         zone de tracé, utilisée pour ajuster la position verticale des tracés RTA et de Fonction de Transfert. Notez  
         que la couleur du texte sur la commande dB+/- change en fonction de la couleur du tracé supérieur. 
    
Commandes Reference  
 
Show 
 
         Menu Control > Reference > Show 
 
         

 
 
         Commande du Clavier = [A], [B], [C], [D] ou [E] 
 
         Les commandes Show (A, B, C, D ou E) sont utilisées pour « activer » le registre de Référence sélectionnée  
         dans la Banque de référence correspondante – en faisant la cible des commandes Capture et Erase  
         Reference Trace. Si le registre sélectionné contient déjà un tracé de référence, cette commande est  
         également un interrupteur pour l’affichage de ce tracé.  
       

Select and Capture  
 
         Menu Control > Reference > Select and Capture 
 
         Commande du Clavier = [Ctrl] + ([A], [B], [C], [D] ou [E]) 
 
         Les commandes Select and Capture capturent un nouveau tracé de référence dans le Registre de Référence  
         sélectionné de la Banque de Référence correspondante en une étape – en fait, combinant les commandes  
         Show et Capture. 
 

Select Next and Capture  
 
         Menu Control > Reference > Select Next and Capture  
 
         Commande du Clavier = [Ctrl] + [Shift] + ([A], [B], [C], [D] ou [E]) 
 
         Les commandes Select Next and Capture capturent un nouveau tracé de référence dans le registre suivant le  
         Registre de Référence actuellement sélectionné (de gauche à droite) dans la Banque de Référence  
         correspondante en une étape – en fait, combinant les commandes Move to Next Register et Capture. 
       



Move to Next Register  
 
         Menu Control > Reference > Move to Next Register  
 
         Commande du Clavier = [shift] + ([A], [B], [C], [D] ou [E]) 
 
         Les commandes Move to Next Register sélectionnent le registre suivant le Registre de Référence  
         actuellement sélectionné (de gauche à droite) dans la Banque de Référence correspondante.  
 

Capture  
 
         Menu Control > Reference > Capture  
 

          
 
         Commande du Clavier = [Barre d’Espace] 
 
         La commande Capture de la section Reference du menu Control enregistre un « snapshot » du tracé actif  
         dans le Registre de Référence actuellement sélectionné. Les tracés de référence enregistrés dans le registre  
         peuvent être sauvegardés comme fichiers de référence (.ref) et rappelés à tout moment en utilisant la  
         commande Show.  
   
         Note : Cette commande est désactivée si aucun Registre de référence n’est sélectionné.  
 

Flip Reference Trace 
 
         Menu Control > Reference > Flip Reference Trace 
 

          
 
         La commande Flip Reference Trace est uniquement active en mode Fonction de Transfert et est identique à  
         la commande Swap Transfer Function Inputs pour le tracé. Cela inverse  le tracé de référence actif, en  
         transposant les valeurs négatives en positives et les valeurs positives en négatives. La commande Flip  
         Reference Trace est un interrupteur. Sélectionnez à nouveau cette commande pour faire revenir le Tracé de  
         référence sélectionné dans son état normal.  
 

Erase Reference Trace 
 
         Menu Control > Reference > Erase Reference Trace 
 

          
 
         Commande du Clavier = [Ctrl] + [Del] 
 
         La commande Erase Reference Trace nettoie le Registre de Référence actif. Cette commande ne peut pas  
         être annulée. Un Tracé de Référence non sauvegardé sur un fichier avant l’utilisation de la  
         commande Erase Reference Trace sera perdu à jamais.  
 

Use E as an Averaging Register  
 
         Menu Control > Reference > Use E as an Averaging Register 
 

          
 



         La commande Use E as an Averaging Register active Les Registres de Référence du groupe E en « mode  
         de moyenne ». Lorsque cette fonction est sélectionné, capturer sur un registre E n’échantillonne pas  
         depuis le tracé. En fait, tous les tracés de référence affichés depuis les banques A, B, C, et D sont ajoutés  
         afin de calculer une moyenne dont les résultats sont enregistrés et affichés sur un seul Tracé de Référence. 
  
         La commande Use E as an Averaging Register est un interrupteur. Répétez cette commande ou cliquez  
         à nouveau sur le bouton pour remettre les registres en mode de capture traditionnel.  
  

Hide All Reference Traces 
 
         Control Menu > Reference > Hide All Reference Traces 
 

          
 
         La commande Hide All Reference Traces enlève temporairement tous les tracés de référence affichés de  
         l’écran sans modifier les sélections du registre de référence. Hide All Reference Traces est un interrupteur.  
         Répétez la commande ou cliquez à nouveau sur le bouton pour afficher les Tracés de Référence cachés.  
    

Erase All Reference Traces 
 
         Menu Control > Reference > Erase All Reference Traces 
 
         Commande du Clavier = [Ctrl] + [shift] + [Delete] 
 
         La commande Erase all Reference Traces efface le contenu de tous les Registres de Référence de  
         SmaartLive – pour les modes RTA et Fonction de Transfert. Cette action ne peut pas être annulée. Les  
         tracés de référence non sauvegardés sur des fichiers avant l’utilisation de la commande Erase All  
         Reference Traces seront perdus à jamais.  
 

Show Reference Information  
 
         Menu Control > Reference > Show Reference Information  
 

          
 
         Commande du Clavier = [Ctrl] + [R] 
 
         La commande Show Reference Information ouvre la fenêtre de dialogue Reference Information. Cette  
         fenêtre de dialogue possède 6 onglets ; un onglet General et un onglet pour chacune des cinq Banques de  
         Registre de référence (A, B, C, D et E). 
 
         Onglet General  
 
         Sur l’onglet General vous pouvez éditer les commentaires et ajuster la position verticale de chacun des  
         Tracés de référence enregistrés. Cliquez sur les boutons de la marge gauche pour voir les commentaires et  
         le décalage vertical des différents registre dans chaque groupe. 
 
         Fonction de sauvegarde de Groupe de Référence  
 
         Les boutons Load All et Save All de l’onglet General vous permettent de sauvegarder et charger le contenu  
         des 40 (RTA et Fonction de Tarnsfert) Registres de Référence comme un simple fichier, en une seule  
         opération. 
 

          
 
         La commande Save All enregistre le contenu actuel de tous les Registres de Référence sur un seul fichier de  



         Groupe de Référence (.rgp). si vous le désirez, vous pouvez entrer un commentaire pour le fichier groupe  
         qui sera visible durant les opérations Load All.       
 

          
 
         Load All ouvre une fenêtre de dialogue Open vous permettant de sélectionner un fichier de Groupe de  
         Référence précédemment sauvegardé à charger. 
 
         Note importante : L’opération Load All replace le contenu des 40 Registres de Référence donc tous les  
         tracés de références existants non sauvegardés seront perdus. SmaartLive vous demandera confirmation  
         avant le chargement afin d’éviter tout écrasement de données accidentel. 
   
         Onglets Individuels de Banque de Registre (A, B, C, D et E) 
 
         Les onglets individuels de banque de registre (A, B, C, D et E) vous permettent de visualiser (pas d’éditer)  
         le Commentaire et le décalage (Y+/-) pour chacun des tracés enregistrés ainsi que tous les paramètres  
         d’entrée en usage lorsque le racé a été capturé :  
          

• Si le tracé est une moyenne de deux ou plusieurs tracés (Tracé de moyenne ) ou capturé directement 
• La fréquence d’échantillonnage (SR) utilisée lors de la capture du tracé 
• La taille d’image FFT utilisée (FFT) 
• Le Temps du Délai interne utilisé (Delay) lors de la capture du tracé 
• Le canal sur lequel le délai était assigné (Delay Ch) 
• Le nombre de points de moyenne utilisés (Averages) 
• La Fenêtre de Donnée utilisée (Window Type) 
• Si le Tracé de Référence a té sauvegardé sur un fichier, le Nom, la Date (de création) et la numéro de 

Version (SIA-Smaart Reference File Specification) du fichier sont également affichés. Les boutons à 
gauche sont utilisés pour naviguer sur les Registres de Référence dans la banque sélectionnée.  

 

 
 
En mode Fonction de Transfert, lorsqu'un registre de référence contenant un tracé de référence à 24 points 
par octave (FPPO) est sélectionné, un bouton Edit apparaît juste au-dessus des boutons de registre 
référence. Cliquer sur le bouton Edit ouvrira l'éditeur de tracé de référence de SmaartLive, vous permettant 
de modifier le tracé sélectionné point par point, d'inverser le tracé, ou de supprimer toute la courbe et d'en 
créer une nouvelle en résolution par octave ou par fraction d'octave. Cette fonction est conçu pour créer des 
courbes de pondération.  
  
Les fonctions de pondération s'appliquent uniquement à l'affichage d'amplitude du mode fonction de 
Transfert, donc cliquer sur les boutons Flat ou Flip dans la fenêtre de dialogue de l'éditeur de tracé aura une 
action sur la courbe de réponse de phase. Si vous voulez modifier la réponse de phase d'une courbe sans 
supprimer la partie amplitude, cliquez juste deux fois sur le bouton Flip. Sauvegarder un tracé de référence 
FPPO comme fichier de référence (voir ci-dessous) dans le dossier Weighting du dossier Files de 
SmaartLive l'ajoutera à la liste des courbes de pondération disponibles la prochaine fois que vous lancerez 
SmaartLive. 
 

 
     
Pour sauvegarder de façon permanente un fichier de Tracé de Référence (.ref) sur le disque ; cliquez sur le 
bouton du registre contenant le tracé que vous voulez sauvegarder puis cliquez sur le bouton Save. Une 
fenêtre de dialogue Enregistrer standard apparaîtra avec le nom du registre sélectionné suggéré come nom 
pour le nouveau fichier, ex : a1.ref. Tout nom de fichier légal se terminant par l’extension « .ref » peut être 
entré.  
 

 
 
Pour charger un fichier de Référence (.ref) précédemment enregistré dans un Registre de Référence, 
sélectionnez le registre de destination en cliquant sur l’un des quatre boutons, puis cliquez sur le bouton 



Load. Ne fenêtre de dialogue Ouvrir apparaîtra, vous permettant de sélectionner un fichier de référence que 
vous désirez ouvrir. 
 
Note : Vous pouvez uniquement charger des tracés RTA lorsque SmaartLive est en mode RTA et des tracés 
de Fonction de Transfert lorsqu’il est en mode Fonction de Transfert. 
 

Save Active Reference Trace 
 
         Menu Control > Reference > Save Active Reference Trace 
 
         Commande du Clavier = [Ctrl] + [S] 
 
         La commande Save Active Reference Traces ouvre une fenêtre de dialogue Enregistrer vous permettant de  
         sauvegarder uniquement le tracé de référence actif sur un fichier (.ref) du disque dur. 
       
         Note : Vous pouvez également sauvegarder des través de référence (et les charger) sur de Fichiers de  
         Référence depuis la fenêtre de dialogue Reference Information.  
 
Delay Time  
 
         Menu Control > Delay Time  
 
         Commandes du Clavier : 
         Increase ou Decrease = [F3] ou [F4] 
         Clear Delay = [F5] 
         Recall Delay Presets = [F6] – [F10] 
 
         Les commandes Delay Time du menu Control peut être utilisé pour augmenter et diminuer ou rappeler des  
         paramètres enregistrés pour le délai interne de SmaartLive. Vous pouvez également modifier le Temps de  
         Délai actuel en cliquant sur le nom au-dessus de l’affichage du délai (voir ci-dessous) pour ouvrir l’onglet  
         Delay de la fenêtre de dialogue Options puis entrer une nouvelle valeur (jusqu’à 750ms) dans le champ  
         Delay Time. 
 

          
 
         Les commandes Increase et Decrease du délai modifient la valeur actuelle du temps du délai de 0.01  
         millisecondes et ont le même effet qu’un clique sur les boutons de la commande à droite de l’affichage du  
         délai voir ci-dessus). La commande Clear du délai ([F5]) remet le temps du délai actuel sur 0 ms. 
  
         Dans tous les modes opérationnels sauf le mode Impulse, les commandes Delay Preset ([F6] – [F10])  
         modifie le temps du délai actuel vers la valeur enregistrée dans le registre du preset de délai correspondant.  
         En mode Impulse, ces commandes activent des marqueurs sur le tracé de réponse d’impulsion qui  
         indiquent les localisations temporelles des temps de délai enregistrés. Les valeurs des presets de délai pour  
         le délai interne sont réglables par l’utilisateur et sont accessibles via l’onglet Delay de la fenêtre de  
         dialogue Options. 
 
Commandes Locked Cursor 
 
Move Left  
 
         Menu Control > Locked Cursor > Move Left 
 
         Commande du Clavier = [Ctrl] + [Flèche Gauche] 
 
         Déplace le Curseur Bloqué d’un pixel vers la gauche. 



 
Move Right  
 
         Menu Control > Locked Cursor > Move Right 
 
         Commande du Clavier = [Ctrl] + [Flèche Droite] 
 
         Déplace le Curseur Bloqué d’un pixel vers la droite. 
 
Move Left 1 Data Point 
 
         Menu Control > Locked Cursor > Move Left 1 Data Point 
 
         Commande du Clavier = [Ctrl] + [shift] + [Flèche Gauche] 
 
         Déplace le Curseur Bloqué jusqu’au prochain point de donnée à gauche. 
 
Move Right 1 Data Point 
 
         Menu Control > Locked Cursor > Move Right 1 Data Point 
 
         Commande du Clavier = [Ctrl] + [shift] + [Flèche Droite] 
 
         Déplace le Curseur Bloqué jusqu’au prochain point de donnée à droite. 
 
Find Peak  
 
         Menu Control > Locked Cursor > Find Peak  
 

          
 
         Commande du Clavier = [Shift] + [P] 
 
         La commande Find Peak créé (ou repositionne) le Curseur Bloqué sur le plus haut point ( d’amplitude)  
         trouvé sur le tracé actuellement affiché au premier plan. En mode Impulse, SmaartLive réalise cette  
         opération automatiquement pour localiser le temps du délai de propagation, ou la première impulsion sur le  
         tracé. 
 
         Veuillez noter que si le Curseur Bloqué est déjà positionné sur la crête la plus haute du tracé (ex : par  
         l’option auto-locate de l’enregistreur), cette commande ne fait rien.  
    
Find Next Higher 
 
         Menu Control > Locked Cursor > Find Next Higher 
 
         Commande du Clavier = [Ctrl] + [Shift] + [P] 
 
         Déplace le Locked Cursor sur le point de donnée du tracé qui est le plus proche en amplitude et plus haut  
         que la position actuelle.  
 
         Note : Si le Locked Cursor est déjà positionné sur le plus haut point du tracé, cette commande ne fait rien.   
 
Find Next Lower 
 
         Menu Control > Locked Cursor > Find Next Lower 
 
         Commande du Clavier = [Ctrl] + [Shift] + [L] 
 



         Déplace le Locked Cursor sur le point de donnée du tracé qui est le plus proche en amplitude et plus bas  
         que la position actuelle.  
 
         Note : Si le Locked Cursor est déjà positionné sur le plus bas point du tracé, cette commande ne fait rien. 
 
Find Low 
 
         Menu Control > Locked Cursor > Find Low 
 
         Commande du Clavier = [Ctrl] + [Shift] + [L] 
 
         Crée (ou repositionne) le Locked Cursor sur le point de donnée du tracé le plus bas (en amplitude). (Si le  
         Locked Cursor est déjà positionné sur le plus haut point du tracé, cette commande ne fait rien.) 
 
Track Peak 
 
         Menu Control > Locked Cursor > Track Peak 
 
         Track Peak active un curseur bloqué qui recherche la plus haute valeur en amplitude dans l'affichage RTA  
         du mode Spectre ou dans le tracé d'Amplitude de la Fonction de Transfert en temps réel. Track Peak est un  
         interrupteur. Sélectionner la commande Track Peak à nouveau et appuyer sur [Ctrl] + [Shift] + [T] sur  
         votre clavier désactive la fonction.  
                    
Show Harmonics 
 
         Menu Control > Locked Cursor > Show Harmonics 
 
         Commande du Clavier = [Ctrl] + [H] 
 
         Show Harmonics place un ensemble de traits verticaux sur le tracé représentant jusqu’à 16 harmoniques et  
         deux sous harmoniques pour la position du Locked Cursor. La commande Show Harmonics défile sur 4  
         états différents lorsqu’on la répète. Vous verrez initialement les fréquences harmoniques paires lorsque la  
         commande est utilisée. Répéter la commande affichera les harmoniques impaires puis les harmoniques  
         paires et impaires. Répéter la commande une quatrième fois désactivera l’affichage des harmoniques.  
    
        Lorsqu’un affichage d’harmonique est activé, vous pouvez déplacer le curseur bloqué d’harmonique en  
         harmonique sans modifier la sélection de l’harmonique fondamentale en utilisant les commandes Next and  
         Previous Harmonic. L’affichage du Locked Cursor (à gauche au-dessus du tracé) affiche l’indication F  
         lorsque le Locked Cursor est placé sur la fondamentale, H(numéro) lorsque vous le déplacez sur une  
         harmonique et S(numéro) pour une sous harmonique.  
  
Next/Previous Harmonic 
 
         Menu Control > Locked Cursor > Next/Previous Harmonic 
 
         Commandes du Clavier : 
         Next Harmonic = [Shift] + [Flèche Droite] 
         Previous Harmonic = [Shift] + [Flèche Gauche] 
 
         Les commandes Next Harmonic et Previous Harmonic déplace le Curseur Bloqué d’une fréquence  
         harmonique vers la droite lorsque Show Harmonics est actif. L’affichage du Locked Cursor (à gauche au- 
         dessus du tracé) affiche l’indication F lorsque le Locked Cursor est placé sur la fondamentale, H(numéro)  
         lorsque vous le déplacez sur une harmonique et S(numéro) pour une sous harmonique.  
      
Remove  
 
         Menu Control > Locked Cursor > Remove  
 
         Commande du Clavier = [Ctrl] + [X] 



         Raccourci de la Souris = [Ctrl] + clique en dehors du tracé (dans les marges de la zone du tracé) 
 
         Cette commande enlève un Curseur Bloqué existant de SmaartLive.  
 
System Presets 
 
         Menu Control > System Presets 
 
 

          
 
         Les System Presets sont des dossiers qui enregistrent de nombreux paramètres de SmaartLive. Tous les  
         paramètres enregistrés dans un preset peuvent être rappelés comme un groupe depuis une seule commande.  
         Les paramètres sont rappelés par un preset comprenant les sélections  
 
         De la Fréquence d’Echantillonnage, de la taille FFT, du délai, des moyennes, du mode Fonction de  
         Transfert et des appareils externes. Vous pouvez également configurer un preset un changement de  
         programme MIDI à envoyer lorsque le preset est rappelé. Les commandes System Preset du menu Control  
         sont utilisées pour enregistrer/rappeler les paramètres du System Preset depuis/vers votre session  
         SmaartLive actuelle. Notez que vous pouvez également enregistrer et rappeler les presets et éditer les  
         paramètres enregistrés directement en utilisant la fenêtre System Preset Options.  
   
         Save Values To > (Preset 1-9) 
 
         Commande du Clavier = [Ctrl] + [Shift] + ([1] – [9]) 
 
         Remplace les paramètres enregistrés dans System Preset (1-10) sélectionné par les paramètres actuels. 
 
         Save Values To > (Any Preset) 
 
         Commande du Clavier = [Ctrl] + [Shift] + [0] 
 
         Ouvre une fenêtre de dialogue vous permettant de nommer et d’enregistrer les paramètres actuels sur l’un  
         des System Preset (1-100). 
 
         Save Values From > (Preset 1-9) 
 
         Commande du Clavier = [Ctrl] + ([1] – [9]) 
 
         Cette commande remplace les paramètres actuellement en usage par les paramètres enregistrés dans le  
         System Preset (1-9) sélectionné.  
 
         Load Values From > (Any Preset) 
 
         Commande du Clavier = [Ctrl] + [Shift] + [0] 
 
         Ouvre une fenêtre de dialogue vous permettant de rappeler les paramètres enregistrés dans l’un des System        
         Preset (1-100). 
 
         Notes : 
 
         Lorsque vous commencez une session SmaartLive, aucun System Preset n’est chargé. Après avoir chargé  
         un preset, son nom apparaît dans la ligne de titre au-dessus du tracé. Si vous modifiez l’un des paramètres  
         enregistrés dans le preset (ex : si vous modifiez le nombre de points de moyenne avec la commande Avg),  
         un astérisque apparaîtra à côté du nom du preset pour indiquer que les paramètres actuels et les paramètres  
         enregistrés ne sont pas les mêmes. Sauvegarder ou recharger le preset enlève l’astérisque. 



 
Menu Spectrum 
 
Mode Spectrum 
 
         Menu Spectrum > Spectrum Mode  
 

          
 
         Cette commande active le mode Spectre de SmaartLive. Notez qu'en mode Spectre et Fonction de  
         Transfert, l'analyseur de SmaartLive ne commence pas à afficher les données du tracé depuis les entrées de  
         votre carte son avant que smaart On ne soit sélectionné.  
  
Affichage RTA   
 
         Menu Spectrum > RTA Display 
 

          
 
         Commande du Clavier = [R] 
 
         Cette commande met SmaartLive en mode RTA. Notez qu’en Mode RTA, Fonction de Transfert et  
         Spectrographe, l’analyseur de SmaartLive ne commence pas à tracer les données provenant des entrées de  
         votre carte son avant que Smaart On ait été sélectionné (voir ci-dessus).  
    
Spectrograph 
 
         Menu Spectrum > Spectrograph 
 

          
 
         Commande du Clavier = [S] 
 
         Cette commande active le mode Spectrographe de SmaartLive. Notez qu’en mode RTA, Fonction de  
         Transfert ou Spectrographe, l’analyseur de SmaartLive ne commence à afficher les données que lorsque  
         Smaart On est sélectionné. 
 
SPL History 
 
         Menu Spectrum > SPL History 
 

          
 
         Cette commande active l'affichage Historique SPL en mode Spectre. Notez qu'en modes Spectre et  
         Fonction de transfert, l'analyseur de SmaartLive ne commence pas à afficher les données provenant des  
         entrées de votre carte son avant que Smaart On ne soit sélectionné.  
 
         Note: Pour plus d'informations sur les principaux types d'affichage du mode Spectre, voir Vue d'Ensemble  
         du Mode Spectre page 14.  
  
Show Inputs  
 
         Menu Spectrum > Show Inputs  
 

          



 
         Gauche (0) – Commande du Clavier= [Alt] + [0] 
         Droit (1) – Commande du Clavier = (alt] + [1] 
 
         Les commandes Show Inputs activent l’affichage de deux tracés de spectre lorsque l’analyseur est en mode  
         RTA. Les commandes Show Inputs sont des interrupteurs. Par exemple, sélectionner la commande Left (0)  
         fait disparaître le tracé du spectre s’il était visible, et l’affiche s’il ne l’était pas. Notez qu’en mode RTA,  
         cacher le tracé du spectre de l’Entrée Active (voir page 84) entraîne l’activation de l’autre entrée (affichée).  
         Notez également que SmaartLive continue de traiter les données des deux entrées, même si les deux sont  
         cachées, jusqu’à ce que l’analyseur soit arrêté ou mis en pause.    
 
Timed Average / LEQ 
 
Timed Average / LEQ Setup 
 
         Menu Spectrum > Timed Average / LEQ Setup 
 
         Cette commande ouvre la fenêtre de dialogue Timed Average / LEQ Setup vous 
permettant de régler une  
         moyenne ou une opération de traitement en mode Spectre. La fenêtre de dialogue Timed 
Average / LEQ  
         Setup est divisée en trois parties avec des commandes pour régler le temps de départ, le 
type de mesure et  
         la destination en sortie. 
   
         Start Time 
 
         Dans cette partie, vous trouverez les commandes permettant de spécifier le temps de départde la mesure.  
         Les options étant de décompter à partir du moment ou vous avez cliqué sur le bouton start (en bas de la  
         fenêtre de dialogue) ou de commencer la mesure à un jour et une heure spécifiés. Pour commencer  
         immédiatement la mesure sélectionnez l'option Count Down et mettez l'horloge du décompte à zéro.  
    
         Time Measurement 
 
         Dans cette partie, vous devrez sélectionner le type de mesure temporelle que vous désirez réaliser. Toutes  
         les moyennes temporelles sont des moyennes des données FFT collectées sur une certaine période donc les  
         trois types de mesures nécessitent la spécification d'une Période d'Echantillonnage (période d'intégration).  
         Pour le Timed Average, c'est le seul paramètre que vous devez régler dans cette partie. Pour les options  
         LEQ log et Spectrum Log, vous devez également régler la Durée de la mesure. Les fichiers LEQ (Niveau  
         Sonore Equivalent et Spectrum log auront une entrée pour chaque Période d'Echantillonnage sur la Durée  
         spécifiée de la mesure.  
   
         Output Destination 
 
         Les options de la partie inférieure de la fenêtre de dialogue Timed Average / LEQ Setup varient en fonction  
         du type de mesure sélectionné. Pour la moyenne temporelle, vous n'avez qu'à sélectionner un registre de  
         référence qui recevra la moyenne des données FFT et optionnellement, une courbe de pondération à  
         appliquer à la mesure et un commentaire pour le tracé de référence en résultant. Pour un LEQ Log vous  
         devrez spécifier un nom de fichier et une courbe de pondération (en général A) pour la mesure. Les  
         mesures Spectrum Log nécessitent la sélection de la résolution de la mesure (octave ou fraction d'octave) et  
         un nom de fichier. Notez que les fichiers Spectrum Log peuvent être retraités pour obtenir les données  
         pondérées LEQ et Bruit Centile à partir des données spectrales non pondérées enregistrées dans les fichiers  
         (voir LEQ Report from File, ci-dessous).  
  
LEQ Report from File 
 



         Menu Spectrum > Timed Average > LEQ Report from File 
 

          
 
         Les fichiers Spectrum Log et LEQ Log de SmaartLive sont enregistrés dans des fichiers texte ASCII  
         pouvant être importés directement dans un programme de traitement de texte ou une autre application pour  
         un traitement ultérieur. SmaartLive possède également un une fonction de traitement ultérieur interne pour  
         les fichiers Spectrum Log qui extrait un rapport des niveaux sonores SPL Minimum/Maximum (LMIN et  
         LMAX) et optionnellement, le Bruit centile pour un maximum de six seuils centiles (L10, L50 et L90 plus  
         trois seuils définis par l'utilisateur) depuis les données spectrales. Les versions pondérées A et C ainsi que  
         la version non pondérée sont inclus automatiquement dans le fichier de rapport. Le générateur de fichier de  
         rapport calculera les valeurs cumulatives pour tout le fichier ou pour une partie spécifiée du fichier avec ou  
         sans moyennes à des intervals spécifiés le long de la période du rapport. 
  
 
Power Comparator Mode  
 
         Menu Spectrum > Power Comparator Mode  
 

          
 
         La fonction Power Comparator somme la puissance dans deux groupes (nommés A et B) de bandes de 1/24  
         d'octave sélectionnées et affiche la pourcentage relatif ou la différence en décibels entre les deux. Les  
         valeurs de pourcentage et de décibels sont également reportées sur un fichier texte à des intervals spécifiés  
         par l'utilisateur lorsque le Power Comparator est en marche. La fonction Power Comparator a été conçu  
         pour une application précise et franchement, nous ne savons pas trop qu'elle autre utilsation vous pourriez  
         en faire. Nous avons choisi de l'incoporer dans cette version car l'utilisation faîtes de SmaartLive ne cesse  
         jamais de nous étonner et le fait que nous ne trouvions pas d'application général pour cette fonction ne  
         signifie certainement pas que qyuelqu'un d'autre ne le fera pas.  
 
         Enabled 
 
         Lorsque le mode Power Comparator est activé, SmaartLive est bloqué en mode Spectre avec une résolution  
         en fréquence de 1/24 d'octave. L'indication dans l'Affichage du Niveau du Signal/SPL devient "Power  
         Comparator" et le numéro affiché représentera soit (définit par l'utilisateur) une différence en décibels ou  
         en pourcentage entre les groupes A et B (voir ci-dessous). Enabled est un interrupteur donc une encoche  
         apparaît à côté de celle-ci lorsqu'elle est sélectionnée et sélectionner à nouveau cette commande depuis le  
         menu désactive le Power Comparator.  
 
         Configure 
 
         Les options du Power Comparator sont réglées depuis la fenêtre de dialogue Power Comparator  
         Configuration, accessible en sélectionnant Configure dans le sous-menu Power comparator du menu  
         Spectrum. La partie Select Octave possède un groupe de boutons utilisés pour sélectionner la bande  
         d'octave apparaissant dans la section Assign Bands to Groups à gauche. La partie Assign Bands to Groups  
         possède deux colonnes de cases vous permettant d'assigner n'importe quelle combinaison de bandes de  
         1/24 d'octave au groupes A et/ou B.  
 
         L'unité affichée dans l'Affichage de Niveau du Signal/SPL lorsque le mode Power Comparator est activé  
         est sélectionnée dans la partie Display Mode de la fenêtre de dialogue. La valeur Printout Interval règle les  
         intervals de report (en secondes) pour le fichier ASCII sélectionné dans la section Printout File. Si aucun  
         fichier n'est sélectionné, la fonction de traitement est désactivée.  
        
Noise Criterion Mode 
 



         Menu Spectrum > Noise Criterion Mode  
 
         Commande du Clavier = [Ctrl] + [N] 
 
         Cette commande met SmaartLive dans un mode opérationnel conçu spécialement pour faire des mesures  
         Noise Criterion (NC). Le Mode NC est un affichage de bande d’octave lais utilise un tracé linéaire  (au lieu  
         du bargraphe familier) et superpose les courbes standards de noise Criterion (NC) sur le tracé. En mode  
         NC, le Rapport Noise Criterion pour chaque tracé est affiché dans le coin supérieur droit du tracé et est mis  
         à jour en temps réel. 
     
         La commande Noise Criterion Mode est un interrupteur. Répétez cette commande pour revenir à  
         l’affichage RTA standard. Cette commande est uniquement en mode RTA. 
 
         Notes : Les mesures NC ne sont valides que si SmaartLive est calibré en SPL. Notez également que les  
         courbes NC sont dans une échelle de +8 à +80dB et sont donc normalement uniquement visibles lorsque  
         l’analyseur est calibré en SPL. Vous pouvez afficher les courbes NC sur tracé standard du mode RTA (sans  
         utiliser la fonction Noise Criterion Mode) en sélectionnant Show Noise Criterion Curves sur l’onglet Graph  
         de la fenêtre de dialogue Options. 
 
NC Rating Table 
 
         Menu Spectrum > NC Rating Table 
 
         En mode RTA avec la résolution de bande d’octave (Oct) sélectionnée, SmaartLive calculera et affichera le  
         Rapport Noise Criterion (NC) standard pour chacun des deux tracés lorsque vous sélectionnez la  
         commande NC Rating Table dans le menu Control. Le tableau peut ensuite être sauvegardé dans un fichier  
         texte en cliquant sur le bouton Save dans la fenêtre de dialogue NC Rating. Pour afficher un tracé NC,  
         utilisez la commande Noise Criterion Mode (voir ci-dessus). 
 
 
Trace Difference  
 
         Menu Spectrum > Trace Difference  
 
         En mode RTA avec une résolution de bande d’octave ou de fraction d’octave, la fonction Trace Difference  
         calculera et affichera la différence de magnitude pour chaque bande entre deux tracés affichés. Si la  
         résolution 1/3-octave est sélectionnée, le rapport Sound Transmission Class (STC) est également calculé.  
         Sélectionner la commande Trace Difference depuis le menu Control ou appuyer sur [Ctrl] + [F] sur le  
         clavier ouvre la fenêtre de dialogue Specify Trace Difference.  
  
         Dans la fenêtre de dialogu Specify Trace Difference, sélectionnez le tracé que vous voulez comparer dans  
         la section « Show How Trace » et le tracé à utiliser comme référence dans la section « Is Different From  
         Trace ». Lorsque vous cliquez sur le bouton OK, les calculs sont réalisés et les résultats affichés dans le  
         tableau. Avec la résolution 1/3-octave, le rapport STC est affiché sous le tableau. Le tableau peut être  
         sauvegardé (avec un commentaire) dans un fichier ASCII, qui pourra être chargé dans un processeur word,  
         en cliquant sur le bouton Save. 
    
         Notez que le tracé de différence n’est pas calculé pour les bandes basses contenant moins de deux points de  
         données FFT car les données peuvent ne pas être fiables. Pour obtenir des données fiables dans les bandes  
         basses, utilisez une taille FFT plus grande et/ou une fréquence d’échantillonnage plus basse pour  
         augmenter la résolution de fréquence du FFT. 
 
 
Reset SPL History Min/Max 
 
         Menu Spectrum > Restart SPL History 
 
         Notez que lorsque le curseur est positionné sur l'affichage Historique SPL, l'affichage du curseur indique  
         les valeurs SPL Minimum et Maximum ainsi que la valeur SPL actuellementaffichée aux coordonnées  



         temporelles du curseur. Les valeurs SPL MIN/MAX rencontrées dans la session SmaartLive sont  
         enregistrées pour la durée de la session ou jusqu'à ce qu'elles remises à zéro en utilisant la commande Reset  
         SPL History ou en appuyant sur [Ctrl] + [R] sur votre clavier.  
  
 
Menu Transfer Function  
 
Transfer Function Mode  
 
         Menu Transfer Function > Transfer Function Mode  
 

          
 
         Commande du Clavier = [T] 
 
         La commande Transfer Function Mode permet de comparer les signaux des entrées audio Gauche et Droite  
         de l’ordinateur (dans le domaine fréquentiel), et de tracer les différences entre les deux signaux sur une  
         seule courbe. Normalement, le calcul de la fonction de transfert de SmaartLive divise le signal de l’entrée  
         Gauche (canal 0) par le signal de l’entrée Droite (canal 1). Cela signifie qu’à moins que la commande  
         Swap Transfer Function Inputs soit sélectionnée, SmaartLive s’attend à trouver le signal de mesure sur  
         l’entrée Gauche et le signal de référence sur l’entrée Droite.  
   
         Notez qu’en mode RTA, Fonction de Transfert et spectrographe, l’analyseur de SmaartLive ne commence  
         pas à tracer les données provenant des entrées de votre carte son avant que Smaart On ait été sélectionné. 
 

Phase 
 
         Menu Transfer Function > Phase  
 

          
 
         Commande du Clavier = [F] 
 
         La commande de Phase active un affichage supplémentaire avec une version plus petite du tracé de  
         fonction de transfert normal (magnitude/fréquence) et un tracé indiquant le décalage de phase du signal de  
         mesure (par rapport au signal de référence) par fréquence. La commande de Phase est un interrupteur.  
         Répétez la commande ou cliquez à nouveau sur le bouton pour retourner à l’affichage fréquence/magnitude  
         plein écran. 
     

Coherence  
 
         Menu Transfer Function > Coherence 
 

          
 
         Commande du Clavier = [H] 
 
         La commande Coherence active l’affichage du tracé de cohérence en mode Fonction de Transfert (voir La  
         Fonction de Cohérence page 20 pour plus d’information). Cette commande a le même effet que le bouton  
         Coh qui apparaît à droite du tracé en mode Fonction de Transfert. La commande Coherence est un  
         interrupteur. Répétez la commande ou cliquez sur le bouton « Coh » à nouveau pour désactiver l’affichage  
         de cohérence. 
 
 



Swap Transfer Function Inputs  
 
         Menu Transfer Function > Swap Transfer Function Inputs  
 

          
 
         Commande du Clavier = [W] 
 
         Cette commande transpose (intervertit) les entrées lors du calcul de la Fonction de Transfert afin que  
         SmaartLive divise le signal de l’entrée Droite (canal 1) par le signal de l’entrée Gauche (canal 0). Cela  
         signifie que lorsque la commande Swap Transfer Function Inputs est activée, SmaartLIve s’attende à  
         trouver le signal de mesure sur l’entrée Droite et le signal de référence sur l’entrée Gauche.  
    
         La fonction Swap Transfer Function Inputs est principalement utilisée lorsque vous voulez afficher la  
         courbe de réponse inverse d’un EQ ou d’un processeur afin de faciliter l’utilisation des mesures de réponse  
         comme guide pour le paramétrage des filtres. La fonction de transposition peut également être utilisée si  
         vous avez fait une erreur dans la connectique des signaux de mesure et de référence mais la modification  
         physique de la connexion est en général préférable et évite la confusion.  
 
         L’indication [Swap] apparaîtra dans le coin supérieur du tracé de Fonction de Transfert lorsque cette  
         fonction est activée pour indiquer que les entrées sont interverties. La commande Swap Transfer Function  
         Inputs est un interrupteur. Répétez la commande ou cliquez à nouveau sur le bouton pour revenir au mode  
         opérationnel de Fonction de Transfert traditionnel.  
  

Averaging 
 
         Menu Transfer Function > Averaging 
 

          
 
         Définit le type de Moyenne (RMS ou Vectorielle) utilisée par SmaartLive pour les mesures de la Fonction  
         de Transfert (voir Moyenne et Adoucissement page 18 pour plus de détails). Notez que la technique de  
         Moyenne utilisée pour l’affichage de la fonction de transfert peut également être sélectionnée en cliquant  
         sur le nom des commandes de moyenne (Avg) à droite du tracé. L’indication « (V) » ou «(R)» apparaît sur  
         les commandes de moyenne en mode fonction de Transfert pour indiquer le type de moyenne actuellement  
         en usage. 
 

Smoothing 
 
         Menu Transfer Function > Smoothing 
 

          
 
         L’adoucissement st un type de moyenne pour les tracés uniquement disponible en mode Fonction de  
         Transfert. Cette fonction vous permet de réduire les fluctuations sur les tracés de fonction de transfert et  
         peut rendre les tendances sur la réponse d’un système ou d’un appareil plus facile à lire. Sur un tracé de  
         fonction de transfert adouci, une moyenne entre le point et un certain nombre de points adjacents  
         (déterminé par la commande Smooth à droite du tracé) est faite pour chaque point. 
   
         Par exemple, si la commande Smooth est réglée sur 3, tout point donné représentera la moyenne de la  
         valeur de ce point avec les 3 points supérieurs et inférieurs (en fréquence) sur le tracé. Les options  
         d’adoucissement disponibles sont 3-point, 5-point, 7-point, 9-point ou None. Notez que vous pouvez  
         également sélectionner le nombre de points de cette moyenne en cliquant sur le champ de la commande  
         Smooth et en faisant votre sélection dans le menu déroulant.  
    



Phase Display Properties 
 
Set Range to –180 →180 
 
         Menu Transfer Function > Phase Display Properties > Set Range to –180 -> 180 
 
         Commande du Clavier = [Alt] + [Home] 
 
         Remet l’affichage de phase réduit (uniquement) sur la gamme par défaut de +180° à –180°.  
 
Set Range to 0 →360 
 
         Menu Transfer Function > Phase Display Properties > Set Range to 0 -> 360  
 
         Commande du Clavier = [Alt] + [Fin] 
 
         Remet l’affichage de phase réduit (uniquement) sur la gamme 0° – 360°. 
 
 
Unwrap 
 
         Menu Transfer Function > Phase Display Properties > Unwrap 
 
         Commande du Clavier = [U] 
 
         Sélectionner cette commande « étend » l’affichage de phase afin que les valeurs de décalage de phase en  
         dehors du cercle (360°) d’affichage standard soient permises. Ce type d’affichage est principalement utile  
         dans les cas où vous voulez avoir une idée de la relation de phase entre deux sigaux sur une gamme de  
        fréquence très large.   

 
Show Phase as Group Delay  
 
         Menu Transfer Function > Phase Display Properties > Show Phase as Group Delay 
 
         L'option Show Phase as Group Delay convertit les angles de phase entre les fréquences adjacentes de  
         L'affichage de phase en millisecondes. Les résultats sont affichés sous la forme de valeurs positives ou  
         négatives en millisecondes avec une valeur de zéro milliseconde pour une fréquence donnée signifiant que   
         les signaux de référence et de mesure arrivent exactement au même moment à cette fréquence. Notez que  
         comme dans le cas de l'affichage à plat, la dérivation à partir du groupe de délai minimum fonctionne en  
         extrapolant les valeurs des données de phase actuelles en fonction de supposition qui peuvent se révéler  
         fausses et donc que son fonctionnement est meilleur lorsque les données de mesure entrantes sont précises. 
 
Régler la Gamme du Graphique de Phase 
 
         Les même commandes (secondaires) de Gamme de Fréquence et d'Amplitude utilisées pour les affichages  
         secondaires en mode Spectre fonctionnent également avec l'affichage de Phase en mode Fonction de  
         Transfert. Dans ce cas l'axe y du tracé vous indique les relations temporelles plutôt que la magnitude mais  
         sinon, les commandes de zoom et de déplacement sur l'échelle fonctionne comme sur les affichages à plat  
         et sur les groupes de délai.  
 
         L'affichage de phase standard est un cas spécial car l'échelle y totale de ce type de tracé est toujours égal à  
         360°. Su rl'affichage de phase standard les commandes Move Up/Down secondaires déplacent la ligne zéro  
         ° vers le haut ou vers le bas par pas de 45°. Les commandes zoom in et zoom out ne sont pas applicables à  
         ce type d'affichage. 
 
         Notez que par défaut, les échelles de fréquence des affichages de Phase et de Magnitude en mode Fonction  
         de Transfert sont liées ensemble afin que les commandes des Echelles de Fréquence primaires et  
         secondaires affectent les deux tracés de la même façon. Si vous avez besoin d'ajuster séparément les  



         échelles de fréquence affichées sur les affichages de Magnitude et de Phase, vous pouvez le faire en  
         désactivant la case "Transfer Function Phase Tracks Magnitude Display" sur l'onglet Zoom de la fenêtre de  
         dialogue Options.  
  
Show (Traces) 
 
         Menu Transfer Function > Show (Traces) 
 

          
 
         Les commandes du menu Show (Traces) change (enlever/recharger) l'affichage des deux types de tracé sur  
         les affichages de magnitude et de Phase en mode Fonction de Transfert.  
         Ces commandes sont des interrupteurs, donc la sélection de l'une de ces commandes désactive l'affichage  
         de l'autre tracé s'il était visible, ou l'affiche s'il ne l'était pas et qu'il a la même fonction que les boutons  
         illustrés ici.  
  
 
 

          
 
         Notez que le bouton et la commande du menu Time Window sont désactivés lorsque FPPO est sélectionné  
         pour la taille FFT. Voit Fenêtre Temporelle page 30 pour plus d'informations.  
 
Amplitude Scale 
 
Log 
 
         Menu Transfer Function > Amplituse Scale  
 
         L'option de l'échelle d'amplitude Logarithmique (Log) du tracé de Magnitude (uniquement) du mode  
         Fonction de Transfert affiche les valeurs d'amplitude sur l'axe y (vertical) de façon logarithmique, en  
         décibels. C'est l'option de l'échelle de l'axe y par défaut et elle ne doit pas être changée pour la plupart des  
         types de mesures de réponse en fréquence.  
          

Lin 
 
         Menu Transfer Funcion > Amplitude Scale  
 
         La commande d'échelle d'amplitude Linéaire (Lin) du mode Fonction de Transfert règle l'amplitude de  
         l'axe vertical de l'affichage de Magnitude sur une échelle linéaire, graduée en Ohms. Il peut y avoir de  
         nombreuses utilisations pour ce type d'affichage mais comme le choix de l'unité le suggère, il est  
         principalement conçu pour les mesures d'impédance en fonction de la fréquence. Sélectionner cette option  
         active également la fonction Z-Calibrate (voir ci-dessous).  
      

Z Calibrate  
 
         Menu Transfer Function > Amplitude Scale  
 
         Lorsque l'échelle linéaire (Lin) est sélectionnée pour l'affichage de magnitude du mode Fonction de  
         Transfert, sélectionner la commande Z Calibrate ou double-cliquer sur le tracé principal ouvre la fenêtre de  
         dialogue Z Calibrate, pour calibrer l'affichage de la fonction de transfert pour les mesures d'impédance.  
         Cette fenêtre règle également l'échelle du tracé de magnitude de la fonction de transfert linéaire et possède  
         un bouton qui remet l'affichage sur l'échelle log standard.  
 
         Our les mesures d'impédance, vous devez calibrer l'affichage en utilisant une résistance de valeur connue.  



         Pour calibrer le graphique d'impédance, insérer la résistance de calibrage dans votre circuit de mesure à la  
         place de l'appareil à tester (voir le schème page suivante), lancez l'analyseur et double cliquez sur  
         l'affichage pour ouvrir la fenêtre de dialogue Z Calibrate.  
  

         

1
2

Zload

+

– Vgenerator

Rshunt

0

0
Measurement Input

Reference Input

To SmaartLive:

      

1
2

Zload

+

– Vgenerator

Rshunt

0

0

Measurement Input

Reference Input

To SmaartLive:
+

–

+

–

 
 
              Schémas des deux types de circuit utilisables pour les mesures d'impédance. La schéma à gauche   
              illustre un circuit passif. La schéma à droite possède des circuits actifs, ne nécessitant aucune courbe  
              de correction. Sur les deux schémas, Vgenerator est la source de stimulus, typiquement un petit  
              générateur avec un bruit pleine bande comme signal d'entrée. Rshunt est une résistance en dérivation et  
              Zload est l'appareil en test.  
 
         Dans la fenêtre Z Calibrate, désactivez la case Lock value puis entrez la valeur (en ohms) de la résistance  
         de calibrage dans le champ "Calibrated Impedance is". Notez qu'en plus de la valeur de calibrage, vous  
         devez également sélectionner le type de circuit utilisé comme circuit de mesure dans la section Circuit  
         Topology. 
  
         Il y a deux choix pour le type de circuit, "Single-Ended" et "Differential". Bien qu'il y ait des exceptions à  
         la règle, en général, l'option Differential nécessite l'utilisation d'un circuit de mesure avec dees entrées  
         différentes (actives) alors que l'option Single-Ended sera utilisée avec la plupart des circuits passifs  
         constitués uniquement de résistances (voir schémas ci-dessus). Lorsque l'option Single-ended est  
         sélectionnée, une courbe de correction est appliquée à la mesure pour inverser la non linéarité connue dans  
         ces circuits. L'option Differential prend en compte les problèmes de linéarité du circuit d'entrée.  
    

Substract Reference Trace  
 
         Menu Transfer Function > Substract Reference Trace 
 
         Commande du Clavier = [M] 
 
         Soustrait le tracé de référence du tracé de la Fonction de Transfert et affiche un seul tracé indiquant la  
         différence. Par exemple, si vous avez mesuré un EQ et que vous avez sauvegardé la réponse de l’EQ  
         comme Tracé de Référence, puis avez rappelé le tracé de référence et soustrait le tracé de référence du  
         tracé actuel, vous devriez voir une ligne droite.  
   
         Lorsque cette fonction est active, une indication apparaît dans le coin supérieur droit du tracé  
         magnitude/fréquence de la Fonction de Transfert pour indiquer le numéro de registre du tracé soustrait au  
         tracé de la Fonction de Transfert.  
 
         La commande Substract Reference Trace est un interrupteur. Répétez cette commande pour revenir à  
         l’affichage de Fonction de Transfert normal.  
 
Menu Impulse  
 
Mode Impulse 
 
         Menu Impulse > Impulse  
 



          
 
         Commande du Clavier = [I] 
 
         Active le mode Impulse de SmaartLive. En mode Impulse, SmaartLive mesure et affiche la réponse  
         d’impulsion du système à tester. Cette affichage vous permet de trouver les différences entre les points  
         d’arrivée des deux signaux d’entrée, de compare les temps de délai et de visualiser les autres types  
         d’information contenus dans la réponse d’impulsion du système ou de l’appareil testé. 
  
Record Impulse  
 
         Menu Impulse > Record Impulse  
 

          
 
         Commande du Clavier = [Alt] + [S] 
 
         L’enregistreur d’impulsion démarre automatiquement lorsque vous activez le mode Impulse de  
         SmaartLive. Si vous avez besoin de relancer l’enregistreur d’impulsion à nouveau ou d’arrêter un  
         enregistrement de mesure d’impulsion en cours, utilisez la commande Start/Stop Impulse. Start/Stop  
         Impulse est une commande modale. Notez que le bouton Start devient un bouton Stop lorsque  
         l’enregistrement est en cours. Cliquer sur le bouton Stop, appuyer sur [Alt] + [S] ou sélectionner la  
         commande depuis le menu arrête l’opération.  
 
Amplitude View 
 
         Menu Impulse > Amplitude View 
 

          
 
         La commande Amplitude View du menu Impulse sélectionne l'échelle d'amplitude verticale (axe y) pour le  
         tracé d'impulsion principal du mode Impulse. Ces options sont également disponibles sur la commande  
         Amplitude scale en mode Impulse. SmaartLive peut afficher les données de réponse d'impulsion ( du  
         domaine temporel) en utilisant une échelle verticale Linéaire ou Logarithmique. Une troisième option, La  
         Courbe d'energie Temporelle est enfait une représentation logarithmique de l'enveloppe de la réponse  
         d'impulsion calculée en utilisant une combinaison des données du domaine fréquentiel et temporel. Cette  
         option est très utile pour trouver les temps de délai des appareils basse fréquence.  
          
         Note: Essayer différentes échelles d'amplitude peut être très utile pour trouver la crête initiale ou le temps  
         de délai lors d'un travail dans un environnement bruyant et/ou réverbérant.  
  
 
Continuous Mode  
 
         Menu Impulse > Continuous Mode  
 

          
 
         Cette commande fait tourner SmaartLive en mode Impulse de façon continue – redémarrant à chaque fois  
         que les calculs sont finis. Cela vous permet d’analyser les changements sur une certaine période. 
   
         La commande Continuous Mode est un interrupteur. Répétez cette commande ou cliquez sur le bouton  
         Continuous à nouveau pour arrêter ce mode et revenir au fonctionnement traditionnel du mode Impulse.  
 
Flip Inputs 
 



         Menu Impulse > Flip Inputs  
 
         Cette commande transpose (intervertit) les deux signaux d’entrée pour des mesures en mode Impulse. Si  
         SmaartLive est en mode Impulse et que vous obtenez un tracé avec la crête la plus haute à droite du tracé –  
         apparaissant pour indiquer un temps de délai incroyablement long  -- sélectionner cette commande et  
         recommencer l’opération peut corriger le problème.  
     
       L’indication « [Flip] » apparaîtra dans le coin supérieur droit du tracé du mode Impulse lorsque cette  
         fonction est activée pour indiquer que les entrées sont intervertis. La commande Flip Inputs est un  
         interrupteur. Appuyer à nouveau sur ce bouton ou sélectionner la commande dans le menu Locator pour  
         revenir au mode opérationnel normal.    
 
 
Set Delay To Peak  
 
         Menu Impulse > Set Delay To Peak  
 

          
 
         Commande du Clavier = [Ctrl] + [Barre d’Espace] 
         Raccourci de la Souris = [Shift] + clique sur le tracé du mode Impulse 
 
         En mode Impulse, lorsque le Locked Cursor est présent sur le tracé, cette commande assigne  
         automatiquement la position temporelle du Curseur Bloqué comme valeur de Temps de Délai. Si le Locked  
         Cursor n’est pas présent, [Shift] + clique sur le tracé du mode Impulse assigne la position du curseur de la  
         souris comme Temps de Délai.  
 
Assign Locked Cursor To (Delay Preset) 
 
         Menu Impulse > Assign Locked Cursor To > Delay Preset (F6-F10) 
 
         Commande du Clavier = [Ctrl] + ([F6] – [F10]) 
 
         La fonction du délai interne de SmaartLive enregistre cinq valeurs de temps de délai. Ces presets de délai (  
         à ne pas confondre avec les System Presets) sont réglables par l’utilisateur. Les valeurs des délai de preset  
         peuvent être configurées directement depuis l’onglet Delay de la fenêtre de dialogue Options ou réglées  
         automatiquement en mode Impulse.  
 
         En mode Impulse, lorsque le Locked Cursor est présent sur le tracé, sélectionner l’une des commandes  
         Assign Locked Cursor To (Delay Preset) entrainera automatiquement : 
 

• L’assignation de la position temporelle du Locked Cursor comme valeur de Temps de Délai 
• L’enregistrement de la position temporelle du Locked Cursor dans un registre de Preset de Délai 

spécifié 
• La sortie du mode Impulse 
 
Les Presets de Délai sont assignés aux touches de Fonction [F6] – [F10] de votre clavier (la touche [F5] 
remet le Temps de Délai à 0). Dans tous les modes opérationnels sauf le mode Impulse, vous pouvez 
rappeler un Preset de Délai enregistré en appuyant simplement sur la touche de Fonction correspondante. 
En mode Impulse, les touches [F6] – [F10] activent l’affichage d’un ensemble de marqueurs sur le tracé qui 
indiquent la position temporelle des temps de délai enregistrés.  
 
 

Compare Delay Presets 
 
         Menu Impulse > Compare Delay Presets 
 

          



 
         La fonction Compare Delay Presets est conçue pour simplifier le processus de comparaison de plusieurs  
         délai pour trouver les différences. Cette fonction est pratique pour l’alignement des haut-parleurs ou  
         d’autres applications où vous avez besoin de comparer deux ou plusieurs temps de délai. L’outil Compare  
         Delay Presets permet de créer un tableau qui vous indique les différences entre un maximum de six temps  
         de délai.  
 
         Cliquer sur le bouton Compare qui apparaît sous la zone de tracé ouvre une fenêtre de dialogue Compare  
         Delays illustrée ci-dessous. Cette fenêtre de dialogue peut être laissée ouverte lorsque vous travaillez sur la  
         fenêtre principale du mode Impulse. Lorsqu’un Locked Cursor est présent, ces coordonnées seront entrées  
         automatiquement dans le tableau avec les temps de délai enregistrés sur l’un des Delay Preset (F6 – F10).  
         Veuillez noter que les temps de délai enregistrés seront affichés sur cette liste uniquement lorsque leur  
         marqueur sont visibles sur le tracé de la réponse d’impulsion.  
 

          
 
         Chaque entrée du tableau Compare Delays possède cinq parties : 
 

• Le nom. Dans le cas des Delay Preset enregistrés, cela consistera d’un numéro de preset (F6 – F10) et 
en option ; d’un nom que vous spécifierez. Le nom du Locked ursor est fixé sur <Locked Cursor>. 

• Le temps de délai absolu (total) en millisecondes. (Abs. ms) 
• La distance absolue (de la source au microphone) en pied ou en mètres (Abs. ft ou Abs. m), en fonction 

de ce qui est sélectionné sur l’onglet de la fenêtre de dialogue Options.  
• Le temps relatif du délai en millisecondes (Rel. Ms) 
• La distnce relative en pied ou en mètres (Rel. Ft ou Rel. m) 
 
La liste Compare Delays est organisé en fonction du temps de délai absolu, du plus court au plus long. Par 
défaut, la première entrée de la liste est considérée « temps zéro ». Toutes les valeurs relatives de temps et 
de distance des autres entrées sont calculées en fonction des valeurs du temps zéro. L’entrée utilisée comme 
temps zéro est indiquée dans la liste par un triangle violet. Pour désigner une autre entrée comme la 
référence des valeurs relatives de temps et de distance, cliquez simplement sur son nom avec la souris pour 
l’entrée en surbrillance et cliquez sur le bouton Set As Time 0. 
 
Pour ajouter ou modifier un nom pour un Delay Preset enregistré, mettez simplement l’entrée en 
surbrillance en cliquant sur son nom, cliquez sur le bouton Label pour ouvrir la fenêtre Label, puis tapez le 
texte dans le champ et cliquez sur le bouton OK. Notez que vous pouvez également définir le nom pour le 
Delay Preset en cliquant sur l’un des champs de temps de preset dans la fenêtre principale du mode Impulse 
et en sélectionnant Label This Delay dans le menu déroulant.  

 
 
Auto-Locate Delay Large 
 
         Menu Impulse > Auto-Locate Delay Large 
 

          
 
         Commande du Clavier = [Q] 



 
         La commande Quick Auto Delay Large active le localisateur de délai automatique de SmaartLive en  
         utilisant les paramètres de la Grande fenêtre temporelle spécifiés dans l’onglet Locator de la fenêtre de  
         dialogue Options. Il y a deux options pour le localisateur de délai automatique car la technique de mesure  
         de réponse d’impulsion que SmaartLive utilise pour trouver les délais est très sensible au temps de  
         « decay » du système mesuré. Il est essentiel que la fenêtre temporelle utilisée lors de la mesure soit grande  
         par rapport au temps de « decay » du système/pièce testé.  
         
         Les paramètres par défaut de la grande fenêtre temporelle du localisateur de délai automatique donne une  
         taille de fenêtre d’environ 3 secondes. Cette fenêtre temporelle devrait être suffisante comme une mesure  
         acoustique de pièces moyennes mais peut nécessiter un agrandissement pour les mesures d’espaces très  
         large et/ou réverbérants. 
 
         Une fois que la fonction de localisation du délai automatique est terminée, une fenêtre de dialogue  
         s’ouvrira pour vous permettre de régler le délai interne du canal de référence sur le temps de délai trouvé.  
         Cette fenêtre de dialogue vous indique également la polarité absolue de la réponse d’impulsion.  
 
Auto-Locate Delay Small 
 
         Menu Impulse > Auto-Locate Delay Small 
 

          
 
         La commande Quick Auto Delay Small active le localisateur de délai automatique de SmaartLive en  
         utilisant les paramètres de la Petite fenêtre temporelle spécifiés dans l’onglet Locator de la fenêtre de  
         dialogue Options. Les paramètres par défaut de la petite fenêtre temporelle d localisateur de délai  
         automatique donne une taille de fenêtre d’environ 300 millisecondes. Cette fenêtre temporelle est  
         appropriée pour mesurer des délais à travers des appareils électroniques ou faire des mesures acoustiques  
         (microphone) dans des pièces très petites. Une fois que la fonction de localisation du délai automatique est  
         terminée, vous pourrez assigner le temps de délai trouvé au délai interne de Smaart. 
 
 
Menu View 
 
 
Frequency Range 
 
         Menu View > Frequency Range 
 
         Les commandes Frequency range modifient l'échelle et la gamme de l'axe horizontal (x) des tracés  
         primaires et secondaires en modes Spectre et Fonction de Transfert. En mode Spectre, un tracé affiché  
         plein écran ou celui qui se trouve dans la partie inférieure de la zone du tracé sur un affichage en écran  
         séparé est considéré comme le premier affichage et celui dans la partie supérieure comme le second. De  
         même, en mode Fonction de transfert, l'affichage de magnitude est considéré comme le premier et  
         l'affichage de phase comme le second.  
  
         Les commandes Frequency range primaires et secondaires décrites ci-dessous peuvent être utilisées pour      
         ajuster les gammes de fréquence de chacun des tracés indépendemment (lorsque c'est possible). En mode  
         impulse, les commandes frequency range primaires servent également de commandes de gamme  
         temporelle du zoom et de déplacement.  
  
Commandes Frequency Range Primaires 
 
          
         Move Primary Right 
 
         Commande du Clavier = [Flèche Droite] 
 
         Déplace la fenêtre de l'affichage primaire sur la droite pour afficher des fréquences plus hautes. 



 
         Move Primary Left 
 
         Commande du Clavier = [Flèche Gauche] 
 
         Déplace la fenêtre de l'affichage primaire sur la gauche pour afficher des fréquences plus basses. 
 
         Zoom Primary In 
 
         Commande du Clavier = [Flèche Bas] 
 
         Augmente la visualisation horizontale de l'affichage primaire en diminuant la taille de l’échelle affichée.  
 
          
         Zoom Primary Out 
 
         Commande du Clavier = [Flèche Haut] 
 
         Diminue la visualisation horizontale de l'affichage secondaire en augmentant la taille de l’échelle affichée. 
 
Commandes Frequency Range Secondaires 
 
          
         Move Secondary Right 
 
         Commande du Clavier = [Alt] + [Flèche Droite] 
 
         Déplace la fenêtre de l'affichage secondaire sur la droite pour afficher des fréquences plus hautes. 
 
         Move Secondary Left 
 
         Commande du Clavier =[Alt] + [Flèche Gauche] 
 
         Déplace la fenêtre de l'affichage secondaire sur la gauche pour afficher des fréquences plus basses. 
 
         Zoom Secondary In 
 
         Commande du Clavier =[Alt] + [Flèche Bas] 
 
         Augmente la visualisation horizontale de l'affichage secondaire en diminuant la taille de l’échelle affichée.  
 
          
         Zoom Secondary Out 
 
         Commande du Clavier =[Alt] + [Flèche Haut] 
 
         Diminue la visualisation horizontale de l'affichage secondaire en augmentant la taille de l’échelle affichée. 
 
         Notes: 
 

1. Les gammes de fréquence des affichages des modes Spectre et Fonction de Transfert peuvent 
également être réglées en utilisant les Frequency Range Presets (Zooms).  

2. Par défaut, les gammes de fréquence des tracés RTA et Spectrographe du mode Spectre sont liés 
ensemble comme le sont les tracés de Magnitude et de Phase du mode Fonction de Transfert. Ils 
peuvent être déliés, cela vous permettant alors de régler indépendemment les gammes en désactivant 
les cases Link Frequency Range Controls dans l'onglet Zoom de la fenêtre de dialogue Options.  

3. En mode Impulse, vous pouvez également faire un zoom sur l'échelle temporelle en cliquant et en 
tirant l'affichage miniature au-dessus du tracé principal avec le bouton gauche de votre souris. Cliquer 
dans la marge gauche du tracé principal en mode impulse remet le tracé sur l'échelle temporelle 
complète (la Constante Temporelle FFT).  



 
 
 
 
    
 
 
 
 
 
 
 
Frequency Scale 
 
         Menu control > Frequency Scale 
 

          
 
         La section Frequency Scale du menu Control liste les options d’affichage disponibles pour l’axe horizontal  
         (axe x) du tracé. Les options d’affichage de l’échelle de fréquence peuvent également être sélectionnées en  
         utilisant la commande Scale (voir ci-dessus) qui apparaît à droite du tracé en mode RTA ou en utilisant les  
         commandes du clavier suivantes : 
 
         Narrowband – Commande du Clavier = [5] 
         1/24-Octave – Commande du Clavier = [6] 
         1/12-Octave – Commande du Clavier = [7] 
         1/6-Octave – Commande du Clavier = [8] 
         1/3-Octave – Commande du clavier = [9] 
         Octave – Commande du Clavier = [0] 
 
         Note : L’option de Narrowband est disponible lorsque l’option Allow Narrowband RTA est sélectionnée sur  
         l’onglet Graph de la fenêtre de dialogue Options.  
  
 
 Frequency Range Presets (Zooms) 
 
 
         Menu View > Frequency range > Frequency Zooms (1-4) 
 
         Commande du Clavier = [1] – [4] 
 
         Les Zooms de Fréquence numérotés (1-4) enregistre des échelles pour l’axe de fréquence des tracés de  
         l’analyseur qui peuvent être rappelées à partir d’une touche ou d’un clique de souris. Les échelles de  
         fréquence des quatre Zooms de Fréquence sont réglables par l’utilisateur. Les paramètres du zoom de  
         Fréquence sont réglés depuis l’onglet Zoom de la fenêtre de dialogue Options.  
   
  
Amplitude Range 
 
         Menu View > Amplitude Range 
 
         Les commandes Amplitude Range sont analogues aux commandes Frequency Range Zoom et Move. Ces  
         commandes agissent sur l’axe vertical du tracé comme si l’échelle d’amplitude affichée était une fenêtre  
         dont on pouvait modifier la position et la taille. Les commandes amplitude range secondaires servent  
         également de commandes de l'axe y pour l'affichage de Phase du mode Fonction de Transfert.  
  
         De plus, il y a également deux ensmbles de commandes séparés pour les graphiques primaires et  
         secondaires, vous permettant de régler la gamme de chaque graphique séparément sur les affichages de  
         l'écran divisé. Lorsque deux graphiques sont affichés ensemble, celui du bas est le premier et celui du haut  



         le second. Lorsqu'un seul graphique est affiché, les commandes de gamme secondaires ne sont pas  
         utilisées.  
         
  
Commandes Amplitude Range Primaires 
 
         Move Primary Up 
 
         Commande du Clavier = [Page Haut] 
 
         Déplace la fenêtre de l'affichage primaire vers le haut pour afficher les amplitudes plus grandes.  
 
 
         Move Primary Down 
 
         Commande du Clavier = [Page Bas] 
 
         Déplace la fenêtre de l'affichage primaire vers le bas pour afficher les amplitudes plus petites. 
 
         Zoom Primary In 
 
         Commande du Clavier = [-] 
 
         Augmente la visualisation verticale de l'affichage primaire en diminuant la taille de l’échelle affichée. 
 
         Zoom Primary Out 
 
         Commande du Clavier = [+/=] 
 
         Diminue la visualisation verticale de l'affichage primaire en augmentant la taille de l’échelle affichée. 
 
Commandes Amplitude Range Secondaires 
 
         Move Secondary Up 
 
         Commande du Clavier = [Page Haut] 
 
         Déplace la fenêtre de l'affichage secondaire vers le haut pour afficher les amplitudes plus grandes.  
 
 
         Move Secondary Down 
 
         Commande du Clavier = [Page Bas] 
 
         Déplace la fenêtre de l'affichage secondaire vers le bas pour afficher les amplitudes plus petites. 
 
         Zoom Secondary In 
 
         Commande du Clavier = [-] 
 
         Augmente la visualisation verticale de l'affichage secondaire en diminuant la taille de l’échelle affichée. 
 
         Zoom Secondary Out 
 
         Commande du Clavier = [+/=] 
 
         Diminue la visualisation verticale de l'affichage secondaire en augmentant la taille de l’échelle affichée. 
 
         Notez que lorsque les option group delay ou unwrapped sont sélectionnées pour l'affichage de Phase du  
         mode Fonction de Transfert, les commandes amplitude range secondaires fonctionnent comme vous  



         pouvez vous y attendre sur l'axe y du tracé de Phase. L'affichage de Phase par défaut est un cas spécial car  
         sa gamme est fixée à 360°. Sur l'affichage de Phase à plat, les commandes move up et move down  
         secondaires déplacent la ligne zéro du tracé vers le haut ou le bas par pas de 45° et les commandes Zoom  
         ne sont pas utilisées (voir Propriétés de l'Affichage de Phase page 117 pour plus d'informations).  
 
 
 
Shift Active Trace 
 
         Menu View > Shift Active Trace 
 

          
 
         Commandes du Clavier : 
         Shift Up = [Ctrl] + [Flèche Haut] 
         Shift Down = [Ctrl] + [Flèche Bas] 
 
         Les commandes Shift Active Trace déplace le tracé du spectre RTA ou fonction de transfert actif vers le  
         haut ou le bas par un pas (spécifié sur l’onglet Graph de la fenêtre de dialogue Options). La position  
         verticale des deux tracés peut être réglée en utilisant la commande dB+/- (voir ci-dessus) qui apparaît à  
         droite du tracé en mode RTA et Fonction de Transfert.  
 
Shift Reference Trace 
 
         Menu View > Shift Reference Trace 
 

          
 
         Commandes du Clavier : 
         Shift Up = [Shift] + [Flèche Haut] 
         Shift Down = [Shift] + [Flèche Bas] 
 
         Les commandes Shift Reference Trace déplace le tracé de référence actif vers le haut ou le bas par un pas  
         (spécifié sur l’onglet Graph de la fenêtre de dialogue Options). Lorsqu’un tracé de référence est le tracé  
         supérieur vous pouvez également ajuster la position verticale en utilisant la commande dB +/- qui apparaît  
         à droite du tracé en mode RTA et Fonction de Transfert. La position verticale de tous les tracés de  
         référence peut également être réglée en utilisant la commande dB +/-. La position verticale de tous les  
         tracés de référence peut aussi être réglée depuis l’onglet General de la fenêtre de dialogue Reference  
         Information. 
 
Cursor  
 

Track Nearest Data Point 
 
         Menu View > Cursor > Track Nearest Data Point 
 
         Commande du Clavier = [Ctrl] + [T] 
 
         Lorsque cette commande est sélectionnée, le curseur passe sur le tracé supérieur (dans tous les modes sauf      
         Spectrographe), et se déplace de point donnée en point de donnée le long du tracé lorsque vouz déplacez le  
         curseur de la souris de gauche à droite. Pour afficher un tracé (ou un bargraphe de spectre) au premier plan  
         (sur l’axe z) en mode RTA, cliquez n’importe où sur le vu-mêtre d’entrée correspondant ou sur le champ  
         Active sous le vu-mêtre d’entrée du canal que vous voulez activer.  
  
         En mode Fonction de Transfert, cliquez sur l’un des vu-mêtres de niveau d’entrée affiche le tracé au  
         premier plan. Pour afficher un tracé de référence au premier plan, cliquez sur le bouton du Registre de  
         Référence correspondant. Cela fonctionne même si le bouton pour ce tracé est déjà enfoncé.  
 



 
 
 
 
Show THD 
 
         Menu View > Cursor > Show THD 
 
         Cette commande est disponible uniquement en mode Spectre lorsque l'échelle de fréquence 1/24 d'octave  
         est sélectionnée. Lorsque Show THD est sélectionné SmaartLive compare la puissance de la bande de 1/24  
         d'octave au niveau du curseur à la somme de la puissance des 9 premiers harmoniques pour cette fréquence  
         et calcule une valeur de Distorsion Harmonique Totale pour la fréquence du curseur. Cette valeur est  
         affichée avec les valeurs de fréquence et de décibels dans le champ de l'Affichage du curseur au-dessus de  
         la zone du tracé principal. Show THD est un interrupteur. Lorsqu'elle est active, sélectionner à nouveau  
         cette commande depuis le menu View > Cursor désactive la fonction Show THD.  
 
Move Cursor  
 
         Menu View > Cursor > Move Cursor  
 
         Commandes du Clavier :  
         Move Left = [Alt] + [Flèche Gauche] 
         Move Right =  [Alt] + [Flèche Droite] 
 
         Lorsque l’option Track Nearest Data Point est activée, les commandes Move Left et Move Right peuvent  
         être utilisées pour déplacer le curseur d’un point de donnée vers la droite ou la gauche (sur  le tracé  
         supérieur). 
 
Quick Zoom  
 
         Menu View > Quick Zoom  
 
         Commande du Clavier = [Ctrl] + [Q] 
 
         Sélectionner la commande Quick Zoom du menu View ou appuyer sur [Ctrl] + [Q] maximise la zone  
         d’affichage des données en enlevant toutes les commandes à l’écran (sauf les commandes de registre de  
         référence) de l’affichage en u clique de souris. Cette fonction est pratique lorsque vous utilisez SmaartLive  
         sur un ordinateur avec un petit écran et/ou lorsque les paramètres d’entrée ont été réglés et que vous désirez  
         avoir une zone de tracé plus large.  
 
 
Device Bar  
 
         Menu View > Device Bar 
 

          
 
         Commande du Clavier = [Ctrl] + [V] 
 
         La Barre d’Appareil de SmaartLive vous donne un accès direct aux appareils externes assignés aux  
         boutons de la barre. La barre d’appareil est située au-dessus du titre de la zone de tracé lorsque vous  
         sélectionnez Device Bar dans le menu View ou que vous cliquez sur le bouton Bar au-dessus du champ de  
         l’appareil sélectionné à droite du tracé. Notez que le nombre de boutons disponibles sur la barre dépend de  
         la résolution de votre écran et de la taille de la fenêtre SmaartLive. Par exemple, avec une résolution 800 x  
         600 et SmaartLive en plein écran, la barre d’appareil sera constituée de cinq boutons. Des tailles plus larges  
         de fenêtre permettront l’utilisation d’un nombre plus important de boutons d’appareil.  
 

          
 



         Vous pouvez assigner un appareil externe configuré à un bouton de la barre d’appareil en cliquant sur le  
         bouton Assign to Device Bar dans la fenêtre de dialogue External Device Information. Lorsque la barre est  
         visible, vous pouvez également assigner un appareil en cliquant un bouton inutilisé avec la souris et en  
         sélectionnant Assign Device to Button dans le menu déroulant. Si vous voulez modifier l’assignation d’un  
         appareil à un bouton d’appareil, cliquez sur celui-ci et sélectionnez Assign Device to Button dans le menu  
         déroulant. Toutes ces actions ouvriront la fenêtre de dialogue Edit Device Buttons illustrée ci-dessous.  
 

          
  
         Dans la fenêtre de dialogue Edit Device Buttons, sélectionnez le nombre de bouton que vous voulez utiliser  
         dans le champ Button et l’Appareil que vous voulez y assigner. Si vous sélectionnez un appareil multi  
         canal, vous devrez également sélectionner la canal d’entrée ou de sortie que le bouton désignera dans le  
         champ Channel. Le champ Label prendra automatiquement le nom assigné à l’appareil/canal sélectionné  
         dans la configuration de l’appareil mais vous pouvez utiliser un nom différent pour le bouton si vous le  
         désirez. Modifier le nom du bouton n’affectera pas le nom assigné dans la configuration de l’appareil.  
 
         Pour enlever un appareil d’un bouton d’appareil, faites un clique droit sur le bouton et sélectionnez Remove  
         Device From Button dans le menu déroulant. Pour enlever tous les appareils de tous les boutons  
         d’appareils, faites un clique droit sur l’un des boutons de la Barre d’Appareil et sélectionnez Clear All  
         Devices Buttons dans le menu déroulant.  
 
Input Bar  
 
         Menu View > Input Bar  
 

          
 
         Lorsque cette option est sélectionnée, un ensemble de commandes auquel on se réfère comme Barre  
         d’Entrée apparaîtra immédiatement sous la zone de tracé dans les quatre modes d’affichage. Ces  
         commandes fournissent des informations à propos des paramètres d’entrée actuels de l’analyseur et vous  
         permettent de faire des modifications. Notez que la Barre d’Entrée peut uniquement être cachée dans les  
         modes de mesures en temps réel. La Barre d’Entrée du mode Impulse (voir ci-dessous) est toujours visible,  
         quelque soit l’état de Input Bar dans le menu View.  
  

          
 
         Cliquer sur l’un des champs de la Barre d’Entrée dans tous les modes opérationnels ouvrira un menu  
         déroulant ou une fenêtre de dialogue vous permettant d’ajuster les valeurs des paramètres d’entrée associés.  
         Notez que la plupart de ces paramètres peuvent également être réglés depuis les onglets Inputs et Locator  
         de la fenêtre de dialogue Options, en fonction du type de mesure.  
    
         Dans tous les modes d’affichage en temps réel (RTA, Fonction de Transfert et Spectrographe), la Barre  
         d’Entrée est composée des éléments suivants : 
 
         Sampling Rate Selector – A chauqe fois que vous démarrez SmaartLive ou que vous modifiez la sélection  
         de votre appareil Wave-IN, le programme vérifie le hardxare son de votre ordinateur afin de détecter les  
         fréquences d’échantillonnage supportées par le hardware et les place dans le menu Sampling Rate (SR)  



         selector. 
 
         FFT Size Selector – Le menu déroulant FFT selector vous permet de sélectionner une taille d’image FFT  
         de 128 à 32 k échantillons en mode Fonction de Transfert, RTA et Spectrographe, ou 128 à 512 k en mode  
         Impulse. 
 
         Time Constant – La constante temporelle, ou fenêtre temporelle d’un FFT est une fonction de la taiile FFT  
         et de la fréquence d’échantillonnage. SmaartLive calcule automatiquement la constante temporelle en  
         fonction de la taille FFT et de la Fréquence d’Echantillonnage actuellement sélectionnées et l’affiche dans  
         le champ TC. Cliquer sur ce champ affichera un menu listant la taille des fenêtres temporelles pour chacune  
         des tailles FFT disponibles, en fonction de la fréquence d’échantillonnage actuelle. Sélectionner  
         directement la constante temporelle depuis ce menu réglera automatiquement la taille FFT associée dans le  
         champ FFT. 
 
         Frequency Resolution – Comme la constante temporelle FFT, la résolution de fréquence d’un FFT est  
         également une fonction de la taille FFT et de la fréquence d’échantillonnage. SmaartLive calcule  
         automatiquement la résolution de la fréquence en fonction de la taille FFT et de la fréquence  
         d’échantillonnage actuellement sélectionnées et l’affiche dans le champ FR. Cliquer sur ce champ affichera  
         un menu listant la résolution de fréquence pour chacune des tailles FFT disponibles, en fonction de la  
         fréquence d’échantillonnage actuelle. Sélectionner directement la résolution de fréquence depuis ce menu  
         réglera automatiquement la taille FFT associée dans le champ FFT. 
    
 
Commandes du Menu External Devices 
 
         Notez que la plupart des fonctions de ce menu ne sont disponibles que lorsque SmaartLive est en mode   
         Fonction de Transfert et que External Device Mode est sélectionné (voir ci-dessous). 
 
Devices 
 
         Menu External Devices  > Devices 
 

          
 
         Le menu déroulant Devices du menu External Devices vous permet de sélectionner n’importe quel  
         appareil/canal externe comme appareil télécommandé. La commande Configure du menu déroulant  
         Devices ouvre la fenêtre de dialogue External Devices Information vous permettant d’ajouter/modifier les  
         définitions d’appareil externe de SmaartLive.  
    
         Le menu déroulant Devices est pratiquement identique au menu déroulant qui apparaît lorsque vous cliquez  
         sur le champ Ext. Device (voir ci-dessus) qui apparaît à droite du tracé dans tous les modes d’affichage de  
         SmaartLive (à moins que Quick Zoom soit sélectionné dans le menu View). 
  
External Device Mode  
 
         Menu External Devices > External Device Mode  
 
         Commande du Clavier = [X] 
 
         Cette commande active le mode External Device de SmaartLive. Le panneau de contrôle pour l’appareil  
         externe sélectionné apparaîtra et en mode Fonction de Transfert, un ensemble de marqueurs de filtre  
         apparaîtra sur la tracé. La composition du panneau de contrôle variera en fonction du type et du modèle de  
         l’appareil sélectionné. Certains contrôles sont spécifiques à l’appareil et seront uniquement accessibles  
         depuis le panneau de contrôle. Les commandes suivantes agissent uniquement sur les marqueurs de filtre  
         affichés sur le tracé.  
    

• En mode External Device, appuyer sur la touche [Shift] et cliquer sur le tracé Fonction de Transfert 
avec le bouton gauche créera un marqueur et place un nouveau filtre à l’emplacement du curseur de la 



souris ou déplace le filtre inutilisé la plus proche sur la position du curseur (en fonction du type 
d’appareil).  

• Pour sélectionner un filtre existant en mode External Device, cliquez sur son marqueur avec le bouton 
gauche. Lorsqu’un filtre est sélectionné, le centre du marqueur devient plein et la fréquence centrale 
(Hz) du filtre, la bande passante (Oct) et la valeur d’augmentation/diminution (dB) sont indiquées dans 
les trois champs d’édition supérieures du panneau de contrôle. Une valeur négative dans le champ dB 
indique un filtre de diminution.  

• Pour ajuster la fréquence centrale et la valeur d’augmentation/diminution d’un filtre, cliquez sur son 
marqueur et maintenez le bouton enfoncé en « tirant » le marqueur vers une autre position.  

 
Vous pouvez également modifié ces paramètres ainsi que la largeur de bande du filtre en utilisant les 
flèches du clavier, les commandes correspondantes sur le panneau de contrôle de l’appareil externe ou en 
tapant une nouvelle valeur dans l’un des trois champs d’édition. Si les valeurs de fréquence centrale, de 
largeur de bande et d’augmentation/diminution de l’appareil externe sont réglées par pas, les valeurs que 
vous spécifierez pourront être ajuster légèrement par SmaartLive lors de la mise à jour des paramètres de 
filtre. 

 
Select Next/Previous Filter  
 
         Menu External Devices > Select Next/Previous Filter 
 
         Commandes du Clavier = [Tab] (next) ou [Shift] + [Tab] (previous) 
 
         Les commandes Select Next Filter et Select Previous Filter permettent de naviguer sur les différents filtres  
         disponibles sur l’appareil externe de façon ascendante (next) ou descendante (previous). Notez que l’ordre  
         de navigation suit le numéro des filtres, qui n’est pas nécessairement l’ordre des fréquences.    
  
         La fréquence centrale (Hz), la largeur de bande (Oct) et la valeur d’augmentation/diminution (dB) du filtre  
         sélectionné, ainsi que le numéro du filtre et du canal, sont indiqués dans la partie supérieure du panneau de  
         contrôle de l’appareil externe.  
 
  Raccourci de la Souris : Pour sélectionner un filtre spécifique, cliquez simplement sur son marqueur sur le  
         tracé de Fonction de Transfert avec le bouton gauche. Les filtres non sélectionnés sont vides (comme à  
         gauche sur l’illustration). Le marqueur du filtre sélectionné aura un centre en couleur.  
 
Flatten Selected Filter 
 
         Menu External Devices > Flatten Selected Filter 
 
         Commande du Clavier = [Delete] (ou [Del]) 
 
         La commande Flatten Selected Filter remet le filtre sélectionné sur l’unité d’EQ externe sur une  
         augmentation/diminution de 0dB. Notez que sur certains appareils, un filtre plat est considéré non assigné  
         et pourra disparaître complètement du tracé de mode Fonction de Transfert.  
   
 
Increase/Decrease Frequency 
 
         Menu External Devices > Increase/Decrease Frequency 
 
         Commandes du Clavier :  
         Increase = [Flèche Droite] 
         Decrease = [Flèche Gauche] 
 
         Les commandes Increase Frequency et Decrease Frequency du menu External Devices augmente et  
         diminue la fréquence centrale du filtre actuellement sélectionné sur l’appareil télécommandé.  
          



Raccourci de la Souris : Vous pouvez également ajuster la fréquence centrale et la valeur 
d’augmentation/diminution d’un filtre en cliquant sur son marqueur et maintenez le bouton enfoncé en 
« tirant » le marqueur vers une autre position.  

 
Increase/Decrease Boost 
 
         Menu External Devices > Increase/Decrease Boost 
 
         Commandes du Clavier :  
         Increase = [Flèche Haut] 
         Decrease = [Flèche Bas] 
 
         Les commandes Increase Boost et Decrease Boost du menu External Devices augmente et  
         diminue la valeur d’augmentation/diminution du filtre actuellement sélectionné sur l’appareil  
         télécommandé.  
 
         Raccourci de la Souris : Vous pouvez également ajuster la fréquence centrale et la valeur  
         d’augmentation/diminution d’un filtre en cliquant sur son marqueur et maintenez le bouton enfoncé en  
         « tirant » le marqueur vers une autre position. 
 
Increase/Decrease Width 
 
         Menu External Devices > Increase/Decrease Width 
 
         Commandes du Clavier :  
         Increase = [Shift] + [Flèche Haut] 
         Decrease = [Shift] + [Flèche Bas] 
 
         Les commandes Increase Width et Decrease Width du menu External Devices augmente et  
         diminue la valeur de largeur de bande du filtre actuellement sélectionné sur l’appareil télécommandé. 
 
 
Commandes du Menu Options  
 
All 
 
         Menu Options > All 
 
         Commande du Clavier = [Alt] + [O] 
 
         La commande All du menu Options ouvre la fenêtre de dialogue Options avec le dernier onglet utilisé au  
         premier plan (tous les onglets peuvent être sélectionnés à chaque fois que la fenêtre de dialogue Options est  
         ouverte). Cette fenêtre de dialogue vous donne accès à pratiquement toutes les options et propriétés  
         réglables par l’utilisateur de SmaartLive depuis un seul emplacement.  
 
          La fenêtre de dialogue options est organisée en 9 pages séparées pour les différents types de paramètres.   
         Nous appelons ces pages des onglets car chacune d’elle à un onglet d’index qui est toujours visible dans la  
         partie supérieure de la fenêtre de dialogue. Sélectionner une des commandes du menu Options ouvrira (sauf  
         pour les commandes All, External Devices, System Presets et Volume Control) la fenêtre de dialogue  
         options avec la page sélectionnée au premier plan. Pour ouvrir une autre page lorsque la fenêtre de dialogue  
         est ouverte, cliquez simplement sur son onglet. 
 
Color  
 
         Menu Options > Color 
 
         SmaartLive vous permet également de régler les couleurs de pratiquement tous les éléments de l’écran et    
         même d’utiliser vos propres fichiers bitmap comme fond. Les options de couleur et de fond sont chargées  
         en tant qu’ensembles appelés Colour Schemes. Plusieurs ensembles de couleurs prêt à l’utilisation (dont  
         deux avec des fonds métalliques) sont inclus avec le programme et vous pouvez facilement définir le votre.  



         L’onglet Colors de la fenêtre de dialogue Options vous permet de créer, éditer et gérer les Colors Schemes  
         de l’affichage de SmaartLive. Notez que des Ensembles de Couleurs séparés peuvent être sélectionnés pour  
         l’affichage et l’impression.  
 
         La section Color Schemes de l’onglet Colors possède une liste de tous les Ensembles de Couleurs ainsi que  
         des boutons pour créer, éditer et effacer les ensembles définis par l’utilisateur et une liste permettant de  
         sélectionner les Ensembles de Couleurs pour l’affichage et l’impression. 
  

          
 
         Cliquer sur le bouton New ouvre une fenêtre de dialogue Editor Color Scheme, vous permettant de créer un  
         nouvel ensemble de couleur. Dans cette fenêtre de dialogue, vous pouvez modifier les couleurs de  
         différents affichages d’éléments et choisir un fichier bitmap (.bmp) à utiliser comme fond pour le  
         programme. Les sélections de couleurs indiquées dans la fenêtre de dialogue pour chaque élément sont  
         basées sur l’Ensemble de Couleur actuellement sélectionné dans la liste. Cliquetr sur l’un des carrés de  
         couleur ouvre une fenêtre de dialogue Couleur standard vous permettant de choisir une couleur standard ou  
         de spécifier une couleur à utiliser pour l’élément sélectionné.  
 

          
 
         Le bouton Edit ouvre une fenêtre de dialogue Edit Color Scheme vous permettant d’éditer un Ensemble de  
         Couleur existant (réglé par l’utilisateur) sélectionné dans la liste Color Schemes. 
   

          
 
         Cliquer sur ce bouton efface l’Ensemble de Couleur sélectionné dans la liste Color Schemes.  
 
         Sous la section Color Schemes se trouve deux listes déroulantes : 
 

• Display Color Scheme – Sélectionne un Ensemble de Couleur existant à utiliser pour l’affichage (les 
couleurs affichées sur votre écran).  

• Printing Color Scheme – Sélectionne un Ensemble de Couleur existant pour l’utilisation lors de 
l’impression depuis SmaartLive.  

 
Delay 
 
         Menu Options > Delay  
 
         Commande du Clavier = [Alt] + [D] 
 
         L’onglet Delay de la fenêtre de dialogue Options est utilisé pour configurer le délai interne et les registres  
         de preset de délai de SmaartLive. 
 
         Delay Time 
 
         Spécifie la quantité de délai (jusqu’à 750 millisecondes par pas de 1/100 milliseconde) à appliquer au  
         signal sur l’entrée sélectionnée. Ce Temps de Délai est indépendant des Delay Presets ([F6] – [F10]).  
         Garder à l’esprit qu’une valeur de Temps de Délai non sauvegardé sur un preset sera perdue si l’un des  
         presets est sélectionné ensuite (puisque la valeur du preset devient la valeur du temps de délai actuelle). Le  
         bouton Clear (F5) à gauche du champ Delay Time remet la valeur du Temps de Délai actuel sur 0  
         (milliseconde). 
 
 
         Channel  
 

• Left (0) – Applique le Temps de Délai spécifié sur l’entrée Gauche (canal 0) 
• Right (1) – Applique le Temps de Délai spécifié sur l’entrée Droite (canal 1) 
 



Assign Time to Preset 
 
Le délai interne peut enregistrer cinq valeurs. Ces Presets de Délai (à ne pas confondre avec les Pesets 
Systèmes) sont réglables par l’utilisateur. Les valeurs de Preset sont assignées aux touches de Fonction 
[F6] – [F10] (la touche [F5] remet le Temps du Délai à 0). Pour assigner le Temps de Délai actuel à une 
touche de Preset, cliquez simplement sur l’un des cinq boutons nommés F6 – F10. La valeur indiquée dans 
le champ du Temps de Délai remplacera alors le contenu du registre de Prset sélectionné.  
 

Presets 
 
Les cinq registres de Preset affichent les valeurs de temps de délai actuellement enregistrées comme 
Presets. Ces champs de Preset peuvent être édités directement ou on peut leur assigner la valeur de Temps 
de Délai actuelle en cliquant sur le bouton Assign Time to Preset correspondant.  
 

Delay Spinner Increment 
 
Le champ Delay Spinner Increment règle le pas par lequel la commande modifie le temps de délai actuel. 
Les valeurs disponibles vont de 0.01 à 100 millisecondes par pas de 0.01 milliseconde. 
 

 
 
Lorsque vous quittez la fenêtre de dialogue Options après avoir modifié les paramètres du délai, la valeur 
de Temps de Délai spécifiée est affichée dans le champ Delay qui apparaît sous les vu-mêtres de niveau 
d’entrée. Les boutons de la commande (haut/bas) à gauche de l’affichage du délai peuvent être utilisés 
pour modifier la valeur du temps de délai actuel par un paas spécifié dans le champ Delay spinner 
Increment (voir ci-dessus). 
 

 
Devices  
 
         Menu Options > Devices  
 
         Si votre ordinateur dispose de plusieurs cartes son et/ou interfaces MIDI, l’onglet Device du Options vous  
         permet de sélectionner lequel SmaartLive doit utiliser.  
     

• Wave In – Sélectionne le matériel à utiliser pour l’entrée audio.  
• Wave Out – Sélectionne le matériel à utiliser pour la sortie audio depuis le générateur de signal interne.  
• MIDI In – Sélectionne le matériel à utiliser pour recevoir les données MIDI.  
• MIDI Out – Sélectionne le matériel à utiliser pour envoyer les données MIDI.  
 
Certaines options supplémentaires apparaissent sous les champs de sélection du matériel qui affecte l’action 
du matériel Wave In sélectionné avec SmaartLive.  
 
• Wave In/Wave Out Bits per Sample – Règle la résolution de l’échantillonnage pour le matériel Wave 

In sélectionné.  
 
En raison des limites de Windows, SmaartLive ne peut pas détecter automatiquement la résolution 
d’échantillonnage des convertisseurs A/N et N/A si elle est supérieure à 16 bits. La plupart des hardware 
son utilise une résolution de 8 à 16 bits par échantillon. Donc à moins que vous n’utilisiez une carte son 
haut de gamme ou un appareil numérique d’entrée avec un convertisseur N/A externe, vous n’aurz pas à 
vous préoccuper de ce paramètre. Si votre hardware son est capable d’avoir une résolution 
d’échantillonnage de plus de 16 bits par échantillons, vous devrez donner à SmaartLive la résolution 
d’échantillonnage des appareils Wave In et Wave Out sélectionnés en sélectionnant le nombre approprié de 
bits par échantillon dans la liste déroulante. 
 



• Advanced Settings – Cliquer sur le bouton Advanced de l'onglet Devices ouvre une deuxième fenêtre 
de dialogue vous permettant de sélectionner les fréquences d'échantillonnage et les résolutions que 
SmaartLive recherche lors de l'ouverture d'un appareil. Si le pilote de votre périphérique d'entrée 
supporte la conversion de la fréquence d'échantillonnage comme le font la plupart d'entre eux, 
l'appareil signalera toujours que ces fréquences et ces résolutions sont supportées.  

 
Donc si par exemple, vous utilisez un périphérique 16 bit, vous pourrez désactivez les cases 18-24 dans 
les sections Input Bits et Output Bits afin d'éviter que ces options n'apparaissent dans les listes Wave in 
et wave Out per Sample. Vous pourrez également enlever certaines options de fréquence 
d'échantillonnage pour raccourcir les listes de fréquence d'échantillonnage dans SmaartLive ou pour 
ajouter 96k comme option si votre périphérique d'entrée le supporte. Vous pouvez également spécifier 
une fréquence d'échantillonnage personnelle dans le champ Other. Notez que la conversion de 
fréquence d'échantillonnage fonctionne très bien dans la plupart des cas, en supposant que la 
commande de conversion de fréquence d'échantillonnagede votre périphérique d'entrée soit réglée sur 
le paramètre de qualité maximum dans le panneau de configuration Multimédia ou Son et Multimédia 
de Windows.  
  

• Slow Computer – Sélectionner cette option oblige l’ordinateur à vérifier plus souvent l’interface 
utilisateur et peut améliorer la réponse globale de l’interface sur des machines plus lentes. Mais cela 
peut également réduire la vitesse de mise à jour de l’affichage.  

• Close Wave In On Reset – Cette option permet de contourner un problème rencontrer sur certaines 
cartes son. Vous devez cocher cette case uniquement si vous rencontrez des problèmes lors de la 
réception de données audio après avoir changer de mode d’affichage ou de paramètres d’entrée. 
SmaartLive ne ferme normalement pas la carte son lors d’une remise à zéro des paramètres Wave In. 
Dans la plupart des cas, cela ne pose aucun problème et évite les « pops » ou les interruptions des 
signaux test générés internement lorsque les paramètres de l’appareil Wave In sont modifiés. Nous 
avons, toutefois, rencontrés quelques pilotes de carte son qui  pourront effectuer cette opération 
proprement uniquement lorsque le pilote est fermé puis rouvert. 

• Use Old Wave Format – Cette option est incluse afin de fournir une compatibilité pour les pilotes de 
périphériques audio quui ne supportent pas correctement les formats audio API de Windows apparus 
sur Windows 98SE et doit normalement être désactivée à moins que vous n'ayez un problème avec 
votre périphérique d'entrée. Lorsque vous utilisez Windows 98SE, ME, 2000 ou XP SmaartLive utilise 
normalement les formats API les plus courants pour accéder aux périphériques audio d'entrée et de 
sortie. Dans certains cas l'utilisation de formats API plus récents peut entrainer le mauvais 
fonctionnement du périphérique d'entrée, particulièrement avec du matériel ancien et certains 
périphériques 16 bit plus récents. Cocher la case Use Old wave Format devrait corriger le problème 
lorsque tel est le cas. Notez que cela limitera également les résolutions d'échantillonnages disponibles à 
16 bits sous Windows 98SE, ME, 2000 et XP.   

• Receive MIDI Program Changes on Channel – Cette option vous permet de rappeler les Presets 
Systèmes de SmaartLive à distance en utilisant un autre ordinateur ou un appareil qui peut envoyer des 
changements de programme MIDI. Lorsque cette case est cochée, SmaartLive « écoutera » les 
changements de programme MIDI sur le canal MIDI spécifié dans le champ à droite. Lorsqu’un 
changement de programme est reçu, le Preset Système correspondant au numéro de programme MIDI 
sera automatiquement chargé.  

 
Graph  
 
         Menu Options > Graph  
 
         Commande du Clavier = [Alt] + [G] 
 
         Title 
 
         Ce champ est utilisé pour entrer un texte pour le titre du graphique affiché sur la zone de tracé.  
 
         Y-Range 
 
         Les deux champs de texte de la section Y-Range règlent la gamme des tracés des modes RTA et Fonction  
         de Transfert, en fonction du mode activé au moment de l’ouverture de la fenêtre de dialogue.  
   



• (RTA or Transfer) Min. – Règle le bas (en décibels) de la gamme d’amplitude affichée (axe y) sur le 
tracé (RTA ou Fonction de Transfert).  

• (RTA or Function) Max. – Règle le haut ( en décibels) de la gamme d’amplitude affichée (axe y) sur 
le tracé (RTA ou Fonction de Transfert). 

 
Note : la gamme de l’axe y des tracés en mode RTA et Fonction de Transfert peut également être modifiée 
en utilisant les raccourcis clavier Amplitude Range ou les commandes du menu (disponible depuis le menu 
View). 
 
Phase Y-Range 
 
Les deux champs de texte de la section Phase Y-Range peuvent être utilisés pour régler la gamme vertical 
(axe y) de l’affichage de phase non réduit (uniquement) si la case Unwrap est cochée. Notez que le fait de 
cocher la case Unwrap a le même effet que de sélectionner la commande Unwrap dans la section Phase 
Range du menu View.  
 

 
Move Increment 
 
• Y +/- -- spécifie l’influence des commandes Shift Active Trace et Shift Reference Trace (et la 

commande dB+/- qui apparaît à droite du tracé en modes RTA et Fonction de Transfert) lors de la 
modification du décalage verticale des tracés. 

• RTA Zoom – spécifie l’influence des commandes Amplitude Range du clavier et du menu (disponibles 
depuis le menu View) sur la modification de l’échelle et de la gamme de l’axe vertical (y) sur le tracé 
en mode RTA.  

• Transfer Zoom – spécifie l’influence des commandes Amplitude Range du clavier et du menu 
(disponibles depuis le menu View) sur la modification de l’échelle et de la gamme de l’axe vertical (y) 
sur la tracé en mode Fonction de Transfert. 

 
Options Supplémentaires  
 
• Show Piano in Note ID mode – Si cette case est cochée, SmaartLive affichera l’image du clavier du 

piano sous le tracé du mode Fonction de Transfert et RTA lorsque Note ID est activé. Le clavier du 
piano a une position et une taille qui font que le curseur Note ID pointera sur la touche correspondante 
du clavier lorsque le curseur de la souris est dans une gamme de 16Hz à 5kHz.  

• Show Noise Criterion Curves – Cocher cette case affiche les courbes standards de Noise Criterion 
(NC) sur le tracé du mode RTA mais n’affiche pas le tracé spécial Noise Criterion Mode que vous 
obtenez lorsque vous sélectionnez la commande Noise Criterion Mode dans le menu Control. Veuillez 
noter que les mesures NC ne sont valides que lorsque SmaartLive est calibré en SPL et que 
puisque les courbes NC se trouvent toutes dans la gamme +8 à +80dB, elles ne sont vivibles que 
lorsque l’affichage est calibré en SPL.  

• Clear Reference Comment After Capturing – Lors de la capture d’un nouveau tracé de référence sur 
un registre contenant un tracé, tout commentaire existant sera effacé si cette option est activée. Lorsque 
cette case n’est pas cochée, capturer un nouveau tracé de référence par dessus un ancien laisse le 
commentaire existant en place mais met en surbrillance tout le commentaire afin qu’il soit 
immédiatement effacé si vous tapez quelque chose.  

• Show Phase as Group Delay – Cette option a le même effet que la commande Show Phase as Group 
Delay de la section Phase Display Properties du menu Transfer Function. Lorsqu'elle est sélectionnée, 
l'affichage de Phase du mode Fonction de Transfert affiche la phase comme une dérivation du groupe 
de délai minimum (en degrés). Notez que cette option à tendance à mieux fonctionner lorsque les 
données entrantes sont très précises et elle est donc plus appropriée aux mesures électroniques qu'aux 
mesures acoustiques.   

• Allow Narrowband RTA – Lorsque cette case est cochée, deux options supplémentaires (Log et Lin) 
apparaîtront sur la commande Scale en mode RTA. Sélectionner l’une des deux options affichera les 
données FFT de chaque tracé point par point (avec une échelle de fréquence logarithmique ou linéaire) 
plutôt qu’un bargraphe par octave ou par fraction d’octave.  

• Have Cursor Track Trace – Lorsque cette option est sélectionnée, le curseur passe sur le tracé 
supérieur (dans tous les modes d’affichage sauf le Spectrographe), et se déplace de point en point le 



long du tracé lorsque vous bougez le curseur de gauche à droite. Notez que cocher cette case a le même 
effet que sélectionner la commande Track Nearest Data Point dans la section Cursor du menu View. 

• Quarter Height Coherence – cette option réduit la hauteur du Tracé de Cohérence du mode Fonction 
de Transfert afin d'utiliser uniquement le quart supérieur du graphique de Magnitude plutôt que toute la 
moitié supérieure du Graphique.   

 
Bars 
 
Les options suivantes contrôlent comment les données sont affichées sur les bargraphes d’octave et de 
fraction d’octave en mode RTA.  
 
• Outline – Cette option affiche seulement le contour des barres en mode RTA. Les barres sont moins 

faciles à voir que les barres remplies ou en 3D mais vous permettent de visualiser les valeurs de 
magnitude des deux canaux simultanément. 

• Solid – Les barres de données RTA sont affichées comme des rectangles remplis lorsque cette case est 
cochée  

• 3D – Sélectionner cette ajoute des surbrillances et des ombres aux barres de données pour leur donner 
une apparence 3D.  

 
Impulse/Locator  
 
         Menu Options > Locator  
 
         Commande du Clavier = [Alt] + [L] 
 
         L’onglet Locator de la fenêtre de dialogue Options contrôle les paramètres associéés aux fonctions du  
         mode Impulse et du localisateur de délai automatique.  
    
         FFT Options  
 
         Les commandes de la section FFT Options règlent les paramèttres d’entrée pour les presets de fenêtre  
         temporelle Small et Large utilisés dans les mesures Auto Delay Locator et Impulse mode (réponse  
         d’impulsion). Les boutons Small et Large définissent l’action des autres commandes de la section afin  
         qu’un ensemble de commandes puisse être utilisé pour régler les paramètres des deux presets de fenêtre  
         temporelle. 
 

• Auto Small – Sélectionner le bouton Small règle l’action des autres commandes de la section FFT 
Options afin qu’ils s’appliquent au preset de fenêtre temporelle Small.  

• Auto Large – Sélectionner ce bouton règle l’action des autres commandes de la section FFT Options 
afin qu’ils s’appliquent au preset de fenêtre temporelle Large.  

• Impulse Mode – Sélectionner ce bouton règle le focus du reste des commandes de la section FFT 
Options sur les mesures du mode Impulse. Notez qu'en mode Impulse, ces paramètres peuvent 
également être réglés en utilisant les commandes à l'écran (voir Paramètres de Mesure du Mode 
Impulse page 39 pour plus de détails).  

• Averages – Le nombre d’images FFT à enregistrer. Lorsqu’une valeur supérieure à 1 est spécifiée, 
l’enregistreur d’impulsion collecte et traite le nombre d’images spécifiées puis fait une moyenne des 
résultats. La raison principale de cette technique est la réjection du bruit – chaque fois que le nombre 
de points de moyenne est doublé le rapport signal sur bruit de la mesure augmente de 3dB (jusqu’au 
niveau de bruit maximum du système à tester ou du système de mesure, quelque soit le plus élevé).  

• FFT (size) – Le nombre d’échantillons à collecter depuis les entrées de la carte son pour l’utilisation 
dans les calculs FFT.  

• Overlap – Régler cette valeur sur un nombre supérieur à zéro entraîne l’enregistreur d’impulsion à 
utiliser le recouvrement, plutôt que les données contigües du domaine temporelle pour calculer 
plusieurs FFT. C’est particulièrement utile pour les mesures où vous avez besoin d’utiliser une grande 
taille FFT et/ou un grand nombre de moyennes car cela réduit grandement le nombre d’échantillons 
nécessaires et donc le temps nécessaire pour collecter les données sans augmenter la composante de 
bruit de la mesure.  

• Sampling rate – Cette valeur, spécifiée en échantillons par seconde, détermine la fréquence de la 
mesure de réponse d’impulsion. Pour des mesures pleine bande vous devrez utiliser une fréquence 



d’échantillonnage de 44.1 k ou plus car la plus haute fréquence atteinte dans la mesure sera égale à la 
moitié de la fréquence d’échantillonnage utilisée (la fréquence de Nyquist). 

• FFT Time Constant – La constante temporelle FFR est la fenêtre temporelle de la mesure. Cette 
valeur, donnée en millisecondes, ne peut pas être éditée directement puisqu’elle varie en fonction de la 
taille FFT et de la fréquence d’échantillonnage sélectionnée. Pour obtenir une mesure de réponse 
d’impulsion fiable, la valeur indiquée doit être large par rapport au temps de « decay » du 
système à tester.  

 
Cursor Units  

 
SmaartLive affiche les valeurs de temps de délai en unités temporelle et de distance. La sélection Cursor 
Units si la distance équivalente aux valeurs de temps est donnée en pieds ou en mètres.  
 

Temperature Units  
 
Etant donné que la température est un des facteurs qui affecte la vitesse du son, SmaartLive vous permet de 
régler sa Vitesse du Son interne, utilisée pour calculer les distances équivalentes pour les temps de délai, 
en utilisant la température ou les pieds/mêtres par seconde. Cette section règle simplement le type d'unité 
pour la température, Fahrenheit ou Celsius. 
  

Speed Of Sound 
 
Ce champ règle la valeur que SmaartLive utilise pour calculer la distance équivalente aux valeurs de temps 
qui apparaît sur l’affichage du curseur du mode Impulse et sur l’affichage du délai interne. La valeur par 
défaut utilisée pour la Vitesse du Son est 1120 pieds par seconde ou 341.35 mètres par seconde (en 
fonction de l’unité sélectionnée dans la section Cursor Units). 

 
Delay  
 
         L’une des erreurs les plus fréquentes associée avec les mesures de réponse d’impulsion dans les premières  
         versions de SIA-Smaart était d’oublier de remettre le délai interne à zéro lors d’une nouvelle mesure. Ce  
         problème peut être rencontré même par les utilisateurs les plus expérimentés et donc SmaartLive offre les  
         options suivantes afin d’y remédier. 
 

• Warn if Delay Not 0 – Lorsque cette option est sélectionnée vous recevrez un message 
d’avertissement si vous essayez d’ enregistrer une impulsion avec un délai ayant une valeur différente 
de 0.00ms. Vous aurez l’option de continuer malgré tout, de régler le délai sur zéro et de continuer, ou 
d’annuler la mesure.  

• Always Set Delay To 0 – Si cette option est sélectionnée, le programme réglera automatiquement le 
délai actuel sur 0.00ms (sans vous demander) à chaque fois que vous lancez la routine de 
l’enregistreur d’impulsion pour faire une nouvelle mesure.  

• Don’t Warn, Don’t Set To 0 – Lorsque cette option est sélectionnée le programme ne vérifie pas le 
temps de délai avant de lancer la routine de l’enregistreur ‘impulsion. Que le temps de délai soit à zéro 
ou non, vous ne recevrez pas de message d’avertissement et la paramètre actuel du délai ne sera pas 
modifié.  

 
Options Supplémentaires 
 
• Shift 0 to Show negative time – Lorsque vous répétez les calculs de l’enregistreur d’impulsion après 

avoir réglé le temps de délai, la première moitié de la crête sélectionnée est normalement « déplacée » 
et affichée à la fin du tracé. Activer cette option « déplace » un petit segment de données au début du 
tracé afin de voir la structure entière de la crête en une pièce. Il y une légère baisse du rapport signal 
sur bruit associée avec cette procédure mais pas assez importante pour affecter la plupart des 
applications.  

• Flip Inputs – Sélectionner cette option transpose (intervertit) les deux entrées pour les mesures de 
mode Impulse. L’indication « [Flip] » apparaît dans le coin supérieur droit du tracé du mode Impulse 
lorsque cette fonction est activée pour indiquer que les entrées sont intervertis. Si SmaartLive est en 
mode Impulse et que vous obtenez un tracé avec la plus grande crête à droite du tracé – apparaissant 
pour indiquer un temps de délai incroyablement long – sélectionner cette option et recommencer 
l’enregistrement d’impulsion pourra corriger le problème. 



• Locate Peak Automatically – Lorsque cette option est sélectionnée, SmaartLive règle 
automatiquement sont Locked Cursor sur la crête la plus haute trouvée dans la réponse d'impulsion 
dès qu'une mesure est terminée. La crête la plus haute de l'impulsion correspondera en général à la 
propagation totale du délai à travers le système en test, cette fonction est donc pratique pour localiser 
les temps de délai. Cette option est activée par défaut.  

• Use Data Window for Asynchronous Stimuli – Lorsque cette option est sélectionnée SmaartLive 
applique une fenêtre plate sur les données entrantes de la réponse d'impulsion dans le domaine 
temporelle, avant de réaliser les calculs FFT et de Fonction de Transfert. La fonction de Fenêtre de 
Données est utilisée pour minimiser les erreurs liées à l'utilisation d'un stimuli aléatoire lors de 
l'analyse FFT. Notez que cette étape n'est théoriquement pas nécessaire lorsque des signaux 
synchronisés sont utilisés comme stimulus donc SmaartLive désactive la fenêtre de données en modes 
Fonction de Transfert et Impulse lors de l'utilisation du Générateur de Signal Interne avec l'une des 
quatre options de stimulus synchronisés.      

 
Input 
 
         Menu options > Input 
 
         Commande du Clavier = [Alt] + [I] 
 
         L’onglet Input de la fenêtre de dialogue Options vous permet de régler différentes options qui affecte les  
         paramètres d’entrée de SmaartLive pour les trois modes de mesures en temps réel (RTA, Fonction de  
         Transfert et Spectrographe). Notez que la plupart des paramètres de cet onglet sont spécifiques au mode,  
         n’affectant que le mode de mesure actuellement sélectionné et sont également disponibles depuis Input Bar  
         et les commandes à l’écran. Notez également que les paramètres d’entrée du mode Impulse et du  
         localisateur de délai automatique sont réglés séparément sur l’onglet Locator de la fenêtre de dialogue  
         Options. 
 

• SR – Ce champ règle la fréquence d’échantillonnage du mode d’affichage actuel. SmaartLive tentera 
d’établir la liste des fréquences d’échantillonnage disponibles supportées par le programme et par la 
carte son de votre ordinateur.  

• FFT – Cette liste sélectionne la taille de l’image FFT utiliser pour créer les affichages en temps réel 
dans le domaine fréquentiel de l’analyseur. En mode Fonction de Transfert (uniquement) une option 
supplémentaire appelée « FPPO » est disponible pour l’affichage à résolution par octave fixe. 

• (Data) Window – Ce champ règle le type de fenêtre de données utilisé sur les affichages en temps réel 
du domaine fréquentiel. 

• FR (Frequency Resolution) – SmaartLive calcule et affiche automatiquement la résolution de 
fréquence pour la taille FFT sélectionnée à la fréquence d’échantillonnage sélectionnée. La valeur FR 
ne peut pas être éditée directement.  

 
Inputs  

 
Les commandes de cette section affectent l’apparence et le comportement des tracés. Il y a deux ensembles 
de commandes identiques qui vous permettent de spécifier les options pour chacun des tracés en mode 
RTA. Lorsque cette fenêtre de dialogue est ouverte en mode Fonction de Transfert, un seul ensemble de 
commandes est activé et les paramètres sélectionnés ne s’appliqueront qu’au tracé de la Fonction de 
Transfert.  
 
• Label – Les deux champs Label apparaissent uniquement en modes RTA et Spectrographe pour régler 

les noms sur les boutons Show/Hide pour les deux entrées analogiques. Ces boutons apparaissent sous 
les vu-mêtres d’entrée dans la fenêtre principale et sont remplacés par un seul bouton qui combine les 
deux noms des entrées analogiques en mode Fonction de Transfert.  

• Y+/- -- Cette valeur contrôle le décalage vertical du tracé, la déplaçant vers le haut ou le bas sur le 
tracé.  

• Average – Ces champs règlent le nombre de points de moyenne utilisés pour les tracés.  
• Half Life – Cette valeur, spécifiée en secondes, règle la demie vie de la méthode de moyenne 

exponentielle réglable par l'utilisateur. Notez que deux options de moyenne exponentielle 
supplémentaires avec des demies vies fixes sont également disponibles afin de fournir une corrélation 
dans les mesures RTA avec les options d'intégration temporelle des vu-mêtres de niveau standards. 



Notez également que ce champ est activé uniquement lorsque l'option Exp est sélectionnée dans le 
champ Average.   

• Avg Type – Ce champ apparaît uniquement en mode Fonction de Transfert et sélectionne si la 
moyenne RMS ou Vectorielle est utilisée pour les mesures de Fonction de Transfert. 

 
 

Printing 
 
         Menu Options > Printing 
 
         L’onglet Printing de la fenêtre de dialogue Options contrôle l’apparence et le contenu des pages imprimées  
         directement depuis SmaartLive. Il vous permet d’ajouter un texte aux impressions des tracés et des  
         graphiques de SmaartLive. Un maximum de trois lignes de texte peuvent être comprises dans la section  
         Header au dessus du graphique sur la page imprimée. Deux lignes de texte peuvent être ajoutées en bas de  
         la page en plus de la date et du nom de l’utilisateur. Notez que les commentaires attachés aux tracés de  
         référence affichés sur SmaartLive au moment de l’impression (ou de l’aperçu avant impression)  
         apparaîtront immédiatement sous le tracé sur la page imprimée. 
     
         Header  
 

• Title (1, 2 et 3) – Vous pouvez spécifier jusqu’à trois lignes de texte qui apparaîtront dans la section 
d’en-tête en haut des imprimés de SmaartLive. Si l’un de ces trois champs Title est laissé vide, cette 
ligne n’est pas pris en compte sur la page imprimée. 

 
Footer 
 
• Note (1 et 2) – Vous pouvez spécifier jusqu’à deux lignes de texte qui apparaîtront en bas des 

imprimés de SmaartLive. Si l’un des champs Note est laissé vide, cette ligne ne sera pas pris en compte 
sur la page imprimée.  

• Print Today’s Date – Si cette case est cochée, la date actuelle (définie sur votre ordinateur) sera 
insérée dans la zone de titre en haut de l’imprimé. Si vous voulez utiliser une date autre que celle 
indiquée sur votre ordinateur, ne cochez pas cette case et tapez la date désirée sur l’une des lignes Title.  

 
Note : En plus des lignes note et date de la section Footer, les imprimés de SmaartLive comprendront 
également une autre igne avec l’indication « Created by (Nom d’Utilisateur) using SIA Smaart. »Le Nom 
d’Utilisateur sera le nom de l’utilisateur sous lequel cette copie a été enregistré. Cette ligne ne peut pas être 
éditée ou ignorée. 
 
• Show custom print dialog before print and print preview – Lorsque cette case est cochée, sélectionner 

les commandes Print ou Print Preview ouvrira la fenêtre de dialogue Custom Print Information vous 
permet de régler le texte du titre et d’autres options pour l’imprimé avant de réaliser l’opération 
sélectionnée. La fenêtre de dialogue Custom Print Information comprend les mêmes options que 
l’onglet Printing de la fenêtre de dialogue Options. Si vous ne cochez pas cette case, SmaartLive 
n’ouvrira pas la fenêtre de dialogue Custom Print nformation pour les opérations Print et Print 
Preview et exécutera immédiatement la commande sélectionnée. 

 
Spectrograph 
 
         Menu Options > Spectrograph 
 
         Les options suivantes contrôlent l’apparence et le comportement de l’affichage en temps réel du  
         Spectrographe de SmaartLive. 
 
         Y Range 
 
          Min et Max Frequency – Règle la gamme totale de l'axe y du tracé du Spectrographe. Vous pouvez  
         également régler la gamme de fréquence du Spectrographe en utilisant les prestes Frequency Zoom  
         toutefois les touches +/- ont une fonction différentes en mode Spectrographe (voir la note ci-dessus) et les  
         touches Page Up/Page Down n'affectent pas le tracé du Spectrographe.  
   



         
 
         NarrowBand Display Mode  
 
         Les options suivantes traitent uniquement du rendu des données sur le Spectrographe lorsque l'Echelle de     
         Fréquence à bande étroite (Linéaire ou Logarithmique) est sélectionnée en mode Spectre. Ces deux options  
         représentent les deux diffrentes manières de répondre au fait que, pour des tailles FFT typiques, il y a  
         beaucoup plus de pints de données sur les FFT que de pixels sur votre écran.  
 
         Power Averaged – Lorsque cette option est sélectionnée, on fait la moyenne de la puissance de tous les  
         points de données des FFT représentés par chaque rangée de pixels du Spectrographe pour les hautes  
         fréquences. C'est le même processus que pour les bades d'octave et pour les fractions d'octave et cela vous  
         donne un affichage de très haute résolution qui correspond bien à l'audition humaine.  
         Maximum Value – Cette option prend simplement la plus haute magnitude trouvée dans la gamme de  
         points de données FFT représentée par une rangée de pixels su Spectrographe et l'inscrit sur l'affichage.  
         C'est la façon la plus courante de répondre à l'incompatibilité entre la résolution de l'écran et la résolution  
         en fréquence du FFT, cette option fournit donc une meilleur corrélation entre les affichages du  
         Spectrgraphe et RTA lorsque la résolution à bande étroite est sélectionnée.  
      
 

• Frames to show in Spectrograph – Ce champ règle le nombre d’images FFT (barres verticales de 
couleurs) à inclure dans l’affichage du Spectrographe. Avec la taille de l’image FFT et la fréquence 
d’échantillonnage sélectionnées, ce paramètre détermine également la gamme temporelle du tracé du 
Spectrographe.  

 
Colors  
 
• Dynamic Range – Règle la gamme de magnitude de l’affichage du Spectrographe. Toutes les valeurs 

de magnitude de l’affichage du Spectrographe sont données en « dB depuis zéro » donc spécifier une 
gamme de dynamique de 50 donne une gamme de magnitude de 0dB à –50dB. 

• Number – Sélectionne le nombre de couleurs à utiliser sur le tracé du Spectrographe (de 8 à 236 en 
fonction de vos pilotes et de votre hardware d’affichage). Ce paramètre, ainsi que Dynamic Range 
détermine également le nombre de décibels représenté par chaque couleur.  

• Gray – Affiche le tracé du Spectrographe en utilisant des nuances de gris plutôt que des couleurs. 
Cette option est utile pour les affichages monochromes ou l’impression.  

• Min – Sélectionne la couleur utilisée pour représenter les valeurs minimums de magnitude sur le tracé 
du Spectrographe. Cliquer sur les carrés de couleur ouvre une fenêtre de dialogue Couleur standard 
vous permettant de choisir une couleur différente pour les valeurs les plus basses.  

• Max – Sélectionne la couleur utilisée pour représenter les valeurs maximums de magnitude sur le 
tracé du Spectrographe. Cliquer sur les carrés de couleur ouvre une fenêtre de dialogue Couleur 
standard vous permettant de choisir une couleur différente pour les valeurs les plus hautes. 

• Default – Le bouton Default remet la sélection des couleurs Min et Max par défaut. 
 

 
SPL History 
 
         Menu Options > SPL History 
 
         Les options suivantes contrôlent l'apparence et l'attitude de l'affichage en temps réel SPL History de   
         SmaartLive en mode Spectre.  
 
         Y Range 
 
         Min/Max (Dynamic Range) – Règle la gamme de magnitude de l’affichage SPL History. Toutes les  
         valeurs de magnitude de l’affichage du SPL History sont données en « dB depuis zéro » donc spécifier  
         une gamme de dynamique de 50 donne une gamme de magnitude de 0dB à –50dB. 
 
         Display Type  
 



• Solid – Lorsque cette option est sélectionnée, l'affichage SPL History est sous la forme d'un 
histogramme solide.  

• Line Plot – Cette option met l'affichage SPL History sous la forme d'un tracé en ligne.  
  

         Frames to show in Spectrograph – Ce champ règle le nombre d’images FFT (barres verticales de   
         couleurs) à inclure dans l’affichage du Spectrographe. Avec la taille de l’image FFT et la fréquence  
         d’échantillonnage sélectionnées, ce paramètre détermine également la gamme temporelle du tracé du  
         Spectrographe. 
 
Zooms 
 
         Menu Options > Zooms  
 
         Commande du Clavier = [Alt] + [Z] 
 
         L’onglet Zoom de la fenêtre de dialogue Options vous permet de spécifier une gamme de fréquence pour  
         chacun des quatre presets Frequency Zooms.  
 
         Zoom 1, 2, 3 et 4 
 

• MIN – Règle la fréquence minimum affichée lorsque le preset de zoom est sélectionné.  
• MAX – Règle la plus haute fréquence à afficher. Entrer le mot « Nyquist » dans ce champ règle 

automatiquement la fréquence MAX sur la plus haute fréquence possible à partir de la fréquence 
d’échantillonnage sélectionnée (Fréquence de Nyquist (Hz.) = Fréquence d’2chantillonnage / 2) 

 
         Link Frequency Range Controls  
 

• Spectrograph Tracks RTA Display – Lorsque cette option est sélectionnée (comme elle l'est, par 
défaut) les gammes de fréquence des affichages RTA et Spectrographe du mode Spectre sont liés 
ensemble de telle façon que la modification de l'un s'applique également à l'autre qu'ils soient affichés 
ensemble ou séparément. Désactiver cette option permet de régler séparément les gammes de 
fréquence des deux graphiques.  

• Transfer Function Phase Track Magnitude – Cette option est identique à celle du dessus mais elle 
lie les gammes de fréquence des affichages de Magnitude et de Phase du mode Fonction de Transfert. 
Cette option est également activée par défaut. Désactiver cette option vous permet de régler 
séparément les gammes de fréquence des graphiques de Magnitude et de Phase du mode Fonction de 
Transfert.  

 
Clock 
 

          
 
         Menu Options > Clock  
 
         Raccourci de la Souris = Cliquer sur l’Affichage de l’Horloge 
 
         Cette commande ouvre la fenêtre de dialogue Clock Options vous permettant de régler les options pour  
         l’affichage d’horloge qui apparaît dans le coin supérieur gauche de SmaartLive. Les options suivantes de  
         l’affichage d’horloge de SmaartLive sont réglables par l’utilisateur : 
 

• Show Current Time – Lorsque cette option est sélectionnée, l’affichage d’horloge fonctionne comme 
une horloge normale, indiquant le temps actuel en fonction de l’horloge de votre ordinateur.  

• Count Down To – Lorsque cette option est sélectionnée, l’horloge fonctionne comme un chronomètre 
indiquant le temps restant avant le temps indiqué dans le champ à droite.  

• Count Up From – Lorsque cette option est sélectionnée, l’horloge indique le temps écoulé depuis le 
temps indiqué dans le champ à droite.  

 
Show 
 



• Seconds – Lorsque cette case est cochée, l’horloge indiquera les secondes en plus des heures et des 
minutes. Notez que cela réduira la taille du texte dans l’affichage d’horloge.  

• 24 Hour – Modifie l’affichage d’horloge sur une horloge de 24 heures (au lieu de 12).  
• AM/PM – Lorsque cette case est sélectionnée, l’horloge par défaut de 12 heures comprendra une 

indication AM ou PM après l’heure. Notez que cela réduira également la taille du texte de l’horloge.  
 
         Time Average/LEQ Setup 
 
         Le bouton Time Average/LEQ Setup en bas de la fenêtre de dialogue Clock Options est juste un raccourci  
         vers la fenêtre de dialogue Time Average/LEQ Setup où vous pouvez accéder aux fonctions de mesure  
         spectrale et de niveau sonore dans le temps.  
   
External Devices  
 
         Menu Options > External Devices  
 

          
 
         Commande du Clavier = [Alt] + [X] 
 
         La commande External Devices du menu Options ouvre le fenêtre de dialogue External Device  
         Information. Cette fenêtre de dialogue vous permet d’ajouter, de configurer ou d’éditer les définition  
         d’appareils pour les égaliseurs les processeurs et autres appareils commandés à distance supportés. 
          
         Liste des Appareils Configurés  
 
         Avant de pouvoir contrôler un appareil externe supporté depuis SmaartLive, vous devez configurer une  
         définition d’appareil pour l’appareil. Les définitions d’appareil sont créées et éditées depuis la fenêtre de  
         dialogue External Device Information. Pour accéder à cette fenêtre de dialogue, sélectionner Devices >  
         Configure dans le menu External Devices ou le menu déroulant du clique droit de la souris ou cliquez sur  
         Ext. Device au-dessus du champ de l’appareil sélectionné (voir ci-dessus) et sélectionnez Configure dans le  
         menu déroulant. 
 
         Ajouter, Enlever et Configurer les Définitions d'Appareil 
 
         Pour ajouter une nouvelle définition, cliquez sur le bouton Add dans la fenêtre de dialogue External Device  
         Information  (voir ci-dessus). Vous serez invité à sélectionner le type d’appareil que vous voulez ajouter  
         depuis la liste actuelle des appareils supportés (basée sur les fichiers « plug-in » présents dans le dossier  
         Devices de votre dossier programme SmaartLive). Après avoir sélectionné le type d’appareil, une fenêtre  
         de dialogue de configuration de l’appareil apparaîtra. Ci vous pourrez entrer un nom d’appareil (ou  
         accepter le nom par défaut assigné) et sélectionnez le port E/S (COM ou LPT) ou le numéro du canal MIDI   
         que vous utiliserez pour communiquer avec cet appareil et l’ID de l’appareil (si nécessaire). 
 
         Une fois la routine du localisateur de délai automatique terminée, une fenêtre de dialogue apparaîtra vous  
         permettant de régler le délai interne pour le canal de référence sur le temps de délai trouvé. Les appareils  
         multi canaux présenteront des options supplémentaires. Lors de la configuration d’un appareil multi canal,  
         un premier nom d’appareil est assigné à l’appareil physique actuel. C’est le nom qui apparaîtra sur le côté  
         gauche de la fenêtre de dialogue External Device Information. Vous devrez également assigner des noms  
         aux canaux et :ou aux modes opérationnels de l’appareil et sélectionnez lequel de ces noms apparaîtra dans  
         les listes des appareils disponibles des menus déroulants de la souris, la section Devices du menu External  
         Devices et la fenêtre de dialogue System Presets.  
      
         Une fois qu’un appareil est configuré, le nom de l’appareil (ou le Premier nom pour les appareils multi  
         canaux) apparaîtra à gauche de la fenêtre de dialogue External Device Information en plus du type  
         d’appareil et de l’assignation du port E/S (Configuration). Un marqueur vert apparaît à gauche de l’appareil  
         actuellement contrôlé. Lorsque vous sélectionnez un nom d’appareil physique dans la liste à gauche, une  
         liste de tous les noms d’appareil associés avec celui-ci ainsi que les numéros des System Presets l’utilisant  
         apparaîtra sur la droite. 
 



         Vous pouvez assigner un appareil mono ou tout canal d’entrée ou de sortie d’un appareil multi canal  
         disponible à un bouton de la Barre d’Appareil en sélectionnant l’appareil dans la liste ou en cliquant sur le  
         bouton Add to Device Bar. La Barre d'Appareil apparaît au-dessus du tracé lorsque vous cliquez sur le  
         bouton Bar au dessus du champ de l’appareil sélectionné à droite du tracé ou que vous sélectionnez Device  
         Bar depuis le menu View. 
 
 
 
 
 
Signal Generator  
 
         Menu Options > Signal Generator 
 

          
 
         Raccourci de la Souris = Cliquer sur la Commande Signal Generator 
 
         Cette commande ouvre la fenêtre de dialogue Options Generate vous permettant de régler les paramètres  
         du générateur de signal interne de SmaartLive. Les commandes du générateur de signal sont très simples  
         mais les options disponibles varieront en fonction du type de signal.  
   

• Le type de signal est sélectionné dans la liste déroulante nommée Signal. Les options disponibles sont 
Pink Noise, Sine wave, Dual Sine (wave) et File Loop.  

• La case Generator On à droite de la liste Signal active ou désactive le générateur.  
• Sélectionner Pink Noise active la commande Level 1 qui règle le niveau de sortie du signal.  
• Sélectionner Sine Wave active également la commande Level 1 ainsi que la commande Freq 1 qui règle 

la fréquence du signal sinus. Vous pouvez taper une fréquence de signal sinus (en Hertz) dans le 
champ Freq 1 puis appuyer sur la touche [Enter] pour confirmer ou utilisez la commande à droite afin 
de faire glisser la fréquence de 20Hz jusqu’à la fréquence de Nyquist de la fréquence 
d’échantillonnage actuelle.  

• Sélectionner Dual Sine comme type e signal active les deux ensembles de contrôle de niveau (Level 1 
et Level 2) et de fréquence (Freq 1 et Freq 2)vous permettant de régler le niveau et la fréquence pour 
chacun des signaux sinus d’un signal de test double sinus indépendamment.  

• Sélectionner File Loop comme type signal active l’entrée de texte File en bas de la fenêtre de dialogue 
Generate Options et le bouton Browse à sa droite. Le bouton Browse ouvre une fenêtre de dialogue 
Ouvrir standard vous permettant de naviguer sur le disque et le dossier contenant le fichier que vous 
voulez utiliser comme signal de test et de l’ouvrir. Vous pouvez également taper l’adresse entière du 
fichier que vous voulez utiliser dans le champ File si vous préférez. L’amplitude et la fréquence d’un 
signal de test en bouclage de fichier sont déterminées par le fichier wave source, donc toutes les 
commandes de niveau et de fréquence sont désactivées lorsque ce type de signal est sélectionné.  

 
 

SPL  
 
         Menu Options > SPL 
 
         Raccourci de la Souris = Cliquer sur l’Affichage du Niveau du Signal/SPL 
 

          
 
         La commande SPL ouvre la fenêtre de dialogue Signal Level/Sound Pressure Level (SPL) Readout. Cette  
         fenêtre de dialogue règle les paramètres et les options de calibrage pour l’Affichage du Niveau du  
         Signal/SPL. Notez que le calibrage de l’Affichage du Niveau du Signal/SPL s’applique également un mode  



         d’affichage RTA de SmaartLive. Notez également que plusieurs de ces options peuvent être réglées depuis  
         l’onglet Inputs de la fenêtre de dialogue Options. 
 

SPL 
 
Les commandes de la section SPL détermine comment les valeurs de niveaudu signal/SPL sont affichées. 
Souvenez-vous que les valeurs SPL de SmaartLive ne seront précises que si l’affichage RTA est 
calibré en SPL.  
 
• Weight – Règle la courbe de pondération (s’il y en a une) utilisée dans les calculs SPL. Les options 

sont A-Weighted, C-Weighted ou Flat (pas de pondération). 
• Speed – Ce paramètre détermine si le SPL est calculé uniquement depuis les données de l’image FFT 

actuelle ou en utilisant une moyenne de quelques unes des dernières images (Slow) en fonction du 
réglage du champ Avg à droite.  

• Calibrate Using Peak – Lorsque vous cliquez sur ce bouton, SmaartLive trouvera automatiquement la 
crête la plus haute sur le spectre en mode RTA et ouvrira une petite fenêtre de dialogue vous 
permettant de spécifier une valeur en décibels pour la crête de magnitude. Cette fonction est utilisée en 
conjonction avec un calibreur de microphone acoustique lors du calibrage de SmaartLive en SPL. Voir 
Calibrer en SPL page 39 pour plus d’information. Notez que le bouton Calibrate Using Peak est 
activé uniquement lorsque SmaartLive est en mode RTA.  

• Full Scale Calibration – Cliquer sur ce bouton remet SmaartLive sur son schéma de calibrage Full 
Scale par défaut. Le calibrage full scale prend en compte la sortie maximum du convertisseur A/N sur 
l’appareil Wave In sélectionné comme le 0dB et donne toutes les autres valeurs de magnitude en dB 
inférieur à zéro.  

 
    
         Peak Hold 

 
• Show Peak In Readout – Lorsque cette case est cochée, la valeur affichée dans l’affichage SPL au-

dessus des vu-mêtres de niveau d’entrée est basée sur l’indicateur du niveau de crête du canal suivit 
pour le SPL, plutôt que par la valeur actuelle du vu-mêtre.  

• Hold Peak For – Spécifie la durée (en secondes) pendant laquelle les indicateurs de niveau de crête 
des vu-mêtres de niveau d’entrée (et l’affichage SPL si Show Peak in Readout est sélectionné) 
maintiennent la dernière crête rencontrée sur les signaux d’entrée. 

         
          Alarmes 1 et 2  
 
         Les commandes de cette section règlent les paramètres pour les deux alarmes SPL réglables par  
         l'utilisateur. Les alarmes de niveau sont utilisées par l'affichage du Niveau du Signal/SPL et par l'affichage  
         Historique SPL du mode Spectrum. Sur l'affichage SPL la couleur du tracé change en fonction de la  
         couleur de l'alarme correspondante lorsque le niveau SPL excède la valeur en dB spécifiée pour chacune  
         des alarmes. De même, l'arrière-plan de l'Affichage SPL change en fonction de la couleur de l'Alarme  
         correspondante si l'une des alarmes de niveau est excédée pour le Durée spécifiée et clignotera lorsque le  
         seuil est dépassé si la case "Blink if Exceeded" pour cette alarme est cochée. 
   
         SPL Log to File 
 
         Les commandes de cette section règlent les paramètres pour le traitement SPL. Notez que des fonctions de  
         niveau sonore et de traitement spectral plus avancées sont disponibles via la fonction Time Average/LEQ.  
         Notez également que l'activation du mode Impulse suspendera temporairement le traitement SPL lorsqu'il  
         est actif, car SmaartLive revient en calibrage Full Scale en mode Impulse.  
   

• Interval – Ce paramètre, spécifié en secondes, règle l'interval auquel le niveau SPL est 
échantillonné sur le fichier.  

• Logging Enabled – Le Traitement SPL est activé lorsque cette case est cochée. Notez qu'un 
fichier de sortie doit également être désigné avant que le traitement ne commence.  

• File – Ce champ est utilisé pour spécifier le fichier de sortie pour le Traitement SPL. Les fichiers 
SPL Log de SmaartLive sont des fichiers texte ASCII qui peuvent être importés dans un 
programme de traitement de texte ou une autre application. Chaque entrée dans le fichier est 



accompagnée d'un temps et d'une date en plus de la valeur en décibel, et les types de pondération 
et d'intégration temporelles utilisés lors de l'échantillonnage de cette entrée.  

   
         Time Average/LEQ Setup 
 
         Le bouton Time Average/LEQ Setup en bas de la fenêtre de dialogue Clock Options est juste un raccourci  
         vers la fenêtre de dialogue Time Average/LEQ Setup à partir de laquelle vous pouvez accéder aux  
         fonctions de mesures des données de niveau sonore et de spectre dans le temps.  
 
System Presets 
 
         Menu Options > System Presets 
 
         Commande du Clavier = [Alt] + [P] 
 
         La commande System Presets du menu Options ouvre une fenêtre de dialogue System Presets vous  
         permettant de sauvegarder, de charger, de rechercher et d’éditer les paramètres de SmaartLive enregistrés  
         sur l’un des 100 System Presets maximum.  
   

• Number – Le sélecteur Number en haut de la fenêtre de dialogue System Presets est utilisé pour 
sélectionner le preset que vous vous voulez visualiser ou éditer. Vous pouvez utiliser les boutons de la 
commande pour naviguer sur les presets enregistrés ou simplement taper le numéro dans le champ et 
appuyer sur la touche [enter] sur vote clavier pour accéder directement au numéro du preset spécifié. 

• Warn Before Loading – Si cette case est cochée, SmaartLive ouvrira un message d’avertissement 
(précaution de sécurité) avant de charger le preset sélectionné.  

• Label – Ce champ est utilisé pour assigner un nom au preset sélectionné. Le nom entré dans ce champ 
apparaîtra dans le champ du titre de SmaartLive lorsque le preset sélectionné est rappelé.  

 
SR/FFT 
 
• Mode – Un System Preset peut enregistrer des paramètres de Fréquence d’Echantillonnage et de FFT 

séparés pour chacun des trois modes de mesure en temps réel. La liste Mode de la section SR/FFT 
règle l’action des commandes SR et FFT immédiatement à sa droite.  

• SR – Sélectionne une fréquence d’échantillonnage définie pour le Mode sélectionné lorsque le Preset 
est rappelé. Sélectionner <Don’t Change> dans ce champ laissera la fréquence d’échantillonnage 
actuelle du mode d’affichage sélectionné telle quelle. 

• FFT – Sélectionne la taille FFT définie pour le Mode sélectionné lorsque le preset est rappelé.  
• Delay Time – Enregistre une valeur de délai définie lorsque le Preset est rappelé.  
• Delay Channel – Sélectionne le canal sur lequel le Temps de Délai spécifié sera appliqué. 
 
Run Mode  
 
SmaartLive passera automatiquement au mode opérationnel sélectionné dans la section Run Mode de la 
fenêtre de dialogue lorsque le preset est rappelé. Notez que le mode Impulse ne peut pas être appelé 
automatiquement depuis un preset.  
 
Spectrum 
 
Si cette option est sélectionnée, le mode Spectre de SmaartLive s'activera lorsque ce Preset est rappelé. De 
plus, vous pouvez sélectionner l'un des trois types d'affichage du mode Spectre (RTA, Spectrographe ou 
Historique SPL) simultanément.  
  
Transfer Function  
 
Les options de la section Transfer Function règle définissent l’état des options du mode d’affichage 
Fonction de Tranfert lorsque le preset est rappelé. Les paramètres de Fonction de Transfert sont 
indépendants de la sélection Run Mode (voir ci-dessus). Si Run mode est réglé sur autre chose que Transfer 
Function, ces paramètres seront en effets si vous passez en mode Fonction de Transfert après avoir rappelé 
le preset. 



 
• Phase – Active l’affichage de Phase du mode Fonction de Transfert.  
• Swapped – Intervertit les canaux d’entrée du mode Fonction de Transfert.  
• Smoothing – Définit l’adoucissement pour le tracé de Fonction de Transfert.  
 
Impulse  
 
Lorsque cette option est sélectionnée, rappelée ce preset activera automatiquement le mode Impulse de 
SmaartLive. Aucune autre option d'affichage n'est associée à cette option.  
   
Trace Information 
 
Dans cette section, les options de moyenne et de décalage de l’axe y peuvent être réglées indépendamment 
pour les tracés du mode RTA et de Fonction de Transfert. L’ensemble de commandes est partagée par les 
trois tracés donc les trois boutons à gauche (RTA 0, RTA 1 et Transfer) sont utilisés pour définir l’action 
des autres commandes.  
 
MIDI Program Change  
 
• Send Program Change – Si cette option est activée, le chargement du System Preset sélectionné 

envoie également un changement de programme MIDI spécifié sur le canal MIDI sélectionné (voir ci-
dessous). Si vous utilisez une console contrôlable par MIDI pour contrôler les signaux provenant de 
l’ordinateur, vous pouvez définir des System Presets pour différents microphones, EQ, etc. et passer de 
l’un à l’autre avec une seule commande.  

• Channel – Sélectionne le canal MIDI pour l’appareil vers lequel vous enverrez le changement de 
programme.  

• Program – Spécifie le programme MIDI à envoyer sur le canal sélectionné.  
 

 
External Device  
 
Les commandes de la section External Device peuvent être utilisées pour modifier la sélection d’un 
appareil externe et définir les options supplémentaires lorsque le preset sélectionné est rappelé.  
 
• Device – Ce champ désigne un appareil externe configuré à sélectionner lorsque le preset sélectionné 

est rappelé. Sélectionner <Don’t Change> dans ce champ laissera la sélection d’appareil telle quelle.  
• Channel – L’appareil sélectionné ci-dessus est un appareil multi canal, cette commande sélectionne le 

canal d’entrée ou de sortie que vous voulez contrôler.  
• External Device Mode – Cocher cette case fera apparaître automatiquement un panneau de contrôle 

pour l’appareil externe sélectionné lorsque le preset est rappelé.  
• Show EQ Filters Inverted – Inverse les indicateurs des filtres d’EQ sur le tracé de la Fonction de 

Transfert (normalement utilisé lorsque les entrées de la Fonction de Transfert sont interverties).  
 
Volume Control  
 
         Menu Options > Volume Control  
 

          
 
         Commande du Clavier = [Alt] + [V] 
 
         La commande Volume Control du menu Options est simplement un raccourci vers la console Recording  
         Control de l’utilitaire Contrôle du Volume de Windows. La plupart des hardware son compatibles  
         Windows utilisent ceci pour contrôler les signaux d’entrée et de sortie des différentes sources à l’intérieur  
         et à l’extérieur de l’ordinateur.  
 
 



 
 
 Raccourcis 
 
Raccourcis d’Affichage de Mode 
 
Raccourcis Généraux (Tous Modes) 
 
Mode RTA Uniquement 
 
Mode Fonction de Transfert Uniquement 
 
Raccourcis Gamme, Echelle et Zoom 
 
Gamme Amplitude/Magnitude (axe y) 
 
Gamme Fréquence/Temps (axe x) 
 
Echelle de Fréquence du Mode RTA 
 
Raccourcis des Tracés 
 
Raccourcis du Tracé de Référence 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
Raccourcis des Appareils Externes 
 
Opérations avec la Souris 
 
Raccourcis du Mode Impulse 
 
Opérations avec la Souris 
 
Raccourcis du Locked Cursor 
 
Déplacer le Locked Cursor 
 
Raccourcis du Menu Options 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
Chapitre 5 :Concepts Basiques et Terminologie 
 
         Ce chapitre présente les définitions concrètes de certains concepts basiques et de terminologie utilisés dans  
         SmaartLive. Les définitions données ici sont précises en ce qui concerne SmaartLive, mais ne doivent pas  
         être considérées mathématiquement complète. Une liste de titres de référence est fournit à la fin de ce  
         chapitre pour ceux qui désirent acquérir des connaissances plus complète sur ces sujets. 
  
Concepts Basiques  
 
Moyenne  
 
         Lorsque vous utilisez des signaux de test tel que de la musique ou un bruit (rose, blanc) pour les mesures  
         FFT, il est souvent nécessaire de faire une moyenne des données sur un certain nombre d’images FFT. Cela  
         est due au fait que le bruit n’est pas constant. Il n’a pas la même énergie pour toutes les fréquences à tout  
         instant. En faisant une moyenne du nombre d’images (étendant ainsi le temps d’étude de chaque  
         fréquence), vous augmentez les chances que le signal de test ait assez d’énergie à une fréquence donnée  
         pour faire une mesure significative.  
    
         SmaartLive utilise une moyenne arithmétique Root Mean Square (RMS), traçant un seul point pour chaque  
         point de donnée en utilisant les données du nombre d’images FFT précédentes spécifiées. Toutes les  
         données utilisées dans la moyenne sont données sans pondération. Le nombre d’images que vous pouvez  
         inclure dans une moyenne est compris entre 1 (pas de moyenne) et 256 (chaque point de donnée représente  
         une moyenne des valeurs de ce point sur les 256 dernières images FFT). 
    
         Notes : En règle générale, essayez de sélectionner des paramètres de moyenne qui permettent des mesures  
         raisonnables sans prendre trop de temps pour être collecter. Modifier le nombre de points de moyenne vide  
         les buffers de moyenne, l’affichage prendra donc un certain temps pour se rétablir.  
 
Cohérence  
 
         L’affichage de Cohérence de SmaartLive représente une fonction mathématique complexe utilisée pour  
         déterminer la linéarité entre deux signaux. Dans SmaartLive, la fonction de Cohérence est utilisée pour  
         vous donner une idée de la qualité des données de la fonction de transfert pour chaque point sur l’axe de  
         fréquence.  
   
         La fonction de Cohérence donne une valeur comprise entre 0 et 1 pour chaque fréquence. Une valeur égale  
         à 0 indique aucune cohérence. Une valeur égale à 1 signifie que la cohérence est parfaite entre les deux  
         signaux. En général, la cohérence pour deux images FFT mesurées en utilisant les mêmes paramètres  
         d’entrée sera toujours un parfait 1. Les différences apparaissent uniquement lorsque vous faites une  
         moyenne des deux signaux sur une période plus longue, la fonction de cohérence est donc désactivée  
         lorsque le nombre de points de moyenne est réglé sur 1. Notez également que la cohérence globale à  
         tendance à diminuer lorsque le nombre de points de moyenne augmente.  
    
         Des exemples de facteurs autres que le nombre de points de moyenne qui peuvent affecter la cohérence des  
         données de la fonction de transfert comprennent le délai entre les deux signaux, l’énergie insuffisante pour  
         faire une mesure au niveau du signal de référence à une certaine fréquence, des influences acoustiques  
         telles que les réflexions, la modulation et la réverbération, le bruit ambiant ou électrique. Les processeurs  
         non linéaires tels que les compresseurs et les limiteurs dans le cheminement du signal peuvent également  
         avoir une influence négative sur la cohérence et doivent être désactivés si possible pour les mesures de  
         fonction de transfert et de réponse d’impulsion. 
 
Fonctions de la Fenêtre de Données  
 
         Les fonctions de la Fenêtre de Données aident à réduire les erreurs provenant de la segmentation de  
         longues séries de données en images FFT. Souvenez-vous que la FFT nécessite des séries de données d’une  
         durée finie. Ce qui se passe immédiatement avant et après les séries de données FFT n’est pas connu et  
         donc les calculs supposent que les séries de données se répètent indéfiniment. Cela peut entraîner certaines  



         anomalies dans les résultats de la transformation de Fourier.  
   
         Tous les types de fenêtre de données opèrent sous le même principe de base. Elles suppriment l’échantillon  
         le plus proche du début ou de la fin des séries de données FFT afin de réduire ces erreurs ou ces « effets de  
         coupure ». La seule vraie différence entre les différents types de Fenêtre de Données est la forme de la  
         fenêtre. SmaartLive fournit neuf options de Fenêtre de Données dont Hannçing, Hamming, Blackman,  
         Blackman-Harris, Parzen, Welch et Flat Top. L’option nommée « None » ( pas de fenêtre de données ;  
         également appelée fenêtre « rectangulaire »), ne sera pas utile dans la plupart des applications.  
 
Décibels  
 
         Le décibel (dB) est une unité utilisée pour exprimer le rapport logarithmique de deux quantités de  
         puissance, de tension ou de deux valeurs. En général, les décibels sont utilisés lorsque deux valeurs  
         peuvent varier dans une gamme très large. Le besoin d’échelles logarithmiques dans l’acoustique et l’audio  
         est un résultat de la très large gamme de sensibilité aux pressions sonores et aux fréquences qui constitue  
         l’échelle auditive humaine. La plupart des mesures audio basées sur la tension  ou la pression sonore sont  
         exprimées en décibels. 
 
         Les rapports de puissance et de tension indiqués dans le tableau ci-dessous illustre l’une des raisons pour  
         lesquelles une échelle logarithmique est nécessaire. Notez qu’une chute de 60dB dans la colonne Power  
         Ratio représente une division par 1 million de l’énergie ! Un point de confusion fréquent à propos des  
         décibels est que 0dB peut signifier plusieurs choses. Pour SmaartLive, 0dB signifie : 
 

1. Sur une mesure de fonction de transfert, les valeurs en décibel représentent la différence entre les 
signaux de référence et de mesure. Lorsque l’énergie des deux signaux d’entrée est la même à une 
fréquence donnée,  la fonction de transfert est à 0dB à cette fréquence. Aux fréquences où le signal de 
mesure a plus d’énergie que le signal de référence, la fonction de transfert aura un nombre de décibels 
positif. Lorsque le signal de mesure a moins d’énergie, la valeur sera négative.  

2. En respect des vu-mêtres de niveau d’entrée et du calibrage Full-Scale par défaut, 0dB signifie la sortie 
maximum possible du convertisseur A/N sur l’appareil d’entrée sélectionné. Toutes les autres valeurs 
d’amplitude/magnitude sont données comme « dB inférieur » depuis ce maximum.  

 
En fait, il existe une troisième possibilité. Vous avez peu de chance de rencontrer cette valeur lors des 
mesures dans des conditions normales mais il existe une chose appelée 0dB SPL. La définition du décibel 
comme rapport rend tous ces usages valides.  
 

 
FFT  
 
         Le FFT est un cas spécial de la Transformation de Fourier, une technique mathématique utilisée pour  
         transformer des données du domaine temporelle en données du domaine fréquentiel. La sortie de la  
         transformation est un ensemble de nombres complexes représentant les informations de fréquence et de  
         phase à propos des séries temporelles originales. Le terme Fast Fourier Transform vient du fait que si vous  
         spécifiez des données du domaine temporelle contenant un échantillon « puissance de 2 », la  
         transformation peut être calculée très rapidement par des ordinateurs. Les puissances de 2 sont les valeurs  
         de 2n, avec n un nombre entier (1, 2, 3, etc.). 
         
 
         Toutes les transformations de fréquence réalisées par SmaartLive sont des FFT et nécessitent que le temps  
         enregistré soit une puissance de 2 (échantillons) en durée. Pour des opérations en temps réel, SmaartLive  
         réalise la transformation du domaine fréquentiel par morceaux (images).  
  
         Note : Il est certainement possible de calculer la Transformation de Fourier pour un temps  
         d’enregistrement avec n’importe quel nombre d’échantillons. Mais lorsque le nombre d’échantillons n’est  
         pas une puissance de 2, le nombre de calculs nécessaires peut devenir très important. (Sur un PC, cela peut  
         résulter en une Transformation de Fourier très lente.) 
 
Résolution de la Fréquence 
 
         La résolution de la fréquence d’un FFT est calculée depuis la fréquence d’échantillonnage et la taille FFT.  



         Pour une taille FFT donnée, la résolution de la fréquence du FFT sera égale à la fréquence  
         d’échantillonnage divisée par 2 (la fréquence de Nyquist), divisée par la moitié de la taille FFT. Les points  
         de donnée FFT sont distribués de façon linéaire le long de l’axe de fréquence chaque « Q » Hertz, avec Q  
         la résolution de la fréquence. Par exemple, échantillonner à 44,100 échantillons par seconde vous donne  
         une fréquence de Nyquist de 22,050Hz. Une taille FFT de 4096 (4k) donne 2048 points de donnée de  
         fréquence. Diviser 22,050 par 2048 pour obtenir une résolution de fréquence de 10.77Hz. En d’autres mots,  
         un FFT de 4k échantillonné à une fréquence d’échantillonnage de 44.1k aura un point de donnée tous les  
         10.77Hz, de 0 à 22,050Hz. 
 
 
         Affichage du Point Fixe par Octave (FPPO) de la Fonction de Transfert de SmaartLive 
 
         Un problème associé avec la distribution linéaire des points de donnée FFT provient du fait que nous  
         entendons les fréquences de façon logarithmique. L’audition humaine perçoit chaque doublement de la  
         fréquence comme un intervalle égal et donc chaque octave successive contient deux fois plus de fréquences  
         que la précédente. En utilisant le même exemple d’un FFT 4k échantillonné à 44.1kHz abordé page  
         précédente, notez que la fréquence de 10.77Hz signifie qu’il n’y aura que trois points de donnée entre  
         31.5Hz et 63Hz (les fréquences centrales des deux octaves les plus basses), fournissant donc une résolution  
         très faible dans cette gamme. 
 
         Sur les deux octaves les plus hautes, l’écart entre les fréquences centrales (8kHz et 16kHz) est 8000 hertz.  
         Cela signifie qu’il y a plus de 700 points de données FFT dans cette octave. Lorsque l’on visualise ceci en  
         utilisant une échelle de fréquence logarithmique, les points de données sur cette gamme sont si denses, que  
         l’affichage peut être très difficile à interpréter. 
  
         SmaartLive traite ce problème en mode Fonction de Transfert en utilisant plusieurs FFT, à différentes  
         fréquences d’échantillonnage et tailles de FFT, puis en combinant les résultats pour fournir une résolution  
         égale pour chaque octave (sauf les deux plus basses). La résolution du mode Fonction de Transfert est de  
         24 points par octave au-dessus de 44Hz (avec un total de 24 points sur les deux octaves les plus basses).  
         Notez que l’utilisation de plusieurs FFT résulte également en une fenêtre temporelle plus longue pour les  
         basses fréquences et une plus courte pour les hautes fréquences.  
 
         Résolution de Fréquence et Affichages d’Octave/Fraction d’Octave 
 
         En mode RTA, la technique à plusieurs FFT utilisée en mode Fonction de Transfert n’est pas une option en  
         raison des limites mathématiques et donc tous les affichages RTA sont créés depuis un seul FFT. Etant  
         donné que la distribution linéaire des points FFT sur un seul FFT donne une résolution très basse dans les  
         octaves basses par rapport aux octaves hautes, il peut y avoir des bandes dans le bas du spectre qui ne  
         contiennent qu’un point de donnée ou même aucun point de donnée, en fonction de l’affichage et des  
         paramètres d’entrée FFT.  
  
         Dans les modes d’affichage RTA de bande d’octave ou de 1/3 d’octave, SmaartLive affichera uniquement  
         les bandes contenant au moins deux points de données FFT. Les affichages 1/6, 1/12 et 1/24 d’octave  
         nécessiteront tous au moins un point par bande. L’espace plus large entre les points de données FFT dans  
         les octaves basses explique les manques au niveau du bas du spectre sur les affichages de bandes.  
  
         Augmenter la taille FFT ou diminuer la fréquence d’échantillonnage augmentera la résolution de la  
         fréquence et aidera à combler les trous du bas du spectre. Notez que ces deux actions augmente le temps  
         nécessaire à collecter un groupe d’échantillons. Etudier un signal sur une longue période est la vraie clé  
         pour augmenter la résolution de la fréquence.  
  
 
Réponse d’Impulsion 
 
         Vous pouvez voir la réponse d’impulsion comme la signature d’un système (ex : un appareil audio, une  
         pièce et/ou un système électroacoustique). Pour nos applications, nous pouvons définir la réponse  
         d’impulsion comme le signal qui décrit les modifications qu’un signal de test subit lorsqu’il traverse un  
         appareil ou un système à tester. La réponse d’impulsion contient une quantité d’information à propos du  
         système dont le délai à travers le système, la réponse en fréquence, les réflexions, la réverbération et le  
         « decay ». En fait, il est actuellement possible d’utiliser la réponse d’impulsion d’une pièce/système  



         comme un filtre pour modifier un signal « dry », comme une voix ou de la musique, et d’entendre  
         exactement ce que qu’il donnerait s’il était joué à travers ce système dans cette pièce et entendu à la  
         position où la mesure a été faite. 
 
Bruit Rose et Bruit Blanc 
 
         Le bruit rose et le bruit blanc sont des sons ou des signaux audio contenant une énergie variable sur la  
         bande. Tous deux sont fréquemment utilisés comme signal source dans les tests audio.  
 
         Bruit Rose 
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         Le bruit rose est un signal qui (en moyenne sur une période) a une énergie identique pour chaque octave.  
         Cela signifie que lorsqu’on l’affiche sur un tracé de bande d’octave le spectre du bruit rose sera plat.  
         Lorsque le spectre du bruit rose est affiché sur une narrowband, il semblera diminuer en énergie à une  
         vitesse de –3dB par octave. 
 
         Bruit Blanc 
 
         Le bruit blanc est un signal qui (en moyenne sur une période) a la même énergie pour chaque fréquence.  
         Cela signifie que si vous affichez le spectre du bruit blanc en résolution narrowband, il sera plat. Toutefois,  
         puisqu’il y a deux fois plus de Hertz dans chaque bande d’octave successive, le bruit blanc affiché sur une  
         bande d’octave  semblera augmenter de 3dB en énergie pour chaque octave successive comme illustré ci- 
         dessous. 
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         La différence entre ces deux types de bruit n’est pas importante pour les mesures de Fonction de Transfert.  
         La fonction de transfert affiche une comparaison entre les deux signaux d’entrée sur la base point de  
         fréquence par point de fréquence. Il faut la prendre en compte lorsque vous regardez une mesure d’un seul  
         canal de bruit (RTA). Si elle est plate en résolution narrowband, c’est du bruit blanc. Si elle semble  
         diminuer vers la droite en résolution narrowband (perte dans les hautes fréquences) c’est du bruit rose.  
    
         Note : Le bruit blanc a tant d’énergie dans les hautes fréquences qu’il peut endommager les haut-parleurs  
         s’il est mal utilisé. Nous ne vous le recommandons pas comme signal de test pour la plupart des  
         applications audio. 
 
Fréquence d’Echantillonnage 
 
         La fréquence d’échantillonnage en audio numérique représente le nombre de fois par seconde qu’un signal  
         audio analogique est échantillonné et numérisé. La considération pratique la plus importante est que la  



         fréquence d’échantillonnage limite le contenu fréquentiel du signal numérisé. Une règle générale est que la  
         fréquence d’échantillonnage doit être au moins le double du nombre de Hertz de la plus haute fréquence  
         que vous voulez inclure dans le signal numérisé. La fréquence égale à la moitié de la fréquence  
         d’échantillonnage est appelée fréquence de Nyquist.  
         
         D’autres critères affectent la plus haute fréquence mesurable précisément sur les signaux échantillonnés.  
         En théorie, vous pouvez mesurer jusqu’à la moitié de la fréquence d’échantillonnage mais en pratique des  
         choses comme l’aliasing, la conversion Sigma/Delta et les filtres anti-aliasing rendent les fréquences  
         proches de Nyquist difficiles à mesurer.  
 
         Les compact disques tournent à une fréquence d’échantillonnage standard de 44.1kHz. Les machines  
         d’enregistrement audio professionnelles échantillonnent souvent de 48kHz à 96kHz. Les cartes son des  
         ordinateurs fonctionnent à une fréquence d’échantillonnage réglable par l’utilisateur (44.1kHz, 22.05kHz  
         ou 11.025kHz). 
 
         SmaartLive détermine les fréquences d’échantillonnage disponibles en analysant votre carte son à chaque  
         qu’il est chargé. Actuellement, la fréquence d’échantillonnage la plus grande supportée par SmaartLive est  
         48kHz.  
 
         Les deux choses principales à propos de la fréquence d’échantillonnage sont : 
 
         La fréquence d’échantillonnage limite le contenu fréquentiel du signal numérisé dans le haut du spectre.  
 
         La fréquence d’échantillonnage, ainsi que la taille des images FFT, détermine la durée de la fenêtre  
         temporelle (la constante temporelle FFT) et la résolution de fréquence d’une mesure FFT.  
 
Alignement du Signal  
 
         Lorsque vous réalisez des mesures de fonction de transfert, il est essentiel que le signal d’entrée de la carte  
         son soit aligné dans le temps. Pour faire une comparaison significative de deux signaux, les calculs de la  
         fonction de transfert doivent « voir » la même partie de chaque signal au même moment. Avec la plupart  
         des équipements audio analogiques, ce n’est pas un problème et aucune compensation n’est nécessaire.  
    
         Lorsque vous mesurez un appareil ou un système qui créé un délai lorsqu’il est traversé, tel qu’une ligne de  
         délai ou un haut-parleur avec un microphone éloigné, vous devrez compenser le délai avant de pouvoir  
         faire une mesure de fonction de transfert valide. Compenser les délais nécessitent de trouver le délai dans le  
         signal de mesure et d’ajouter un délai équivalent au signal de référence. Le localisateur de délai et le délai  
         interne de SmaartLive facilitent cette opération. 
 
Adoucissement du Tracé 
 
         En mode Fonction de Transfert, la fonction adoucissement peut aider à enlever la plupart de ce qui semble  
         être du bruit sur le tracé de Fonction de Transfert, rendant les tendances globales de la réponse du système  
         plus facile à lire. L’adoucissement augmente la largeur de bande apparente des points de donnée FFT sans  
         réduire la résolution de fréquence. SmaartLive offre quatre options d’adoucissement, 3, 5, 7 ou 9 points.  
         Toutes les options d’adoucissement de SmaartLive utilisent une moyenne centrée à n points où la valeur de  
         chaque point de données du tracé de la fonction de transfert est calculé en faisant la moyenne avec un  
         certain nombre de points adjacents. Par exemple, avec un adoucissement à 3 points chaque point de donnée  
         est calculé en faisant la moyenne avec le point supérieur suivant et le point inférieur précédant.  
         L’adoucissement à 5 points fait la moyenne de chacun des points de donnée avec les deux points de chaque  
         côté de ceux-ci et ainsi de suite. 
 
 
La Fonction de Transfert  
 
         La fonction de transfert est une comparaison de deux signaux, en général un signal de référence et un  
         signal de mesure. En général, cette comparaison est faite entre l’entrée et la sortie d’un appareil ou d’un  
         système, tel qu’un égaliseur, un système de sonorisation, ou une pièce. SmaartLive utilise les calculs de la  
         Fonction de Transfert dans les mesures de réponse en fréquence et de réponse d’impulsion. Les calculs de  
         la fonction de transfert sont toujours réalisés dans le domaine fréquentiel en utilisant les données FFT. Les  



         résultats des calculs sont affichés dans le domaine fréquentiel ou temporel, en fonction du mode  
         opérationnel.  
   
         L’affichage en temps réel de la Fonction de Transfert indique les résultats de la fonction de transfert dans le  
         domaine fréquentiel pour indiquer la réponse en fréquence (magnitude et phase) de l’appareil ou du  
         système à tester. En mode Impulse, SmaartLive calcule la fonction de transfert en utilisant les données de  
         FFT très long puis transforme le résultat dans le domaine temporel pour vous montrer la réponse  
         d’impulsion de l’appareil ou du système à tester.  
   
         Ces deux types de mesures de fonction de transfert sont liés. Les signaux de référence et de mesure doivent  
         être synchronisés (dans le temps) afin d’obtenir une mesure de la réponse en fréquence valide (temps réel).  
         La mesure de la réponse d’impulsion est utilisée pour trouver le temps de délai entre les deux signaux  
         d’entrée. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Lexique 
 
         Conversion Analogique à Numérique (A/N) : Le processus de numérisation d’un signal analogique. Ce  
         processus implique presque toujours la limitation du contenu du signal numérisé.  
   
         Amplitude : La taille d’un nombre réel (ex, un nombre de volts), dans le sens positif ou négatif. Le terme  
         d’amplitude se réfère en général aux nombre non complexes ou tracés sur une échelle logarithmique, tel  
         que les nombres enregistrés dans un processus A/N. (Les nombres exprimés de façon logarithmique sont  
         plutôt appelés magnitude.) 
   
         Atténuation : Une baisse du niveau d’un signal. L’atténuation peut se référer à la réduction du niveau pour  
         une gamme de fréquence spécifiée ou à une baisse globale du niveau. 
  
         Cohérence : Une fonction mathématique qui représente la linéarité entre deux signaux. La cohérence est  
         exprimée par une valeur comprise entre 0 et 1. Notez que la cohérence est affectée par les conditions de  
         mesure et le nombre de points de moyenne utilisés.  
 
         Compresseurs : Appareils électroniques qui entraînent une modification du gain (en général une  
         atténuation) en fonction du niveau d’entrée. Ces appareils NE doivent PAS être utilisés lors de mesures de  
         fonction de transfert puisque que par nature ils ne sont pas linéaires.  
 
         Crosstalk : Energie non désirée sur un signal (ou un canal) introduite depuis le signal ou le canal adjacent.  
 
         Fenêtre de Données : Une fonction mathématique utilisée pour réduire les effets négatifs du découpage  
         qui prend place lorsqu’un nombre fini de points FFT est utilisé pour transformer dees données du domaine  
         temporel dans le domaine fréquentiel.  
  
         Rapport de Decay : Le rapport auquel un signal diminue (en magnitude), en général une fonction de la  
         fréquence et exprimé en décibels par seconde ou en rapport avec le temps nécessaire pour que le signal  
         diminue de 60 décibels au rapport de décay donné. (voir Temps de Réverbération). 
 
         Décibel : Le décibel, souvent abrégé par dB, est un rapport logarithmique entre deux valeurs. En  
         acoustique, les décibels font en général référence au rapport du niveau d’entrée sur le niveau de sortie d’un  
         système, ou un niveau donné en comparaison avec une référence fixe.  
 
         Gamme de Dynamique : La différence en niveau entre le signal le plus haut et le plus bas qu’un système  
         peut accepter ou reproduire.  
 
         FFT : La Fast Fourier Transform est une technique mathématique utilisée pour transformer les données du  
         domaine temporelle dans le domaine fréquentiel. Le terme « Fast » se référe au fait que lorsque le nombre  
         d’échantillons du domaine temporel est une puissance de 2 (16, 32, 64, 128, 256, etc.) les calculs peuvent  
         être réalisés très rapidement par un ordinateur.  
 
         Constante Temporelle FFT : Le temps nécessaire pour collecter tous les échantillons d’une seule image  
         FFT d’une taille donnée à une fréquence d’échantillonnage donnée. La constante temporelle d’une FFT,  
         également appelée fenêtre temporelle, peut être calculée en divisant la taille FFT par la fréquence  
         d’échantillonnage. Par exemple, un FFT 4k échantillonné à 44.1k échantillons/secondes a une fenêtre  
         temporelle de 0.09 secondes.  
   
         Egaliseur Graphique : Un appareil avec de nombreux filtres utilisés pour modifier le gain ou l’atténuation  
         d’un signal à des fréquences présélectionnées. Les largeurs de bandes des filtres sont typiquement réglées  
         sur un ou 1/3 d’octave et ne sont pas réglables par l’utilisateur.  
 
         Latence : Le délai à travers une unité ou un système donné. La latence se réfère souvent au délai de   
         traversée d’un appareil. Il est courant pour les délais numériques d’avoir une petite latence même lorsqu’ils  
         sont réglés sur un temps de délai nul. 
      
         Echelle Linéaire : Le terme linéaire, se réfère à un ensemble de valeurs ou à une échelle de graphique sur  
         laquelle les valeurs sont espacées régulièrement. Sur une échelle linéaire, chaque valeur (unité) à la même  



         dimension. 
 
         Echelle Logarithmique : Une échelle où chaque puissance d’un nombre donné (ex : dix) a la même  
         dimension. 
 
         Magnitude : Un nombre assigné à une quantité afin qu’il puisse être comparé à d’autres quantités. Pour les  
         quantités complexes, la magnitude est la racine carrée de la somme des carrés des parties réelles et  
         imaginaires. 
 
         Fréquence de Nyquist : En audio numérique, la fréquence de Nyquist est égale à la moitié de la fréquence  
         d’échantillonnage. La fréquence de Nyquist représente la plus haute fréquence possible lors de la  
         numérisation d’un signal échantillonné à une fréquence donnée.  
 
         Résolution de Bande d’Octave : La résolution de bande d’octave combine tous les points de données  
         d’une octave et affiche une valeur totale d’énergie pour chaque octave (en opposition avec un affichage  
         linéaire ou logarithmique narrowband qui affiche la valeur des points de données FFT individuels). Les  
         octaves standards utilisées dans les mesures audio sont centrées sur 16, 31.5, 63, 125, 250, 500, 1k, 2k, 4k,  
         8k et 16k Hertz (cycles par seconde).  
 
         Overlap : Pour SmaartLive, overlap se réfère à la quantité de données que chaque image FFT successive  
         partage avec l’image qui la précède.  
         Le chevauchement des images FFT est identique à celui des tuiles sur un toit. Lorsqu’aucun  
         chevauchement n’est utilisé, chaque nouvelle image FFT commence où la dernière s’est arrêtée. 
 
         Egaliseur Paramétrique : Les égaliseurs sont des appareils avec un ou plusieurs filtres qui affectent le  
         contenu fréquentiel du signal. Sur les égaliseurs fréquentiels, les paramètres des filtres dont le gain ou  
         l’atténuation, la fréquence et la largeur de bande sont réglables par l’utilisateur.  
  
         Décalage de Phase : Une différence temporelle sur un signal (par rapport à une référence) à une ou  
         plusieurs fréquences, typiquement exprimé en degrés.  
 
         Bruit Rose : Un signal variable sur lequel, dans une période donnée, chaque bande d’octave a une  
         quantité d’énergie égale.  
 
         Délai de Propagation: Le temps nécessaire au son pour être transmis d’un endroit (haut-parleur) au à un  
         autre (microphone).  
  
         Temps de Réverbération : Le temps nécessaire pour que l’énergie audio introduite dans un système (une  
         pièce) disparaisse, ou diminue d’un nombre de décibels spécifiés. Souvent exprimé comme valeur RT60.  
    
         RT60 : Temps de Réverbération. Le temps nécessaire pour qu’un système, en général une pièce, diffuse 60  
         décibels.  
  
         Fréquence d’Echantillonnage : Le nombre de points par seconde utilisé lors d’un processus de  
         conversion analogique/numérique. En général exprimée en Hertz.  
 
         Spectrographe : Un tracé en trois dimensions, affiché en deux dimensions avec la couleur représentant la  
         troisième dimension (ou l’axe z). Le spectrographe est une représentation topographique de l’affichage  
         waterfall commun.  
 
         Spectre : Le contenu fréquentiel d’un signal donné.  
 
         Vitesse du Son : La vitesse du son est dépendante du matériau de propagation, de la température et  
         d’autres facteurs. Les valeurs typiques pour la vitesse du son dans l’air sont 1120 ft/sec ou 341.376 m/sec.  
         C’est la valeur que SmaartLive utilise pour calculer les distances équivalentes aux différences temporelles.  
 
         Fenêtre Temporelle : Voir Constante Temporelle FFT.  
 
         Bruit Blanc : Un signal variable sur lequel sur une période donnée, chaque fréquence a la même énergie.  
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         Voici une liste des ouvrages suggérés pour les lecteurs désireux d’étendre leur connaissance des 
concepts  
         physiques et théoriques et des procédures mathématiques agissant dans SmaartLive, ainsi que dans 
la  
         conception des systèmes de sonorisation et en acoustique.  
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 

Chapitre 6 : Mauvais Fonctionnement 
 
Problèmes d’Installation 
 
         Problèmes Pendant l’Installation 
 
         La cause la plus fréquente des problèmes d’installation de SmaartLive et des logiciels Windows en général  
         est un conflit avec les anti-virus automatiques, les vérificateurs du système et les vérificateurs  
         d’installation. D’autres types de programme peuvent parfois causer des problèmes pendant l’installation.  
         Nous vous recommandons donc vivement de fermer tous les autres programmes Windows avant d’installer  
         SmaartLive. 
 
         Les autres causes des problèmes durant l’installation de Smaartlive sont un logiciel d’installation  
         défectueux, un manque d’espace libre sur le disque dur, ou sur les systèmes NT/2000 si le compte  
         utilisateur actuellement connecté n’a pas la permission d’accéder à tous les disques et :ou tous les dossiers  
         sur lesquels SmaartLive a besoin d’installer ou de mettre à jour des fichiers. En fonction de la configuration  
         des paramètres de sécurité de Windows, l’accès administrateur peut être nécessaire pour installer  
         SmaartLive. Les problèmes liés aux permissions utilisateur peuvent aussi apparaître après l’installation sur  
         les systèmes NT/2000 si le programme du fichier de SmaartLive n’est pas conçu pour un accès à tous les  
         utilisateurs. 
 
         SmaartLive a besoin d’environ 10Mb d’espace libre sur le disque lorsqu’il est installé toutefois un espace  
         supplémentaire est nécessaire pendant l’installation pour les fichiers temporaires. Windows peut avoir  
         également besoin d’espace du disque dur et en général, il est conseillé de garder au moins 100Mb d’espace  
         libre sur le disque à tout moment. Si votre ordinateur ne dispose pas d’assez d’espace libre sur le disque,  
         cela peut entraîner des problèmes sans aucun rapport avec SmaartLive.  
      
         Les problèmes provenant de logiciel d’installation défectueux peuvent prendre plusieurs formes.  
         L’installateur peut s’arrêter ou se bloquer sans aucune explication. Vous pouvez également obtenir des   
         messages d’erreur en relation avec des fichiers si le logiciel d’installation est défectueux. Si vous pensez  
         rencontrer un problème lié au logiciel d’installation, contactez le support technique de SIA afin d’obtenir  
         un logiciel de remplacement. Les informations concernant le support technique de SIA se trouvent à la fin  
         de ce chapitre. 
 
         Problèmes Après l’Installation 
 
         Une source fréquente de problèmes durant l’installation de SIA SmaartLive est un conflit avec les anti- 
         virus automatiques, les vérificateurs du système et les vérificateurs d’installation. Le programme  
         d’installation doit modifier le Registre de Windows (base de données du registre) et créer ou remplacer  
         certains fichiers du dossier Système de Windows afin d’installer correctement et d’enregistrer SmaartLive  
         et ses composants avec le système opérationnel. Les anti-virus et les applications de vérification du  
         système/installation qui protègent les fichiers et les dossiers du système peuvent empêcher l’installateur de  
         réaliser toutes les étapes nécessaires. 
  
         Souvent les problèmes d’installation liés aux conflits avec d’autres logiciels se manifestent après une  
         installation en apparence réussie. SmaartLive peut se plaindre de l’absence de fichiers DLL ou OCX et/ou  
         refuser de démarrer. Fermez tous les autres programmes et recommencer l’installation corrigera en général  
         ce problème. 
 
         Dans de rares cas, SmaartLive peut refuser de démarrer après une installation en apparence réussie en  
         raison d’un conflit avec un pilote MIDI (ou des conflits entre plusieurs pilotes MIDI). Si vous essayez de  
         lancer SmaartLive et que vous ne recevez aucun message d’erreur mais que la fenêtre du programme ne  
         s’ouvre jamais, essayez de désactiver « Périphériques et Instruments MIDI » de l’onglet Périphériques  
         (nommé Avancés dans Windows 95) du panneau de configuration Multimedia en double cliquant sur  
         chaque entrée et en sélectionnant « Ne pas utiliser les fonctions MIDI sur ce périphérique ». Notez que  
         vous devrez redémarrer Windows après avoir désactiver les périphériques pour que les modifications soient  



         appliquées. Si cela corrige le problème, vous pouvez réactiver ces périphériques l’un après l’autre afin de  
         déterminer lequel était coupable. Dans la plupart des cas, des mises à jour de pilotes seront disponibles et  
         corrigeront ce problème. 
 
         Si SmaartLive est installé avec succès et semble fonctionner correctement mais que vous rencontrez des  
         problèmes liés à l’audio, cela vient sans doute d’un problème de configuration. Référez-vous aux sections  
         Configurer les commandes Entrée/Sortie Audio , Problèmes du Hardware Son et Niveaux d’Entrée de la  
         Mesure de ce chapitre pour une aide sur le mauvais fonctionnement audio.  
   
Configurer les Commandes Entrée/Sortie Audio 
 
         Si vous rencontrez des problèmes pour obtenir un signal sur SmaartLive à partir des entrées ligne de votre  
         carte son ou pour envoyer des signaux générés internement vers les sorties, vérifiez tout d’abord que les  
         périphériques Wave In (entrée) et Wave Out (sortie) corrects sont sélectionnés sur l’onglet Devices de la  
         fenêtre de dialogue options. Même si votre ordinateur n’a qu’un périphérique audio, Windows peut   
         considérer qu’un pilote de modem vocal ou que le pilote d’un périphérique qui n’est même pas installé soit  
         préféré aux périphériques Wave In et Wave Out. 
  
         Si les sélections des périphériques Wave In et Wave Out sont correctes sur SmaartLive et que vous avez  
         des problèmes à envoyer des signaux, le problème peut être que la commande de sortie Wave du   
         périphérique sélectionné est « mutée » ou baissée dans l’application de la console du périphérique. Si  
         vous avez des problèmes pour recevoir des signaux audio, vérifiez la console d’entrée du périphérique  
         Wave In sélectionné.  
 

          
 
         L’application Windows Contrôle du Volume (console) fournit une interface standard pour contrôler les  
         entrées et les sorties sur la plupart des hardware son compatibles Windows. Un malentendu commun parmi  
         les nouveaux utilisateurs de Smaart est que la console du Contrôle du Volume que vous voyez lorsque  
         l’utilitaire Contrôle du Volume s’ouvre depuis la barre des tâches de Windows contrôle les signaux  
         d’entrée et de sortie. En fait, la console Contrôle du Volume ne contrôle que les signaux de sortie. Les  
         contrôles d’entrée sont cachés derrière les controles du volume (sortie) dans une console séparée nommée  
         Recording Control. 
 
         Si vous avez des problèmes pour obtenir un signal dans SmaartLive depuis les entrées de l’ordinateur (line- 
         in) ou que vous pensez que le microphone interne de l’ordinateur est activé et qu’il contamine vos mesures,  
         vérifier les paramètres de la console Recording Control. Pour accéder à la console d’entrée du périphérique  
         Wave In sélectionné, sélectionnez Contrôle du Volume dans le menu Options. Pour accéder à la console  
         Recording Control sous Windows, utilisez la procédure suivante :  
  

• Ouvrez le Contrôle du Volume de Windows – double cliquez sur l’icône du haut parleur (voir ci-
dessus) dans la Barre de Tâches de Windows ou cliquez sur le bouton Démarrer et sélectionnez 
Programmes > Accessoires > Multimedia > Contrôle du Volume. Si vous n’avez pas de section 
Multimedia dans le menu Démarrer le Contrôle du Volume peut se trouver dans Programmes > 
Accessoires > Divertissement.  

• Dans l’application Contrôle du Volume, sélectionnez Propriétés dans le menu Options.  
• Cliquez sur le bouton Enregistrement, assurez-vous que les cases Microphone et Line-In sont cochées 

dans la liste et cliquez sur OK pour fermer la fenêtre de dialogue Propriétés.  
 
Notez que le titre de la fenêtre Contrôle du Volume devient Recording Control. Assurez-vous que la case 
Select pour Line-In est cochée, que la commande de balance est  centrée et que le fader se trouve à un 
niveau correct. Si votre ordinateur est équipé d’un microphone interne, vous aurez probablement à 
décocher la case Select sous le fader Microphone avant de quitter l’application Recording Control.  
 

 
Problèmes du Hardware Son  
 
         Le hardware son compatible Windows doit être présent et correctement configuré afin que votre système  
         puisse utiliser SmaartLive. Smaart utilise des techniques d’interface multimédia standard pour accéder à la  



         carte son et devrait fonctionner correctement avec tous les périphériques audio compatibles Windows. Si  
         votre ordinateur dispose de plus d’un hardware son et/ou périphériques ou pilote MIDI E/S installés, vous  
         devez également vous assurer que les périphériques appropriés sont sélectionnés pour l’audio et le MIDI  
         sur l’onglet Devices de la fenêtre de dialogue Options (accessible depuis le menu Options).  
          
         Si SmaartLive ne reconnaît pas votre hardware son, vérifiez si vous pouvez enregistrer et lire des fichiers  
         wave en utilisant le Magnétophone ou le Lecteur Windows Media. Ce sont des utilitaires standards de  
         Windows, en général situés dans Multimedia ou Divertissement dans la section Accessoires du menu  
         Programmes (accessible en cliquant sur le bouton Démarrer dur la Barre de Tâches de Windows). 
   
         Si vous ne pouvez pas lire et enregistrer en utilisant le Magnétophone et/ou le Lecteur Windows Media,  
         vérifiez que le périphérique et le logiciel qui le pilote sont correctement installés. La configuration d’un  
         hardware son nécessite en général de charger des pilotes et des utilitaires en plus de l’installation du  
         hardware. Notez que le Magnétophone et le Lecteur Windows Media ont accès au hardware son à un  
         niveau plus basique que SmaartLive, donc le fait qu’un périphérique fonctionne avec ces utilitaires ne fait  
         pas disparaître la possibilité d’un problème de pilote. Il est toutefois certain que si un périphérique ne  
         fonctionne pas avec le Magnétophone ou avec le Lecteur Windows Media il ne fonctionnera pas avec  
         SmaartLive. 
 
         En fonction de votre système, le pilote du hardware son peut se trouver sur un disque fournit avec la carte  
         ou l’ordinateur, les disques d’installation de Windows, ou sur les deux. Certaines cartes son nécessitent  
         également d’installer des interrupteurs DIP sur la carte elle-même avant l’installation. Et si vous avez mis à   
         jour la version de Windows tournant sur votre ordinateur, vous pourrez avoir besoin de nouveaux pilotes  
         pour votre hardware son.  
     
         Il n’est pas rare que les constructeurs découvre des problèmes sur un pilote de périphérique après leur  
         sortie. Si vous êtes sûr que les pilotes de votre harware et de votre logiciel sont correctement configurés et  
         que vous continuez de rencontrer des problèmes, contactez le constructeur de votre hardware ou de votre  
         ordinateur. Dans la plupart des cas vous pourrez obtenir des mises à jour de pilote qui pourront corriger les  
         problèmes.  
 

Close Wave In On Reset 
 
Si vous rencontrez des problèmes lors de la réception de données audio après avoir changer le mode 
d’affichage ou les paramètres d’entrée dans Smaart Pro, essayez de sélectionner la case nommée Close 
Wave In On Reset dans l’onglet Inputs de la fenêtre de dialogue Options. Cette option fournit une solution 
pour certains pilotes de cartes son qui ne fonctionnent pas correctement lorsque les paramètres d’entrée 
sont modifiés normalement. Dans la plupart des cas SmaartLive n’a pas besoin de fermer le pilote de la 
carte son lorsqu’il modifie les paramètres d’entrée mais certains pilotes de cartes son fonctionnent 
normalement uniquement lorsque le pilote est fermé puis réouvert. Lorsque la case Close Wave In On 
Reset est cochée, vous pourrez entendre des « pops » ou des interruptions dans les signaux de test générés 
internement quand SmaartLive modifie les paramètres du périphérique d’entrée mais le programme 
fonctionnera normalement dans tous les autres cas.  

 
         Use Old Wave Format 
 
         Si votre périphérique d'entrée semble posséder par des démons, activer cette option peut se révéler utile.  
         L'option Use Old wave Format, également accessible depuis l'onglet Devices de la fenêtre de dialogue  
         options, est une solution pour les problèmes liés aux pilotes de carte son. Cette option fournitune  
         compatibilité pour les pilotes de périphériques audio qui ne supportent pas correctement la mise à jour API  
         de Windows apparue la première fois sur Windows 98SE.  
      
         De drôles de choses peuvent arriver si vous fonctionner sous Windows 98SE, ME, 2000 ou XP avec un  
         pilote qui ne supporte pas correctement le nouveau format. La gamme de problèmes dont nous avons eu  
         écho comprend la saturation , la perte des hautes fréquences sur une ou les deux entrées, un périphérique  
         stéréo devenant soudainement mono et le blocage de SmaartLive lors d'un changement de modes  
         d'affichage ou de paramètres d'entrée.  
 
         Cocher la case Use old Wave Format devrait corriger les problèmes provenant de l'incompatibilité du pilote  
         avec les nouveaux formats API. Notez que cela limitera également les résolutions d'échantillonnages  



         disponibles à 16 bits par échantillons sous Windows 98SE, ME, 2000 et XP mais jusqu'à présent nous  
         n'avons entendu parler de ces problèmes que sur des périphériques 16 bit, cela ne devrait donc pas poser de  
         problèmes, dans la plupart des cas. Notez également que si vous utilisez SmaartLive avec Windows 95 ou  
         la version originale de Windows 98, cette option doit être activée par défaut et ne doit pas être désactivée.  
  
Niveaux d’Entrée de la Mesure 
 
         Il est très important de maintenir des niveaux d’entrée appropriés dans SmaartLive. Pour de meilleurs  
         résultats dans tous les types de mesures vous aurez besoin d’un signal assez fort pour délivrer des données  
         solides et un bon rapport signal sur bruit (S/B) mais pas assez fort pour que les crêtes des transitoires  
         fassent clipper le convertisseur A/N. Les vu-mêtres de niveau d’entrée de SmaartLive indique le niveau  
         d’entrée du signal au niveau du convertisseur A/N du hardware son.  
      
         Si le signal est trop faible pour délivrer un bon rapport signal sur bruit, vous risquez de ne pas obtenir des  
         mesures fiables. S’il est trop haut, les entrées seront saturées. Cela n’aura pas seulement une influence sur  
         la fiabilité de vos mesures mais pourra également endommager physiquement votre ordinateur dans des cas  
         extrêmes. Et étant donné que le circuit des deux canaux d’entrée est en général sur une simple puce, saturer  
         un canal peut avoir une influence sur l’autre.  
   
         Les vu-mêtres de niveau d’entrée de SmaartLive ont un indicateur de clip pou chaque canal mais lorsque  
         vous utilisez un signal de test avec un facteur de crête haut, tel qu’un bruit rose, les crêtes de transitoires du  
         signal peuvent être trop rapides pour que le vu-mêtre de niveau d’entrée les détecte. Nous vous  
         recommandons de garder les niveaux d’entrée globaux à environ –12dB afin de prévenir la saturation du  
         convertisseur A/N de l’ordinateur.  
  
         La tension d’entrée du convertisseur A/N est variable. Certaines cartes son vous permettent de régler les  
         niveaux de tension d’entrée du A/N en utilisant des paramètres ou un logiciel de réglage. Certains non.  
         Cela peut nécessiter quelques essais pour trouver un niveau d’entrée analogique approprié pour les entrées  
         audio de votre ordinateur et il est en général conseillé d’utiliser une console, un préamplificateur  
         microphone ou un autre appareil externe pour contrôler les niveaux d’entrée de l’extérieur.  
   
         Si votre ordinateur a des entrées à niveau ligne et microphone, assurez-vous que vous n’envoyez pas un  
         signal à niveau ligne sur une entrée microphone. En règle général, nous vous recommandons d’éviter  
         d’utiliser les entrées à niveau ligne sur la plupart des ordinateurs. La qualité du circuit du préamplificateur  
         des cartes son n’approche même pas, en général, celle des préamplificateurs des consoles bas de gamme et  
         utiliser une petite console pour gérer les signaux d’entrée des mesures offre également d’autres avantages.  
 
Problèmes avec la Fonction de Transfert  
 
         Si le tracé de la fonction de transfert devient instable, assurez-vous que le niveau du signal des deux entrées  
         est suffisant. Pour de meilleurs résultats, utilisez un signal contenant une énergie pleine bande, tel qu’un  
         bruit rose, pour des mesures de fonction de transfert complètes. Tous les processeurs de dynamique  
         (appareils sur lesquels le niveau de sortie est dépendant du niveau d’entrée, tel que des compresseurs ou  
         des limiteurs) doivent être désactivés si possible lors d’une mesure de Fonction de transfert.  
  
         Il est essentiel que les deux signaux soient alignés dans le temps afin que le calcul de la fonction de    
         transfert soit correct. Tout appareil qui introduit un délai (même lorsqu’il est désactivé) doit être utilisé sur          
         les deux signaux d’entrée, compensé en ajoutant un délai identique sur l’autre canal d’entrée, ou  
         complètement supprimé des cheminements des signaux de mesure et de référence. Lorsque vous faites des  
         mesures acoustiques (microphone) vous devez toujours penser à trouver et à compenser le délai total du  
         système à tester et le temps nécessaire au son pour aller du haut-parleur au microphone.  
  
         Dans des espaces très réverbérants avec des sols durs, si le microphone est placé sur (ou juste au-dessus)  
         d’une surface réfléchissante un filtrage en peigne risque d’apparaître. Vous pouvez souvent réduire ou  
         éliminer le filtrage en peigne en plaçant des matériaux absorbants sous ou derrière le microphone ou en  
         obstruant le chemin de réflexion pour casser l’onde. Par exemple, un pan de fly-case peu bien fonctionner  
         pour couper une réflexion du sol. Une autre option étant de placer le microphone de mesure sur le sol afin  
         que le temps de  réflexion depuis le sol sit trop court pour affecter les fréquences audibles.  
     
         Nous vous recommandons d’utiliser des microphones omnidirectionnels pour la plupart des mesures  



         acoustiques. Dans des espaces très bruyants ou réverbérants, ou lorsque vous faites des mesures en  
         extérieur dans le vent, utiliser un microphone cardioïde de haut qualité peut aider à améliorer la cohérence  
         de la mesure de fonction de transfert. Cette utilisation doit en général être évitée puisque la réponse  
         directive des microphones cardioïdes peut varier largement en fonction des fréquences.  
   
 
Problèmes avec le Delay Locator/Impulse Mode 
 
         Voici certains des problèmes les plus courants qui affecte les mesures de mode Impulse ainsi que le  
         localisateur de délai automatique. Ces deux fonctions sont basées sur une mesure de réponse d’impulsion  
         donc tous problèmes affectant une fonction affectera également l’autre. Et beaucoup des mêmes problèmes  

-- particulièrement les problèmes liés au signal – qui peuvent entraîner des mesures de réponse d’impulsion 
peu fiables peuvent également compromettre la qualité des données sur d’autres types de mesure.    

 
         Rapport Signal sur Bruit Faible  
 
         Dans des espaces réverbérants, l’amplitude de la crête du tracé de la réponse d’impulsion est une fonction  
         du rapport signal sur bruit de la mesure. Si vous ne voyez pas une grande crête sur le tracé du mode  
         Impulse ou si le seuil du bruit de la mesure est trop haut pour visualiser les informations acoustiques à  
         propos de la pièce, il peut être utile d’augmenter le gain du microphone de mesure et/ou des haut-parleurs  
         utilisés pour stimuler la pièce.  
   
         Une autre façon d’augmenter le rapport signal sur bruit dans les mesures de réponse d’impulsion est  
         d’augmenter le nombre de points de moyenne. Le nombre de points de Moyenne pour les presets de Petite  
         et de Grande fenêtre temporelle est réglé (indépendamment) depuis l’onglet Locator de la fenêtre de  
         dialogue Options. Si cette valeur est supérieure à 1, l’enregistreur d’impulsion enregistre le nombre  
         d’images FFT spécifié et fait une moyenne des données de toutes les images enregistrées dans le calcul de  
         la réponse d’impulsion. Chaque fois que le nombre de points de moyenne double le rapport signal sur bruit  
         augmente de 3dB (jusqu’au seuil de bruit absolu du système en test ou du système de mesure, en fonction  
         de celui qui est le plus silencieux).  
   
         Entrées Saturées  
 
         Si la réponse d’impulsion semble « clippée », ou coupée en haut, assurez-vous que les signaux entrant dans  
         l’ordinateur ne saturent pas les entrées de la carte son. Lorsque vous utilisez le bruit rose, les niveaux  
         d’entrée indiqués sur le vu-mêtre ne doivent pas dépasser –12dB.  
  
         Constante Temporelle FFT Trop Courte 
 
         Si le tracé du mode Impulse semble instable, sans une seule grande crête et/ou avec plusieurs crêtes d’une  
         amplitude pratiquement égale, la raison peut être que la Constante Temporelle FFT EST TROP COURTE.  
         Assurez-vous que la constante temporelle FFT est réglée sur une valeur plus grande que le temps de decay  
         du système en test.  
   
 
         Entrées Interverties  
 
         Une singularité du calcul de l’enregistreur d’impulsion entraîne l’affichage des délais négatifs à la fin de  
         l’échelle temporelle, semblant ainsi indiquer un temps de délai, incroyablement long. Il y a deux causes à  
         ce problème.  
 
         La cause la plus courante des délais négatifs est que les canaux d’entrée sont intervertis (le signal de  
         mesure est sur le canal 1 alors que SmaartLive s’attend à trouver le signal de référence). Dans ce cas,  
         sélectionner Flip Inputs dans le menu options devrait résoudre le problème mais il est préférable de  
         modifier physiquement la connectique des câbles des deux entrées afin d’éviter toute confusion.  
    
         L’autre cause possible pour un délai négatif est qu’il y a réellement un délai sur le signal de référence. Ce  
         problème peut en général être évité en amenant le signal de référence à l’ordinateur par le plus court  
         chemin possible. Sinon il peut être nécessaire de mesurer et de compenser le délai du signal de référence en  



         utilisant le délai interne ou une unité de délai externe.  
   
         Les appareils numériques de traitement du signal sont des suspects idéaux pour le délai du signal de  
         référence. Beaucoup d’unités de délai numériques introduisent un délai, mais lorsqu’elles sont en  
         « bypass » et/ou indiquent un temps de délai de 0ms. On appelle cela la latence. D’autres appareils  
         numériques peuvent également introduire un délai non désiré. Si le délai du canal de référence est connu, il  
         est possible de calculer le délai actuel en intervertissant les entrées, en recommençant l’enregistrement  
         d’impulsion et en ajoutant le délai de référence au temps du délai de propagation trouvé. 
    
         Erreur de l’Opérateur  
 
         L’une des erreurs les plus fréquentes en ce qui concerne les mesures de réponse d’impulsion dans les  
         premières versions de SIA Smaart était d’oublier de mettre le délai interne de SmaartLive sur zéro avant de  
         faire de nouvelles mesures. Le localisateur de délai automatique de SmaartLive désactive automatiquement  
         le délai interne et par défaut, le programme vous avertira si le paramètre de délai n’est pas à zéro lorsque  
         vous faites une nouvelle mesure en mode Impulse. Si vous désactivez cette option pour quelque raison  
         vous devrez vous souvenir de remettre le délai à zéro vous-même avant de faire une mesure de réponse  
         d’impulsion. Pour éviter les problèmes avec les mesures en mode Impulse nous vous recommandons de  
         garder l’une des options Warn if Delay Not 0 ou Always Set Delay To 0 activées sur l’onglet Locator de la  
         fenêtre de dialogue Options.  
  
 
Performances  
 
         Par défaut SmaartLive tente de collecter et de traiter les nouvelles données audio provenant des entrées  
         audio de l’ordinateur plusieurs fois par seconde. Cela peut laisser de ressources pour traiter les commandes  
         et les cliques de souris sur certaines machines.  
   
         Si le programme semble lent ou ne répond plus, prend beaucoup de temps à répondre aux cliques de souris  
         et aux commandes du clavier essayez de cocher la case Slow Computer de l’onglet Inputs de la fenêtre de  
         dialogue Options. Cela forcera SmaartLive à vérifier l’interface utilisateur plus souvent et peut améliorer la  
         réponse globale toutefois cela peut aussi réduire la vitesse de mise à jour de l’affichage.  
  
         Si l’ordinateur n’a pas assez de RAM physique pour contenir l’information dont SmaartLive a besoin il  
         utilisera la mémoire virtuelle et cela peut altérer dramatiquement les performances du programme.  
         SmaartLive peut même sembler bloquer dans certains cas. Cela s’accompagne en général par une activité  
         soutenue au niveau du disque dur lorsque l’ordinateur transfère les données de la mémoire physique vers le  
         disque dur et vice versa. 
   
         Si vous rencontrez ce problème, fermez les autres programmes pour augmenter la quantité de mémoire  
         disponible pour Smaart Pro. Vous pouvez également essayer de limiter le nombre de points de moyennes  
         des tracés de SmaartLive au maximum et d’afficher les tracés de référence uniquement lorsque c’est  
         nécessaire. Si le problème persiste, vous aurez peut être à installer de la RAM supplémentaire sur votre  
         ordinateur. 
 
Problèmes d’Affichage 
 
         Problèmes pour les Titres et les Noms 
 
         SmaartLive utilise normalement la police Arial (TrueType) pour les titres des graphiques, les noms et les  
         légendes. Ces polices sont installées sur votre ordinateur par Windows et bien qu’elles puissent être  
         supprimées comme tout autre police TrueType, beaucoup d’applications Windows (dont SmaartLive)  
         s’attendent à les trouver et peuvent se compter bizarrement dans le cas contraire.  
   
         Bien que SmaartLive puisse fonctionner sans ces polices, l’apparence des commandes à l’écran et des  
         graphiques peut en souffrir si elles ne sont pas disponibles. Les résultats varient d’un ordinateur à l’autre en  
         fonction des polices disponibles. Si un ou plusieurs des fichiers de polices Arial manquent ou sont  
         corrompus, le problème peut se manifester de différentes façons.  
         Les symptômes peuvent inclure des polices et/ou des tailles bizarres sur les noms des graphiques et les  



         affichages du curseur et les noms des tracés verticaux qui ne pivotent pas (lecture horizontal).  
  
 
         Espace entre Commandes  
 
         Vous avez peut être remarqué que lorsque vous changez de résolution vidéo ou de couleur dans Windows  
         vous disposez également d’options vous permettant de sélectionner des « Petites Polices » ou des  
         « Grandes Polices ». Certains pilotes fournissent d’autres choix. Ces options se réfèrent aux polices d’écran  
         bitmap utilisées dans les menus, les fenêtres de dialogue et les autres zones de contrôle. Puisque ces polices  
         sont constituées de simples bitmaps les pilotes d’affichage comprennent en général plusieurs ensembles de  
         polices dans différentes tailles pour s’adapter aux différentes résolutions d’écran.  
     
         Dans certains cas, les noms des boutons et l’espace entre les commandes de SmaartLive, particulièrement  
         dans les fenêtres de dialogue, sont basés sur le système de police bitmap chargé depuis les pilotes vidéo de  
         Windows. Il est possible que certaines zones de contrôle ne soient pas affichées correctement avec toutes  
         les combinaisons police/résolution, en fonction de vos pilotes d’affichage.  
 
Revenir à la Configuration par Défaut 
 
         Les options d’affichage et d’échelle de SmaartLive sont très flexibles et peuvent parfois être troublantes,  
         surtout au départ. Presque toutes ces options sont enregistrées dans la Configuration actuelle qui est mise à  
         jour à chaque fois que vous quittez le programme.  
  
         Lorsque vous démarrez SmaartLive, il inspecte la dernière Configuration utilisée et charge ses paramètres.  
         Si vous désirez revenir aux paramètres par défaut du programme, sélectionnez Set All Values to Default  
         dans la section Configuration du menu File. Cela remet tous les paramètres du programme sauf Color  
         Scheme et Device par défaut. 
   
Notes sur les Appareils Externes  
 
         SmaartLive est capable d’envoyer des commandes vers des appareils externes très rapidement et dans  
         certaines circonstances peut envoyer des instructions plus vite qu’un appareil donné pourra traiter ces  
         données entrantes. Cela peut parfois entraîner la surcharge du buffer d’un appareil récepteur et donc l’arrêt  
         bref du traitement des instructions entrantes. S’il y a une surcharge, l’appareil télécommandé sera  
         déconnectera pendant quelques instants et le message « [No Device Found] » apparaîtra sur le tracé de  
         SmaartLive. 
 
         Si vous constatez ceci, vous modifiez peut être trop de paramètres, trop rapidement sur l’appareil  
         télécommandé. Essayez d’utiliser la souris au lieu des touches des flèches lorsque vous avez besoin de  
         modifier de nombreux paramètres du filtre. Lorsque vous utilisez les flèches, l’ordinateur envoie toutes les  
         informations provenant du clavier à l’appareil télécommandé alors que quand vous utilisez la souris pour  
         déplacer un filtre, une commande est envoyée uniquement lorsque vous faites une pause pendant un temps  
         déterminé ou que vous relâchez le bouton. 
  
         Une surcharge du buffer de commandes n’est normalement pas une erreur fatale et ne devrait pas mettre en  
         danger l’appareil télécommandé ou aucun de ses composants. SmaartLive peut en général rétablir la  
         communication en une à deux secondes et résoudra automatiquement toutes différences entre les états  
         actuels des commandes du logiciel et les paramètres de l’appareil externe.  
    
         Notes sur la Communication MIDI 
 
         SmaartLive a besoin d’une communication bidirectionnelle pour télécommander des appareils externes,  
         quelque soit la méthode de communication utilisée. Avec des appareils MIDI, cela signifie que les lignes  
         MIDI In et MIDI Out doivent être connectées entre l’ordinateur et l’appareil télécommandé. Notez  
         également que certains appareils coexistent sur un réseau MIDI mieux que d’autres. Par exemple, un  
         appareil provenant d’un constructeur pourra ne pas répondre correctement aux commande MIDI d’un autre  
         appareil d’un constructeur différent depuis son port MIDI IN vers son port MIDI Out. Cela peut rendre la  
         communication bidirectionnelle entre appareils de constructeurs différents via un seul port MIDI E/S  
         impossible. 



 
 
 
Information sur le Support Technique 
 
         Les mises à jour de maintenance pou SmaartLive seront publiées sur le site web de SIA Software  
         Company, Inc lorsqu’elles seront disponibles. Le site web se trouve à www.siasoft.com. Vous pouvez  
         également trouver des Notes d’Applications, des Etudes de Cas, des réponses aux questions les plus  
         fréquentes ainsi que des informations sur nos produits et d’autres informations intéressantes pour les   
         utilisateurs de SmaartLive sur notre site web.  
     
         Le support technique est disponible depuis notre site internet, par e-mail ou par téléphone. Le site web SIA  
         comprend un forum de support en ligne – un bulletin électronique où les utilisateurs de SmaartLive peuvent  
         poser des questions et le personnel technique de SIA ainsi que les autres utilisateurs peuvent répondre. Le  
         site web indique également la liste la plus récente des informations concernant le contact du support  
         technique de SIA sur la page Support.  
  
         Pour un support technique via e-mail, l’adresse est support@siasoft.com. Le numéro de téléphone du  
         support technique de SIA (aux USA) est (+) 1-508-234-9877.  
 
 
 
 
 
    
 


